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Basic Safety Instructions

Always read through and comply with the following safety instructions!

All plants and locations of the Rohde & Schwarz group of companies make every effort to keep the safety
standards of our products up to date and to offer our customers the highest possible degree of safety. Our
products and the auxiliary equipment they require are designed, built and tested in accordance with the
safety standards that apply in each case. Compliance with these standards is continuously monitored by
our quality assurance system. The product described here has been designed, built and tested in
accordance with the EC Certificate of Conformity and has left the manufacturer’s plant in a condition fully
complying with safety standards. To maintain this condition and to ensure safe operation, you must
observe all instructions and warnings provided in this manual. If you have any questions regarding these
safety instructions, the Rohde & Schwarz group of companies will be happy to answer them.

Furthermore, it is your responsibility to use the product in an appropriate manner. This product is designed
for use solely in industrial and laboratory environments or, if expressly permitted, also in the field and must
not be used in any way that may cause personal injury or property damage. You are responsible if the
product is used for any purpose other than its designated purpose or in disregard of the manufacturer's
instructions. The manufacturer shall assume no responsibility for such use of the product.

The product is used for its designated purpose if it is used in accordance with its product documentation
and within its performance limits (see data sheet, documentation, the following safety instructions). Using
the product requires technical skills and, in some cases, a basic knowledge of English. It is therefore
essential that only skilled and specialized staff or thoroughly trained personnel with the required skills be
allowed to use the product. If personal safety gear is required for using Rohde & Schwarz products, this
will be indicated at the appropriate place in the product documentation. Keep the basic safety instructions
and the product documentation in a safe place and pass them on to the subsequent users.

Observing the safety instructions will help prevent personal injury or damage of any kind caused by
dangerous situations. Therefore, carefully read through and adhere to the following safety instructions
before and when using the product. It is also absolutely essential to observe the additional safety
instructions on personal safety, for example, that appear in relevant parts of the product documentation. In
these safety instructions, the word "product"” refers to all merchandise sold and distributed by the Rohde &
Schwarz group of companies, including instruments, systems and all accessories. For product-specific
information, see the data sheet and the product documentation.

Safety labels on products

The following safety labels are used on products to warn against risks and dangers.

Symbol Meaning Symbol Meaning

Notice, general danger location | O ON/OFF Power

Observe product documentation

Caution when handling heavy equipment d) Standby indication

Danger of electric shock f— Direct current (DC)

> B>
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Basic Safety Instructions

Meaning Symbol Meaning
Caution ! Hot surface ~_ Alternating current (AC)
Protective conductor terminal = Direct/alternating current (DC/AC)
To identify any terminal which is intended for
connection to an external conductor for
protection against electric shock in case of a
fault, or the terminal of a protective earth
Earth (Ground) D Class Il Equipment
to identify equipment meeting the safety

requirements specified for Class Il equipment
(device protected by double or reinforced
insulation)

Frame or chassis Ground terminal

EU labeling for batteries and accumulators

For additional information, see section "Waste
disposal/Environmental protection”, item 1.

devices

Be careful when handling electrostatic sensitive

EU labeling for separate collection of electrical
and electronic devices

For additional information, see section "Waste
disposal/Environmental protection”, item 2.

Warning! Laser radiation

For additional information, see section
"Operation", item 7.

Signal words and their meaning

The following signal words are used in the product documentation in order to warn the reader about risks

and dangers.

& WARNING

A CAUTION

Indicates a hazardous situation which, if not avoided, will result in death or
serious injury.

Indicates a hazardous situation which, if not avoided, could result in death or
serious injury.

Indicates a hazardous situation which, if not avoided, could result in minor or
moderate injury.

Indicates information considered important, but not hazard-related, e.g.
messages relating to property damage.
In the product documentation, the word ATTENTION is used synonymously.

These signal words are in accordance with the standard definition for civil applications in the European
Economic Area. Definitions that deviate from the standard definition may also exist in other economic
areas or military applications. It is therefore essential to make sure that the signal words described here
are always used only in connection with the related product documentation and the related product. The
use of signal words in connection with unrelated products or documentation can result in misinterpretation
and in personal injury or material damage.
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Basic Safety Instructions

Operating states and operating positions

The product may be operated only under the operating conditions and in the positions specified by the
manufacturer, without the product's ventilation being obstructed. If the manufacturer's specifications are
not observed, this can result in electric shock, fire and/or serious personal injury or death. Applicable local
or national safety regulations and rules for the prevention of accidents must be observed in all work
performed.

1.

Unless otherwise specified, the following requirements apply to Rohde & Schwarz products:
predefined operating position is always with the housing floor facing down, IP protection 2X, use only
indoors, max. operating altitude 2000 m above sea level, max. transport altitude 4500 m above sea
level. A tolerance of +10 % shall apply to the nominal voltage and +5 % to the nominal frequency,
overvoltage category 2, pollution degree 2.

Do not place the product on surfaces, vehicles, cabinets or tables that for reasons of weight or stability
are unsuitable for this purpose. Always follow the manufacturer's installation instructions when
installing the product and fastening it to objects or structures (e.g. walls and shelves). An installation
that is not carried out as described in the product documentation could result in personal injury or
even death.

Do not place the product on heat-generating devices such as radiators or fan heaters. The ambient
temperature must not exceed the maximum temperature specified in the product documentation or in
the data sheet. Product overheating can cause electric shock, fire and/or serious personal injury or
even death.

Electrical safety

If the information on electrical safety is not observed either at all or to the extent necessary, electric shock,
fire and/or serious personal injury or death may occur.

1.

Prior to switching on the product, always ensure that the nominal voltage setting on the product
matches the nominal voltage of the mains-supply network. If a different voltage is to be set, the power
fuse of the product may have to be changed accordingly.

In the case of products of safety class | with movable power cord and connector, operation is
permitted only on sockets with a protective conductor contact and protective conductor.

Intentionally breaking the protective conductor either in the feed line or in the product itself is not
permitted. Doing so can result in the danger of an electric shock from the product. If extension cords
or connector strips are implemented, they must be checked on a regular basis to ensure that they are
safe to use.

If there is no power switch for disconnecting the product from the mains, or if the power switch is not
suitable for this purpose, use the plug of the connecting cable to disconnect the product from the
mains. In such cases, always ensure that the power plug is easily reachable and accessible at all
times. For example, if the power plug is the disconnecting device, the length of the connecting cable
must not exceed 3 m. Functional or electronic switches are not suitable for providing disconnection
from the AC supply network. If products without power switches are integrated into racks or systems,
the disconnecting device must be provided at the system level.

Never use the product if the power cable is damaged. Check the power cables on a regular basis to
ensure that they are in proper operating condition. By taking appropriate safety measures and
carefully laying the power cable, ensure that the cable cannot be damaged and that no one can be
hurt by, for example, tripping over the cable or suffering an electric shock.
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10.

11.

12.

13.

14.

15.

16.

17.

18.

Basic Safety Instructions

The product may be operated only from TN/TT supply networks fuse-protected with max. 16 A (higher
fuse only after consulting with the Rohde & Schwarz group of companies).

Do not insert the plug into sockets that are dusty or dirty. Insert the plug firmly and all the way into the
socket provided for this purpose. Otherwise, sparks that result in fire and/or injuries may occur.

Do not overload any sockets, extension cords or connector strips; doing so can cause fire or electric
shocks.

For measurements in circuits with voltages Vs > 30 V, suitable measures (e.g. appropriate
measuring equipment, fuse protection, current limiting, electrical separation, insulation) should be
taken to avoid any hazards.

Ensure that the connections with information technology equipment, e.g. PCs or other industrial
computers, comply with the IEC 60950-1 / EN 60950-1 or IEC 61010-1 / EN 61010-1 standards that
apply in each case.

Unless expressly permitted, never remove the cover or any part of the housing while the product is in
operation. Doing so will expose circuits and components and can lead to injuries, fire or damage to the
product.

If a product is to be permanently installed, the connection between the protective conductor terminal
on site and the product's protective conductor must be made first before any other connection is
made. The product may be installed and connected only by a licensed electrician.

For permanently installed equipment without built-in fuses, circuit breakers or similar protective
devices, the supply circuit must be fuse-protected in such a way that anyone who has access to the
product, as well as the product itself, is adequately protected from injury or damage.

Use suitable overvoltage protection to ensure that no overvoltage (such as that caused by a bolt of
lightning) can reach the product. Otherwise, the person operating the product will be exposed to the
danger of an electric shock.

Any object that is not designed to be placed in the openings of the housing must not be used for this
purpose. Doing so can cause short circuits inside the product and/or electric shocks, fire or injuries.

Unless specified otherwise, products are not liquid-proof (see also section "Operating states and
operating positions", item 1). Therefore, the equipment must be protected against penetration by
liquids. If the necessary precautions are not taken, the user may suffer electric shock or the product
itself may be damaged, which can also lead to personal injury.

Never use the product under conditions in which condensation has formed or can form in or on the
product, e.qg. if the product has been moved from a cold to a warm environment. Penetration by water
increases the risk of electric shock.

Prior to cleaning the product, disconnect it completely from the power supply (e.g. AC supply network
or battery). Use a soft, non-linting cloth to clean the product. Never use chemical cleaning agents such
as alcohol, acetone or diluents for cellulose lacquers.

Operation

1.

Operating the products requires special training and intense concentration. Make sure that persons
who use the products are physically, mentally and emotionally fit enough to do so; otherwise, injuries
or material damage may occur. It is the responsibility of the employer/operator to select suitable
personnel for operating the products.
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2. Before you move or transport the product, read and observe the section titled "Transport".

3. As with all industrially manufactured goods, the use of substances that induce an allergic reaction
(allergens) such as nickel cannot be generally excluded. If you develop an allergic reaction (such as a
skin rash, frequent sneezing, red eyes or respiratory difficulties) when using a Rohde & Schwarz
product, consult a physician immediately to determine the cause and to prevent health problems or
stress.

4. Before you start processing the product mechanically and/or thermally, or before you take it apart, be
sure to read and pay special attention to the section titled "Waste disposal/Environmental protection”,
item 1.

5. Depending on the function, certain products such as RF radio equipment can produce an elevated
level of electromagnetic radiation. Considering that unborn babies require increased protection,
pregnant women must be protected by appropriate measures. Persons with pacemakers may also be
exposed to risks from electromagnetic radiation. The employer/operator must evaluate workplaces
where there is a special risk of exposure to radiation and, if necessary, take measures to avert the
potential danger.

6. Should a fire occur, the product may release hazardous substances (gases, fluids, etc.) that can
cause health problems. Therefore, suitable measures must be taken, e.g. protective masks and
protective clothing must be worn.

7. Laser products are given warning labels that are standardized according to their laser class. Lasers
can cause biological harm due to the properties of their radiation and due to their extremely
concentrated electromagnetic power. If a laser product (e.g. a CD/DVD drive) is integrated into a
Rohde & Schwarz product, absolutely no other settings or functions may be used as described in the
product documentation. The objective is to prevent personal injury (e.g. due to laser beams).

8. EMC classes (in line with EN 55011/CISPR 11, and analogously with EN 55022/CISPR 22,

EN 55032/CISPR 32)

— Class A equipment:
Equipment suitable for use in all environments except residential environments and environments
that are directly connected to a low-voltage supply network that supplies residential buildings
Note: Class A equipment is intended for use in an industrial environment. This equipment may
cause radio disturbances in residential environments, due to possible conducted as well as
radiated disturbances. In this case, the operator may be required to take appropriate measures to
eliminate these disturbances.

— Class B equipment:
Equipment suitable for use in residential environments and environments that are directly
connected to a low-voltage supply network that supplies residential buildings

Repair and service

1. The product may be opened only by authorized, specially trained personnel. Before any work is
performed on the product or before the product is opened, it must be disconnected from the AC supply
network. Otherwise, personnel will be exposed to the risk of an electric shock.
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Adjustments, replacement of parts, maintenance and repair may be performed only by electrical
experts authorized by Rohde & Schwarz. Only original parts may be used for replacing parts relevant
to safety (e.g. power switches, power transformers, fuses). A safety test must always be performed
after parts relevant to safety have been replaced (visual inspection, protective conductor test,
insulation resistance measurement, leakage current measurement, functional test). This helps ensure
the continued safety of the product.

Batteries and rechargeable batteries/cells

If the information regarding batteries and rechargeable batteries/cells is not observed either at all or to the
extent necessary, product users may be exposed to the risk of explosions, fire and/or serious personal
injury, and, in some cases, death. Batteries and rechargeable batteries with alkaline electrolytes (e.g.
lithium cells) must be handled in accordance with the EN 62133 standard.

1.
2.

Cells must not be taken apart or crushed.

Cells or batteries must not be exposed to heat or fire. Storage in direct sunlight must be avoided.
Keep cells and batteries clean and dry. Clean soiled connectors using a dry, clean cloth.

Cells or batteries must not be short-circuited. Cells or batteries must not be stored in a box or in a
drawer where they can short-circuit each other, or where they can be short-circuited by other
conductive materials. Cells and batteries must not be removed from their original packaging until they
are ready to be used.

Cells and batteries must not be exposed to any mechanical shocks that are stronger than permitted.

If a cell develops a leak, the fluid must not be allowed to come into contact with the skin or eyes. If
contact occurs, wash the affected area with plenty of water and seek medical aid.

Improperly replacing or charging cells or batteries that contain alkaline electrolytes (e.g. lithium cells)
can cause explosions. Replace cells or batteries only with the matching Rohde & Schwarz type (see
parts list) in order to ensure the safety of the product.

Cells and batteries must be recycled and kept separate from residual waste. Rechargeable batteries
and normal batteries that contain lead, mercury or cadmium are hazardous waste. Observe the
national regulations regarding waste disposal and recycling.

Transport

1.

The product may be very heavy. Therefore, the product must be handled with care. In some cases,
the user may require a suitable means of lifting or moving the product (e.g. with a lift-truck) to avoid
back or other physical injuries.

Handles on the products are designed exclusively to enable personnel to transport the product. It is
therefore not permissible to use handles to fasten the product to or on transport equipment such as
cranes, fork lifts, wagons, etc. The user is responsible for securely fastening the products to or on the
means of transport or lifting. Observe the safety regulations of the manufacturer of the means of
transport or lifting. Noncompliance can result in personal injury or material damage.

If you use the product in a vehicle, it is the sole responsibility of the driver to drive the vehicle safely
and properly. The manufacturer assumes no responsibility for accidents or collisions. Never use the
product in a moving vehicle if doing so could distract the driver of the vehicle. Adequately secure the
product in the vehicle to prevent injuries or other damage in the event of an accident.
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Instrucciones de seguridad elementales

Waste disposal/Environmental protection

1. Specially marked equipment has a battery or accumulator that must not be disposed of with unsorted
municipal waste, but must be collected separately. It may only be disposed of at a suitable collection
point or via a Rohde & Schwarz customer service center.

2. Waste electrical and electronic equipment must not be disposed of with unsorted municipal waste, but
must be collected separately.
Rohde & Schwarz GmbH & Co. KG has developed a disposal concept and takes full responsibility for
take-back obligations and disposal obligations for manufacturers within the EU. Contact your
Rohde & Schwarz customer service center for environmentally responsible disposal of the product.

3. If products or their components are mechanically and/or thermally processed in a manner that goes
beyond their intended use, hazardous substances (heavy-metal dust such as lead, beryllium, nickel)
may be released. For this reason, the product may only be disassembled by specially trained
personnel. Improper disassembly may be hazardous to your health. National waste disposal
regulations must be observed.

4. If handling the product releases hazardous substances or fuels that must be disposed of in a special
way, e.g. coolants or engine oils that must be replenished regularly, the safety instructions of the
manufacturer of the hazardous substances or fuels and the applicable regional waste disposal
regulations must be observed. Also observe the relevant safety instructions in the product
documentation. The improper disposal of hazardous substances or fuels can cause health problems
and lead to environmental damage.

For additional information about environmental protection, visit the Rohde & Schwarz website.

Instrucciones de seguridad elementales

iEs imprescindible leer y cumplir las siguientes instrucciones e informaciones de seguridad!

El principio del grupo de empresas Rohde & Schwarz consiste en tener nuestros productos siempre al dia
con los estandares de seguridad y de ofrecer a nuestros clientes el maximo grado de seguridad. Nuestros
productos y todos los equipos adicionales son siempre fabricados y examinados segun las normas de
seguridad vigentes. Nuestro sistema de garantia de calidad controla constantemente que sean cumplidas
estas normas. El presente producto ha sido fabricado y examinado segun el certificado de conformidad
de la UE y ha salido de nuestra planta en estado impecable segun los estandares técnicos de seguridad.
Para poder preservar este estado y garantizar un funcionamiento libre de peligros, el usuario debera
atenerse a todas las indicaciones, informaciones de seguridad y notas de alerta. El grupo de empresas
Rohde & Schwarz esta siempre a su disposicién en caso de que tengan preguntas referentes a estas
informaciones de seguridad.

Ademés queda en la responsabilidad del usuario utilizar el producto en la forma debida. Este producto
esta destinado exclusivamente al uso en la industria y el laboratorio o, si ha sido expresamente
autorizado, para aplicaciones de campo y de ninguna manera debera ser utilizado de modo que alguna
persona/cosa pueda sufrir dafio. El uso del producto fuera de sus fines definidos o sin tener en cuenta las
instrucciones del fabricante queda en la responsabilidad del usuario. El fabricante no se hace en ninguna
forma responsable de consecuencias a causa del mal uso del producto.
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Instrucciones de seguridad elementales

Se parte del uso correcto del producto para los fines definidos si el producto es utilizado conforme a las
indicaciones de la correspondiente documentacion del producto y dentro del margen de rendimiento
definido (ver hoja de datos, documentacién, informaciones de seguridad que siguen). El uso del producto
hace necesarios conocimientos técnicos y ciertos conocimientos del idioma inglés. Por eso se debe tener
en cuenta que el producto solo pueda ser operado por personal especializado o personas instruidas en
profundidad con las capacidades correspondientes. Si fuera necesaria indumentaria de seguridad para el
uso de productos de Rohde & Schwarz, encontraria la informacion debida en la documentacion del
producto en el capitulo correspondiente. Guarde bien las informaciones de seguridad elementales, asi
como la documentacién del producto, y entréguelas a usuarios posteriores.

Tener en cuenta las informaciones de seguridad sirve para evitar en lo posible lesiones o dafios por
peligros de toda clase. Por eso es imprescindible leer detalladamente y comprender por completo las
siguientes informaciones de seguridad antes de usar el producto, y respetarlas durante el uso del
producto. Deberan tenerse en cuenta todas las demas informaciones de seguridad, como p. €j. las
referentes a la proteccion de personas, que encontrardn en el capitulo correspondiente de la
documentacién del producto y que también son de obligado cumplimiento. En las presentes
informaciones de seguridad se recogen todos los objetos que distribuye el grupo de empresas

Rohde & Schwarz bajo la denominacién de "producto”, entre ellos también aparatos, instalaciones asi
como toda clase de accesorios. Los datos especificos del producto figuran en la hoja de datos y en la
documentacién del producto.

Sefializacién de seguridad de los productos

Las siguientes sefiales de seguridad se utilizan en los productos para advertir sobre riesgos y peligros.

Simbolo Significado Simbolo Significado

Aviso: punto de peligro general | O Tension de alimentacion de PUESTA EN

o, MARCHA / PARADA
Observar la documentacion del producto

Atencién en el manejo de dispositivos de peso d) Indicacion de estado de espera (standby)
A elevado
| 18 kg |
2 Peligro de choque eléctrico e Corriente continua (DC)
f Advertencia: superficie caliente A~ Corriente alterna (AC)
. Conexion a conductor de proteccion —_ Corriente continua / Corriente alterna (DC/AC)
Conexion a tierra D El aparato esta protegido en su totalidad por un
aislamiento doble (reforzado)
Conexi6n a masa Distintivo de la UE para baterias y
acumuladores

Mas informacién en la seccion
"Eliminacion/proteccion del medio ambiente",
punto 1.
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Simbolo Significado Significado

Aviso: Cuidado en el manejo de dispositivos
sensibles a la electrostatica (ESD)

Distintivo de la UE para la eliminacion por
separado de dispositivos eléctricos y
electronicos

Mas informacién en la seccion
"Eliminacion/proteccion del medio ambiente”,
punto 2.

Advertencia: rayo laser

Mas informacion en la seccién
"Funcionamiento", punto 7.

Palabras de sefial y su significado

En la documentacidon del producto se utilizan las siguientes palabras de sefial con el fin de advertir contra
riesgos y peligros.

A PELIGRO Indica una situacion de peligro que, si no se evita, causa lesiones
graves o incluso la muerte.

Indica una situacién de peligro que, si no se evita, puede causar

A ADVERTENCIA lesiones graves o incluso la muerte.

Indica una situacién de peligro que, si no se evita, puede causar
lesiones leves o moderadas.

A ATENCION

m Indica informacién que se considera importante, pero no en relacion
con situaciones de peligro; p. €j., avisos sobre posibles dafios
materiales.

En la documentacion del producto se emplea de forma sindénima el
término CUIDADO.

Las palabras de sefial corresponden a la definicion habitual para aplicaciones civiles en el area
econdémica europea. Pueden existir definiciones diferentes a esta definicién en otras areas econémicas o
en aplicaciones militares. Por eso se deberd tener en cuenta que las palabras de sefial aqui descritas
sean utilizadas siempre solamente en combinacion con la correspondiente documentacién del producto y
solamente en combinacion con el producto correspondiente. La utilizacion de las palabras de sefial en
combinacion con productos o documentaciones que no les correspondan puede llevar a interpretaciones
equivocadas y tener por consecuencia dafios en personas u objetos.

Estados operativos y posiciones de funcionamiento

El producto solamente debe ser utilizado segun lo indicado por el fabricante respecto a los estados
operativos y posiciones de funcionamiento sin que se obstruya la ventilacion. Si no se siguen las
indicaciones del fabricante, pueden producirse choques eléctricos, incendios y/o lesiones graves con
posible consecuencia de muerte. En todos los trabajos deberan ser tenidas en cuenta las normas
nacionales y locales de seguridad del trabajo y de prevencion de accidentes.
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Si no se convino de otra manera, es para los productos Rohde & Schwarz valido lo que sigue:
como posicién de funcionamiento se define por principio la posicién con el suelo de la caja para
abajo, modo de proteccién IP 2X, uso solamente en estancias interiores, utilizacién hasta 2000 m
sobre el nivel del mar, transporte hasta 4500 m sobre el nivel del mar. Se aplicara una tolerancia de
+10 % sobre el voltaje nominal y de +5 % sobre la frecuencia nominal. Categoria de sobrecarga
eléctrica 2, indice de suciedad 2.

No sitle el producto encima de superficies, vehiculos, estantes o mesas, que por sus caracteristicas
de peso o de estabilidad no sean aptos para él. Siga siempre las instrucciones de instalacion del
fabricante cuando instale y asegure el producto en objetos o estructuras (p. ej. paredes y estantes). Si
se realiza la instalacion de modo distinto al indicado en la documentacion del producto, se pueden
causar lesiones o, en determinadas circunstancias, incluso la muerte.

No ponga el producto sobre aparatos que generen calor (p. €j. radiadores o calefactores). La
temperatura ambiente no debe superar la temperatura maxima especificada en la documentacion del
producto o en la hoja de datos. En caso de sobrecalentamiento del producto, pueden producirse
choques eléctricos, incendios y/o lesiones graves con posible consecuencia de muerte.

Seguridad eléctrica

Si no se siguen (o se siguen de modo insuficiente) las indicaciones del fabricante en cuanto a seguridad
eléctrica, pueden producirse choques eléctricos, incendios y/o lesiones graves con posible consecuencia
de muerte.

1.

Antes de la puesta en marcha del producto se deberd comprobar siempre que la tensién
preseleccionada en el producto coincida con la de la red de alimentacion eléctrica. Si es necesario
modificar el ajuste de tension, también se deberan cambiar en caso dado los fusibles
correspondientes del producto.

Los productos de la clase de proteccién | con alimentacion mévil y enchufe individual solamente
podran enchufarse a tomas de corriente con contacto de seguridad y con conductor de proteccion
conectado.

Queda prohibida la interrupcién intencionada del conductor de proteccién, tanto en la toma de
corriente como en el mismo producto. La interrupcion puede tener como consecuencia el riesgo de
gue el producto sea fuente de choques eléctricos. Si se utilizan cables alargadores o regletas de
enchufe, debera garantizarse la realizacién de un examen regular de los mismos en cuanto a su
estado técnico de seguridad.

Si el producto no est& equipado con un interruptor para desconectarlo de la red, o bien si el
interruptor existente no resulta apropiado para la desconexion de la red, el enchufe del cable de
conexion se debera considerar como un dispositivo de desconexion.

El dispositivo de desconexién se debe poder alcanzar facilmente y debe estar siempre bien accesible.
Si, p. €]., el enchufe de conexion a la red es el dispositivo de desconexién, la longitud del cable de
conexion no debe superar 3 m).

Los interruptores selectores o electrénicos no son aptos para el corte de la red eléctrica. Si se
integran productos sin interruptor en bastidores o instalaciones, se debera colocar el interruptor en el
nivel de la instalacion.

No utilice nunca el producto si esta dafiado el cable de conexién a red. Compruebe regularmente el
correcto estado de los cables de conexion a red. Asegurese, mediante las medidas de proteccién y
de instalacion adecuadas, de que el cable de conexién a red no pueda ser dafiado o de que nadie
pueda ser dafiado por él, p. €j. al tropezar o por un choque eléctrico.
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10.

11.

12.

13.

14.

15.

16.

17.

18.

Instrucciones de seguridad elementales

Solamente esta permitido el funcionamiento en redes de alimentacion TN/TT aseguradas con fusibles
de 16 A como maximo (utilizacién de fusibles de mayor amperaje solo previa consulta con el grupo de
empresas Rohde & Schwarz).

Nunca conecte el enchufe en tomas de corriente sucias o llenas de polvo. Introduzca el enchufe por
completo y fuertemente en la toma de corriente. La no observacion de estas medidas puede provocar
chispas, fuego y/o lesiones.

No sobrecargue las tomas de corriente, los cables alargadores o las regletas de enchufe ya que esto
podria causar fuego o choques eléctricos.

En las mediciones en circuitos de corriente con una tension Ug; > 30 V se deberan tomar las medidas
apropiadas para impedir cualquier peligro (p. ej. medios de medicién adecuados, seguros, limitacion
de tensidn, corte protector, aislamiento etc.).

Para la conexiéon con dispositivos informaticos como un PC o un ordenador industrial, debe
comprobarse que éstos cumplan los estandares IEC60950-1/EN60950-1 o IEC61010-1/EN 61010-1
validos en cada caso.

A menos que esté permitido expresamente, no retire nunca la tapa ni componentes de la carcasa
mientras el producto esté en servicio. Esto pone a descubierto los cables y componentes eléctricos y
puede causar lesiones, fuego o dafos en el producto.

Si un producto se instala en un lugar fijo, se debera primero conectar el conductor de proteccion fijo
con el conductor de proteccion del producto antes de hacer cualquier otra conexién. La instalacion y
la conexidon deberan ser efectuadas por un electricista especializado.

En el caso de dispositivos fijos que no estén provistos de fusibles, interruptor automatico ni otros
mecanismos de seguridad similares, el circuito de alimentacién debe estar protegido de modo que
todas las personas que puedan acceder al producto, asi como el producto mismo, estén a salvo de
posibles dafios.

Todo producto debe estar protegido contra sobretension (debida p. ej. a una caida del rayo) mediante
los correspondientes sistemas de proteccion. Si no, el personal que lo utilice quedara expuesto al
peligro de choque eléctrico.

No debe introducirse en los orificios de la caja del aparato ningin objeto que no esté destinado a ello.
Esto puede producir cortocircuitos en el producto y/o puede causar choques eléctricos, fuego o
lesiones.

Salvo indicacién contraria, los productos no estan impermeabilizados (ver también el capitulo
"Estados operativos y posiciones de funcionamiento”, punto 1). Por eso es necesario tomar las
medidas necesarias para evitar la entrada de liquidos. En caso contrario, existe peligro de choque
eléctrico para el usuario o de dafios en el producto, que también pueden redundar en peligro para las
personas.

No utilice el producto en condiciones en las que pueda producirse o ya se hayan producido
condensaciones sobre el producto o en el interior de éste, como p. €j. al desplazarlo de un lugar frio a
otro caliente. La entrada de agua aumenta el riesgo de choque eléctrico.

Antes de la limpieza, desconecte por completo el producto de la alimentacion de tension (p. €j. red de
alimentacion o bateria). Realice la limpieza de los aparatos con un pafio suave, que no se deshilache.
No utilice bajo ninglin concepto productos de limpieza quimicos como alcohol, acetona o diluyentes
para lacas nitrocelulésicas.
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Instrucciones de seguridad elementales

Funcionamiento

1.

El uso del producto requiere instrucciones especiales y una alta concentracion durante el manejo.
Debe asegurarse que las personas que manejen el producto estén a la altura de los requerimientos
necesarios en cuanto a aptitudes fisicas, psiquicas y emocionales, ya que de otra manera no se
pueden excluir lesiones o dafios de objetos. El empresario u operador es responsable de seleccionar
el personal usuario apto para el manejo del producto.

Antes de desplazar o transportar el producto, lea y tenga en cuenta el capitulo "Transporte".

Como con todo producto de fabricacion industrial no puede quedar excluida en general la posibilidad
de que se produzcan alergias provocadas por algunos materiales empleados —los llamados
alérgenos (p. €j. el niquel)—. Si durante el manejo de productos Rohde & Schwarz se producen
reacciones alérgicas, como p. €j. irritaciones cutaneas, estornudos continuos, enrojecimiento de la
conjuntiva o dificultades respiratorias, debe avisarse inmediatamente a un médico para investigar las
causas y evitar cualquier molestia o dafio a la salud.

Antes de la manipulacién mecénica y/o térmica o el desmontaje del producto, debe tenerse en cuenta
imprescindiblemente el capitulo "Eliminacién/proteccion del medio ambiente”, punto 1.

Ciertos productos, como p. €]. las instalaciones de radiocomunicacion RF, pueden a causa de su
funcion natural, emitir una radiacion electromagnética aumentada. Deben tomarse todas las medidas
necesarias para la proteccion de las mujeres embarazadas. También las personas con marcapasos
pueden correr peligro a causa de la radiacién electromagnética. El empresario/operador tiene la
obligacion de evaluar y sefalizar las areas de trabajo en las que exista un riesgo elevado de
exposicion a radiaciones.

Tenga en cuenta que en caso de incendio pueden desprenderse del producto sustancias téxicas
(gases, liquidos etc.) que pueden generar dafios a la salud. Por eso, en caso de incendio deben
usarse medidas adecuadas, como p. ej. mascaras antigas e indumentaria de proteccion.

Los productos con laser estan provistos de indicaciones de advertencia normalizadas en funcién de la
clase de laser del que se trate. Los rayos laser pueden provocar dafios de tipo biolégico a causa de
las propiedades de su radiacion y debido a su concentracién extrema de potencia electromagnética.
En caso de que un producto Rohde & Schwarz contenga un producto laser (p. €j. un lector de
CD/DVD), no debe usarse ninguna otra configuracion o funcion aparte de las descritas en la
documentacién del producto, a fin de evitar lesiones (p. ej. debidas a irradiacion laser).

Clases de compatibilidad electromagnética (conforme a EN 55011 / CISPR 11; y en analogia con EN

55022 / CISPR 22, EN 55032 / CISPR 32)

— Aparato de clase A:
Aparato adecuado para su uso en todos los entornos excepto en los residenciales y en aquellos
conectados directamente a una red de distribucion de baja tensiéon que suministra corriente a
edificios residenciales.
Nota: Los aparatos de clase A estan destinados al uso en entornos industriales. Estos aparatos
pueden causar perturbaciones radioeléctricas en entornos residenciales debido a posibles
perturbaciones guiadas o radiadas. En este caso, se le podra solicitar al operador que tome las
medidas adecuadas para eliminar estas perturbaciones.

— Aparato de clase B:
Aparato adecuado para su uso en entornos residenciales, asi como en aquellos conectados
directamente a una red de distribucién de baja tension que suministra corriente a edificios
residenciales.
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Instrucciones de seguridad elementales

Reparacion y mantenimiento

1.

El producto solamente debe ser abierto por personal especializado con autorizacion para ello. Antes
de manipular el producto o abrirlo, es obligatorio desconectarlo de la tension de alimentacion, para
evitar toda posibilidad de choque eléctrico.

El ajuste, el cambio de partes, el mantenimiento y la reparacion deberan ser efectuadas solamente
por electricistas autorizados por Rohde & Schwarz. Si se reponen partes con importancia para los
aspectos de seguridad (p. €j. el enchufe, los transformadores o los fusibles), solamente podran ser
sustituidos por partes originales. Después de cada cambio de partes relevantes para la seguridad
debera realizarse un control de seguridad (control a primera vista, control del conductor de
proteccién, medicién de resistencia de aislamiento, medicion de la corriente de fuga, control de
funcionamiento). Con esto queda garantizada la seguridad del producto.

Baterias y acumuladores o celdas

Si no se siguen (o se siguen de modo insuficiente) las indicaciones en cuanto a las baterias y
acumuladores o celdas, pueden producirse explosiones, incendios y/o lesiones graves con posible
consecuencia de muerte. El manejo de baterias y acumuladores con electrolitos alcalinos (p. €j. celdas de
litio) debe seqguir el estandar EN 62133.

1.
2.

No deben desmontarse, abrirse ni triturarse las celdas.

Las celdas o baterias no deben someterse a calor ni fuego. Debe evitarse el almacenamiento a la luz
directa del sol. Las celdas y baterias deben mantenerse limpias y secas. Limpiar las conexiones
sucias con un pafio seco y limpio.

Las celdas o baterias no deben cortocircuitarse. Es peligroso almacenar las celdas o baterias en
estuches o cajones en cuyo interior puedan cortocircuitarse por contacto reciproco o por contacto con
otros materiales conductores. No deben extraerse las celdas o baterias de sus embalajes originales
hasta el momento en que vayan a utilizarse.

Las celdas o baterias no deben someterse a impactos mecanicos fuertes indebidos.

En caso de falta de estanqueidad de una celda, el liquido vertido no debe entrar en contacto con la
piel ni los ojos. Si se produce contacto, lavar con agua abundante la zona afectada y avisar a un
médico.

En caso de cambio o recarga inadecuados, las celdas o baterias que contienen electrolitos alcalinos
(p. €j. las celdas de litio) pueden explotar. Para garantizar la seguridad del producto, las celdas o
baterias solo deben ser sustituidas por el tipo Rohde & Schwarz correspondiente (ver lista de
recambios).

Las baterias y celdas deben reciclarse y no deben tirarse a la basura doméstica. Las baterias o
acumuladores que contienen plomo, mercurio o cadmio deben tratarse como residuos especiales.
Respete en esta relacién las normas nacionales de eliminacion y reciclaje.

Transporte

1.

El producto puede tener un peso elevado. Por eso es necesario desplazarlo o transportarlo con
precaucion y, si es necesario, usando un sistema de elevacion adecuado (p. ej. una carretilla
elevadora), a fin de evitar lesiones en la espalda u otros dafios personales.
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Instrucciones de seguridad elementales

Las asas instaladas en los productos sirven solamente de ayuda para el transporte del producto por
personas. Por eso no esta permitido utilizar las asas para la sujecion en o sobre medios de transporte
como p. €j. gruas, carretillas elevadoras de horquilla, carros etc. Es responsabilidad suya fijar los
productos de manera segura a los medios de transporte o elevacion. Para evitar dafios personales o
dafos en el producto, siga las instrucciones de seguridad del fabricante del medio de transporte o
elevacién utilizado.

Si se utiliza el producto dentro de un vehiculo, recae de manera exclusiva en el conductor la
responsabilidad de conducir el vehiculo de manera segura y adecuada. El fabricante no asumira
ninguna responsabilidad por accidentes o colisiones. No utilice nunca el producto dentro de un
vehiculo en movimiento si esto pudiera distraer al conductor. Asegure el producto dentro del vehiculo
debidamente para evitar, en caso de un accidente, lesiones u otra clase de dafios.

Eliminacién/protecciéon del medio ambiente

1.

Los dispositivos marcados contienen una bateria o un acumulador que no se debe desechar con los
residuos domésticos sin clasificar, sino que debe ser recogido por separado. La eliminacién se debe
efectuar exclusivamente a través de un punto de recogida apropiado o del servicio de atencién al
cliente de Rohde & Schwarz.

Los dispositivos eléctricos usados no se deben desechar con los residuos domésticos sin clasificar,
sino que deben ser recogidos por separado.

Rohde & Schwarz GmbH & Co.KG ha elaborado un concepto de eliminacién de residuos y asume
plenamente los deberes de recogida y eliminacién para los fabricantes dentro de la UE. Para
desechar el producto de manera respetuosa con el medio ambiente, dirijase a su servicio de atencion
al cliente de Rohde & Schwarz.

Si se trabaja de manera mecéanica y/o térmica cualquier producto o componente mas alla del
funcionamiento previsto, pueden liberarse sustancias peligrosas (polvos con contenido de metales
pesados como p. ej. plomo, berilio o niquel). Por eso el producto solo debe ser desmontado por
personal especializado con formacién adecuada. Un desmontaje inadecuado puede ocasionar dafios
para la salud. Se deben tener en cuenta las directivas nacionales referentes a la eliminacién de
residuos.

En caso de que durante el trato del producto se formen sustancias peligrosas o combustibles que
deban tratarse como residuos especiales (p. €j. refrigerantes o aceites de motor con intervalos de
cambio definidos), deben tenerse en cuenta las indicaciones de seguridad del fabricante de dichas
sustancias y las normas regionales de eliminacion de residuos. Tenga en cuenta también en caso
necesario las indicaciones de seguridad especiales contenidas en la documentacién del producto. La
eliminacién incorrecta de sustancias peligrosas o combustibles puede causar dafios a la salud o
dafios al medio ambiente.

Se puede encontrar mas informacion sobre la proteccién del medio ambiente en la pagina web de
Rohde & Schwarz.
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Grundlegende Sicherheitshinweise

Lesen und beachten Sie unbedingt die nachfolgenden Anweisungen und Sicherheitshinweise!

Alle Werke und Standorte der Rohde & Schwarz Firmengruppe sind standig bemaht, den
Sicherheitsstandard unserer Produkte auf dem aktuellsten Stand zu halten und unseren Kunden ein
héchstmdogliches Mal? an Sicherheit zu bieten. Unsere Produkte und die dafiir erforderlichen Zusatzgerate
werden entsprechend der jeweils gultigen Sicherheitsvorschriften gebaut und gepriift. Die Einhaltung
dieser Bestimmungen wird durch unser Qualitatssicherungssystem laufend Uberwacht. Das vorliegende
Produkt ist gemaf beiliegender EU-Konformitatsbescheinigung gebaut und geprift und hat das Werk in
sicherheitstechnisch einwandfreiem Zustand verlassen. Um diesen Zustand zu erhalten und einen
gefahrlosen Betrieb sicherzustellen, muss der Benutzer alle Hinweise, Warnhinweise und Warnvermerke
beachten. Bei allen Fragen beziiglich vorliegender Sicherheitshinweise steht lhnen die Rohde & Schwarz
Firmengruppe jederzeit gerne zur Verfigung.

Darliber hinaus liegt es in der Verantwortung des Benutzers, das Produkt in geeigneter Weise zu
verwenden. Das Produkt ist ausschlie3lich fur den Betrieb in Industrie und Labor bzw., wenn ausdriicklich
zugelassen, auch fur den Feldeinsatz bestimmt und darf in keiner Weise so verwendet werden, dass einer
Person/Sache Schaden zugefligt werden kann. Die Benutzung des Produkts aul3erhalb des
bestimmungsgemafen Gebrauchs oder unter Missachtung der Anweisungen des Herstellers liegt in der
Verantwortung des Benutzers. Der Hersteller Gbernimmt keine Verantwortung fir die Zweckentfremdung
des Produkts.

Die bestimmungsgemaRe Verwendung des Produkts wird angenommen, wenn das Produkt nach den
Vorgaben der zugehdrigen Produktdokumentation innerhalb seiner Leistungsgrenzen verwendet wird
(siehe Datenblatt, Dokumentation, nachfolgende Sicherheitshinweise). Die Benutzung des Produkts
erfordert Fachkenntnisse und zum Teil englische Sprachkenntnisse. Es ist daher zu beachten, dass das
Produkt ausschlief3lich von Fachkréaften oder sorgféltig eingewiesenen Personen mit entsprechenden
Fahigkeiten bedient werden darf. Sollte fur die Verwendung von Rohde & Schwarz-Produkten personliche
Schutzausristung erforderlich sein, wird in der Produktdokumentation an entsprechender Stelle darauf
hingewiesen. Bewahren Sie die grundlegenden Sicherheitshinweise und die Produktdokumentation gut
auf und geben Sie diese an weitere Benutzer des Produkts weiter.

Die Einhaltung der Sicherheitshinweise dient dazu, Verletzungen oder Schaden durch Gefahren aller Art
auszuschlieRen. Hierzu ist es erforderlich, dass die nachstehenden Sicherheitshinweise vor der
Benutzung des Produkts sorgfaltig gelesen und verstanden sowie bei der Benutzung des Produkts
beachtet werden. Sadmtliche weitere Sicherheitshinweise wie z.B. zum Personenschutz, die an
entsprechender Stelle der Produktdokumentation stehen, sind ebenfalls unbedingt zu beachten. In den
vorliegenden Sicherheitshinweisen sind sdmtliche von der Rohde & Schwarz Firmengruppe vertriebenen
Waren unter dem Begriff ,,Produkt” zusammengefasst, hierzu zahlen u. a. Gerate, Anlagen sowie
samtliches Zubehor.
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Grundlegende Sicherheitshinweise

Symbole und Sicherheitskennzeichnungen

Symbol

Bedeutung

Symbol

Bedeutung

Achtung, allgemeine Gefahrenstelle

Produktdokumentation beachten

EIN-/AUS (Versorgung)

Vorsicht beim Umgang mit Geraten mit hohem
Gewicht

Stand-by-Anzeige

Gefahr vor elektrischem Schlag

Gleichstrom (DC)

Warnung vor hei3er Oberflache

Wechselstrom (AC)

Schutzleiteranschluss

Gleichstrom/Wechselstrom (DC/AC)

Erdungsanschluss

Gerat entspricht den Sicherheits-
anforderungen an die Schutzklasse Il
(Gerét durchgehend durch doppelte /
verstarkte Isolierung geschiitzt.

Masseanschluss des Gestells oder Gehauses

EU - Kennzeichnung fir Batterien und
Akkumulatoren.

Das Gerat enthélt eine Batterie bzw. einen
Akkumulator. Diese dirfen nicht Giber
unsortierten Siedlungsabfall entsorgt werden,
sondern sollten getrennt gesammelt werden.

Weitere Informationen siehe Seite 7.

Achtung beim Umgang mit elektrostatisch
geféhrdeten Bauelementen

EU - Kennzeichnung fir die getrennte
Sammlung von Elektro- und
Elektronikgeraten.

Elektroaltgerate durfen nicht Gber unsortierten
Siedlungsabfall entsorgt werden, sondern
missen getrennt gesammelt werden.

Weitere Informationen siehe Seite 7.

Warnung vor Laserstrahl

Produkte mit Laser sind je nach ihrer Laser-
Klasse mit genormten Warnhinweisen
versehen.

Laser kdnnen aufgrund der Eigenschaften
ihrer Strahlung und aufgrund ihrer extrem
konzentrierten elektromagnetischen Leistung
biologische Schaden verursachen.

Fur zuséatzliche Informationen siehe Kapitel
,Betrieb” Punkt 7.
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Grundlegende Sicherheitshinweise

Signalworte und ihre Bedeutung

Die folgenden Signalworte werden in der Produktdokumentation verwendet, um vor Risiken und Gefahren
Zu warnen.

kennzeichnet eine unmittelbare Gefahrdung mit hohem Risiko, die Tod oder
A GEFAHR schwere Koérperverletzung zur Folge haben wird, wenn sie nicht vermieden

wird.

kennzeichnet eine mégliche Gefahrdung mit mittlerem Risiko, die Tod oder
A WARNUNG (schwere) Korperverletzung zur Folge haben kann, wenn sie nicht vermieden
wird.

kennzeichnet eine Gefahrdung mit geringem Risiko, die leichte oder mittlere
A VORSICHT Kdrperverletzungen zur Folge haben kdnnte, wenn sie nicht vermieden wird.

weist auf die Mdglichkeit einer Fehlbedienung hin, bei der das Produkt
m Schaden nehmen kann.

Diese Signalworte entsprechen der im europaischen Wirtschaftsraum Ublichen Definition fur zivile
Anwendungen. Neben dieser Definition kdnnen in anderen Wirtschaftsraumen oder bei militarischen
Anwendungen abweichende Definitionen existieren. Es ist daher darauf zu achten, dass die hier
beschriebenen Signalworte stets nur in Verbindung mit der zugehérigen Produktdokumentation und nur in
Verbindung mit dem zugehdrigen Produkt verwendet werden. Die Verwendung von Signalworten in
Zusammenhang mit nicht zugehdrigen Produkten oder nicht zugehdrigen Dokumentationen kann zu
Fehlinterpretationen fiihren und damit zu Personen- oder Sachschaden fuhren.

Betriebszustande und Betriebslagen

Das Produkt darf nur in den vom Hersteller angegebenen Betriebszustanden und Betriebslagen ohne
Behinderung der Beliftung betrieben werden. Werden die Herstellerangaben nicht eingehalten, kann dies
elektrischen Schlag, Brand und/oder schwere Verletzungen von Personen, unter Umstanden mit
Todesfolge, verursachen. Bei allen Arbeiten sind die ortlichen bzw. landesspezifischen Sicherheits- und
Unfallverhitungsvorschriften zu beachten.

1. Sofern nicht anders vereinbart, gilt fir R&S-Produkte folgendes:
als vorgeschriebene Betriebslage grundsatzlich Gehduseboden unten, IP-Schutzart 2X,
Verschmutzungsgrad 2, Uberspannungskategorie 2, nur in Innenraumen verwenden, Betrieb bis
2000 m . NN, Transport bis 4500 m U. NN, fur die Nennspannung gilt eine Toleranz von +10%, fur
die Nennfrequenz eine Toleranz von +5%.

2. Stellen Sie das Produkt nicht auf Oberflachen, Fahrzeuge, Ablagen oder Tische, die aus Gewichts-
oder Stabilitdtsgriinden nicht dafiir geeignet sind. Folgen Sie bei Aufbau und Befestigung des
Produkts an Gegenstanden oder Strukturen (z.B. Wéande und Regale) immer den Installations-
hinweisen des Herstellers. Bei Installation abweichend von der Produktdokumentation kénnen
Personen verletzt, unter Umstéanden sogar getotet werden.

3. Stellen Sie das Produkt nicht auf hitzeerzeugende Gerétschaften (z.B. Radiatoren und Heizlifter). Die
Umgebungstemperatur darf nicht die in der Produktdokumentation oder im Datenblatt spezifizierte
Maximaltemperatur tiberschreiten. Eine Uberhitzung des Produkts kann elektrischen Schlag, Brand
und/oder schwere Verletzungen von Personen, unter Umstéanden mit Todesfolge, verursachen.
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Grundlegende Sicherheitshinweise

Elektrische Sicherheit

Werden die Hinweise zur elektrischen Sicherheit nicht oder unzureichend beachtet, kann dies elektrischen
Schlag, Brand und/oder schwere Verletzungen von Personen, unter Umstanden mit Todesfolge,
verursachen.

1.

10.

11.

Vor jedem Einschalten des Produkts ist sicherzustellen, dass die am Produkt eingestellte
Nennspannung und die Netznennspannung des Versorgungsnetzes lUbereinstimmen. Ist es
erforderlich, die Spannungseinstellung zu andern, so muss ggf. auch die dazu gehérige
Netzsicherung des Produkts geédndert werden.

Bei Produkten der Schutzklasse | mit beweglicher Netzzuleitung und Geratesteckvorrichtung ist der
Betrieb nur an Steckdosen mit Schutzkontakt und angeschlossenem Schutzleiter zulassig.

Jegliche absichtliche Unterbrechung des Schutzleiters, sowohl in der Zuleitung als auch am Produkt
selbst, ist unzuléssig. Es kann dazu fuihren, dass von dem Produkt die Gefahr eines elektrischen
Schlags ausgeht. Bei Verwendung von Verlangerungsleitungen oder Steckdosenleisten ist sicher-
zustellen, dass diese regelméRig auf ihren sicherheitstechnischen Zustand Uberprift werden.

Sofern das Produkt nicht mit einem Netzschalter zur Netztrennung ausgerustet ist, beziehungsweise
der vorhandene Netzschalter zu Netztrennung nicht geeignet ist, so ist der Stecker des
Anschlusskabels als Trennvorrichtung anzusehen.

Die Trennvorrichtung muss jederzeit leicht erreichbar und gut zuganglich sein. Ist z.B. der Netzstecker
die Trennvorrichtung, darf die Lange des Anschlusskabels 3 m nicht Gberschreiten.

Funktionsschalter oder elektronische Schalter sind zur Netztrennung nicht geeignet. Werden Produkte
ohne Netzschalter in Gestelle oder Anlagen integriert, so ist die Trennvorrichtung auf Anlagenebene
zu verlagern.

Benutzen Sie das Produkt niemals, wenn das Netzkabel beschadigt ist. Uberpriifen Sie regelmaRig
den einwandfreien Zustand der Netzkabel. Stellen Sie durch geeignete SchutzmalRnahmen und
Verlegearten sicher, dass das Netzkabel nicht beschadigt werden kann und niemand z.B. durch
Stolperfallen oder elektrischen Schlag zu Schaden kommen kann.

Der Betrieb ist nur an TN/TT Versorgungsnetzen gestattet, die mit héchstens 16 A abgesichert sind
(hdhere Absicherung nur nach Ricksprache mit der Rohde & Schwarz Firmengruppe).

Stecken Sie den Stecker nicht in verstaubte oder verschmutzte Steckdosen/-buchsen. Stecken Sie die
Steckverbindung/-vorrichtung fest und vollstandig in die dafiir vorgesehenen Steckdosen/-buchsen.
Missachtung dieser MalRnahmen kann zu Funken, Feuer und/oder Verletzungen fihren.

Uberlasten Sie keine Steckdosen, Verlangerungskabel oder Steckdosenleisten, dies kann Feuer oder
elektrische Schlage verursachen.

Bei Messungen in Stromkreisen mit Spannungen U > 30 V ist mit geeigneten MalRnahmen Vorsorge
zu treffen, dass jegliche Gefahrdung ausgeschlossen wird (z.B. geeignete Messmittel, Absicherung,
Strombegrenzung, Schutztrennung, Isolierung usw.).

Bei Verbindungen mit informationstechnischen Geréaten, z.B. PC oder Industrierechner, ist darauf zu
achten, dass diese der jeweils gultigen IEC 60950-1 / EN 60950-1 oder IEC 61010-1/ EN 61010-1
entsprechen.

Sofern nicht ausdrucklich erlaubt, darf der Deckel oder ein Teil des Gehauses niemals entfernt
werden, wenn das Produkt betrieben wird. Dies macht elektrische Leitungen und Komponenten
zuganglich und kann zu Verletzungen, Feuer oder Schaden am Produkt fuihren.
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12.

13.

14.

15.

16.

17.

18.

Grundlegende Sicherheitshinweise

Wird ein Produkt ortsfest angeschlossen, ist die Verbindung zwischen dem Schutzleiteranschluss vor
Ort und dem Gerateschutzleiter vor jeglicher anderer Verbindung herzustellen. Aufstellung und
Anschluss darf nur durch eine Elektrofachkraft erfolgen.

Bei ortsfesten Geraten ohne eingebaute Sicherung, Selbstschalter oder ahnliche Schutzeinrichtung
muss der Versorgungskreis so abgesichert sein, dass alle Personen, die Zugang zum Produkt haben,
sowie das Produkt selbst ausreichend vor Schaden geschiitzt sind.

Jedes Produkt muss durch geeigneten Uberspannungsschutz vor Uberspannung (z.B. durch
Blitzschlag) geschuitzt werden. Andernfalls ist das bedienende Personal durch elektrischen Schlag
gefahrdet.

Gegensténde, die nicht dafiir vorgesehen sind, diirfen nicht in die Offnungen des Gehauses
eingebracht werden. Dies kann Kurzschlisse im Produkt und/oder elektrische Schlage, Feuer oder
Verletzungen verursachen.

Sofern nicht anders spezifiziert, sind Produkte nicht gegen das Eindringen von Flissigkeiten
geschitzt, siehe auch Abschnitt "Betriebszustédnde und Betriebslagen”, Punkt 1. Daher missen die
Geréate vor Eindringen von Flussigkeiten geschiitzt werden. Wird dies nicht beachtet, besteht Gefahr
durch elektrischen Schlag fur den Benutzer oder Beschadigung des Produkts, was ebenfalls zur
Gefahrdung von Personen fithren kann.

Benutzen Sie das Produkt nicht unter Bedingungen, bei denen Kondensation in oder am Produkt
stattfinden kdnnte oder ggf. bereits stattgefunden hat, z.B. wenn das Produkt von kalter in warme
Umgebung bewegt wurde. Das Eindringen von Wasser erhoht das Risiko eines elektrischen
Schlages.

Trennen Sie das Produkt vor der Reinigung komplett von der Energieversorgung (z.B. speisendes
Netz oder Batterie). Nehmen Sie bei Geraten die Reinigung mit einem weichen, nicht fasernden
Staublappen vor. Verwenden Sie keinesfalls chemische Reinigungsmittel wie z.B. Alkohol, Aceton,
Nitroverdinnung.

Betrieb

1.

Die Benutzung des Produkts erfordert spezielle Einweisung und hohe Konzentration wahrend der
Benutzung. Es muss sichergestellt sein, dass Personen, die das Produkt bedienen, bezuglich ihrer
korperlichen, geistigen und seelischen Verfassung den Anforderungen gewachsen sind, da
andernfalls Verletzungen oder Sachschaden nicht auszuschlieRen sind. Es liegt in der Verantwortung
des Arbeitsgebers/Betreibers, geeignetes Personal fur die Benutzung des Produkts auszuwahlen.

Bevor Sie das Produkt bewegen oder transportieren, lesen und beachten Sie den Abschnitt
"Transport".

Wie bei allen industriell gefertigten Gultern kann die Verwendung von Stoffen, die Allergien
hervorrufen - so genannte Allergene (z.B. Nickel) - nicht generell ausgeschlossen werden. Sollten
beim Umgang mit R&S-Produkten allergische Reaktionen, z.B. Hautausschlag, haufiges Niesen,
Bindehautrdétung oder Atembeschwerden auftreten, ist umgehend ein Arzt aufzusuchen, um die
Ursachen zu klaren und Gesundheitsschaden bzw. -belastungen zu vermeiden.

Vor der mechanischen und/oder thermischen Bearbeitung oder Zerlegung des Produkts beachten Sie
unbedingt Abschnitt "Entsorgung”, Punkt 1.
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Grundlegende Sicherheitshinweise

Bei bestimmten Produkten, z.B. HF-Funkanlagen, kénnen funktionsbedingt erhéhte elektromag-
netische Strahlungen auftreten. Unter Beriicksichtigung der erhéhten Schutzwirdigkeit des unge-
borenen Lebens miissen Schwangere durch geeignete Ma3nahmen geschutzt werden. Auch Trager
von Herzschrittmachern kénnen durch elektromagnetische Strahlungen gefahrdet sein. Der
Arbeitgeber/Betreiber ist verpflichtet, Arbeitsstatten, bei denen ein besonderes Risiko einer Strahlen-
exposition besteht, zu beurteilen und zu kennzeichnen und mdégliche Gefahren abzuwenden.

Im Falle eines Brandes entweichen ggf. giftige Stoffe (Gase, Flussigkeiten etc.) aus dem Produkt, die
Gesundheitsschaden verursachen kénnen. Daher sind im Brandfall geeignete MalRhahmen wie z.B.
Atemschutzmasken und Schutzkleidung zu verwenden.

Falls ein Laser-Produkt in ein R&S-Produkt integriert ist (z.B. CD/DVD-Laufwerk), dirfen keine
anderen Einstellungen oder Funktionen verwendet werden, als in der Produktdokumentation beschrie-
ben, um Personenschaden zu vermeiden (z.B. durch Laserstrahl).

EMV Klassen (nach EN 55011 / CISPR 11; sinngemaf3 EN 55022 / CISPR 22, EN 55032 / CISPR 32)

Geréat der Klasse A:

Ein Gerat, das sich fur den Gebrauch in allen anderen Bereichen auf3er dem Wohnbereich und
solchen Bereichen eignet, die direkt an ein Niederspannungs-Versorgungsnetz angeschlossen sind,
das Wohngebéaude versorgt.

Hinweis: Diese Einrichtung kann wegen maglicher auftretender leitungsgebundener als auch
gestrahlten StérgréfZen im Wohnbereich Funkstérungen verursachen. In diesem Fall kann vom
Betreiber verlangt werden, angemessene MalRnahmen durchzufuhren.

Geréat der Klasse B:

Ein Gerat, das sich fur den Betrieb im Wohnbereich sowie in solchen Bereichen eignet, die direkt an
ein Niederspannungs-Versorgungsnetz angeschlossen sind, das Wohngebaude versorgt.

Reparatur und Service

1.

Das Produkt darf nur von dafir autorisiertem Fachpersonal getffnet werden. Vor Arbeiten am Produkt
oder Offnen des Produkts ist dieses von der Versorgungsspannung zu trennen, sonst besteht das
Risiko eines elektrischen Schlages.

Abgleich, Auswechseln von Teilen, Wartung und Reparatur darf nur von R&S-autorisierten
Elektrofachkréaften ausgefihrt werden. Werden sicherheitsrelevante Teile (z.B. Netzschalter,
Netztrafos oder Sicherungen) ausgewechselt, so dirfen diese nur durch Originalteile ersetzt werden.
Nach jedem Austausch von sicherheitsrelevanten Teilen ist eine Sicherheitsprifung durchzufiihren
(Sichtprufung, Schutzleitertest, Isolationswiderstand-, Ableitstrommessung, Funktionstest). Damit wird
sichergestellt, dass die Sicherheit des Produkts erhalten bleibt.

Batterien und Akkumulatoren/Zellen

Werden die Hinweise zu Batterien und Akkumulatoren/Zellen nicht oder unzureichend beachtet, kann dies
Explosion, Brand und/oder schwere Verletzungen von Personen, unter Umstanden mit Todesfolge,
verursachen. Die Handhabung von Batterien und Akkumulatoren mit alkalischen Elektrolyten (z.B.
Lithiumzellen) muss der EN 62133 entsprechen.

1.
2.

Zellen durfen nicht zerlegt, geéffnet oder zerkleinert werden.

Zellen oder Batterien durfen weder Hitze noch Feuer ausgesetzt werden. Die Lagerung im direkten
Sonnenlicht ist zu vermeiden. Zellen und Batterien sauber und trocken halten. Verschmutzte
Anschlisse mit einem trockenen, sauberen Tuch reinigen.
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Grundlegende Sicherheitshinweise

Zellen oder Batterien dirfen nicht kurzgeschlossen werden. Zellen oder Batterien dirfen nicht
gefahrbringend in einer Schachtel oder in einem Schubfach gelagert werden, wo sie sich gegenseitig
kurzschlieBen oder durch andere leitende Werkstoffe kurzgeschlossen werden kénnen. Eine Zelle
oder Batterie darf erst aus ihrer Originalverpackung entnommen werden, wenn sie verwendet werden
soll.

Zellen oder Batterien dirfen keinen unzulassig starken, mechanischen Stéf3en ausgesetzt werden.

Bei Undichtheit einer Zelle darf die Flussigkeit nicht mit der Haut in Beriihrung kommen oder in die
Augen gelangen. Falls es zu einer Beriihrung gekommen ist, den betroffenen Bereich mit reichlich
Wasser waschen und érztliche Hilfe in Anspruch nehmen.

Werden Zellen oder Batterien, die alkalische Elektrolyte enthalten (z.B. Lithiumzellen), unsachgeméan
ausgewechselt oder geladen, besteht Explosionsgefahr. Zellen oder Batterien nur durch den ent-
sprechenden R&S-Typ ersetzen (siehe Ersatzteilliste), um die Sicherheit des Produkts zu erhalten.

Zellen oder Batterien missen wiederverwertet werden und dirfen nicht in den Restmdll gelangen.
Akkumulatoren oder Batterien, die Blei, Quecksilber oder Cadmium enthalten, sind Sonderabfall.
Beachten Sie hierzu die landesspezifischen Entsorgungs- und Recycling-Bestimmungen.

Transport

1.

Das Produkt kann ein hohes Gewicht aufweisen. Daher muss es vorsichtig und ggf. unter
Verwendung eines geeigneten Hebemittels (z.B. Hubwagen) bewegt bzw. transportiert werden, um
Rickenschaden oder Verletzungen zu vermeiden.

Griffe an den Produkten sind eine Handhabungshilfe, die ausschlief3lich fir den Transport des
Produkts durch Personen vorgesehen ist. Es ist daher nicht zulassig, Griffe zur Befestigung an bzw.
auf Transportmitteln, z.B. Kranen, Gabelstaplern, Karren etc. zu verwenden. Es liegt in lhrer
Verantwortung, die Produkte sicher an bzw. auf geeigneten Transport- oder Hebemitteln zu
befestigen. Beachten Sie die Sicherheitsvorschriften des jeweiligen Herstellers eingesetzter
Transport- oder Hebemittel, um Personenschaden und Schaden am Produkt zu vermeiden.

Falls Sie das Produkt in einem Fahrzeug benutzen, liegt es in der alleinigen Verantwortung des
Fahrers, das Fahrzeug in sicherer und angemessener Weise zu filhren. Der Hersteller Gbernimmt
keine Verantwortung fur Unfélle oder Kollisionen. Verwenden Sie das Produkt niemals in einem sich
bewegenden Fahrzeug, sofern dies den Fahrzeugfuhrer ablenken kénnte. Sichern Sie das Produkt im
Fahrzeug ausreichend ab, um im Falle eines Unfalls Verletzungen oder Schéaden anderer Art zu
verhindern.

Entsorgung

1.

2.

Batterien bzw. Akkumulatoren, die nicht mit dem Hausmiill entsorgt werden dirfen, darf nach Ende
der Lebensdauer nur Gber eine geeignete Sammelstelle oder eine Rohde & Schwarz-
Kundendienststelle entsorgt werden.

Am Ende der Lebensdauer des Produktes darf dieses Produkt nicht tiber den normalen Hausmiill
entsorgt werden, sondern muss getrennt gesammelt werden.

Rohde & Schwarz GmbH & Co.KG ein Entsorgungskonzept entwickelt und Gibernimmt die Pflichten
der Ricknahme- und Entsorgung fur Hersteller innerhalb der EU in vollem Umfang. Wenden Sie sich
bitte an Ihre Rohde & Schwarz-Kundendienststelle, um das Produkt umweltgerecht zu entsorgen.
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Grundlegende Sicherheitshinweise

3. Werden Produkte oder ihre Bestandteile Giber den bestimmungsgemalfien Betrieb hinaus mechanisch
und/oder thermisch bearbeitet, kénnen ggf. gefahrliche Stoffe (schwermetallhaltiger Staub wie z.B.
Blei, Beryllium, Nickel) freigesetzt werden. Die Zerlegung des Produkts darf daher nur von speziell
geschultem Fachpersonal erfolgen. Unsachgemafles Zerlegen kann Gesundheitsschaden
hervorrufen. Die nationalen Vorschriften zur Entsorgung sind zu beachten.

4. Falls beim Umgang mit dem Produkt Gefahren- oder Betriebsstoffe entstehen, die speziell zu
entsorgen sind, z.B. regelméaRig zu wechselnde Kuhlmittel oder Motorendéle, sind die
Sicherheitshinweise des Herstellers dieser Gefahren- oder Betriebsstoffe und die regional giltigen
Entsorgungsvorschriften einzuhalten. Beachten Sie ggf. auch die zugehdérigen speziellen
Sicherheitshinweise in der Produktdokumentation. Die unsachgemafe Entsorgung von Gefahren-
oder Betriebsstoffen kann zu Gesundheitsschaden von Personen und Umweltschéden fiihren.

Weitere Informationen zu Umweltschutz finden Sie auf der Rohde & Schwarz Home Page.

1171.0000.41 - 08 Seite 8



Consignes de securité fondamentales

Lisez et respectez impérativement les instructions et consignes de sécurité suivantes

Les usines et sites du groupe Rohde & Schwarz veillent a la conformité des produits du groupe avec les
normes de sécurité en vigueur dans un souci constant de garantir aux clients le plus haut niveau de
sécurité possible. Nos produits ainsi que les accessoires nécessaires sont fabriqués et testés
conformément aux régles de sécurité en vigueur. Le respect de ces regles est vérifié régulierement par
notre systeme d’assurance qualité. Le présent produit a été fabriqué et contrélé conformément au
certificat de conformité CE ci-joint et a quitté 'usine dans un parfait état de sécurité. Pour le maintenir
dans cet état et en garantir une utilisation sans danger, I'utilisateur doit respecter 'ensemble des
consignes, remarques de sécurité et avertissements qui se trouvent dans ce manuel. Le groupe

Rohde & Schwarz se tient a votre disposition pour toutes questions relatives aux présentes consignes de
sécurité.

Il incombe a l'utilisateur d’employer ce produit de maniére appropriée. Le produit est exclusivement
destiné a l'utilisation en industrie et en laboratoire et/ou, si cela a été expressément autorisé, également
aux travaux extérieurs ; il ne peut en aucun cas étre utilisé a des fins pouvant causer des dommages
corporels ou matériels. L’exploitation du produit en dehors de son utilisation prévue ou le non-respect des
consignes du fabricant se font sous la responsabilité de l'utilisateur. Le fabricant décline toute
responsabilité en cas d’utilisation non conforme du produit.

Le produit est présumé faire I'objet d’'une utilisation conforme lorsqu’il est utilisé conformément aux
consignes de la documentation produit correspondante et dans la limite de ses performances (voir fiche
technique, documentation, consignes de sécurité ci-aprés). L'utilisation du produit exige des compétences
en la matiére et des connaissances de base de I'anglais. Par conséquent, le produit ne devra étre utilisé
gue par un personnel qualifié ou des personnes formées de maniére approfondie et possédant les
compétences requises. Si, pour l'utilisation des produits Rohde & Schwarz, 'emploi d’'un équipement
personnel de protection s’avére nécessaire, il en est fait mention dans la documentation produit a
'emplacement correspondant. Conservez les consignes de sécurité fondamentales et la documentation
produit dans un lieu sOr et transmettez ces documents aux autres utilisateurs du produit.

La stricte observation des consignes de sécurité a pour but d’exclure des blessures ou dommages causés
par des dangers de toutes sortes. A cet effet, il est nécessaire de lire avec soin et de bien comprendre les
consignes de sécurité ci-dessous avant I'utilisation du produit et de les respecter lors de I'utilisation du
produit. Toutes les autres consignes de sécurité présentées a I'emplacement correspondant de la
documentation produit, par exemple, celles concernant la protection des personnes, doivent également
étre impérativement respectées. Dans les présentes consignes de sécurité, toutes les marchandises
commercialisées par le groupe Rohde & Schwarz, notamment les appareils, les systemes ainsi que les
accessoires, sont dénommeés « produit ».
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Consignes de sécurité fondamentales

Symboles et marquages de sécurité

Symbole

Signification

Symbole

Signification

Avis, source générale de danger

Se référer a la documentation produit

| O

MARCHE / ARRET (tension d’alimentation)

Attention lors de la manipulation d’appareils
ayant un poids élevé

O

Indicateur de veille

Risque de choc électrique

Courant continu (CC)

Avertissement, surface chaude

Courant alternatif (CA)

Borne de conducteur de protection

Courant continu/alternatif (CC/CA)

Borne de mise a la terre

L’appareil est conforme aux exigences de
sécurité du degré de protection I

(appareil entierement protégé par isolation
double/renforcée).

Borne de mise a la masse du bati ou du boitier

Marquage UE pour batteries et accumulateurs.

L’appareil contient une batterie ou un
accumulateur. Ces pieces ne peuvent pas étre
éliminées avec les déchets urbains non triés,
mais doivent faire I'objet d’'une collecte
séparée.

Pour plus d’informations, voir la page 7.

Avis : prudence lors de la manipulation de
composants sensibles aux décharges
électrostatiques

Marquage UE pour la collecte séparée
d’équipements électriques et électroniques.

Les déchets d’équipements électriques et
électroniques ne peuvent pas étre éliminés
avec les déchets urbains non triés, mais
doivent faire I'objet d’'une collecte séparée.

Pour plus d’informations, voir la page 7.

Avertissement, rayon laser

Les produits laser sont munis d’avertissements
normalisés d’aprés leur catégorie laser.

En raison des caractéristiques de leur
rayonnement ainsi que de leur puissance
électromagnétique extrémement concentrée,
les lasers peuvent causer des dommages
biologiques.

Pour plus d’informations, voir le chapitre
« Fonctionnement »", point 7.
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Consignes de sécurité fondamentales

Mots d’alerte et significations

Les mots d’alerte suivants sont utilisés dans la documentation produit pour avertir des risques et dangers.

A DANGER Indique une situation dangereuse immédiate qui, si elle n’est pas
évitée, comporte un risque élevé de blessures graves ou
mortelles.

Indique une situation dangereuse possible qui, si elle n’est pas

A AVERTISSEMENT évitée, comporte un risque modéré de blessures (graves) ou

mortelles.
Indique une situation dangereuse qui, si elle n’est pas évitée,
A ATTENTION comporte un risque faible de blessures mineures ou modérées.
Indique la possibilité d’'une fausse manceuvre susceptible
m d’endommager le produit.

Ces mots d’alerte correspondent a la définition habituelle utilisée pour des applications civiles dans
'espace économique européen. Des définitions divergentes peuvent cependant exister dans d’autres
espaces économiques ou dans le cadre d’applications militaires. Il faut donc veiller a ce que les mots
d’alerte décrits ici ne soient utilisés qu’en relation avec la documentation produit correspondante et
seulement avec le produit correspondant. L’utilisation des mots d’alerte en relation avec des produits ou
des documentations non correspondants peut conduire a des erreurs d’interprétation et par conséquent a
des dommages corporels ou matériels.

Etats et positions de fonctionnement

L’appareil ne doit étre utilisé que dans les états et positions de fonctionnement indiqués par le fabricant.
Tout obstacle a la ventilation doit étre empéché. Le non-respect des indications du fabricant peut
provoquer des chocs électriques, des incendies et/ou des blessures graves pouvant éventuellement
entrainer la mort. Pour tous les travaux, les régles locales et/ou nationales de sécurité et de prévention
des accidents doivent étre respectées.

1. Sauf stipulations contraires, les produits Rohde & Schwarz répondent aux exigences ci-apres :
faire fonctionner le produit avec le fond du boitier toujours en bas, degré de protection IP 2X, degré de
pollution 2, catégorie de surtension 2, utilisation uniquement a I'intérieur, fonctionnement a une
altitude max. de 2000 m au-dessus du niveau de la mer, transport a une altitude max. de 4500 m au-
dessus du niveau de la mer, tolérance de +10 % pour la tension nominale et de +5 % pour la
fréquence nominale.

2. Ne jamais placer le produit sur des surfaces, véhicules, dépdts ou tables non appropriés pour raisons
de stabilité ou de poids. Suivre toujours strictement les indications d’installation du fabricant pour le
montage et la fixation du produit sur des objets ou des structures (par exemple parois et étagéres). En
cas d'installation non conforme a la documentation produit, il y a risque de blessures, voire de mort.

3. Ne jamais placer le produit sur des dispositifs générant de la chaleur (par exemple radiateurs et
appareils de chauffage soufflants). La température ambiante ne doit pas dépasser la température
maximale spécifiée dans la documentation produit ou dans la fiche technique. Une surchauffe du
produit peut provoquer des chocs électriques, des incendies et/ou des blessures graves pouvant
éventuellement entrainer la mort.
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Consignes de sécurité fondamentales

Sécurité électrique

Si les consignes relatives a la sécurité électrique ne sont pas ou sont insuffisamment respectées, il peut
s’ensuivre des chocs électriques, des incendies et/ou des blessures graves pouvant éventuellement
entrainer la mort.

1.

10.

11.

Avant chaque mise sous tension du produit, il faut s’assurer que la tension nominale réglée sur le
produit correspond a la tension nominale du réseau électrique. S’il est nécessaire de modifier le
réglage de la tension, il faut remplacer le fusible du produit, le cas échéant.

L'utilisation des produits du degré de protection | pourvus d’un céble d’alimentation mobile et d’'un
connecteur n’est autorisée qu’avec des prises munies d’'un contact de protection et d’'un conducteur
de protection raccordé.

Toute déconnexion intentionnelle du conducteur de protection, dans le cable ou dans le produit lui-
méme, est interdite. Elle entraine un risque de choc électrique au niveau du produit. En cas
d’utilisation de cables prolongateurs ou de multiprises, ceux-ci doivent étre examinés régulierement
guant a leur état de sécurité technique.

Si le produit n’est pas doté d’un interrupteur d’alimentation pour le couper du réseau électrique ou si
I'interrupteur d’alimentation disponible n’est pas approprié pour couper le produit du réseau électrique,
le connecteur male du cable de raccordement est a considérer comme dispositif de séparation.

Le dispositif de séparation doit étre a tout moment facilement accessible. Si, par exemple, le
connecteur d’alimentation sert de dispositif de séparation, la longueur du cable de raccordement ne
doit pas dépasser 3 m.

Les commutateurs fonctionnels ou électroniques ne sont pas appropriés pour couper I'appareil du
réseau électrique. Si des produits sans interrupteur d’alimentation sont intégrés dans des bétis ou
systémes, le dispositif de séparation doit étre reporté au niveau du systeme.

Ne jamais utiliser le produit si le cable d’alimentation est endommagé. Vérifier régulierement le parfait
état du cable d’alimentation. Prendre les mesures préventives appropriées et opter pour des types de
pose tels que le cable d’alimentation ne puisse pas étre endommageé et que personne ne puisse subir
de préjudice, par exemple en trébuchant sur le cable ou par des chocs électriques.

L'utilisation des produits est uniquement autorisée sur des réseaux d’alimentation de type TN/TT
protégés par des fusibles d’une intensité max. de 16 A (pour toute intensité supérieure, consulter le
groupe Rohde & Schwarz).

Ne pas brancher le connecteur dans des prises d’alimentation sales ou poussiéreuses. Enfoncer
fermement le connecteur jusqu’au bout de la prise. Le non-respect de cette mesure peut provoquer
des étincelles, incendies et/ou blessures.

Ne pas surcharger les prises, les cables prolongateurs ou les multiprises, cela pouvant provoquer des
incendies ou chocs électriques.

En cas de mesures sur les circuits électriques d’une tension efficace > 30 V, prendre les précautions
nécessaires pour éviter tout risque (par exemple équipement de mesure approprié, fusibles, limitation
de courant, coupe-circuit, isolation, etc.).

En cas d’interconnexion avec des équipements informatiques comme par exemple un PC ou un
ordinateur industriel, veiller a ce que ces derniers soient conformes aux normes IEC 60950-1 /
EN 60950-1 ou IEC 61010-1/ EN 61010-1 en vigueur.

Sauf autorisation expresse, il est interdit de retirer le couvercle ou toute autre piéce du boitier lorsque
le produit est en cours de service. Les cables et composants électriques seraient ainsi accessibles, ce
qui peut entrainer des blessures, des incendies ou des dégéats sur le produit.
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12.

13.

14.

15.

16.

17.

18.

Consignes de sécurité fondamentales

Si un produit est connecté de fagon stationnaire, établir avant toute autre connexion le raccordement
du conducteur de protection local et du conducteur de protection du produit. L’installation et le
raccordement ne peuvent étre effectués que par un électricien ou électronicien qualifié.

Sur les appareils stationnaires sans fusible ni disjoncteur automatique ou dispositif de protection
similaire intégrés, le circuit d’alimentation doit étre sécurisé de sorte que toutes les personnes ayant
acces au produit et le produit lui-méme soient suffisamment protégés contre tout dommage.

Chaque produit doit étre protégé de maniére appropriée contre les éventuelles surtensions (par
exemple dues a un coup de foudre). Sinon, les utilisateurs sont exposés a des risques de choc
électrique.

Ne jamais introduire d’objets non prévus a cet effet dans les ouvertures du boitier, étant donné que
cela peut entrainer des courts-circuits dans le produit et/ou des chocs électriques, incendies ou
blessures.

Sauf spécification contraire, les produits ne sont pas protégés contre l'infiltration de liquides, voir aussi
la section « Etats et positions de fonctionnement », point 1. Il faut donc protéger les produits contre
linfiltration de liquides. La non-observation de cette consigne entraine le risque de choc électrique
pour l'utilisateur ou d’endommagement du produit, ce qui peut également mettre les personnes en
danger.

Ne pas utiliser le produit dans des conditions pouvant occasionner ou ayant déja occasionné, le cas
échéant, des condensations dans ou sur le produit, par exemple lorsque celui-ci est déplacé d’'un
environnement froid dans un environnement chaud. L’infiltration d’eau augmente le risque de choc
électrique.

Avant le nettoyage, débrancher le produit de I'alimentation (par exemple réseau électrique ou
batterie). Pour le nettoyage des appareils, utiliser un chiffon doux non pelucheux. N’utiliser en aucun
cas de produit de nettoyage chimique, tel que de I'alcool, de I'acétone ou un diluant nitrocellulosique.

Fonctionnement

1.

L'utilisation du produit exige une formation spécifique ainsi qu’une grande concentration. Il est
impératif que les personnes qui utilisent le produit présent les aptitudes physiques, mentales et
psychiques requises, vu qu’autrement des dommages corporels ou matériels ne peuvent pas étre
exclus. Le choix du personnel qualifié pour I'utilisation du produit est sous la responsabilité de
I'employeur/I'exploitant.

Avant de déplacer ou de transporter le produit, lire et respecter la section « Transport ».

Comme pour tous les biens produits de facon industrielle, I'utilisation de matériaux pouvant causer
des allergies (allergenes, comme par exemple le nickel) ne peut étre totalement exclue. Si, lors de
I'utilisation de produits Rohde & Schwarz, des réactions allergiques surviennent, telles qu’éruption
cutanée, éternuements fréquents, rougeur de la conjonctive ou difficultés respiratoires, il faut
immédiatement consulter un médecin pour en clarifier la cause et éviter toute atteinte a la santé.

Avant le traitement mécanique et/ou thermique ou le démontage du produit, il faut impérativement
observer la section « Elimination des déchets », point 1.
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Consignes de sécurité fondamentales

Selon les fonctions, certains produits, tels que des systemes de radiocommunication RF, peuvent
produire des niveaux élevés de rayonnement électromagnétique. Etant donné la vulnérabilité de
'enfant a naitre, les femmes enceintes doivent étre protégées par des mesures appropriées. Les
porteurs de stimulateurs cardiaques peuvent également étre menacés par les rayonnements
électromagnétiques. L’employeur/I'exploitant est tenu d’évaluer et de repérer les lieux de travail
soumis a un risque particulier d’exposition aux rayonnements et de prévenir les dangers éventuels.

En cas d’incendie, il se peut que le produit dégage des matiéres toxiques (gaz, liquides, etc.)
susceptibles de nuire a la santé. Il faut donc, en cas d’incendie, prendre des mesures adéquates
comme par exemple le port de masques respiratoires et de vétements de protection.

Si un produit laser est intégré dans un produit Rohde & Schwarz (par exemple lecteur CD/DVD), il ne
faut pas utiliser de réglages ou fonctions autres que ceux décrits dans la documentation produit pour
éviter tout dommage corporel (par exemple causé par rayon laser).

Classes CEM (selon EN 55011 / CISPR 11 ; selon EN 55022 / CISPR 22, EN 55032 / CISPR 32 par

analogie)

— Appareil de la classe A:
Appareil approprié a un usage dans tous les environnements autres que I’environnement
résidentiel et les environnements raccordés directement a un réseau d’alimentation basse tension
gui alimente des batiments résidentiels.
Remarque : ces appareils peuvent provoquer des perturbations radioélectriques dans
'environnement résidentiel en raison de perturbations conduites ou rayonnées. Dans ce cas, on
peut exiger que I'exploitant mette en ceuvre de mesures appropriées pour éliminer ces
perturbations.

— Appareilde laclasse B :
Appareil approprié a un usage dans I'environnement résidentiel ainsi que dans les
environnements raccordés directement & un réseau d’alimentation basse tension qui alimente des
batiments résidentiels.

Réparation et service aprés-vente

1.

Le produit ne doit étre ouvert que par un personnel qualifié et autorisé. Avant de travailler sur le
produit ou de I'ouvrir, il faut le couper de la tension d’alimentation ; sinon il y a risque de choc
électrique.

Les travaux d’ajustement, le remplacement des piéces, la maintenance et la réparation ne doivent
étre effectués que par des électroniciens qualifiés et autorisés par Rohde & Schwarz. En cas de
remplacement de pieces concernant la sécurité (notamment interrupteur d’alimentation,
transformateur d’alimentation réseau ou fusibles), celles-ci ne doivent étre remplacées que par des
piéces d’origine. Aprés chaque remplacement de piéces concernant la sécurité, une vérification de
sécurité doit étre effectuée (contréle visuel, vérification du conducteur de protection, mesure de la
résistance d’isolement et du courant de fuite, essai de fonctionnement). Cela permet d’assurer le
maintien de la sécurité du produit.

Batteries et accumulateurs/cellules

Si les instructions concernant les batteries et accumulateurs/cellules ne sont pas ou sont insuffisamment
respectées, cela peut provoquer des explosions, des incendies et/ou des blessures graves pouvant
entrainer la mort. La manipulation de batteries et accumulateurs contenant des électrolytes alcalins (par
exemple cellules de lithium) doit étre conforme a la norme EN 62133.
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Consignes de sécurité fondamentales

Les cellules ne doivent &tre ni démontées, ni ouvertes, ni réduites en morceaux.

Ne jamais exposer les cellules ou batteries a la chaleur ou au feu. Ne pas les stocker dans un endroit
ou elles sont exposées au rayonnement direct du soleil. Tenir les cellules et batteries au sec. Nettoyer
les raccords sales avec un chiffon sec et propre.

Ne jamais court-circuiter les cellules ou batteries. Les cellules ou batteries ne doivent pas étre
gardées dans une boite ou un tiroir ou elles peuvent se court-circuiter mutuellement ou étre court-
circuitées par d’autres matériaux conducteurs. Une cellule ou batterie ne doit étre retirée de son
emballage d’origine que lorsqu’on l'utilise.

Les cellules ou batteries ne doivent pas étre exposées a des chocs mécaniques de force non
admissible.

En cas de manque d’étanchéité d’une cellule, le liquide ne doit pas entrer en contact avec la peau ou
les yeux. S’il y a contact, rincer abondamment a I'eau I'endroit concerné et consulter un médecin.

Il y a danger d’explosion en cas de remplacement ou chargement incorrect des cellules ou batteries
gui contiennent des électrolytes alcalins (par exemple cellules de lithium). Remplacer les cellules ou
batteries uniquement par le type Rohde & Schwarz correspondant (voir la liste des piéces de
rechange) pour maintenir la sécurité du produit.

Il faut recycler les cellules ou batteries et il est interdit de les éliminer comme déchets normaux. Les
accumulateurs ou batteries qui contiennent du plomb, du mercure ou du cadmium sont des déchets
spéciaux. Observer les régles nationales d’élimination et de recyclage.

Transport

1.

Le produit peut avoir un poids élevé. Il faut donc le déplacer ou le transporter avec précaution et en
utilisant le cas échéant un moyen de levage approprié (par exemple, chariot élévateur) pour éviter des
dommages au dos ou des blessures.

Les poignées des produits sont une aide de manipulation exclusivement réservée au transport du
produit par des personnes. Il est donc proscrit d’utiliser ces poignées pour attacher le produit a ou sur
des moyens de transport, tels que grues, chariots et chariots élévateurs, etc. Vous étes responsable
de la fixation sdre des produits a ou sur des moyens de transport et de levage appropriés. Observer
les consignes de sécurité du fabricant des moyens de transport ou de levage utilisés pour éviter des
dommages corporels et des dégats sur le produit.

L'utilisation du produit dans un véhicule se fait sous I'unique responsabilité du conducteur qui doit
piloter le véhicule de maniére s(re et appropriée. Le fabricant décline toute responsabilité en cas
d’accidents ou de collisions. Ne jamais utiliser le produit dans un véhicule en mouvement si cela
pouvait détourner I'attention du conducteur. Sécuriser suffisamment le produit dans le véhicule pour
empécher des blessures ou dommages de tout type en cas d’accident.

Elimination des déchets

1.

Au terme de leur durée de vie, les batteries ou accumulateurs qui ne peuvent pas étre éliminés avec
les déchets ménagers peuvent uniquement étre éliminés par des points de collecte appropriés ou par
un centre de service aprés-vente Rohde & Schwarz.
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Consignes de sécurité fondamentales

2. Auterme de sa durée de vie, un produit ne peut pas étre éliminé avec les déchets ménagers
normaux, mais doit étre collecté séparément.
Rohde & Schwarz GmbH & Co. KG a développé un concept d’élimination des déchets et assume
toutes les obligations en matiére de reprise et d’élimination, valables pour les fabricants au sein de
'UE. Veuillez vous adresser a votre centre de service aprés-vente Rohde & Schwarz pour éliminer le
produit de maniére écologique.

3. Siles produits ou leurs composants sont travaillés mécaniquement et/ou thermiquement au-dela de
l'utilisation prévue, ils peuvent, le cas échéant, libérer des substances dangereuses (poussiéres
contenant des métaux lourds comme par exemple du plomb, du béryllium ou du nickel). Le
démontage du produit ne doit donc étre effectué que par un personnel qualifié et spécialement formé.
Le démontage inadéquat peut nuire a la santé. Les regles nationales concernant I'élimination des
déchets doivent étre observées.

4. Si, lors de l'utilisation du produit, des substances dangereuses ou combustibles exigeant une
élimination spéciale sont dégagées, comme par exemple liquides de refroidissement ou huiles
moteurs qui sont & changer régulierement, les consignes de sécurité du fabricant de ces substances
dangereuses ou combustibles ainsi que les régles sur I'élimination en vigueur au niveau régional
doivent étre respectées. Les consignes de sécurité spéciales correspondantes dans la documentation
produit doivent également étre respectées, le cas échéant. L’élimination non conforme des
substances dangereuses ou combustibles peut provoquer des atteintes a la santé et des dommages
écologiques.

Pour plus d’informations concernant la protection de I'environnement, voir la page d’accueil de
Rohde & Schwarz.
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Customer Support

Technical support — where and when you need it

For quick, expert help with any Rohde & Schwarz equipment, contact one of our Customer Support
Centers. A team of highly qualified engineers provides telephone support and will work with you to find a
solution to your query on any aspect of the operation, programming or applications of Rohde & Schwarz
equipment.

Up-to-date information and upgrades

To keep your instrument up-to-date and to be informed about new application notes related to your
instrument, please send an e-mail to the Customer Support Center stating your instrument and your wish.
We will take care that you will get the right information.

Europe, Africa, Middle East Phone +49 89 4129 12345
customersupport@rohde-schwarz.com

North America Phone 1-888-TEST-RSA (1-888-837-8772)
customer.support@rsa.rohde-schwarz.com

Latin America Phone +1-410-910-7988
customersupport.la@rohde-schwarz.com

Asia/Pacific Phone +6565 1304 88
customersupport.asia@rohde-schwarz.com

China Phone +86-800-810-8228 /
+86-400-650-5896
customersupport.china@rohde-schwarz.com

ROHDE&SCHWARZ

1171.0200.22-06.00
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1.1

1.2

Key Features

Preface

The R&S SGS RF Source is a signal generator intended either for the generation of
IQ-modulated signals or as a pure local oscillator (LO) source in the frequency range of
1 MHz to 12.75 GHz.

Optimized for use in automated test equipment (ATE), the instrument offers very fast
settling times in an exceptionally small form factor and low power consumption. The
R&S SGS can be equipped optionally with an active electronic step attenuator, a high
stability reference oscillator and LO connectors for coupling multiple generators to a
common LO source.

Key Features

The key features of the R&S SGS include the following:

® Compact size and low power consumption

® Remote connection via PCI Express, minimizing time for setup
Alternatively, LAN or USB connections available

® Coherent LO input and output connectors, also usable as MIMO input/output and
phase coherent I/Q demodulation

® Broadband analogue input for vector modulation (I, Q)
® Linux operating system

® Graphical user interface R&S SGMA-GUI to set up and control one or more
R&S SGS instruments simultaneously from one remote computer, available for
Windows and Linux systems

Documentation Overview

The user documentation for the R&S SGS consists of the following parts:

® "Getting Started" printed manual

® Documentation CD-ROM with:
— Online help system (*.chm) as a standalone help

— User Manual for base unit and options
— Service manual

— Data sheet and product brochure

— Links to useful sites on the R&S internet

R&S SGMA-GUI Online Help

The Online Help is embedded in the R&S SGMA-GUI software. It offers quick, context-
sensitive access to the complete information needed for operation and programming.
The online help contains help on operating the R&S SGS and all available options.
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Typographical Conventions

Getting Started

This manual is delivered with the instrument in printed form and in PDF format on the
Documentation CD-ROM. It provides the information needed to set up and start work-
ing with the instrument. Basic operations and typical measurement examples are
described. The manual includes also general information, e.g., safety instructions.

User Manual

The User Manual is a supplement to the Getting Started manual. The manual is availa-
ble in PDF format - in printable form - on the Documentation CD-ROM delivered with
the instrument. In this manual, all instrument functions are described in detail. Further-
more, it provides an introduction to remote control and a complete description of the
remote control commands with programming examples. Information on maintenance,
instrument interfaces and error messages is also given.

Service Manual

The Service Manual is available in PDF format - in printable form - on the documenta-
tion CD-ROM delivered with the instrument. It informs on how to check compliance
with rated specifications, on instrument function, repair, troubleshooting and fault elimi-
nation. It contains all information required for repairing the instrument by the replace-
ment of modules.

Web Help

The content of the web helps correspond to the user manual for the latest product ver-
sion.

The web help is an additional file format that offers quick online access. This format is
not intended for download but rather for accessing the required information directly
form the R&S website.

Web helps are available on the R&S website, on the R&S SGS product page at http://
www2.rohde-schwarz.com/product/SGS100A.html > Download > Web Help.

Typographical Conventions

The following text markers are used throughout this documentation:

Convention Description
"Graphical user interface ele- All names of graphical user interface elements on the screen, such as
ments" dialog boxes, menus, options, buttons, and softkeys are enclosed by

quotation marks.

KEYS Key names are written in capital letters.

File names, commands, File names, commands, coding samples and screen output are distin-
program code guished by their font.

Input Input to be entered by the user is displayed in italics.



http://www2.rohde-schwarz.com/product/SGS100A.html
http://www2.rohde-schwarz.com/product/SGS100A.html

Typographical Conventions

Convention Description

Links Links that you can click are displayed in blue font.

"References" References to other parts of the documentation are enclosed by quota-
tion marks.
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2.1 Putting into Operation

This section describes the basic steps to be taken when setting up the R&S SGS for
the first time.

Risk of injury and instrument damage

The instrument must be used in an appropriate manner to prevent electric shock, fire,
personal injury, or damage.

® Do not open the instrument casing.

® Read and observe the "Basic Safety Instructions" at the beginning of this manual or
on the documentation CD-ROM, in addition to the safety instructions in the follow-
ing sections. Notice that the data sheet may specify additional operating condi-
tions.

Risk of instrument damage

Note that the general safety instructions also contain information on operating condi-
tions that will prevent damage to the instrument. The instrument's data sheet may con-
tain additional operating conditions.

Risk of electrostatic discharge (ESD)

Electrostatic discharge (ESD) can cause damage to the electronic components of the
instrument and the device under test (DUT). ESD is most likely to occur when you con-
nect or disconnect a DUT or test fixture to the instrument's test ports. To prevent ESD,
use a wrist strap and cord and connect yourself to the ground, or use a conductive
floor mat and heel strap combination.

For details, refer to the safety instructions delivered in electronic format on the docu-
mentation CD-ROM.
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Risk of instrument damage during operation

An unsuitable operating site or test setup can cause damage to the instrument and to
connected devices. Ensure the following operating conditions before you switch on the
instrument:

® All fan openings are unobstructed and the airflow perforations are unimpeded. The
minimum distance from the wall is 10 cm.

® The instrument is dry and shows no sign of condensation.

® The instrument is positioned as described in the following sections.

® The ambient temperature does not exceed the range specified in the data sheet.
® Signal levels at the input connectors are all within the specified ranges.

® Signal outputs are correctly connected and are not overloaded.

2.1.1 EMI Suppression

Electromagnetic interference (EMI) may affect the measurement results.

To suppress generated Electromagnetic Interference (EMI),

® Use suitable shielded cables of high quality. For example use double-shielded RF
and LAN cables.
Note: USB cables are of varying and often poor quality. Therefore, check the qual-
ity of each individual USB cable as described in the service manual.

® Always terminate open cable ends.

® Note the EMC classification in the data sheet

2.1.2 Unpacking and Checking the Instrument

Check the equipment for completeness using the delivery note and the accessory lists
for the various items. Check the instrument for any damage. If there is damage, imme-
diately contact the carrier who delivered the instrument. Make sure not to discard the
box and packing material.

Packing material

Retain the original packing material. If the instrument needs to be transported or ship-
ped at a later date, you can use the material to protect the control elements and con-
nectors.
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Risk of damage during transportation and shipment

Insufficient protection against mechanical and electrostatic effects during transportation
and shipment can damage the instrument.

® Always make sure that sufficient mechanical and electrostatic protection is provi-
ded.

® When shipping an instrument, the original packaging should be used. If you do not
have the original packaging, use sufficient padding to prevent the instrument from
moving around inside the box. Pack the instrument in antistatic wrap to protect it
from electrostatic charging.

® Secure the instrument to prevent any movement and other mechanical effects dur-
ing transportation.

The carrying handles at the front and side of the casing are designed to lift or carry

the instrument. Do not apply an excessive external force to the handles.

Observe the information on transporting heavy instruments in the basic safety instruc-
tions included at the front of the printed manual and on the supplied CD ROM.

2.1.3 Accessory List

The instrument comes with the following accessories:

® Power cable
® (etting Started printed manual
® R&S SGS User Documentation CD-Rom

2.1.4 Placing or Mounting the Instrument

The R&S SGS is designed for use under laboratory conditions, either on a bench top
or in a rack using a rack adapter kit (order number see data sheet).

Bench Top Operation

If the R&S SGS is operated on a bench top, the surface should be flat. The instrument
can be used in horizontal position, standing on its feet.
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A CAUTION

Risk of injury and instrument damage if stacking instruments

A stack of instruments may tilt over and cause injury. Furthermore, the instruments at
the bottom of the stack may be damaged due to the load imposed by the instruments
on top.

Observe the following instructions when stacking instruments:

® Never stack more than three instruments with the same dimensions (width and
length). If you need to stack more than three instruments, install them in a rack.

® The overall load imposed on the lowest instrument must not exceed 500 N.

® Allinstruments should have the same dimensions (width and length).
If you need to stack smaller instruments on the top, the overall load imposed on the
lowest instrument must not exceed 250 N.

e |f the instruments have foldable feet, fold them in completely.

R

E l imax. 500 N

=TI —
A —
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Correct Too many instruments Different dimensions Feet folded out
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Rackmounting

The R&S SGS can be installed in a rack using a rack adapter kit (Order No. see data
sheet). The installation instructions are part of the adapter kit.

Risk of instrument damage in a rack

An insufficient airflow can cause the instrument to overheat, which may disturb the
operation and even cause damage.

Make sure that all fan openings are unobstructed, that the airflow perforations are
unimpeded, and that the minimum distance from the wall is 10 cm.

2.1.5 Switching the Instrument On and Off

The R&S SGS is automatically adapted to the AC voltage supplied. There is no need
to set the voltage manually or change fuses. The AC SUPPLY AND POWER SWITCH
is at the rear of the unit.

HE
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To connect the AC supply

» Connect the R&S SGS to the AC power source using the AC power cable deliv-
ered with the instrument.

Note: The instrument is in compliance with safety class EN61010-1.
Connect the instrument only to a socket with earthing contact.

To start up the instrument

1. Connect the instrument to the AC supply.

2. To turn the power on, press the main power switch to position | (On).

To switch between standby and ready state

» Press the POWER ON /STAND BY key briefly to switch the instrument from the
standby to ready state or vice versa.

In ready state, the button is green. The instrument is ready for operation. All mod-
ules are power-supplied and the R&S SGS initiates its startup procedure.

In standby state, the button is orange. The standby power mode keeps the power
switch circuits and the remote control system active.

Start-up and booting

The instrument boots the operating system and starts the instrument firmware. During
the booting process the green POWER ON /STAND BY key blinks. If the previous ses-
sion was terminated regularly, the instrument uses the last setup with the relevant
instrument settings.

Once the startup procedure has been terminated, the instrument is ready for operation.

In the R&S SGMA-GUI, select "Instrument > Preset" function to return the instrument
to its defined reset/preset state, if the current setup is no longer relevant.

To customize the start settings, use the "SGMA-GUI > File > Save As/Open" function.

To shut down the Instrument

To shut down the R&S SGS, proceed as described below.

HE
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Risk of losing data
If you switch off the running instrument using the rear panel switch or by disconnecting
the power cord, the instrument loses its current settings.

Always press the POWER ON/STANDBY key first to shut down the application prop-
erly.

2.1.6

21.7

1. Press the POWER ON /STAND BY key to save the current setup, shut down the
operating system and set the instrument to standby state.

The POWER ON /STAND BY LED must be orange.

Tip: If the instrument is operated manually via the R&S SGMA-GUI, select "SGMA-
GUI > Instrument Name > Setup > Standby".

2. To turn the power off, press the main power switch to position 0 (Off).

None of the front-panel LEDs should be on.

Function Check

The instrument automatically monitors the main functions when it is switched on and
monitors them continuously during operation.

A detected fault is indicated by an "Error" message displayed in the info line of the
R&S SGMA-GUI together with a brief error description. For an in-depth identification of
the error, press the "SGMA-GUI > Info" button. In response, a description of the
error(s) is displayed. For more information, refer to the "Error Messages" section in the
User Manual.

In addition to the automatic monitoring, the R&S SGS offers the following capabilities
to ensure correct functioning:

® Internal Adjustments
In the R&S SGMA-GUI, select the "Instrument > Setup > Internal Adjustments” dia-
log to access the dialog for performing and configuring the adjustments settings. A
maximum level accuracy can be obtained, for instance.

® Selftest
A selftest is provided for service purposes ("SGMA-GUI > Instrument > Diagnostic/
Test > Self Test").

Default Settings

When the instrument is switched on, it is not the preset state that is active, but rather
the instrument state that was set before the instrument was switched off. It is recom-
mended that you use the "SGMA-GUI > Instrument > Preset" function to return the
instrument to its defined preset state every time a new configuration is required or the
current setup is no longer relevant.
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The R&S SGS offers a two-stage preset concept:

® Preset the instrument to a predefined state
The "SGMA-GUI > Instrument Name > Preset" function calls up a defined instru-
ment setup. All parameters and switching states are preset (also those of inactive
operating modes). The default instrument settings provide a reproducible initial
basis for all other settings. However, functions that concern the integration of the
instrument into a measurement setup are not changed.

® Preset the instrument to its factory settings
The instrument can also be forced to load its default factory settings. To access the
corresponding dialog box, select the "SGMA-GUI > Instrument Name > Setup >
Factory Preset" function.
For more information and an overview of the settings affected by the factory preset
function, see chapter 8.10, "Factory Preset", on page 105.

User-defined instrument states can be stored and called up using the functions
"SGMA-GUI > File > Save As/Open".

2.2 Linux Operating System

The instrument uses an embedded Linux operating system, optimally adapted to the
instrument.

Accessing the Operating System
No access to the operating system is required for normal operation.

All necessary system settings can be made in the "Setup" dialog.

2.3 Connecting an External PC and Devices

As a rule, the R&S SGS is operated exclusively via remote control on a connected PC.
Another way to control the instrument is the manual operation via the R&S SGMA-GUI
software on the connected PC.

Both the remote control and the manual operation of the instrument require an external
controller. For the prerequisites and the instructions on how to configure an external
controller for remote control, refer to the User Manual. A brief introduction to the
remote control capabilities is provided in chapter 10, "Network and Remote Control
Operation”, on page 124.

This section gives an introduction on how to configure the external PC for manual
operation (see chapter 2.3.1, "Installing the R&S SGMA-GUI Software on an External
PC", on page 21).

In addition to connecting an external controller, it may be useful to connect other exter-
nal devices, e.g. a memory stick. The following interfaces are provided on the rear
panel of the instrument, see also chapter 3.2, "Rear Panel Tour", on page 28:
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® PCI Express (refer to chapter 2.3.3, "Connecting a Controller via PCI Express",
on page 24

® USB interface (refer to chapter 2.3.4, "Connecting a Controller or an USB Device
via USB", on page 24)

® [ AN interface (refer to chapter 2.3.2, "Connecting a Remote PC via LAN",
on page 22)

2.3.1 Installing the R&S SGMA-GUI Software on an External PC

The R&S SGMA-GUI is delivered in the latest version available on the CD-ROM inclu-
ded in the instrument's delivery. Software updates as well as the Release Notes
describing the improvements and modifications are provided on the Internet at the
download site of the Rohde&Schwarz home page. This home page always offers the
latest information on your R&S SGMA-GUI.

The R&S SGMA-GUI software is provided as separate installation package for the dif-
ferent operating systems.

This description focuses on the handling of the Windows-32 version. The file naming
conventions and the installation instructions for the other operating systems are analo-
gous.

The R&S SGMA-GUI installation package for Windows-32 operating system consists
of the file SGMA-GUI <V.VV.VVV.VVV>.exe. The version numbers in the file names
vary with each update. To install the R&S SGMA-GUI, the following hardware and soft-
ware requirements have to be met.

Table 2-1: Hardware and Software Requirements

Requirement Remark

One of the following operating sys- | R&S SGMA-GUI has to be installed on one of the supported operat-

tems: ing systems.

®  Windows XP SP2 Note:

®  Windows Vista ) ) .

e  Windows 7 Any other Windows version or other operating systems are not sup-
e Windows 8/ 8.1 ported.

e Linux Windows Installer Version 4.5 or higher is needed for the installation

of the software on a Windows XP computer.
During installation, the operation system is checked.

The installation will be terminated if this requirement is not fulfilled.

National Instruments (NI) VISA VISA drivers can be obtained from R&S or NI directly.
version 3.4.1 or higher (optional)

or

Agilent VISA version 14 or higher

(optional)
CPU At least Pentium or compatible, as from 1 GHz (recommended).
VGA color display resolution At least 800*600 pixels
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Installing a new software version

Administrator rights are necessary for installation and starting.

2.3.2

2.3.21

» In Windows Explorer double-click SGMA-GUI V.VV.VVV.VVV.exe and follow the
instructions.

Uninstalling an old software version

An uninstallation of a previous version of the SW can be performed prior to the installa-
tion of the new one but is not mandatory.

» To uninstall this version, go to "Start > Settings > Control Panel > Add/Remove
Programs" and select the entry SGMA-GUI V.VV.VVV.VVV.

The script file identifies and removes all currently installed R&S SGMA-GUI soft-
ware items.

Connecting a Remote PC via LAN

The R&S SGS is equipped with a network interface and can be connected to an Ether-
net LAN (local area network). The interface can be used, for example:

® To connect an external computer for manual control of the instrument by means of
the R&S SGMA-GUI software.

® To operate the device by a remote control program.
See chapter 10, "Network and Remote Control Operation", on page 124.

This section describes how to configure the LAN interface. It includes the following top-
ics:

® chapter 2.3.2.1, "Connecting the Instrument to the Network", on page 22

® chapter 2.3.2.2, "Assigning the IP Address", on page 23

® chapter 2.3.2.3, "Automatically adding instruments to the SGMA-GUI ",
on page 23

Connecting the Instrument to the Network

There are two methods to establish a LAN connection to the instrument:

® A non-dedicated network (Ethernet) connection from the instrument to an existing
network.

® A dedicated network connection (Point-to-point connection) between the instru-
ment and a single computer.

In both cases, an IP address has to be assigned to the instrument and the computer,
see chapter 2.3.2.2, "Assigning the IP Address", on page 23.
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Setting Up a Network (LAN) Connection

Risk of network failure

Before connecting the instrument to the network or configuring the network, consult
your network administrator. Errors may affect the entire network.

23.2.2

» Connect the instrument to the network or to a single PC.

If the instrument is connected to the LAN, the operating system automatically
detects the network connection and activates the required drivers.

By default, the instrument is configured to use dynamic TCP/IP configuration and
obtain all address information automatically.

Assigning the IP Address

Depending on the network capacities, the TCP/IP address information for the instru-
ment can be obtained in different ways.

® |f the network supports dynamic TCP/IP configuration using the Dynamic Host
Configuration Protocol (DHCP), all address information can be assigned automati-
cally.

® |f the network does not support DHCP, the instrument tries to obtain the IP address
via Zeroconf (APIPA) protocol. If this attempt does not succeed or if the instrument
is set to use alternate TCP/IP configuration, the addresses must be set manually.

The R&S SGS uses the Zeroconf IP addresses 169.254.xxx.yyy., where xxx may take
values between 1...254 and yyy the values in the value range 1...255; the subnet mask
is always 255.255.0.0. The IP address of the host must be within the same address
area for Zeroconf.

23.23

By default, the instrument is configured to use dynamic TCP/IP configuration and
obtain all address information automatically. This means that it is safe to establish a
physical connection to the LAN without any previous instrument configuration.

Automatically adding instruments to the SGMA-GUI

For information on how to install the R&S SGMA-GUI software, refer to chapter 2.3.1,
"Installing the R&S SGMA-GUI Software on an External PC", on page 21.

1. For each new instrument perform the following steps:

a) Connect the instrument to the network.
b) Press the POWER ON /STAND BY key to switch on the instrument.
c) Wait until the POWER ON /STAND BY LED is green and not blinking.
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d) Press the ID key on the front panel of the instrument.
2. Start the SGMA-GUI on a computer connected to the same network.

3. Open the "Instruments"” dialog and click "Scan".

Note: This step is performed automatically on the first start and can also be omit-
ted for instruments with a direct LAN connection to the computer.

All instruments will be added automatically to the main panel of the SIGMA-GUI.

2.3.3 Connecting a Controller via PCI Express
A PCI Express connector is provided on the rear panel of the instrument, see chap-
ter 3.2, "Rear Panel Tour", on page 28.

NOTICE

Risk of device failure
The R&S SGS is equipped with a single lane PCle interface that supports hot plugging.
Do not connect an external PC to the PCle connector of the instrument during opera-
tion if this external PC does not support hot-plugging!
Using the PCle interface for remote control of the instrument requires extended knowl-
edge. Refer to chapter 10.3, "Advanced Remote Control Using PCle", on page 134 for
detailed information.

2.3.4 Connecting a Controller or an USB Device via USB

The USB interface on the rear panel of the R&S SGS allows you to connect either an
USB device or use the R&S SGS as a device and connect it to a controller.
Connecting a controller (host PC or compatible signal generator)

If you connect a controller (host PC or compatible signal generator) to the R&S SGS,
the R&S SGS acts as an USB device.

To connect the controller to the USB interface of the R&S SGS, always connect the
USB Type Micro-B connector to the R&S SGS. Refer to the documentation of the con-
troller to find out which USB connector type you can connect to the controller.

The figure 2-1 illustrates schematically the required connector type to emphasize on
the different connector shape.

NI,

Fig. 2-1: USB Type Micro-B connectors




Connecting an External PC and Devices

An external PC with installed R&S SGMA-GUI is required for manual operation of the
R&S SGS.

On the remote PC, perform the steps as described in chapter 2.3.2.3, "Automatically
adding instruments to the SGMA-GUI ", on page 23.
Connecting an USB device

If you connect an USB device (Memory stick, CD-ROM, an instrument) to the
R&S SGS, the R&S SGS acts as a host.

To connect an USB device to the interface of the R&S SGS, always connect the
USB Type Micro-A connector to the R&S SGS. Refer to the documentation of the
USB device to find out which USB connector type you can connect to the USB device.

The figure 2-2 illustrates schematically the required connector type to emphasize on
the different connector shape.

| . .

Fig. 2-2: USB Type Micro-A connectors

If you connect an R&S SGS to an R&S SGU via an USB cable, perform the steps as
described in chapter 5.2, "Setups for Connecting an R&S SGS and an R&S SGU",
on page 37.

Using an USB Adapter
You can use an USB adapter to customize the connectors of an USB cable to the
requirements of the instrument.

For example you can use a Type-A / Micro-A adapter to customize a standard USB
cable with Type A and Type Micro-B connectors for the connection of an R&S SGS
(acting as a host) to an R&S SGU (acting as an USB device).

In some cases you can also use a Type-A / Micro-B adapter to establish a connection
to the instrument. To check whether the adapter you have is suitable or not you can
connect an USB stick with an LED through the adapter to the instrument. If the LED of
the USB stick lights up after a connection to the instrument then you can use this
adapter for further applications with the instrument.
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3 Instrument Tour

The following topics will help you get familiar with the instrument and perform the first
steps:

® Front Panel Tour
® Rear Panel Tour

This section explains the control elements and the connectors of the R&S SGS with
the aid of the front and rear views. Specifications of interfaces can be found in the data
sheet.

3.1 Front Panel Tour

This section provides an overview of control elements on the front panel of the

R&S SGS. The connectors of the R&S SGS are placed on the rear panel and are
described in chapter 3.2, "Rear Panel Tour", on page 28. As the R&S SGS is mainly
intended to be remote-controlled, the front panel of the R&S SGS contains no display
but mostly LEDs to inform the user about the status of the instrument. The user inter-
face can be displayed on a remote PC station used to manually remote control the
instrument.

@nouns&scuwnnz SGMA - RF SOURCE

R&S SGS100A

ERROR /
REF EXT \waRNING LAN L}

> & o @ -

(U] RFON

Fig. 3-1: Front panel view

POWER ON /STAND BY
O

The POWER ON /STAND BY key switches the instrument from the standby to ready
state or vice versa.

In ready state, the button is green. The instrument is ready for operation.

In standby state, the button is orange. In this state it is safe to switch off the AC power
and disconnect the instrument from the power supply.

A blinking green color indicates that a booting operation is in proccess.

RF ON

RFON
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The RF ON key switches the RF signal on or off. If activated, the button is green.

REF EXT

REF EXT

L

The REF EXT LED indicates the status of the external reference.

® Green indicates that the instrument can synchronize to the external clock.
® Red indicates that the instrument cannot synchronize to the external clock.
® No light indicates that the internal reference is used.

ERROR / WARNING

ERROR /
WARNING

The ERROR / WARNING LED indicates the status of the R&S SGS.

® Red indicates that an error has occurred, e.g. temperature exceeded or power fail-
ure.

® Blinking orange indicates a running process (e.g calibration, self test).

® No light indicates that no errors or warnings have occurred.

For details on errors or warnings refer to the graphical user interface on a remote PC
("SGMA-GUI > Info").

For more information, refer to the "Error Messages" section in the User Manual.

LAN

Pressing the key for more than 3 s resets the LAN interface settings, i.e the "IP Adress
Mode" is reset to DHCP.

ID

Pressing the ID key while the instrument is active,opens the "SGMA-GUI > Setup >
Instruments > Configure Instruments > Edit Instrument" dialog of the corresponding
instrument on the remote controller.

Pressing the ID key of an inactive instrument and starting "SGMA-GUI > Setup >
Instruments > Scan", leads to an automatic activation of the instrument in the SGMA-
GUI.



R&S®SGS100A Instrument Tour

3.2 Rear Panel Tour

This section provides an overview of the connectors on the rear panel of the instru-
ment. For technical data of the connectors refer to the data sheet.

e~ [

0020V - RF 500
= 111 0=
A L1

Fig. 3-2: Rear panel view

Protection of mechanical components

To avoid damage of the SMA connectors it is essential to limit the tightening torque to
60 Ncm. Use an adequate 8 mm torque wrench and not an ordinary open-end wrench.

PCI EXPRESS CONNECTOR

The PCle (Peripheral Component Interconnect Express) single lane interface allows
remote control with optimized speed.

For details see chapter 2.3.3, "Connecting a Controller via PCIl Express", on page 24.

USB CONNECTOR

—

The USB (universal serial bus) interface, Type Micro, allows you to connect various

external devices, e.g.:

e |f the interface is configured as a device interface, a remote computer can be con-
nected for firmware update, manual operation via the R&S SGMA-GUI software or
for remote control of the instrument.

® |f the interface is configured as a host interface, a memory stick for file transmis-
sion can be connected.

For details see chapter 2.3.4, "Connecting a Controller or an USB Device via USB",
on page 24.

User Manual 1173.9105.02 — 10 28
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LAN CONNECTOR

The LAN (Ethernet) interface allows you to connect the R&S SGS to other devices,
e.g. a remote computer, for firmware update, manual operation via the R&S SGMA-
GUI software or for remote control of the instrument. The connection to the remote

computer can be direct or via a network.

For details see chapter 2.3.2, "Connecting a Remote PC via LAN", on page 22.

RF OUT
RF 50Q

9

D &>

Provides an RF 50 Ohm signal output.

NOTICE! Maximum Input Levels. Do not overload the RF output. The maximum per-
missible back-feed is specified in the data sheet.

I,Q
CEC)

Inputs of the 1/Q modulator, provided for feeding of external signal.

NOTICE! Maximum Input Levels. Do not overload the | and Q inputs. The maximum
permissible voltage is 1V. For details, refer to the data sheet.

Note: The I/Q modulator requires one of the hardware options R&S SGS-B106V/-
B112V.

Connectors for reference or local oscillator signals, and alternatively also in MIMO set-
ups.

Reference input and output:

® REF IN: Input for external reference signal.

® REF OUT: Output of internal reference signal.

Local oscillator input and output:
® O IN: Input for external LO signals

HE
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® | O OUT: Output of internal LO signals.

Note: The Local Oscillator input/output requires the additional software option
R&S SGS-K90.

Multi purpose connector. The TRIG connector is used mainly as an input connector for
an external pulse modulator source.

AC SUPPLY AND POWER SWITCH

The AC supply and power switch allow you to connect the R&S SGS to the power sup-
ply and switch on the instrument.

For details see "To connect the AC supply" on page 18.

HE
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Configuring a CW Signal with the R&S SGMA-GUI

4 First steps with the Instrument

4.1

This section provides examples on how to configure the R&S SGS to generate a con-
tinuous wave (CW) signal via the R&S SGMA-GUI and the R&S SGS100A Web-GUI.

Configuring a CW Signal with the R&S SGMA-GUI

The R&S SGS in this example is a base unit equipped with the frequency option
R&S SGS-B106.

As a prerequisite for this example, the R&S SGS has to be connected to a remote PC.
The R&S SGMA-GUI software has to be installed on this remote PC and the instru-
ment is added to the list of "Available Instruments".

— . RF QLT

LA
-

REF/LO OUT

o Ll B o
= a L
3 H o
= o
e REF IN I
o
= RF 1M
= -

Fig. 4-1: Example of the setup

For information on how to fulfill these requirements, refer to
® chapter 2.3.2.1, "Connecting the Instrument to the Network", on page 22
® chapter 2.3.1, "Installing the R&S SGMA-GUI Software on an External PC",
on page 21
® chapter 2.3.2.3, "Automatically adding instruments to the SGMA-GUI ", on page 23

1. Check the front panel of the R&S SGS.
The POWER ON/STANDBY and LAN key have to be green.

2. On the connected remote PC, start the R&S SGMA-GUI software application.

The main panel of the application opens. The panel provides a quick access to the
main settings of the configured and activated instruments. The display shows one
row per instrument with the instrument specific settings. The rows comprise the
instrument, the connection state, the used frequency and power level, the state of
the RF output and the modulator and the used reference frequency source.
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3.

4.

5.

6.

First steps with the Instrument
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In the R&S SGMA-GUI main panel, the green indicator in front of the instrument's
name confirms that there is a connection between the instrument and the remote
PC and that the instrument is recognized by the software.

In the R&S SGMA-GUI main panel, select the row corresponding to the instrument
to be configured and select "Instrument Name > Preset" to restore the predefined
instrument's settings.

5 SGMA-GUI =3 =R =

File Setup Help

CIEL s

(
{. [6] | ses-o0021 Freql 6.000 000 000 000
©f2 | scs100020 Freql 1.000 000 000 000

Operation Mode_
Frequency / Phase...
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oz - BE Mod PEP[-1I].I]I]]dBm Level | -10.00|dBm -

Ext
Ref
Off

Info.
GHz _'pEP[-1I].l]l]]dBm Level | .10_00|d3m ] E%E T

Reference Oscillator._
Level

1/Q Settings...

Pulse Modulation
Connector....

Extension...
Setup 3
Diagnostic / Test >

Service 4

In the R&S SGMA-GUI main panel, select the row corresponding to the instrument
to be configured and adjust the "Frequency" as required.

0 SGMA-GUI (=R EER (==
File Setup Help

LS
[ @ Info

Ext
GHz ~ Ref
Off
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[. | ses-00021 Freq[ 6.000 000 000 000

_pEP[-w.nn]dBm Level | -10.00[d8m -

@@ | $6s100020 [Freq .00 000 000 000

GHz ~

Select "SGMA-GUI > RF On" to enable the output of the CW signal.

0 SGMA-GUI =lrE =S
File Setup Help

BEa=
[ @ Info

GHz ~ .10_00|dBm -

@ :I_g PEP[—‘IU.Uﬂ]dBm Level E%‘; q

GHz | @ “6?? PEP[-1|].|]|]]dBm Level ‘ -10.00|dBm .| E%‘;

[. | scs-o0021 Freq[ 6.000 000 000 000

©[E | s6s100020  Fiea| 5.000 000 000 000

The 5 GHz signal is output at the RF OUT connector at the rear panel of the
R&S SGS.
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Identifying a specific instrument

If several instruments are active in the R&S SGMA-GUI use one of the device identifi-
cation functions to identify a specific device:

® Select "SGMA-GUI > Instrument Name > Setup > Remote > Remote Channels >
Device Identify". The green LAN LED on the front panel of the instrument blinks.

® Press the ID key on the instrument's front panel. The "Edit Instrument" dialog of the
respective instrument opens.

4.2

Configuring a CW Signal with the R&S SGS100A Web-
GUI

The R&S SGS100A Web-GUI is an alternative way to operate the R&S SGS. There is
no installation needed. It can be used with all devices and operating systems, including
tablets and smart phones, which have one of the following web browsers installed:

® Mozilla Firefox

® Google Chrome

® Microsoft Internet Explorer 9 or later

In order to connect to the R&S SGS from an external device, both of them must have
access to the same network, i.e. use a shared network.

The feature set of the R&S SGS100A Web-GUI is limited to the most common settings,
needed especially for modifying the output signal. For additional actions like firmware
updates or adjustments, please use the R&S SGMA-GUI.

You can operate the R&S SGS100A Web-GUI and the R&S SGMA-GUI simultane-
ously. Furthermore you can enable the "Update" function (upper right corner ) to allow
an automatic update of the settings shown in the R&S SGS100A Web-GUI, if the set-
tings were changed via other software.

As a prerequisite for this example, the R&S SGS has to be connected to the same net-
work as the device used for controlling the instrument. Additionally one of the suppor-
ted web browsers has to be available.

1. Check the front panel of the R&S SGS.
The POWER ON /STAND BY and the LAN key have to be green.

2. Open a supported webbrowser.

3. Enter the instrument name or the IP address of the R&S SGS you want to connect

to.

Tip: The default hostname of the instrument is a non case sensitive string built as
follows:

hostname = rssgslOQa<serial number>, where

<serial number> is the individual serial number of the instrument.
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The serial number can be found ar the rear side of the instrument. It is the third
part of the device ID printed on the bar code sticker, see figure 4-2.

Serial Number
L i‘

The main panel of the R&S SGS100A Web-GUI opens.

Fig. 4-2: Serial number of the R&S SGS100A

System Status Bl

Device: rssgs100a100001 Update : ON O

(e}

Frequency | ’.OOOOOOOOOOOOHGI—:

| RF REF (é)lnternal (:)Extemal
Level | -’0.00HdBﬂ '| Modulation

PEP -10.00 dBm

Frequency / Phase

Reference Oscillator Frequency ‘ '-UOOOOOOOOOOOHG?‘Z v

Level

Q) Settings Local Oscillator (LO) Coupling
Connector Source ‘Iﬂt v

Preset REF/LO OQutput ‘OFF v

In the R&S SGS100A Web-GUI main panel, the green indicator "System Status >
OK " confirms that there is a connection between the instrument and the remote
PC and that the instrument is recognized by the software.

If you want to get additional information about the instrument click on the "Device
Name". For additional information on other settings, hold the mouse cursor over
the specific setting.

Error messages are also displayed in the R&S SGS100A Web-GUI. If you want to
hide an error message, click on it.

4. In the menu bar on the left side press "Preset" to restore the predefined instru-
ment's settings.

5. Select "Frequency" and adjust the setting as required.
6. Select "RF On" to enable the output of the CW signal.

A signal with the set frequency is output at the RF OUT connector at the rear panel
of the R&S SGS.

HE
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5 System Overview

The R&S SGS RF Source is a signal generator intended either for the generation of
IQ-modulated signals or as a pure local oscillator (LO) source in the frequency range of
1 MHz to 12.75 GHz.

Optimized for use in automated test equipment (ATE), the instrument offers very fast
settling times in an exceptionally small formfactor and low power consumption. The
R&S SGS can be equipped optionally with an active electronic step attenuator, a high
stability reference oscillator and LO connectors for coupling multiple generators to a
common LO source.

5.1 Setups for Instrument Control

The R&S SGS is an instrument designed for the automated test equipment (ATE)
needs. To maintain the small size, the instrument is not equipped with a display and
hence additional equipment is required to control the instrument.

This section provides an overview of the possible configuration setups for controlling
the R&S SGS.

5.1.1 Manual Operation from the R&S SGMA-GUI

The following example represents a basic configuration of the R&S SGS, operated
manually by the configuration software R&S SGMA-GUI. The configuration software is
installed on a remote PC and controls several instruments. The instruments are con-
nected to the remote PC over different remote control interfaces. Any combination of
the used interfaces is possible.

© R&S
SGMA-GUI USB/PCle / LAN(e.g. VXI-11) >

Fig. 5-1: Configuration example: manual control from R&S SGMA-GUI

® chapter 6, "Understanding the R&S SGMA-GUI Software", on page 44
® chapter 7, "Signal Generator Settings", on page 65

@ For information about the manual control, refer to:

® chapter 8, "General Instrument Settings and Instrument Setup”, on page 91




5.1.2

Setups for Instrument Control

Remote Control from a Controller

The remote control provides access to the instrument's settings from a remote com-
puter (external controller) by means of remote commands. To automate often repeat-
ing settings and settings sequences, these are grouped in the remote control pro-
grams, i.e. application programs.

An instrument may be connected to the controller via any of the supported interfaces
LAN, USB or PCle.

Application
Program USB /PCle / LAN(e.g. VXI-11)

Controller

Fig. 5-2: Configuration example: remote control from a controller

For information about remote control, refer to:
® chapter 10, "Network and Remote Control Operation”, on page 124
® chapter 14.1, "Remote Control Basics", on page 231

513

Control of an R&S SGS from an R&S Signal Generator

The R&S SGS can be used as an additional signal source to increase the number of
available RF outputs of a R&S Signal Generator. In this setup a controller does not
need to access the R&S SGS directly. Instead, the signal generator acts as a controller
to the R&S SGS and depending on the required output signal parameters performs all
required settings automatically.

The figure 5-3 shows a configuration example of the R&S SGS, directly controlled by a
R&S SMW.

Control

(Rear Panel) N ;LAN

rl ouT 1 Stream C—b&@ e —
[ e —— —
N

QouT1
— S tream C—’C ===
Ql

* REF OUT
| )MHz Reference

RF A|RF B

DUT

i 0 T
—p Tx2

Tx3 o|-

Fig. 5-3: Configuration example: Control from a R&S SMW



Setups for Connecting an R&S SGS and an R&S SGU

5.2 Setups for Connecting an R&S SGS and an R&S SGU

If an R&S SGU is connected to an R&S SGS the R&S SGU acts as an extension to the
R&S SGS extending its frequency range. In this setup a controller does not need to
access the R&S SGU directly. Instead, the R&S SGS acts as a controller to the R&S
SGU. The generator performs all required settings automatically depending on the
required output signal parameters.

This chapter gives an overview of how to connect the instruments.

5.2.1 Direct Connection

The R&S SGS and the R&S SGU can be connected through a direct connection as
shown in figure 5-4.

Direct connection of an R&S SGS and an R&S SGU

R&S SGS R&S SGU

m— LAN LAN e . __
e —— I ===
(1 — —DC E-u gy S=====

R&S SGU
USB UsSB B ), e el
> e =—=—=——2

Fig. 5-4: Direct connection of an R&S SGS and an R&S SGU

1. Connect the R&S SGS and the R&S SGU directly using one of the following

options:

a) USB cable. Use a Type Micro-A connector for R&S SGS and a Type Micro-B
connector for R&S SGU. See also chapter 2.3.4, "Connecting a Controller or
an USB Device via USB", on page 24.

b) LAN cable. No additional cable considerations are required.

c) PCle cable. Refer to chapter 10.3.3, "Connecting the Controller and the Instru-
ment", on page 137 for cable requirements and setup information.

2. Switch on the R&S SGS and the R&S SGU.

The R&S SGS automatically identifies the connected R&S SGU as its extension
and starts the extension mode.
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sion is only available for an R&S SGS with a "Controller > Revision" 5 or higher. For a
description on how to manually set the PCle indentification, see chapter 9.14, "How to
Manually Set a PCle Direct Connection between an R&S SGS and an R&S SGU",

on page 123.

You can check the "Controller > Revision" of your instrument in the "SGMA-GUI >
Instrument Name > Hardware Config" dialog.

6 For a direct PCle connection, an automatic identification of the R&S SGU as an exten-

@ If instrument is not automatically added as an extension

If the R&S SGU is not automatically added as an extension you can do that manually
in the "SGMA-GUI > R&S SGS Name > Extension" dialog.

If the R&S SGU is not listed in the list of "Available Instruments" you can press "Scan >
Start" to find the instrument.

———————— Available Instruments

SGU-100014 Socket

Scan Start

——————— Test Signal Connections ————————————,

Test

5.2.2 Connection in a Company Network

Connection of an R&S SGS and an R&S SGU in a Company Network

As a prerequisite for this example the R&S SGMA-GUI software has to be installed on
a remote PC.
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Company
Network

R&S SGU
LAN

®
R&S SGMA-GUI

Fig. 5-5: Connection of an R&S SGS and an R&S SGU in a company network

R&S SGS

e & oo o o

1. Connect the test equipment as shown in figure 5-5:

a) Connect the R&S SGS, the R&S SGU and the controller to the company net-
work.
b) Connect the RF OUT of the R&S SGS to the LO IN of the R&S SGU.

2. Switch on the R&S SGS and the R&S SGU.
The POWER ON/STANDBY keys have to be green and not blinking.

3. Press the ID keys on the front panels of the R&S SGS and the R&S SGU.

4. On the connected remote PC, start the R&S SGMA-GUI software application.

The main panel of the application and the configure instruments dialog open. Both
instruments are added automatically to the instruments list and to the main panel of
the R&S SGMA-GUI software.

5 SGMA-GUT
File Setup Help

|2 = m=
|
{. | SGS400004  Frea| 1.000 000 000 000

® 0] | SGU-100014 IFrqu 1.000 000 000 000

" Configure Instruments o = =

GHz ~

GHz ~

[ o
E,F %?f PEPdBm Level -1l].l]l] E’% j
E’F 'g?? PEF'-dEhn Level -1I].l]l] ]

_scan | _tow | oolte | _coar || eat. || epor

Scan LAN instruments with host name prefix :]

Note: If you connect the instruments to the company network for the first time this
process may take several minutes.
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In the R&S SGMA-GUI main panel, the green indicator in front of the instrument's
name confirms that there is a connection between the instrument and the remote
PC and that the instrument is recognized by the software.

Select "SGMA-GUI main panel > R&S SGS > Extension".

The "Extension" dialog opens.

~——— Available Instruments

SGU-100014 Socket OFF

Scan Start

Tip: Instrument doesn't appear in the extension dialog. If the R&S SGU is not auto-
matically shown in this dialog press "Scan > Start" to find the instrument.

Select the R&S SGU from the list and set "Available Instruments > Select > On" to
enable it as an extension.

A green status indicator "Connected" indicates the successfully established remote
connection between the R&S SGS ant the R&S SGU.

The R&S SGMA-GUI indicates the extended frequency range of the R&S SGS and
the activated extension mode.

[0 | SGS400004 | Freq 1.000 000 000 000

O [ | SGU-100014 l
8G 4 i

——— Available Instruments
SGU-100014 Socket

Scan
h Test Signal Connections

Extension to SGS-100004

(6 tnto,
GHz ]O‘E %?fpﬂ’mdﬂ'“ L""“'m E% TJ

8. Select "Test Signal Connections > Test" to trigger a check of all required signal

connections.
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X 1

Connected .

~—— Awvailable Instruments

ESGLMOHH Socket ﬁ
Scan Start

~——— Test Signal Connections ————————

Test

The diagram displays the connection state of the tested signal connections. If the
test connections are correct (shown by an uninterrupted blue line), you can start
using the R&S SGS and the R&S SGU in extension mode.

Tip: If your connection is marked as faulty- a red line is crossing the blue connec-
tion line - check whether the cables are connected properly. Check also if the con-
nection cables are functioning properly.

SGU
Loin
RF
SGS

Fig. 5-6: A faulty connection between an R&S SGU and an R&S SGS

5.2.3 Connection with a PCle Switch

The R&S SGS and the R&S SGU can be connected through a PCle switch as shown
in figure 5-7. This setup is recommended for achieving the highest setting/ measuring
speeds.
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PCle switch connection of an R&S SGS and an R&S SGU

Application Program R&S SGU LOIN

®
R&S SGMA-GUI
SGMA-GU o] PCle
-

R&S SGS RF QUT

=

rowm

Switch

— —————
S — —————
e e — ———
— ———— —

Fig. 5-7: Connection of an R&S SGS and an R&S SGU through a PCle switch

1. Connect the PCle switch to a switched off computer with a single lane PCle cable.
2. Connect the R&S SGS and the R&S SGU to the PCle switch.

3. Switch on the R&S SGS and the R&S SGU.

The POWER ON/STANDBY keys of both instruments have to be green and not
blinking.

4. Switch on the computer.

5. On the computer start one of the following:

a) the R&S SGMA-GUI
b) an application program for remote control of the instruments

6. Manually (or remotely ) activate the R&S SGU as an extension to the R&S SGS.

The logical connection between an R&S SGS and an R&S SGU is established by the

6 driver layer of a program (e.g. the R&S SGMA-GUI) or the library PCleController.dll
(Linux: libpciecontroller.so) of a remote control program on the PC. Such a program
has to be running on the PC so that an R&S SGS is able to communicate with an R&S
SGU.

5.3 Introduction to the Instrument Functions

This section is intended to give a brief introduction to the instrument's function. The
description of the related user interface parameters is provided in the corresponding
section in chapter 7, "Signal Generator Settings", on page 65.

For detailed information on how to work with the instrument and to perform basic and
advanced operating and configuration tasks, refer to chapter 9, "Performing Configura-
tion Tasks", on page 109.

The figure 5-8 provides a simplified block diagram of the instrument.
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For better understanding of the instrument functions and the signal flow, the block dia-
gram shows the main blocks of the instrument together with the corresponding GUI

parameters.
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Fig. 5-8: Simplified Block Diagram
TCXO = Built-in reference oscillator
OCXO = Oven-controlled oscillator, requires hardware option
R&S SGS-B1
Synth. = Synthesizer
1/Q Mod = 1/Q Modulator
REF/LO IN, REF/LO OUT, |, Q, RF OUT = Connector at the rear panel

"Ref. Osc. Source", "REF/LO Out", "LO Coupling = R&S SGMA-GUI equivalent parameter
Source", "Mod On/Off", RF On/Off", "Operation
Mode"

The instrument can generate an CW or an 1/Q modulated signal ("Mod On/Off"). The
frequency and level settings are adjustable ("Level", "RF on/Off", "Frequency"). The
instrument can use its internal reference frequency or a fed-in external one (REF/LO
IN, "Ref. Osc. Source"). The reference frequency can also be output for synchronisa-
tion purposes (REF/LO OUT, "REF/LO Out"). The local oscillator (LO) signal can be
distributed in such a way, that two or more instruments are connected to generate
phase coherent signals ("LO Coupling Source", REF/LO OUT, "REF/LO Out").
Whereat both possibilities, the input of the reference frequency and the input of a LO
signal, exclude each other because they use the same connectors. The same applies
for the output of the reference frequency and the LO signal. The instrument can also
be configured to work in the special baseband bypass mode ("Operation Mode").

Refer to chapter 9, "Performing Configuration Tasks", on page 109 for an overview of
the general operating tasks. The chapter 9.1, "How to Generate an I/Q Modulated Sig-
nal", on page 109 explains the basic operating concept by means of an example.
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6 Understanding the R&S SGMA-GUI Soft-
ware

This section gives a detailed description of the R&S SGMA-GUI user interface and
information on how to work with it. The main panel with the overview of the configured
instruments is the operating and control interface for the whole program. From here, all
program functions are accessible. This panel is displayed after the start of R&S SGMA-
GUI. The program always loads the previously used settings so you can continue your
work in the next session.
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6.1 Operating Menu and Toolbar

On the top of the main panel, there are the menu bar, the tool bar and the info bar with
the corresponding "Info" button. Some of the functions are accessible via the toolbar
with its icons below the menu selection line.

The dialogs are built using elements, e.g., selection lists, check boxes, and entry fields.
A blue frame indicates that the selected item is active. In a highlighted element, entries

can be made.
Table 6-1: Content of the operating menu

File Setup Help

a New Instruments About

= Open Software Contents
Save Reset SGMA-GUI Index
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File Setup Help

E save as

Exit

Shut down instruments and exit

6.1.1 File Menu

The R&S SGMA-GUI employs the standard Save/Recall file management function and
allows you to store and reload settings in/to a file with a user-defined name and loca-
tion (see also chapter 6.4.1, "Storing and Loading Settings", on page 57).

In the following, the "File" menu of the R&S SGMA-GUI is described in detail. It incor-
porates standard functions.

New
Resets R&S SGMA-GUI and all connected instruments to their preset settings.

Open

Opens the standard file open browser for loading a saved R&S SGMA-GUI file
(*.savrcl). The file contains the user specific settings of a session, such as instru-
ments configured in the software, etc. The complete settings of a session can be saved
and loaded.

Only files of this type are selectable.

Note: Instrument specific settings, e.g. frequency and level settings, are stored locally
on the particular instrument itself. These instruments settings are saved automatically
in a predefined directory and loaded by default when starting the instrument again.
The files with instrument settings are not accessible.

Save
Standard quick save of the settings of the current session if a file name previously has
been applied. If not, the "Save As" dialog is opened.

Save as

Opens the standard file save browser for saving the settings of the current session.
R&S SGMA-GUI files have the file extension . savrcl so the name typed in is equip-
ped with this extension. The complete settings of a session are saved.

Exit
Quits the R&S SGMA-GUI. The current settings of the instrument's session are saved
and loaded by default when starting the software again.

Note: The instruments configured in the R&S SGMA-GUI are not shut down.

Shut down instruments and exit

Quits the R&S SGMA-GUI and switches the connected instruments to the standby
state (see alsochapter 9.9, "How to Switch Between the Operating States”,

on page 118).
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6.1.2 Setup Menu

6.1.2.1

The setup menu provides access to dialogs for setting the general settings of the soft-
ware, like dialogs for managing the connected instruments or dialogs providing infor-
mation about the installed options.

File | Setup Help
| =

Software...

Reset SGMA-GUI

C [
0@ s

Configure Instruments

This dialog is the central point for managing the instrument that will be configured and
operated via the R&S SGMA-GUI. New instruments can be created and appended to
the list of available instruments, connection settings can be edited, instruments can be
removed from the list or they can be deactivated, but kept in the list for further use.

Available Instruments

(o) L | Lo ] o ] | et

Scan LAN instruments with host name prefix l l

@

Refer to chapter 6.4.2, "Handling Instruments in the R&S SGMA-GUI", on page 58
for information on how to configure and manage instruments in R&S SGMA-GUI.
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Available Instruments

This section comprises a list of configured instruments. Each instrument is represented
by a "Symbolic Name" which is also displayed in the main panel and an "Instrument
Type". It is also displayed whether the instrument is activated in the R&S SGMA-GUI
and hence displayed in the main panel or not.

Remote command:

:INSTruments:COUNt? on page 221

: INSTruments : NAME on page 222

: INSTruments:TYPE on page 224
:INSTruments:ACTive[:STATe] on page 221

Scan

Triggers a scan function and searches for instruments connected to the remote com-
puter via all of the available interfaces. During the scan process a progress bar is dis-
played.

Tip: The first initialization of a newly connected instrument in a network and the instru-
ment's request to the DHCP server for an IP address may take some time. During this
time, the instrument does not respond to the query sent by the scan function. If the
instrument does not appear in the list of "Available Instruments", trigger the scan func-
tion again after some minutes.

Remote command:
: INSTruments: SCAN on page 223

New Instrument
Calls the Add/Edit Instruments dialog.

Delete Instrument
Removes the selected instrument from the list of Available Instruments.

Edit Instrument
Calls the Add/Edit Instruments dialog.

Clear Instrument
Removes all instruments from the list of Available Instruments.

Export

Opens the standard file save browser for saving the list of the available instruments in
a mapping file. The mapping files have the file extension .map so the file name typed
in is automatically equipped with this extension.

A mapping file provides a cross-reference between the instruments' symbolic names
and their respective remote control parameters. The information in the mapping file is
grouped in rows, where one row corresponds to one configured instrument. The rows
have the following structure:

<InstrumentType> <SymbolicName> <IP Address/Hostname>
<RemoteChannel> <SerialNumber>



Operating Menu and Toolbar

File Edit Format View Help

SGMA-GUI Instrument mapping -
version 1

5G5S 5G5S rsgs100al100002 LAN 100002

5GU 5GU rsgsl00al00008 LAN 100008

SGT SGT rsgs100al00006 LAN 100006

Fig. 6-1: Mapping file example

Tip: In a remote control application program, address the instruments by their symbolic
names and retrieve the remain required settings from the mapping file. This workflow is
especially useful for frequent exchange of instruments.

Remote command:
:INSTruments:MAPPing:FILE on page 222

Scan LAN instruments with host name prefix
Sets the prefix the searched host names begin with. Use this function to limit the
amount of the searched instruments and to speed up the scan process.

For example, set this field to "RsSGS, RsSGU, RsSGT", if you want to search for all
available instruments.

Tip: If you start a scan for an instrument with a set IP adress and it doesn't appear in
the list of available instruments it may be due to the prefixes written in this field. You
can perform another scan while leaving this field empty.

Remote command:
:INSTruments:SCAN:HNPRefix on page 223

6.1.2.2 Add/Edit Instruments

The dialog provides access to the main instrument's settings, such as "Symbolic
Name", "Instrument Type" and connection settings.
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Instrument Nr. 3
Symbolic Name 5GS-100021
Instrument Type lSGS -
Active on
Exclusive Access On
Device Identify ‘ . off
Remote Control -
Hardware Channel [PCIe ']
Serial Number [ 100 021
A
o mey || cace

Refer to chapter 6.4.2, "Handling Instruments in the R&S SGMA-GUI", on page 58
for information on how to configure and manage instruments in R&S SGMA-GUI.

Instrument Nr.
Automatically assigned number that indicates the instrument's index in the list of "Avail-
able Instruments".

Symbolic Name
Selects the alias name of the instrument.

Remote command:
: INSTruments:NAME on page 222

Instrument Type
Selects the instrument's family.

Remote command:
: INSTruments:TYPE on page 224

Active
Activates/deactivates the display of the instrument's settings in the main panel.

Note: Only instruments in an active state can be controlled from the R&S SGMA-GUI!

Remote command:
:INSTruments:ACTive[:STATe] on page 221
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Exclusive Access

Checks whether the instrument is locked by another user and if not locks the instru-

ment. When an instrument is locked it is reserved and can be operated manually or

remote exclusively from the remote PC on which the R&S SGMA-GUI is running or
from which the SCPI command is sent.

For interfaces using VISA, i.e. for LAN and USB, enabling the "Exclusive Access" trig-
gers the standard viLock request. For remote control over PCle or Socket the lock
request is performed on a higher application level.

Note: It is recommended to lock the instrument prior to further configuration.
Locked instruments will not be found by the scan function.

The instrument has to be unlocked to allow operation from another remote PC.

Note: The two functions "Exclusive Access" and monitoring are mutually exclusive!
Disable "Exclusive Access" if the instrument is monitored by an external PC.

Remote command:
:INSTruments:EACCess|[:STATe] on page 221
: LOCK? on page 158

:UNLock on page 158

Device ldentity
Triggers the device identification function. The LAN LED on the front panel of the
selected instrument blinks.

See also chapter 6.4.4, "Bidirectional Instrument Identification ", on page 61.

Hardware Channel
Selects the hardware interface used by the remote channel.

Remote command:
:INSTruments:REMote:CHANnel on page 222

Instrument Name / IP Address
Enters the IP Address or the host name of the connected instrument.

See also chapter 6.4.3, "Finding Out the Default Hostname of the Instrument”,
on page 61.

Remote command:
:INSTruments:REMote : NAME on page 223

Serial Number
Enters the serial number as instrument's identification while using the USB or PCle
interfaces for remote control.

Remote command:
:INSTruments:SERial on page 223

OK
Confirms the settings and closes the dialog.

Apply
Confirms the settings.
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Cancel
Discards settings and closes the dialog.

6.1.2.3 Software/Options Dialog

Querying information about the installed options and software version

» To access the dialog, select "Setup > Software".

An info dialog opens, showing program information.

Firmware

In the group box "Firmware", the following columns are displayed:
"Package" Installed software packages, e.g. SW platform.
"Version" Release of the software package.

6.1.2.4 Reset SGMA-GUI

Resets R&S SGMA-GUI to its factory preset settings.

@ The connected instruments are not affected by this preset!

To preset one specific instrument to its factory preset settings, select "SGMA-GUI >
Instrument Name > Setup > Factory Preset". Refer to chapter 8.10, "Factory Preset",
on page 105 for an overview of the settings affected by this function.

6.1.3 Help
The R&S SGMA-GUI is equipped with a context-sensitive help function. A help page
can be called any time during software operation.

The context-sensitive page which is opened with the F1 button is part of a comprehen-
sive help system.

It is possible to move from this context-sensitive page to any page of the help system.
An overview of the contents of the online help can be reached via the menu "SGMA-
GUI > Help > Contents".
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A search for keywords within the help function is available via menu item "SGMA-GUI
> Help > Index".

6.2 Info Dialog and Messages in the Info Bar

A few operating states and the current messages are displayed in the info line. For
information on messages in greater detail and their management, an "Info" dialog can
be opened.

6.2.1 Info Dialog

The "Info" dialog provides a list of currently active permanent messages and a detailed
description of each message. The messages are color-coded according to their level.
Accessing the Info Dialog

» In the "R&S SGMA-GUI main panel", select the "Info" button.

The "Info" dialog opens.

& scmacu eTErs)
File Setup Help
|8 ee=
_ | 110 |nfo line
Lev | scpi| Text |
90 Sav/Rcl Handler Info -Save completed LISt Of current
90 SaviRcl Handler Info -Save data to file C:/U AppD: lite 1
messages
with short
message text
1: Jan-27-2015/ 10:42:32-059ms, Error code 90005,
Sav/Rcl Handler Info -Save completed Detailed
SCPI: Device specific error description of
a highlighted
message
Q Delete Delete Show

The upper part of the "Info" dialog lists the currently active permanent messages. See
the following table for explanation of the displayed information.
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Parameter Description

"LEV" Message level. Messages referring to a logical component of R&S SGMA-GUI, e.g.,
Unicode, are marked in red color, info messages are marked in black color.
The following levels might occur:

®  Err: Error message

® Info: Information message
®  Sys: System message

®  Crit: Critical message

For detailed information on the message types, see chapter 6.2.2, "Understanding the
Messages in the Info Bar", on page 53.

"SCPI" Indicates the SCPI error code.

Text A list of all currently permanent messages in the order of their occurrence, i.e., the most
recent message is displayed first.

The buttons in the lower part of the "Info" dialog provide quick access to some func-
tions for managing these messages. For a detailed description on how to clear error
messages or display a history of all messages, refer to chapter 6.4.5, "Managing Mes-
sages in the Info Dialog", on page 64.

Function Description

"Delete" Clears the highlighted message. This button is available only if the history of the
messages is displayed.

"Delete All" Clears all messages.

This button is available only if the history of the messages is displayed.

"Del. volatile" Clears all brief messages. This button is available only if the history of the mes-
sages is displayed.

"Show History/Static" | Calls the list of all messages that have occurred since instrument switch-on. The
most recent messages are displayed at the top of the list. When the button is
pressed again, the list of current messages is displayed.

Refer to chapter 6.4.5, "Managing Messages in the Info Dialog", on page 64 for infor-
mation on how to manage messages.

6.2.2 Understanding the Messages in the Info Bar

Messages indicate information, warnings, and errors. They are displayed in the info
line in different colors depending on their importance and display duration. The follow-
ing messages are displayed:

® Error
There are two options:
— Critical errors are errors that prevent the instrument from working, e.g. a HW
failure. Critical errors are displayed in red color.
— System errors are errors that concern the operating system, e.g., wrong file
path. System errors are displayed in black color.

® |nformation
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The information, e.g., file not found, is displayed in black color.

® Warning
A warning indicates a less significant error and is displayed in black color.

® Brief message
Brief messages report automatic settings in the program, e.g. switching on illegal
entries that are not accepted by the program, e.g., range violations. They are dis-
played in the info line on a yellow background. They are displayed on top of status
information or permanent messages.
Brief messages usually do not demand user actions and disappear automatically
after a short period of time. They are stored in the history, however.

® Permanent messages
Permanent messages are displayed if an error occurs that impairs further program
operation. The error signaled by a permanent message must be eliminated before
correct software operation can be ensured.
The message is displayed until the error is eliminated. It covers the status display
in the info line. After error elimination, the message automatically disappears and is
also recorded in the history.

6.3 Main Panel

The main panel of the R&S SGMA-GUI provides quick access to the main settings of
the configured instruments. The display shows one row per instrument and comprises
the instrument name and state, the used frequency and power level, the states of the
RF output and modulator and the used reference source.

Click on one of the buttons with an instrument name on it to access the menu tree with
further settings for the corresponding instrument. For a detailed description of the pro-
vided settings, refer to chapter 7, "Signal Generator Settings”, on page 65.
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Instrument/Connection State
The three colors of the state indicator in front of the instrument's name distinguish
between the following states:
® grey: the instrument is configured and activated in the R&S SGMA-GUI but there is
no connection to the instrument.
® green: the instrument is active, the connection is working and the instrument can
be manually and remotely operated.
® red: the instrument is in one of the following states:
— Standby state
To operate the instrument manually, it has to be switched to ready state (see
"To return the instrument from standby to ready state" on page 119).
— Instrument locked
The red state indication together with the message "Instrument Locked" in the
"Info" line indicates that the instrument is locked for Exclusive Access from
another SGMA-GUI or controller.
— The instrument is performing a time consuming operation, e.g. a selftest.

Maximum Frequency
The numbers in the rectangular box on the left of the instrument's name indicate the
maximum frequency of the instrument.

When the Eco Mode is turned on then this rectangular is colored in green and the fre-
quency shown in the rectangular corresponds to the maximum frequency available in
this mode.

Pulse Modulation
A I1 sign on the left of the instrument's name indicates that the pulse modulation is
switched on.

Local Oscillator
A @ sign on the left of the instrument's name indicates that the internal Local Oscillator
is switched off.

Instrument Name
Displays the alias name of the instrument, as selected by the parameter "SGMA-GUI >
Setup > Instruments > Add/Edit Instruments > Symbolic Name".

A click on this button provides access to a menu tree for configuring the available
instrument's settings, e.g. "Level" settings.
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Frequency

Sets the RF frequency at the RF output connector of the selected instrument.

Remote command:
[ :SOURce] : FREQuency [ :CW|FIXed] on page 180

RF ON/OFF
Activates and deactivates the RF output signal.

The current state of the RF output (activated and deactivated) is indicated in the main
panel by means of the different block color (blue or grey) and the status "On/Off".

Remote command:
:OUTPut [ :STATe] on page 179

Mod State
Switches the I/Q modulation on and off.

Remote command:
[:SOURce] : IQ:STATe on page 189

PEP
Displays the Peak Envelope Power (PEP) of the RF signal of the selected instrument.
The value is calculated as follows:

"PEP" = Level + Crest Factor

Remote command:
[ :SOURce] : POWer : PEP? on page 195

Level
Sets the RF level at the RF output connector of the selected instrument.

If you set a level offset, it will be indicated in the R&S SGMA-GUI main panel by a
change in the name of this parameter from "Level" to "Level Offset".
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6.4.1
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Level

30.00/dem ~| Lev

30.10/dm ~|

Note: The SCPI command [ : SOURce] : POWer [ :LEVel] [ : IMMediate] [ :
AMPLitude] sets the level of the "Level" display, that means the level containing off-
set while [ : SOURce] : POWer : POWer sets the level at the RF output connector.

Remote command:
[:SOURce] : POWer [:LEVel] [:IMMediate] [ :AMPLitude] on page 194
[ :SOURce] : POlWer : POWer on page 193

REF/Ref. Oscillator Source

Determines whether the internal built-in oscillator (TXCO or OXCOQ) is used as a refer-
ence source or if an external reference is used. The internal reference oscillator OCXO
requires the additional option R&S SGS-B1.

To feed in an external instrument reference, use the input connector REF/LO IN. To
output the reference frequency at the output REF/LO OUT, select "SGMA-GUI >
Instrument Name > Ref. Oscillator > REF/LO Output > REF".

See also chapter 9.4, "How to Configure the Reference Oscillator Source”,
on page 114.

"Int" The internal reference signal of 10 MHz is used.

"Ext" An external reference signal is used. The frequency of the external
reference signal must be selected with the parameter "SGMA-GUI >
Instrument Name > Ref. Oscillator > Ex. Ref. Input Frequency".

Remote command:
[:SOURce] :ROSCillator:SOURce on page 202

Working with R&S SGMA-GUI

This section explains how to work with the R&S SGMA-GUI software and perform con-
figuration tasks for manual operation of the instruments.

Storing and Loading Settings

In order to proceed work with a particular configuration of the instruments in the R&S
SGMA-GUI, it is useful to save the used settings and load them again later.

How to store and load settings

1. Select "SGMA-GUI main panel > File > Save As".

2. Navigate to the desired directory and enter the file name.
The extension * . savrcl is applied automatically.

The current settings of the software are saved to the selected file.
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To load settings from a file, select "SGMA-GUI main panel > File > Open"

Navigate to the directory the file is stored in and select the setting file.

The saved settings are loaded to the R&S SGMA-GUI and the main panel of the
software displays the saved instrument's configuration.

6.4.2 Handling Instruments in the R&S SGMA-GUI

6.4.2.1

6.4.2.2

This section provides information on how to configure and manage instruments in the
R&S SGMA-GUIL.

For reference information about all provided settings in the user interface, refer to the
corresponding sections:

chapter 6.1.2.1, "Configure Instruments", on page 46 and chapter 6.1.2.2, "Add/
Edit Instruments”, on page 48

chapter 6.1.2.3, "Software/Options Dialog", on page 51
chapter 6.1.2.4, "Reset SGMA-GUI", on page 51

How to Automatically Add New Instruments to the SGMA-GUI

For each new instrument perform the following steps:

a) Connect the instrument to the network.
b) Switch the instrument on.
c) Press the ID key on the front panel of the instrument.

Start the SGMA-GUI on a computer connected to the same network.

All instruments will be added automatically to the main panel of the SGMA-GUI.

How to Manually Add New Instruments to the SGMA-GUI

In the R&S SGMA-GUI main panel, select "Setup > Instruments”.

The Configure Instruments dialog opens.

Select the "New" button.

The Add Instrument dialog opens to register a new instrument.

In the "Symbolic Name" field, enter an alias name of your choice, e.g. SGS
\-100021.

In the "Instrument Type" field, select the device family to connect to.
Select "Remote Control > Hardware Channel" and select the hardware interface.

For LAN or Socket interfaces, select "Remote Control > Instrument Name / IP
Address" and enter the IP Address or the hostname of the connected instrument,
e.g. rssgs100a100021.
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6.4.2.4

6.4.2.5
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Tip: See also chapter 6.4.3, "Finding Out the Default Hostname of the Instrument”,
on page 61.

For USB or PCle interfaces, select "Remote Control > Serial Number" and enter
the serial number of the connected instrument , e.g. 100021.

Set "Active > On" to activate the instrument. Only active instruments are displayed
in the R&S SGMA-GUI main panel.

Click "OK" to confirm the settings and to close the dialog or press the "Apply" but-
ton to confirm the settings.

10. Click the "Cancel" button to discard settings and to close the dialog.

How to Scan for New Instruments

In the R&S SGMA-GUI main panel, select "Setup > Instruments".

The Configure Instruments dialog opens.

Click the "Scan" button to trigger the instrument to scan all remote channel interfa-
ces for connected instruments.

Tip: To limit the amount of the searched instruments and to speed up the scan
process, select "Configure Instruments > Scan LAN instruments with hostname
prefix" and enter the prefix the searched hostnames begin with.

The scan function searches only for instruments whose hostnames begin with the
selected prefix.

All instruments which are connected to one of the available interfaces, are
switched on and are not locked are displayed in the"Available Instruments" list.
The R&S SGMA-GUI obtains all information for connecting to the instrument, so
further configuration is not necessary.

How to Activate Instruments for Control from the R&S SGMA-GUI

In the R&S SGMA-GUI main panel, select "Setup > Instruments”.

The "Available Instruments” in the Configure Instruments dialog lists all instruments
configured in the software.

Select the newly configured/connected or deactivated instrument and set "Active >
On" to activate it.

Tip: Only active instruments are displayed in the R&S SGMA-GUI main panel!

How to Edit Instruments

In the R&S SGMA-GUI main panel, select "Setup > Instruments”.

The Configure Instruments dialog opens and lists the "Available Instruments".
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2. Select the instrument to be edited and click the "Edit" button.

The Edit Instrument dialog opens.
3. Change the settings and confirm with OK.
The edited settings are applied.

6.4.2.6 How to Delete an Instrument

1. In the R&S SGMA-GUI main panel, select "Setup > Instruments".
The Configure Instruments dialog opens.

2. Select the instrument to be deleted and click the "Delete" button.

The selected instrument is deleted from the list of "Available Instruments".

6.4.2.7 How to Delete all Instruments

1. In the R&S SGMA-GUI main panel, select "Setup > Instruments".
The Configure Instruments dialog opens.

2. Click the "Clear" button.

All instruments are deleted from the list of "Available Instruments".

6.4.2.8 How to Reserve the Instrument for Control

1. Open the "SGMA-GUI > Setup > Instruments > Configure Instruments" dialog,
select the instrument in the list of "Available Instruments" and select "Edit".

2. In the "Edit Instrument" dialog, enable "Exclusive Access".

3. Alternatively, send the SCPI command : INSTruments:EACCess[:STATe] from
the external PC the R&S SGMA-GUI is installed on.

The instrument is reserved for control from this external PC and cannot be
accessed from any other controller. A scan function started from another controller
will find the instrument but the instrument is indicated as locked.

@ The two functions "Exclusive Access" and monitoring are mutually exclusive!

The "Exclusive Access" must be disabled to remote control or monitor the instrument
form another external PC (see chapter 10.5, "Using the R&S SGMA-GUI to Monitor the
Remote Control Operation", on page 141).
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6.4.3 Finding Out the Default Hostname of the Instrument

The default hostname of the instrument is a non case sensitive string built as follows:
hostname = <instrument name><serial number>, where
<serial number> is the individual serial number of the instrument

<instrument name> is the complete name of the instrument, written without spaces.

How to query the hosthame of the instrument
1. Find the individual serial number on rear of the instrument , e.g. 100021.
2. Build the default hostname.

For the R&S SGS with serial number 100021, the default hostname is
rssgsl00al00021.

For instructions on how to change the default hostname, refer to chapter 9.10, "How to
Use Computer Names", on page 120.

6.4.4 Bidirectional Instrument Identification

In practice, instruments are integrated into a large network or placed in racks together
with several other instruments of the same kind. It might be difficult then to find out
which of the instruments configured in the R&S SGMA-GUI corresponds to which
physical instrument or to localize all instruments operated by the current controller.

The R&S SGMA-GUI and the instrument provide the "Device Identification" function for
this purpose.
How to find an instrument in the R&S SGMA-GUI

» If several instruments have been configured and activated in the R&S SGMA-GUI,
press the ID button on the instrument's front panel to trigger device identification.

The "Edit Instrument" dialog of this instrument opens.
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Instrument Nr. 3
[smm: Name 5GS-100021
Instrument Type lSGS -]
Active on
Exclusive Access On
e BN
Remote Control
Hardware Channel [PCIe v]
Serial Number [ 100 021]
o | || con

Field "Edit Instrument > Symbolic Name" displays the name of the instrument as
shown in the R&S SGMA-GUI main panel.
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Dialog "Edit Instrument” does not appear

If this dialog does not open, perform the following:

® Check whether the instrument is correctly connected to the external PC on which
you work with the R&S SGMA-GUI.

® Check if the instrument is configured in the R&S SGMA-GUI and perform, if neces-
sary, the steps described in chapter 6.4.2, "Handling Instruments in the R&S
SGMA-GUI", on page 58.

® Select "SGMA-GUI > Setup > Instruments"”, check the state of the instrument in the
"Configure Instruments > Available Instruments" table and activate it, if disabled.

File | Setup Help

= N

Software... —

Reset SGMA-GUl =————

C
0@ [ s

Available Instruments

-

|_soam | Wow. || volto || Clar | Egt.  Ewort.

Scan LAN instruments with host name prefix [ l

How to identify an instrument in an instrument set

» To identify the instrument in an instrument set, use one of the device identification
functions:

a) select "SGMA-GUI > Setup > Instruments > Available Instruments > Instrument
> Edit > Edit Instrument" and trigger "Device Identify"

b) select "SGMA-GUI > Instrument Name > Setup > Remote > Remote Channels"
and trigger "Device Identify"

The green LAN LED on the front panel of the instrument blinks.
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6.4.5 Managing Messages in the Info Dialog

How to get additional information on the message
» In the "Info" dialog, click a message to select it.

In the lower section of the dialog, additional information on the highlighted mes-
sage is displayed.

How to display all messages
» In the "Info" dialog, click the "History" button.

A history of all messages that have occurred since the R&S SGMA-GUI software
was started is listed in the upper dialog pane. The most recent message is dis-
played first.

How to delete an error message

» In the "Info" dialog, select the highlighted message and click the "Delete" button.

Tip: This button is available only when the history of the messages is displayed.

The highlighted message is cleared.

How to delete all error messages

» In the "Info" dialog, click the "Delete All" button.

Tip: This button is available only when the history of the messages is displayed.

All messages are cleared.

How to delete all brief messages

» In the "Info" dialog, click the "Del. volatile" button.

Tip: This button is available only when the history of the messages is displayed.

All brief messages are cleared.

How to call the history
1. In the "Info" dialog, click the "History" button.

A list of all messages that have occurred since the instrument switch-on is dis-
played. The most recent messages are displayed at the top of the list.

2. Click the "History" button once more.
A list of current messages is displayed.
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7 Signal Generator Settings

This section summarizes the settings necessary to configure the instrument for signal
generation. The description in this section follows the menu tree structure of the graph-
ical user interface. Each of the discussed topis follows a common structure, providing
basic background information, and reference to the user interface.

For step-by-step instructions for fulfilling typical tasks, refer to chapter 9, "Performing
Configuration Tasks", on page 109.

7.1 Operation Mode

You can operate the R&S SGS in two modes, normal mode and baseband bypass
mode. In baseband bypass mode, an external IF signal fed in at the | or Q connectors
is directly routed to the RF OUT connector. The level of the signal can be adjusted.

Refer to figure 5-8 for visualization of the signal flow.

» To access the "Operation Mode" dialog, select "SGMA-GUI > Instrument Name >
Operation Mode".

Operation Mode
Sets the operation mode.

"Normal" The complete signal processing chain is used.

"Baseband Bypass"
The IF signal fed in at the | or Q connectors is directly routed to the
RF OUT connector.

Note: The "Baseband Bypass" is a special operation mode. See also
chapter 9.3, "How to Enable a Baseband Bypass Mode",
on page 113.

Remote command:
[ :SOURce] : OPMode on page 180

7.2 Frequency/Phase Settings

Depending on the installed options, the instrument provides an adjustable output fre-
quency in the frequency range of 1 MHz to 6 GHz or to 12.75 GHz.
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> To access this dialog, select "SGMA-GUI > Instrument Name > Frequency/Phase".

Fremenq l 1.000 000 000 000| GHz -

Delta Phase l 0.0|deqg Y]

I Reset Delta Phase Display I

Local Oscillator (LO) Coupling

Source

:

REF/LO Qutput [REF ']

The frequency and phase related settings are provided in this dialog.

Configuring the RF Frequency

» To change the RF frequency of the selected instrument, perform one of the follow-
ing:
a) Select "SGMA-GUI main panel > Freq" and enter the desired frequency.
b) Select "SGMA-GUI > Instrument Name > Frequency/Phase > Frequency" and
enter the desired frequency.

Changes of the RF frequency have an immediate effect on the output signal.

Frequency
Sets the RF frequency at the RF output connector of the selected instrument.

Remote command:
[ :SOURce] : FREQuency [ :CWW|FIXed] on page 180

Delta Phase

Sets the phase of the RF signal. The current phase of the signal is used as the refer-
ence. This function allows, for example, the phase of the output signal to be synchron-
ized with the phase of a signal from a second signal generator.

Remote command:
[ :SOURce] : PHASe on page 191

Reset Delta Phase Display
Resets delta phase value. The set phase is adopted as the new current phase, i.e. the
delta phase value is reset to 0.

Remote command:
[:SOURce] : PHASe :REFerence on page 191
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7.3 Local Oscillator (LO) Coupling

The LO Coupling function allows you to distribute the local oscillator signal in a way
that multiple R&S SGSs or other R&S Signal Generators can be driven by the same
LO signal. This is mandatory for phase coherent application, e.g. the generation of
beamformed signals, and for phase coherent demodulation.

The LO Coupling function is available only for instruments equipped with the option

@ R&S SGS-K90 (Phase Coherence). This option enables phase coherent RF outputs of
two or more RF signals. The local oscillator signal is provided at the REF/LO OUT con-
nector. An external signal can be input at the REF/LO IN connector.

Refer to figure 5-8 for visualization of the signal flow.

See also:

® chapter 9.5, "How to Configure the Local Oscillator (LO) Coupling Source",
on page 115

® chapter 9.6, "How to Define the Signal at the REF/LO OUT Connector",
on page 116

® chapter 9.7, "How to Connect and Configure Instruments for Optimum Phase
Coherence", on page 116

7.3.1 Phase Coherence
Phase coherence of RF signals designates a defined, constant delta phase between
two or more RF carrier signals with the same frequency or a multiple of the frequency.

(|
I
|

/\ RF 1

|

I "t
Lo

o

o RF 2

‘\d)l mt
el

If two signal generators are coupled via their 10 MHz reference, they are generating
exactly the same frequency but only in the long term perspective. Having a closer look
into the instantaneous differential phase (“delta phase”) of these two RF signals, this is
quite unstable due to:

® phase noise of the two synthesizers

® “weak” coupling at 10 MHz and a long synthesis chain up to the RF domain

® temperature differences which cause slightly different phase drifts for the different
synthesizers

Most critical for a stable delta phase is the thermal RF phase fluctuation between multi-
ple RF synthesizers. These fluctuations can be minimized by using a common synthe-
sizer (common local oscillator (LO) signal) for all RF carriers.
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See also chapter 9.7, "How to Connect and Configure Instruments for Optimum Phase
Coherence", on page 116.

7.3.2 Local Oscillator (LO) Coupling Settings
The LO Coupling related settings are provided in the "Frequency/Phase" dialog.

» To access this dialog, select "SGMA-GUI > Instrument Name > Frequency/Phase >
Local Oscillator (LO) Coupling".

I Reset Delta Phase Display l

Local Oscillator (LO) Coupling

Source

']

REFILO Output [REF ']

Source
Selects the source of the local oscillator signal.

"Int" The instrument uses the built-in local oscillator.
"Ext" The signal fed-in at the REF/LO IN input connector is used as signal
source.

When you select "Source > Ext" the icon@ appears in the
R&S SGMA-GUI next to the instrument's name.

012
Note: The Local Oscillator input/output requires the additional soft-
ware option R&S SGS-K90.

Remote command:
[:SOURce] :LOSCillator:SOURce on page 180

SGS

REF/LO Output
Determines the signal provided at the output connector REF/LO OUT.

See also chapter 9.6, "How to Define the Signal at the REF/LO OUT Connector",

on page 116.
"OFF" No signal is provided.
"LO" The signal of the local oscillator (LO) is available at the REF/LO OUT

connector.
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Reference Oscillator

"REF" The signal of the reference oscillator is available at the REF/LO OUT
connector.

Remote command:
:CONNector:REFLo:0UTPut on page 162

Reference Oscillator

The R&S SGS is equipped with an internal TXCO reference oscillator. If equipped with
the additional HW option R&S SGS-B1, an OXCO can be used as an internal refer-
ence frequency source for the synthesizer. Moreover, an external reference signal
source can be connected to the REF/LO IN connector of the instrument.

Refer to figure 5-8 for visualization of the signal flow.

» To access this dialog, select "SGMA-GUI > Instrument Name > Reference Oscilla-
tor".

Output Frequency 10MHz - Ext. Ref. Input Frequency 10 MHz -~
REF/LO Output REF - Synchronisation Bandwidth Narrow =~

~—— Adjustment

Output Frequency
Active Adjustment Data ‘

REF/ILO Qutput REF =

10 MHz -~

Active (Jon

DAC Value 32767

LS o

REF/Ref. Oscillator Source

Determines whether the internal built-in oscillator (TXCO or OXCO) is used as a refer-
ence source or if an external reference is used. The internal reference oscillator OCXO
requires the additional option R&S SGS-B1.

To feed in an external instrument reference, use the input connector REF/LO IN. To
output the reference frequency at the output REF/LO OUT, select "SGMA-GUI >
Instrument Name > Ref. Oscillator > REF/LO Output > REF".

See also chapter 9.4, "How to Configure the Reference Oscillator Source",
on page 114.

"Int" The internal reference signal of 10 MHz is used.
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"Ext" An external reference signal is used. The frequency of the external
reference signal must be selected with the parameter "SGMA-GUI >
Instrument Name > Ref. Oscillator > Ex. Ref. Input Frequency".

Remote command:
[:SOURce] :ROSCillator:SOURce on page 202

Ext. Ref. Input Frequency
Available only for "Source > Ext".

Selects the frequency of the external reference signal. An external reference signal
with a frequency of 10 MHz, 100 MHz or 1000 MHz can be used (see alsotable 7-1).

Remote command:
[:SOURce] :ROSCillator:EXTernal : FREQuency on page 202

Synchronization Bandwidth
Available only for "Source > Ext".

Selects the synchronization bandwidth for an external reference signal. The wideband
setting is provided for using very good reference sources of high spectral purity.

"Wide" Synchronization bandwidth is app. 250 Hz.
"Narrow" Synchronization bandwidth is app. 40 Hz.

Remote command:
[:SOURce] :ROSCillator:EXTernal : SBANdwidth on page 203

Output Frequency
Selects the output for the reference oscillator signal. The available values depend on
the input frequency and the reference oscillator source.

Table 7-1: Output Frequency

Reference Oscillator Source Input frequency Output Frequency
"Internal” 10 MHz 10 MHz
1 GHz
"External” 10 MHz 10 MHz, 1 GHz
100 MHz 100 MHz, 1 GHz
1 GHz 1 GHz

Remote command:
[:SOURce] :ROSCillator:0UTPut:FREQuency on page 202

REF/LO Output
Determines the signal provided at the output connector REF/LO OUT.

See also chapter 9.6, "How to Define the Signal at the REF/LO OUT Connector",

on page 116.
"OFF" No signal is provided.
"LO" The signal of the local oscillator (LO) is available at the REF/LO OUT

connector.
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"REF" The signal of the reference oscillator is available at the REF/LO OUT
connector.

Remote command:
:CONNector:REFLo:0UTPut on page 162

Active Adjustment Data
Displays whether the factory or user defined (custom) calibration value is currently
used for the external calibration of the reference oscillator.

Adjusting the calibration value for the OCXO adjustments is a protected service proce-
dure, that requires a Protection Level 2 password.

Adjustment Active
Available only for "Source > Int".

Selects adjustment mode.

"OFF" The calibrated adjustment value of the internal reference frequency is
used. This value is determined at one of the R&S service centers dur-
ing calibration.

"ON" A user-defined adjustment value is used. The value is entered under
"Adjustment DAC Value".
This allows the frequency to be impaired freely, for example, to simu-
late a frequency error.
The instrument is no longer in the calibrated state. However, the cali-
bration value is not changed and the instrument resumes the calibra-
ted state after switching the "Adjustment State" to Off.

Remote command:
[:SOURce] :ROSCillator[:INTernal] :ADJust[:STATe] on page 203

DAC Value
Enters a user-defined adjustment value for the internal reference frequency. This value
is not used unless "Adjustment Active On" is selected.

Remote command:
[:SOURce] :ROSCillator[:INTernal] :ADJust:VALue on page 202

7.5 Level and Power-On Settings

This section explains the level settings of the R&S SGS. The instrument can be equip-
ped optionally with an active electronic step attenuator (R&S SGS-B26).
Configuring RF Level

» To change the RF level of the selects instrument, perform one of the following:

a) Select "SGMA-GUI main panel > Level" and enter the desired value.
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b) Select "SGMA-GUI > Instrument Name > Level > RF Level > Level" and enter
the desired value.

Changes of the RF level have an immediate effect on the output signal.
7.5.1 RF Level

» To access the RF level settings, select "SGMA-GUI > Instrument Name > Level >
RF Level".

ore

Setting Characteristic

T
Limit l 25.I}D|dBm ']
@ Readjust

Auto .]

This dialog comprises settings like the RF level and level limit.

Mode
Allows to optimize the RF output signal for applications, where improved harmonic dis-
tortion or improved wideband noise is required.

"Normal" In normal mode, the generator provides an RF output signal with high
signal to noise ratio as well as low distortion, according to the data
sheet.

"Low Noise" This setting forces the generator to optimize the signal to noise ratio.

"Low Distortion"
In this mode, the generator reduces distortions of the RF signal to a
minimum.

Remote command:
[ :SOURce] : POWer : LMODe on page 192

Offset
Sets a level offset.
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This value represents the level shift of a downstream instrument, as for example an
attenuator or an amplifier, and is indicated in the status bar of the display. It does not
change the level at the RF output.

Remote command:
[:SOURce] : POWer [:LEVel] [: IMMediate] : OFFSet on page 194

Setting Characteristic

Selects the characteristic for the level setting. For some general applications, the
instrument operation can be optimized by selecting one of the predefined level setting
characteristics.

"Auto" The instrument provides the highest dynamic range and the fastest
setting times according to the data sheet.
The RF signal is shortly blanked during the moment the step attenua-
tor is switched on.

"Uninterrupted Level setting"
Suppresses level blanking at frequency and level changes.
This mode reduces the dynamic range of the instrument. The step
attenuator is fixed.

"Strictly Monotone"
Provides level setting without discontinuities. All electronic switches in
the RF path are clamped. The operation mode is useful for applica-
tions using level searching algorithms.
This mode further reduces the dynamic range of the instrument. The
step attenuator is also fixed.

"Constant-VSWR"
Suppresses output impedance variations at the RF OUT connector
due to changed level setting.
This mode reduces the dynamic range of the instrument. The step
attenuator is fixed.

Remote command:
[ :SOURce] : POlWler : SCHaracteristic on page 193

Level
Sets the RF level at the RF output connector of the selected instrument.

If you set a level offset, it will be indicated in the R&S SGMA-GUI main panel by a
change in the name of this parameter from "Level" to "Level Offset".

Level

30.00/dm ~| Lev

30.10/c6m ~|

Note: The SCPI command [ : SOURce] : POWer [ :LEVel] [ : IMMediate] [ :
AMPLitude] sets the level of the "Level" display, that means the level containing off-
set while [ : SOURce] : POWer : POWer sets the level at the RF output connector.

Remote command:
[:SOURce] : POWer [:LEVel] [:IMMediate] [ :AMPLitude] on page 194
[ :SOURce] : POlWer : POWer on page 193
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Level Range

Displays the level range within which the level setting is expected to work properly. The
range limits depend on several parameters like "Mode", "Setting Characteristic", the 1/Q
signal's crest factor etc.

Remote command:
[ :SOURce] : POWer : RANGe : LOWer? on page 195
[ :SOURce] : POWer : RANGe : UPPer? on page 195

Limit

Sets the level limit.

The value specifies the upper limit of the level at the RF OUT connector. A message
appears if an attempt is made to set a level above this limit and the level at the RF out-
put is confined to the upper limit. However, the level indication is not influenced.

The value is not affected by an instrument preset function. This parameter is influenced
only by the Factory Preset and its factory value is equal to the upper limit.

Remote command:
[ :SOURce] : POWer:LIMit [ :AMPLitude] on page 194

Readjust
Recalculates the instrument internal settings optimized for the current level. Not
required for automatic modes.

Remote command:
[ :SOURce] : POWer : ALC: SONCe on page 192

Power-On/EMF

» To access the power- on/EMF settings, select "SGMA-GUI > Instrument Name >
Level > Power-On/EMF".

[Power—()n State RF Off -

This dialog comprises the settings for the power-on behavior of the instrument.

Power-On State
Selects the state which the RF output takes after the instrument is switched on.

"RF Off" The output is deactivated when the instrument is switched on.
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"Previous Setting"
When the instrument is switched on, the output takes the same state
as it had when the instrument was switched off.

Remote command:
:OUTPut [:STATe] : PON on page 179

7.6 Pulse Modulation

This section explains the pulse modulation settings of the R&S SGS. The equipment
layout for generating the pulse modulation signal includes the option Pulse Modulator
(R&S SGS-K22).

To configure and perform a pulse modulation, you need to select the modulation signal
source and provide the corresponding settings.
Modulation Signal Sources

The R&S SGS provides the following signal sources for the signal modulation:

® Internal: A high performance pulse generator, that allows you to generate either
single or double pulse signals

e Externally supplied signal: the instrument expects the pulse modulation signals
at the TRIG connector.

Pulse Modulation Signal Waveforms

The high performance pulse generator enables you to generate single or double pulse
signals.

Al@i @ I

-vY

A

_v_ .|

®

Fig. 7-1: Pulse Generator - Single Pulse Mode

1 = Pulse Period
2 = Pulse Width
3 = Pulse Delay
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Fig. 7-2: Pulse Generator - Double Pulse Mode

1 = Pulse Period
2 = Pulse Width
3 = Double Pulse Width
4 = Double Pulse Delay

7.6.1 Pulse Modulation Settings

» To access the pulse modulation settings, select "SGMA-GUI > Instrument Name >
Pulse Modulation".

State Off On

Source Pulse Generator

The "Pulse Modulation" dialog contains all parameters required to configure pulse
modulation and pulse signal generation.

State
Activates pulse modulation.

The R&S SGMA-GUI indicates an activated pulse modulation as follows:

@[l $6s-100020

Remote command:
[ : SOURce<hw>] : PULM: STATe on page 200
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Source

Selects between the internal "Pulse Generator", or an "External" pulse signal for the
modulation. In the later case the instrument expects the pulse modulation signals at
the TRIG connector.

Remote command:
[ :SOURce<hw>] : PULM: SOURce on page 199

Polarity
Sets the polarity of the active slope of the modulation signal for "Source > External".

Remote command:
[ :SOURce<hw>] : PULM: POLarity on page 199

External Impedance
Selects the input impedance for an external pulse modulation signal.

Remote command:
[ : SOURce<hw>] : PULM: TRIGger :EXTernal : IMPedance on page 200

7.6.2 Pulse Generator Settings

» To access the pulse connector/trigger settings, select "SGMA-GUI > Instrument
Name > Pulse Modulation > Pulse Genrator".

Comprises the settings necessary to configure the internal pulse modulation signal.

Pulse Mode

Sets the operating mode of the pulse generator.

"Single" generates a single pulse in one pulse period, see figure 7-1.
"Double" generates two pulses in one pulse period, see figure 7-2.

Remote command:
[ :SOURce<hw>] : PULM: MODE on page 198
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Pulse Period
Sets the repetition rate of the generated pulse signal, see "Pulse Modulation Signal
Waveforms" on page 75.

Remote command:
[ :SOURce<hw>] : PULM: PERiod on page 199

Pulse Width
Sets the pulse duration of the generated pulse signal, see "Pulse Modulation Signal
Waveforms" on page 75.

Remote command:
[ : SOURce<hw>] : PULM:WIDTh on page 201

Double Pulse Width
Sets the width of the second pulse, see figure 7-2.

Remote command:
[ :SOURce<hw>] : PULM:DOUBle:WIDTh on page 198

Pulse Delay
Sets the pulse delay. The pulse delay determines the time that elapses after a trigger
event before pulse modulation starts, see figure 7-1.

The pulse delay is not effective for double pulse generation.

Remote command:
[ : SOURce<hw>] : PULM: DELay on page 198

Double Pulse Delay
Sets the delay between the start of the first pulse and the start of the second pulse,
see figure 7-2.

Remote command:
[ :SOURce<hw>] : PULM: DOUBle: DELay on page 198
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7.6.3 Pulse Connector/Trigger Settings

» To access the pulse connector/trigger settings, select "SGMA-GUI > Instrument
Name > Pulse Modulation > Connector/Trigger".

[[rigger Mode Auto -
Connector Mode Pulse Mod Ext Source .]
External Impedance [50 9] v]

r
"

Comprises the settings necessary to configure the signal at the multi purpose TRIG
connector in the external trigger mode.

Trigger Connector Mode
Determines the signal at the input/output of the multi purpose TRIG connector.

"Signal Valid"  Output of high signal to mark valid frequency and level settings.

"Not Signal Valid"
Output of high signal to mark the transition state when frequency and
level change.

"Pulse Video Out"
Output of the internally generated pulse video (modulating) signal.
The video signal level corresponds to the RF envelope.

"Pulse Mod Ext Trigger"
Input for an external trigger signal, used to trigger the pulse genera-
tor.

"Pulse Mod Ext Source"
Input for an externally provided pulse modulation signal.
Used when an external pulse modulator source is provided at the
connector.

Remote command:
:CONNector:TRIGger:OMODe on page 163

Trigger Mode

Selects between continuos pulse modulation or pulse modulation triggered by an exter-
nal signal.

"Auto" generates the modulation signal continuously.

"Ext Single" generates the signal each time an external trigger event occurs.
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"Ext Gated" generates the signal triggered by an external gate signal.

Remote command:
[ : SOURce<hw>] : PULM: TRIGger : MODE on page 201

Ext. Trigger Input Slope
available only for "Trigger Mode > Ext Triggered "

Sets the polarity of the active slope of an applied external trigger signal.

Remote command:
[ :SOURce<hw>] : PULM: TRIGger:EXTernal : SLOPe on page 201

Gate Input Polarity
available only for "Trigger Mode > Ext Gated "

Sets the polarity of the active slope of an applied gate signal.

Remote command:
[ : SOURce<hw>] : PULM: TRIGger :EXTernal : GATE: POLarity on page 200

7.7 Trigger Connector Settings

The dialog provides settings to determine the signal at the input/output of the multi pur-
pose TRIG connector.

» To access the pulse connector/trigger settings, select "SGMA-GUI > Instrument
Name > Connector".

Trigger Connector Mode Signal Valid

Comprises the settings necessary to configure the signal at the signal at the input/
output of the multi purpose TRIG connector.

Trigger Connector Mode
Determines the signal at the input/output of the multi purpose TRIG connector.

"Signal Valid"  Output of high signal to mark valid frequency and level settings.

"Not Signal Valid"
Output of high signal to mark the transition state when frequency and
level change.

"Pulse Video Out"
Output of the internally generated pulse video (modulating) signal.
The video signal level corresponds to the RF envelope.

"Pulse Mod Ext Trigger"

Input for an external trigger signal, used to trigger the pulse genera-
tor.
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"Pulse Mod Ext Source"
Input for an externally provided pulse modulation signal.
Used when an external pulse modulator source is provided at the
connector.

Remote command:
:CONNector:TRIGger :OMODe on page 163

7.8 1/Q Modulation and Signal Impairment

The R&S SGS offers I/Q modulation with external analog I/Q signals. I/Q modulation
with an external analog 1/Q signal is possible for the instrument equipped with fre-
quency options R&S SGS-B106V/-B112V. The external signal is input via the | and Q
connectors and transferred to the I/Q modulator.

Before the signal is fed into the 1/Q modulator, the signal can be impaired. Impairment
at this point along the signal flow is provided for error correction of the supplied signal
or for enabling dedicated impairments. Impairments caused by the 1/Q modulator are
automatically corrected by the "Internal Adjustments"” function.

ments. The correction routine should be called in the case of temperature fluctuations
of several degrees. To call the routine, select "SGMA-GUI > Instrument Name > Setup
> Internal Adjustment" and execute the desired adjustment procedure.

6 System error correction of the I/Q modulator permits precise and repeatable measure-

7.8.1 1/Q Impairments

Signal impairments are well-defined arithmetic modifications of the data. Every data
sample is modified in the same way. The purpose of adding impairments to the data
stream is to simulate frequent sources of distortions in a real signal-processing chain in
order to generate a test signal with dirty transmitter conditions.

7.8.1.1 Gain and Gain Imbalance

An 1/Q gain is a multiplication of all I/Q amplitudes by a common factor. The effect is
equivalent to two identical | and Q gain factors. The effect of an increased gain factor
in the 1/Q constellation diagram is shown below.
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Fig. 7-3: Effect of an increased amplitude in the I/Q constellation diagram

An | gain multiplies the | amplitudes by a factor, leaving the Q amplitudes unchanged.
A Q gain has the opposite effect. Different | and Q gain factors result in an I/Q imbal-
ance, which is usually due to different gains of the amplifiers in the | and Q channels of
the 1/Q modulator. The effect of a positive and negative gain imbalance is shown
below.

AQ 1‘0

Fig. 7-4: Negative gain imbalance (left) and positive (right) gain imbalance in the I/Q constellation dia-
gram

7.8.1.2 |and Q Offset

An | offset adds a constant value to all | amplitudes, leaving the Q amplitudes
unchanged. A Q offset has the opposite effect. A combination of | and Q values results
in an 1/Q offset, which is usually due to carrier feedthrough in the 1/Q modulator. Possi-
ble reasons are interfering signals at the RF carrier frequency, e.g. an unsuppressed
RF carrier subchannel. The effect of a positive | and Q offset in the I/Q constellation
diagram is shown below.



I/Q Modulation and Signal Impairment

AQ fQ

f Y

Fig. 7-5: | offset (left) and Q offset (right) in the I/Q constellation diagram

7.8.1.3 Quadrature Offset

Changes the phase angle between the | and Q vectors from the ideal 90 degrees,
while the amplitudes are maintained. A positive quadrature offset results in a phase
angle greater than 90 degrees. The effect of a positive quadrature offset in the 1/Q con-
stellation diagram is shown below.

4Q

Fig. 7-6: Positive quadrature offset in the I/Q constellation diagram
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7.8.2 General I/Q Settings

» To access the settings of the I/Q modulator, select "SGMA-GUI > Instrument Name
> 1/Q Settings > General".

State oft On

~—— Analog Wideband I/Q Input

Crest Factor 0.00|dB

Wideband

A

Comprises the settings for setting the state and the analog wideband 1/Q input.

Mod State
Switches the I/Q modulation on and off.

Remote command:
[:SOURce] : IQ:STATe on page 189

1/Q Wideband
Setting mode for wideband modulation signals (higher I/Q modulation bandwidth).

The modulation frequency response of the R&S SGS in the useful bandwidth is
improved at the expense of poorer harmonic suppression. This is achieved by shifting
the switching frequencies of the lowpass filters in the output section.

Remote command:
[:SOURce] : IQ:WBSTate on page 190

Crest Factor
Sets the crest factor of the 1/Q modulation signal.

The crest factor gives the difference in level between the peak envelope power (PEP)
and average power value (RMS) in dB. This value is necessary for the generation of
the correct output power at the RF output, i.e. the instrument uses the crest factor
value to compensate the average power.

In vector modulation mode, the output level setting is correlated to the nominal full
scale voltage at the 1/Q input. If the baseband signal exhibits no constant envelope, the
instrument internal level setting can be corrected by use of the crest factor value.

Remote command:
[:SOURce] : IQ:CREStfactor on page 190
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7.8.3 Analog Impairment Settings

» To access the settings of the I/Q modulator, select "SGMA-GUI > Instrument Name
> 1/Q Settings > Analog Impairments".

| Offset [ 0.00{% ']
Q Offset [ 0.00{% ']
Gain Imbalance [ 0.000{dB v]
Quadrature Offset [ 0.00{deg ']

Comprises the settings like 1/Q offset and quadrature offset.

State
Activates/deactivates I/Q impairments.

If activated, the settings for offset, gain imbalance and quadrature offset become effec-
tive.

Whether or not 1/Q impairment is activated is indicated in the function block.

Remote command:
[:SOURce] : IQ: IMPairment [:STATe] on page 190

Offset

Sets the carrier offset (in percent) of the amplitudes (scaled to the peak envelope
power (PEP) for the | and/or Q signal component. An ideal I/Q modulator suppresses
the carrier offset completely (offset = 0 percent).

For more information, see chapter 7.8.1.2, "l and Q Offset", on page 82.

Remote command:

[:SOURce] : IQ: IMPairment: LEAKage: I on page 189

[:SOURce] : IQ: IMPairment: LEAKage : Q on page 189

Gain Imbalance
Sets the imbalance of the | and Q vector (see chapter 7.8.1.1, "Gain and Gain Imbal-
ance", on page 81).

The entry is made in dB (default) or %, where 1 dB offset is roughly 12 % according to
the following:

Imbalance [dB] = 20log (| GainQ | /| Gainl |)
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Positive values mean that the Q vector is amplified more than the | vector by the corre-
sponding percentage. Negative values have the opposite effect.

Remote command:
[:SOURce] : IQ:IMPairment:IQRatio[:MAGNitude] on page 189

Quadrature Offset
Sets the quadrature offset (see chapter 7.8.1.3, "Quadrature Offset", on page 83).

Remote command:
[:SOURce] : IQ: IMPairment:QUADrature [ :ANGLe] on page 189

7.9 Preset

Calls up a defined instrument setup. All parameters and switching states are preset
(also those of inactive operating modes). The default instrument settings provide a
reproducible initial basis for all other settings. However, functions that concern the inte-
gration of the instrument into a measurement setup are not changed, e.g. reference
oscillator settings.

Overview of the most important preset states

The following list gives an overview of the presets for the most important generator set-
tings. The other presets can be found in the information accompanying the remote
commands.

® "RF frequency" = 1 GHz

e "Reference frequency" = Internal; adjustment off

® "RF output" switched off

® "Modulator State" = Off

Settings that are not affected by the "SGMA-GUI > Instrument Name > Preset" func-
tion:

® Reference frequency settings ("Ref Oscillator" dialog)

® Power on settings ("Level" dialog)

® Network settings ("Setup" dialog)

® Password and settings protected by passwords ("Setup" dialog)
® Eco Mode state ("Setup > Eco Mode" dialog)

To preset the R&S SGMA-GUI itself and all configured instruments to their predefined
state, use the "SGMA-GUI > File > New" function.

SCPI command:

:SYSTem: PRESet on page 159
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7.10

Extension

Depending on the installed option, your R&S SGS generates an RF signal with fre-
quency range up to 12.75 GHz. Some test cases, however, require even higher fre-
quencies. A general setup would thus include an upconverter connected to the signal
generator and you would have to manually and/or remotely control both the signal gen-
erator and the upconverter.

The R&S SGS equipped with one of the options R&S SGS-B112/B112V provides the
build-in extension mode for controlling the R&S SGU upconverter. If you connect an
R&S SGU to the R&S SGS, this upconverter acts as an extension to your instrument
extending its frequency range to 20 GHz for instance. Refer to chapter 5.2, "Setups for
Connecting an R&S SGS and an R&S SGU", on page 37 for a description of the possi-
ble setups.

The extension mode provides the following advantages:

e Simplified calibration of the R&S SGU and single point of control
In this setup a controller does not need to access the extension, i.e. the R&S SGU,
directly. Instead, the R&S SGS acts as a controller to it and depending on the
required output signal parameters performs all required settings automatically.
The signal generator settings of the extension are disabled for direct configuration
in the R&S SGMA-GUI. However, you can still remotely control the extension using
the corresponding SCPI commands.

® Extended value ranges and functionality
The main application field of the extension mode is the extended frequency range
but you can also benefit from the 1/Q modulation and pulse modulation functions of
the extension. For frequencies greater than 12.75 GHz, the combination of R&S
SGS and R&S SGU can generate vector modulated signals even if the R&S SGS
is not equipped with the required options R&S SGS-B106V/B112V.

Prerequisites and required physical connections for operation in extension mode:
® The R&S SGS is equipped with one of the options R&S SGS-B112/B112V.

® A remote PC is connected to the master instrument, the remote PC and the instru-
ment are switched on and a connection between them is established.
The instrument and the extension are connected via a direct remote connection or
over network/switch. All interfaces (LAN, PCle, or USB) can be used for controlling
the SGU.

® The R&S SGMA-GUI or an application program is running on the remote PC.

® Signal connections between the R&S SGS and the R&S SGU are established, i.e.
the connections between:
— the RF OUT of the R&S SGS and the LO IN of the R&S SGU

— for vector modulated signals, the | OUT/Q OUT of the R&S SGU and the | IN/Q
IN of the R&S SGS

— the TRIG connectors of both instruments
This section describes the manual operation via the R&S SGMA-GUI software. The

remote commands required to define these settings are described in chapter 11.8,
"EXTension Subsystem", on page 164.
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To access the extension mode settings and enable the extension mode

1. Select "SGMA-GUI > Instrument Name > Extension".

. 5G5-100004: Extension

Connected .

~——— Available Instruments

SGU-100014 Socket

Scan Start I
~——  Test Signal Connections

Test \
b

Tip: Steps 2 and 3 can be omitted if the R&S SGS and a single R&S SGU are con-
nected using PCle or USB or by a direct LAN connection. In this case R&S SGS
will automatically activate the R&S SGU.

2. Trigger "Scan" to find all available instruments that can serve as an extension to
the particular instrument.

3. Select an instrument from the list and set "Available Instruments > Select > On" to
enable it as an extension.

A green status indicator "Connected" indicates the successfully established remote
connection to the extension.

4. Select "Test Signal Connections > Test" to trigger a check of all required signal
connections.

The diagram displays the connection state of the tested connections.

The R&S SGMA-GUI indicates the extended frequency range of the master instru-
ment and the activated extension mode.

™ weeeeemeeeeeee Extension to $68-100014 oo 1

You cannot access the signal generation settings of an instrument working in
extension mode. The extension is controlled via the master instrument.

To display the R&S SGU settings click on the [ button next to the instrument's
name.

Select for example "SGMA-GUI > Master Instrument Name > Freq = 20 GHz", "Lev
=-30 dBm" and enable "RF > State > On". The extension adopts these values and
states automaticaly. To confirm, disable the "Extension > Available Instruments >
Extension Name > Select > Off" and compare the values of the parameters
"SGMA-GUI > Extension Instrument Name > Freqg/Lev".
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Connected

The connection state indicator visualizes the state of selected extension:

® grey - the connection to the extension is not activated ("Extension > Available
Instruments > Instrument# > Select > Off")

® green - the extension is connected to the master instrument and can be manually
and remotely operated

® red - the extension is in standby or locked state, or is performing a time consuming
operation

Available Instruments
Lists all available instruments that may serve as an extension to the R&S SGS.

Each instrument is represented by:

"Symbolic Name"
Alias name of the instrument as it is defined in the main panel of

R&S SGMA-GUI.

"Channel" Hardware channel, "Socket", "LAN", "USB" or "PCle", used by the
extension as remote control channel

"Select" State of the remote connection to the extension.
The R&S SGMA-GUI indicates an activated extension mode as fol-
lows:

) eeeeeerenmeees EXtENSTON t0 SGS-100014 --rerrneeeenee

Remote command:

:EXTension:BUSY[:STATe]? on page 166
:EXTension:INSTruments:NAME? on page 164
:EXTension:INSTruments:REMote:CHANnel? on page 165
:EXTension:INSTruments:REMote:LAN:NAME? on page 165
:EXTension:INSTruments:REMote:SERial? on page 166
:EXTension:INSTruments:SCAN[:STATe] on page 165
:EXTension:REMote:STATe? on page 164

Scan
Triggers a scan function and searches for instruments connected to the instrument via
all of the available interfaces.

Remote command:
:EXTension:INSTruments:SCAN[:STATe] on page 165

Test Signal Connections

The "Test" function triggers a test of all signal connections between the instrument and
the extension. The schematic diagram display the required physical signal connection
for the current test setup and the connection state.

A faulty connection is marked with a red line crossing the drawn blue connection line
as shown in figure 7-7. If your connection is marked as faulty check whether the cables
are connected properly and if the connection cables are functioning properly.
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SGU

Loin

SGS

Fig. 7-7: A faulty connection between an R&S SGU and an R&S SGS

Note: If your connection is marked as faulty check whether the cables are connected
properly. Check also if the connection cables are functioning properly.

Remote command:
n.a.
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8 General Instrument Settings and Instrument
Setup

This section describes the settings which do not directly affect signal generation.

» To access these settings, select "SGMA-GUI > Instrument Name > Setup" and
select the required dialog.

inema Adusiment... |

Diagnostic / Test » Hardware Config...
Senvice » Software / Options. .
Install SW-Option__.
Protection_..
Security..
Maintenance...
MNetwork Settings...
Remate. .
Factory Preset. ..
Eco Mode__
Standby
Restart

8.1 Internal Adjustments

The R&S SGS is accurate due to the integrated procedures for adjustments.

All internal adjustments for which no external measuring equipment is needed can be

started in the "Internal Adjustments"” dialog. The adjustments with external measuring

equipment are described in the Service Manual (on CD ROM, supplied with the instru-
ment).

ated changes, prior to all applications which require maximum level and frequency
accuracy, or after enabling/disabling of the "Eco Mode" (see chapter 8.11, "Eco Mode",
on page 106).

6 Adjustment is recommended if the temperature range in which the instrument is oper-

During adjustment a bar indicates the status of progress. If an error occurs, adjustment
is terminated and an error message is output in the info line.

Risk of invalid adjustment

In order to achieve correct adjustment of the instrument, make sure that the instrument
is warm before performing adjustments. The warm-up time is 30 minutes.
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[ Adjust /G Modulator at Current Frequency \

Result

Delta Temperature |

i Result

_oess |[somed | pntones
ot s s |
. A

Adjust All

Starts all internal adjustments for which no external measuring equipment is needed.
The adjustments with external measuring equipment are described in the Service Man-
ual (supplied).

Remote command:

:CALibration:ALL[:MEASure]? on page 160

Adjust I/Q Modulator at Current Frequency
Starts the adjustment for the 1/Q modulator for the currently set frequency. The 1/Q
modulator is adjusted with respect to carrier leakage, I/Q imbalance and quadrature.

The adjustment is only possible when "RF > ON" and "I/Q Mod > State > ON".

Adjustment for only the set frequency is considerably faster than adjustment across the
entire frequency range. An adjustment of the entire range is possible with the 1/Q Mod-
ulator button of this dialog.

Remote command:
:CALibration:IQModulator:L0OCal? on page 161

Synthesis
Performs all adjustments which affect the frequency.

Remote command:
:CALibration:FREQuency[:MEASure] ? on page 160

Level
Performs all adjustments which affect the level. The acquired correction values
improve the settling time and the signal quality.

Remote command:
:CALibration:LEVel [ :MEASure]? on page 161



Hardware Configuration

1/Q Modulator
Starts the adjustment for the 1/Q modulator for the entire frequency range. The 1/Q
modulator is adjusted with respect to carrier leakage, 1/Q imbalance and quadrature.

Remote command:
:CALibration:IQModulator:FULL? on page 160

Delta Temperature

Displays the difference between the current temperature and the temperature by the
last performed adjustment.

Note: Adjustment is recommended if the temperature range in which the instrument is
operated changes, prior to all applications which require maximum level and frequency
accuracy, or after enabling/disabling of the "Eco Mode" (see chapter 8.11, "Eco Mode",
on page 106).

Remote command:

:CALibration:LEVel:TEMPerature? on page 161
:CALibration:FREQuency:TEMPerature? on page 161
:CALibration:IQModulator:TEMPerature? on page 161

8.2 Hardware Configuration

In the "Hardware Config" dialog, the installed assemblies together with their variants
and revision states can be displayed for servicing purposes.

» To access the "Hardware Config" dialog, select "SGMA-GUI > Instrument Name >
Setup > Hardware Config".
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Counter . ]

¢
Common Assembly

H

RF Assembly

H

The dialog is a table that lists the installed assemblies. It is divided into the sections:
® "Common Assembly" and
® "RF Assembly"

Assembly
The tables list the installed assemblies.

"Assembly" Name of the assembly
"Part Number" Part Number of the assembly

"Serial Number"
Serial Number of the assembly

"Revision" Revision state of assembly

Remote command:
:SYSTem:HARDware:ASSembly<dir>:NAME? on page 216
:SYSTem:HARDware:ASSembly<dir>:PNUMber? on page 216
:SYSTem:HARDware: ASSembly<dir>:SNUMber? on page 217
:SYSTem:HARDware:ASSembly<dir>:REVision? on page 216

8.3 Software / Options

The "Software/Options" dialog shows the firmware version of the instrument software
as well as all installed hardware and software options.
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Hardware -,

WinlQSIM o

|
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J

Software options purchased at a later stage can be activated with a keycode. The acti-
vation code is supplied with the software option. An instruction on how to install options
is described in Chapter 4 of the Service Manual (supplied with the instrument). Most
hardware options need to be installed at an authorized Rohde&Schwarz service cen-
ter.

» To access the "Software/Options" dialog, select "SGMA-GUI > Instrument Name >
Setup > Software/Options".

The dialog is divided into the following sections:
® "Firmware"

® "Hardware"

® "Software"

® "Loaded Modules"
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Install SW-Options

Firmware
The "Firmware" section shows the firmware version and the version of the software
platform.

Note: Your instrument is delivered with the latest firmware version available. Firmware
updates as well as the Release Notes describing the improvements and modifications
are provided on the Internet at the download site of the instrument's home page. This
home page always offers the latest information on your instrument, e.g. also on
changes of the firmware update procedure.

Hardware / Software/WinlQSIM
The tables in the sections "Hardware" and "Software" list the installed hardware and
software options.

"Option" Short name of the option
"Designation”  Name of the option
"Licenses" Number of licenses

"Expiration Date"
For regular options, "Permanent" is indicated in this column. Some
options are available as trial versions. This column shows their expi-
ration date. After this date, the option is no longer available on the
instrument.

Remote command:

:SYSTem: SOFTware:0PTion<dir>:NAME? on page 218
:SYSTem: SOFTware:0PTion<dir>:DESignation? on page 217
:SYSTem: SOFTware:0PTion<dir>:LICenses? on page 218
:SYSTem: SOFTware:0PTion<dir>:EXPiration? on page 217

Loaded Modules
Section "Loaded Modules" is provided for service purposes. It lists all loaded software
modules with their versions and offers a short description of each module.

Install SW-Options

Newly purchased software options are enabled in the "Install SW-Option" dialog. They
are ready to operate after they are enabled by means of a key code supplied with the
option.

0 5GS-100004: Install SW-Option [ = | & [:25a]

o

Only if the instrument is equipped with an older firmware version, a firmware update
prior to enabling the software option may be required. The information on the valid
firmware versions for the purchased software option is provided together with the
option. Refer to chapter 9.12, "How to Install a new Firmware Version on the Instru-
ment", on page 121 for information on how to perform firmware update and to chap-
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ter 9.13, "How to Activate Options", on page 123 for instruction on how to install new
options.

The firmware update is also described in the service manual, chapter 4 (on CD ROM,
supplied with the instrument).

8.5 Protection

The "Protection” dialog provides access to the unlocking of protected service functions
(authorized personnel of R&S Service Departments only).

Unlocking of Protected Service Functions

1. Select "SGMA-GUI main panel > Instrument Name > Setup > Protection".

The "Protection” dialog provides access to the unlocking of protected service func-
tions (authorized personnel of R&S Service Departments only).

2. To deactivate the protection, the correct password has to be entered. After the
instrument has been switched on, the protection levels 1 to 4 are automatically
activated.

Enter "Protection Level 1 > Password > 123456".

Protection Level 1 is activated.

i 5GS5-100004: Protection =] & =]

Protection Level 1 /] On [Pnsmm R

Protection Level 2 [i/] On  Password EI
Protection Level 3 [3/] On Password EI
Protection Level 4 [3/] On Password EI

Protection Level / Password
Protection Level 1 can be activated to expand the functionality of the internal adjust-
ment. The password is 123456.

The other protection levels 2 to 4 provide access to protected service functions. Only
the authorized personnel of R&S Service Departments can access these functions.

8.6 Security Setting

The R&S SGS employs a security concept based on user and security password. The
security password is required for changing several critical settings, like performing firm-
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ware updates. An access to the passwords and mass storage security settings is provi-
ded in the "Security" dialog.

» To access the "Security" dialog, select "SGMA-GUI > Instrument Name > Setup >
Security"

The menu is divided into the password sections and the security settings section. In
the password section, the passwords for securing a controlled access to the instrument
are defined and changed.

A change of passwords for the operating system and security password requires the
entry of the old and new password and the conformation of the new password. All set-
tings are only accepted after the "Change Password" button is pressed.

Change User Password
valid for VNC,FTP and SAMBA access

[US‘EF Name

— |

wrmouors | |

e |

Change Password l
L% >
~——— Change Security Password ——

—— |

s |

comers |

Change Password l
L A
—— Security Seftings —,

usa beve
Lan Connections

o |

rocont

6 The settings of this dialog are not accessible over remote control (e.g. SCPI com-
mands).
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Change User Password
The user name and password are required for remote access to the instrument via
VNC, FTP or SAMBA.

Note: It is highly recommended to change the default user password before connect-
ing the instrument to the network.

User Name — Change User Password
Indicates the user name used for access to the Linux operating system and valid for
VNC, FTP and SAMBA access.

Old Password — Change User Password
Enter the currently used user password. The default password is "instrument".

New Password < Change User Password
Enter the new user password.

Confirm Password < Change User Password
Enter the new password for conformation.

The new password is only valid after the "Change Password" button is pressed.

Change Password < Change User Password
Changes the password accordingly.

Change Security Password
Note: It is highly recommended to change the default security password before con-
necting the instrument to the network.

The security password is for exampe required when changing the status of the USB
and LAN interface.

Old Password — Change Security Password
Enter the currently used security password. The default password is '123456'".

New Password < Change Security Password
Enter the new security password. The security password may contain decimal charac-
ters only.

Confirm Password <« Change Security Password
Enter the new password for conformation.

The new password is only valid after the "Change Password" button is pressed.

Change Password «— Change Security Password
Changes the password accordingly.

Security Settings

Comprises the settings for enabling and disabling the USB and LAN interfaces. The
setting requires the entry of the security password and is only accepted after the
"Accept" button is pressed.
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USB Device «— Security Settings
Enable/disable the USB interface.

Note: The instrument does not recognize any device connected to the USB interface
when the interface is disabled.

LAN Connection «— Security Settings
Enable/disable the LAN interface.

Note: It is not possible to access the instrument via LAN while the LAN connection is
disabled.

An enabled LAN Connection is a prerequisite for the remote control of the instrument
via VNC, FTP or SAMBA.

Security Password < Security Settings
Enters the password that is required to enable or to disable the settings protected by a
security password. The default is '123456'".

Note: It is highly recommended to change the default security password before con-
necting the instrument to the network. To change the security password, select
"SGMA-GUI > Instrument Name > Setup > Security > Change Security Password".

The settings are only accepted after the "Accept" button is pressed.

Accept «— Security Settings
Accept a new entry or selection and change the settings accordingly.

8.7 Maintenance

The R&S SGS provides a special dialog for performing some maintenance procedures,
like installing firmware packages.

» To access this dialog, select "SGMA-GUI > Instrument Name > Setup > Mainte-

Install firmware package

None

Select Package Install firmware package
PCle Interface Mode
Update All 5GSs Install FW. package on extension
Security Password [
Operation

Selects the desired maintenance operation.
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Select Package
Available only for "Operation > Install Firmware Package".

Selects the firmware package to be installed, see also chapter 9.12, "How to Install a
new Firmware Version on the Instrument", on page 121.

Update All
Available only for "Operation > Install Firmware Package".

Enable this function to perform a simultaneous firmware update on all instruments, that
are in active state and are connected to this controller.

Note: A firmware update and the required subsequent restart and the automatically ini-
tiated internal adjustment process of the controller may be a time consuming operation.
This feature accelerates the update process and the required restart of the external PC
can be executed once after the update operation of all instruments is completed.

Security Password
Enters the password that is required to enable or to disable the settings protected by a
security password. The default is '123456'.

Note: It is highly recommended to change the default security password before con-
necting the instrument to the network. To change the security password, select
"SGMA-GUI > Instrument Name > Setup > Security > Change Security Password".

The settings are only accepted after the "Accept" button is pressed.

Accept
Accept the selected operation and perform the required procedure.

PCle Interface Mode
Sets the PCle interface mode for the R&S SGS.

"Endpoint” Standard mode.
"Root Com- The mode needed for a direct PCle connection of an R&S SGS and
plex" an R&S SGU.

8.8 Network Settings

The instrument is equipped with a network interface and can be connected to an Ether-
net LAN (local area network). The "Network Settings" dialog provides access to the
network settings.
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Risk of network errors!
Connection errors can affect the entire network.

If your network does not support DHCP, or if you choose to disable dynamic TCP/IP
configuration, you must assign valid address information before connecting the instru-
ment to the LAN.

Contact your network administrator to obtain a valid IP address.

> To access this dialog, select "SGMA-GUI > Instrument Name > Setup > Network
Settings".

Restart Network

e o

———————— IP Address —————————

-
Subnet Mask -
Default Gateway -

“
The dialog provides access to the network settings, like settings about the general net-

work environment and specific identification of the computer in the network, as well as
an indication whether the instrument is connected to the network or not.

Restart Network
Shuts down the network connection of the instrument and subsequently re-establishes
the connection.

This function can be used to resolve network problems.

Note: Only the connection of the instrument to the network restarts, the network itself
is not affected.

Hostname
Displays the individual computer name of the instrument.

A predefined name is indicated and can be used for network connections, see chap-
ter 6.4.3, "Finding Out the Default Hostname of the Instrument", on page 61.
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It is recommend that a connection of the instrument to the network is coordinated with
the network administrator. Connection errors may affect the entire network.

Remote command:
:SYSTem:COMMunicate:NETWork [ :COMMon] : HOSTname on page 212

MAC Address
Indicates the MAC address of the network adapter.

Address Mode
Selects if the IP address is assigned automatically or manually.

It is recommend that a connection of the instrument to the network is coordinated with
the network administrator. Connection errors may affect the entire network.

Note: Lost LAN Connection to an Instrument.

If the connection to an instruments configured to use static IP addresses is lost, press
the LAN LED on the instrument front panel for 3 seconds to reset the "Address Mode"
to its default value ("Auto (DHCP)").

"Auto (DHCP)" The IP address is assigned automatically.
The network used must support automatic assignment of IP address
via DHCP or APIPA (Zeroconf) in order to use this function.

"Static" The IP address is assigned manually.

Remote command:
:SYSTem:COMMunicate :NETWork: IPADdress : MODE on page 211

IP Address
Displays the IP address. To enter the IP address manually, select "Static" Address
Mode.

In case of manual input of the IP address it is recommend that a connection of the
instrument to the network is coordinated with the network administrator. Connection
errors may affect the entire network.

Remote command:
:SYSTem:COMMunicate:NETWork: IPADdress on page 211

Subnet Mask
Displays the Subnet mask. To enter the Subnet mask manually, select "Static" Address
Mode.

This number is used together with the IP address to identify the network segment the
instrument is in.

It is recommend that a connection of the instrument to the network is coordinated with
the network administrator. Connection errors may affect the entire network.

Remote command:
:SYSTem:COMMunicate :NETWork[: IPADdress] : SUBNet : MASK on page 213

Default Gateway
Displays the IP address of the default gateway. To enter the default gateway manually,
select "Static" Address Mode.



Remote Channels

This address identifies the router on the same network as the instrument that is used to
forward traffic to destinations beyond the local network.

It is recommend that a connection of the instrument to the network is coordinated with
the network administrator. Connection errors may affect the entire network.

Remote command:
:SYSTem:COMMunicate:NETWork|[:IPADdress] :GATeway on page 212

Apply
Applies the network settings to the instrument.

8.9 Remote Channels

The "Remote" dialog provides access to the settings for remote control.

> To access this dialog, select "SGMA-GUI > Instrument Name > Setup > Remote".

( Visa Resource Strings

[LAH {VXI-11)

Socket

HISLIP

UsB

PCle
o

Device Identify

Visa Resource Strings
Indicates the VISA resource strings used for remote control of the instrument. A sepa-
rate string is provided for remote control via the different interfaces.

Note: For background information and description of the syntax of the VISA resource
strings, refer to the description of the corresponding interface in chapter 10.1, "Remote
Control Interfaces and Protocols”, on page 124.

Remote command:

:SYSTem:COMMunicate:HISLip:RESource? on page 214
:SYSTem:COMMunicate:NETWork:RESource? on page 213
:SYSTem:COMMunicate: SOCKet :RESource? on page 215
:SYSTem:COMMunicate:USB:RESource? on page 215
:SYSTem:COMMunicate:PCIlexpress:RESource? on page 214
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Device ldentity
Triggers the device identification function. The LAN LED on the front panel of the
selected instrument blinks.

See also chapter 6.4.4, "Bidirectional Instrument Identification ", on page 61.

8.10 Factory Preset

The "Factory Preset" dialog provides a function to reset the instrument's settings to
their factory states

1. To access this dialog, select "SGMA-GUI > Instrument Name > Setup > Factory
Preset".

—
40 5GS-100004: Factory Preset | — | =1 [iaw]

| Execute Factory Preset

Resets instrument to factory configuration.
Security settings and user data are not effected.

2. Select "Execute Factory Preset".

The instrument's settings are reset to their factory states. Security settings and
user data are not effected.

Execute Factory Preset
Reset the instrument's settings to their factory state.

Note: Because "Factory Preset" resets the "Remote Channel Settings" and "Network
Settings" to the default values, executing factory preset via remote control may termi-
nate the connection to the instrument, if these settings had been configured to values
different to the default ones!

The factory preset function resets nearly all instrument settings. In addition to the regu-
lar preset, a "Factory Preset" resets also the following values:

® Power on settings ("Level" dialog)

® Network settings including hostname ("Setup > Network Setting" dialog)

® Remote Channel settings ("Setup > Remote Channel" dialog)

® Eco Mode state ("Setup > Eco Mode" dialog)

To maintain security, password settings and all settings protected by these passwords
like disabled USB and LAN connections are not changed.

Not affected by the "Factory Preset" are also user data, lists or instrument settings
files, created for example by means of the "File Save As" function.

Remote command:
:SYSTem: FPReset on page 159



8.1

Eco Mode

Eco Mode

This energy saving mode is available only for instruments equipped with
optionR&S SGS-B112/B112V.

» To access this dialog, select "SGMA-GUI > Instrument Name > Setup > Eco
Mode".

With enabled "Eco Mode 1" the doubler stage in a 12.75 GHz instrument is perma-
nently switched off to reduce power consumption and the maximum frequency is
limited to 6 GHZ. An enabled "Eco Mode" is indicated by a green coloring of the
frequency range in the R&S SGMA-GUI.

®[E] | sGs-100004

Risk of invalid adjustment after changing the Eco Mode

The switching off and on of the doubler stage changes the thermal conditions in the
instrument.

In order to achieve correct adjustment of the instrument, make sure that the instrument
is warm before performing adjustments. The warm-up time is 30 minutes.

Performing adjustment in Eco Mode

The instruments performs the internal adjustment within the currently active frequency
range, i.e. up to 6 GHz for enabled mode "Eco Mode 1". The correct alignment of the
parameters outside of the current active frequency range is not guaranteed. A subse-
quent re-adjustment for the total frequency range of the instrument is recommended.

8.12

The state of this parameter is not affected by an instrument "Preset". This parameter is
influenced only by the Factory Preset.

SCPI command:

:SYSTem: EMODe on page 208

Standby and Restart

See chapter 9.9, "How to Switch Between the Operating States", on page 118.



8.13

8.13.1

8.13.2

Diagnostic and Tests

Diagnostic and Tests

This section describes the settings provided for diagnostic and test purposes.

Self Test

1. To access this dialog, select "SGMA-GUI > Instrument Name > Diagnostic Tests >
Self Test".

Start Selftest...
Testcase | Result |‘

2. To trigger a self test, select "Selftest".

Performs a self test on all installed hardware options.

The result of the self test, succeeded or failed, is displayed. The list of the numeric
results of the performed test cases is protected by protection level 2.

SCPI command:
:TEST:ALL:STARt on page 219

:TEST:ALL:RESult? on page 219

Keyboard Tests

» To access this dialog, select "SGMA-GUI > Instrument Name > Diagnostic Tests >
Keyboard Test".

Use this function to check the proper operation of all front panel elements. If "Keyboard
Test" is enabled, all front panel LEDs except the POWER ON are orange. The exact
test procedure is described in the Service Manual (on CD ROM, supplied with the
instrument).

SCPI command:

:TEST:KEYBoard[:STATe] on page 220



External Adjustments

8.14 External Adjustments

» To access this dialog, select "SGMA-GUI > Instrument Name > Service > External
Adjustments".

———— TCXO Adjustment ———

Active Adjustment Data

Factory -I

Catiration Value -J

L

Depending on the installed options, the R&S SGS is equipped with a TCXO or OCXO
reference oscillator. The reference oscillator is factory calibrated to a specific calibra-
tion value. The external adjustment dialog allows you to select a different (custom) cali-
bration value.

Active Adjustment Data
Selects whether the factory provided or a custom defined calibration value is used to
adjust the reference oscillator.

Remote command:
:CALibration<hw>:ROSCillator:DATA:MODE on page 162

Calibration Value
Sets a user definable calibration value.

The permanent storage of this value in the instrument's memory is a password protec-
ted function. The exact test procedure is described in the Service Manual (on CD
ROM, supplied with the instrument).

This parameter is restored to its permanently stored value by "Preset" and instrument
restart.

Remote command:
:CALibration<hw>:ROSCillator[:DATA] on page 162
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How to Generate an I/Q Modulated Signal

Performing Configuration Tasks

This section provides a general explanation on how to operate the instrument manually
via the R&S SGMA-GUI software.

We assume, that the R&S SGS is connected to a remote PC. The R&S SGMA-GUI
software has to be installed on this remote PC and the instrument has to be added to
the list of "Available Instruments".

@

For information on how to fulfill these requirements, refer to:
® chapter 2.3.2.1, "Connecting the Instrument to the Network", on page 22
® chapter 2.3.1, "Installing the R&S SGMA-GUI Software on an External PC",
on page 21
® chapter 2.3.2.3, "Automatically adding instruments to the SGMA-GUI ", on page 23

9.1

General Workflow
The general workflow for generating a signal with the R&S SGS comprises the follow-
ing main steps:
1. Decide whether a CW or an I/Q modulated signal will be generated.
See chapter 9.1, "How to Generate an I/Q Modulated Signal", on page 109.

2. Select the operating mode.
See chapter 9.3, "How to Enable a Baseband Bypass Mode", on page 113.

3. Configure the reference and local oscillator settings.
See chapter 9.4, "How to Configure the Reference Oscillator Source",
on page 114 and chapter 9.5, "How to Configure the Local Oscillator (LO) Cou-
pling Source", on page 115.

4. Adjust the frequency, level and I/Q settings, for example, to optimize performance
or to add impairments to the generated signal (see chapter 9.11, "How to Optimize
Performance", on page 120).

How to Generate an I/Q Modulated Signal

The instrument is manually operated via the R&S SGMA-GUI software.

The 1/Q Modulator requires the hardware option R&S SGS-B106V and for operation up
to 12.75 GHz additionally the hardware option R&S SGS-B112V.

An example of how to configure the instrument to generate a continuous wave (CW)
signal is provided in chapter 4, "First steps with the Instrument”, on page 31.



How to Generate an I/Q Modulated Signal

To generate an I/Q modulated signal

1. Connect the test equipment and provide the external analog signal to be modula-
ted at the | and Q connectors of the instrument.
The figure 9-1 shows an example of the test setup. A signal generator, e.g. R&S
AFQ100B is used as a source of the external analog signal. The R&S Signal Gen-
erator provides its internal reference signal to the R&S SGS and the connected sig-
nal analyzer, e.g. the R&S FSW.

— sl REF OUT
=iommi | LP PP
1OUT] laout

® ' * * 2 REF/LO IN
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Control =
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Fig. 9-1: Example of the setup

Tip: Refer to the Operating Manual of the R&S Signal Generator and the R&S Sig-
nal Analyzer for information on how to configure the corresponding instrument.

2. Select "SGMA-GUI main panel > Instrument Name > Reference Oscillator > Ext"
and adjust the settings as required.

3. Select "SGMA-GUI main panel > Instrument Name > Frequency/Phase > LO Cou-
pling Source > Int".
Tip:
For detailed description on how to select the reference frequency source and the
LO Coupling source, refer to:
e chapter 9.4, "How to Configure the Reference Oscillator Source", on page 114

and
e chapter 9.5, "How to Configure the Local Oscillator (LO) Coupling Source",

on page 115.
4. In the "Frequency/Phase" dialog, configure the frequency settings.

5. Select the "SGMA-GUI > Instrument Name > Level > RF Level > Level" and set the

RF Level.
In the same dialog, configure the further "Level" and "Power-On" settings.

6. Select the "SGMA-GUI main panel > Instrument Name > 1/Q settings > Analog
Impairments" and enable 1/Q impairments.



How to Generate 1/Q Signals with an R&S SGS and an R&S SGU Upconverter

In the "I/Q settings >General" dialog, set "State > On" to enable the I/Q modulator.

7. Select "SGMA-GUI main panel > RF > On" or press the RF ON key on the front
panel of the instrument.

The RF ON key is green.

The 1/Q modulated signal is output at the RF connector of the instrument.

If the R&S SGS is equiped with one of the options R&S SGS-B112/B112V, you can
connect an extension, an R&S SGU, to it and thus extend the frequency range of the
generated 1/Q signal to 40 GHz for instance.

Refer to chapter 9.2, "How to Generate 1/Q Signals with an R&S SGS and an R&S
SGU Upconverter", on page 111 for more information.

@ How to generate an I/Q modulated signal with higher RF?

9.2 How to Generate 1/Q Signals with an R&S SGS and an
R&S SGU Upconverter

6 Options R&S SGS-B112V and R&S SGU-B120V/-B140V are required for the 1/Q mod-
ulation.

To generate an I/Q modulated signal with higher frequency

In this example, the R&S SGU acts as an extension to the R&S SGS extending its fre-
quency range to 40 GHz.

The figure 9-2 shows an example of the test setup.



How to Generate 1/Q Signals with an R&S SGS and an R&S SGU Upconverter
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Fig. 9-2: Example of the test setup

@ For higher setting/ measuring speeds use a PCle switch and a PCle connections.

If a common reference frequency is required, use the internal reference signal of the
signal generator and provide it to the R&S SGS and the connected signal analyzer,
e.g. the R&S FSW.

1. Connect the test equipment as shown on figure 9-2:

a) Connect the R&S SGS, the R&S SGU and the controller to a LAN switch.

b) Connect the I/Q OUT of the base band signal source to the 1/Q IN of the R&S
SGU.

c) Connect the I/Q OUT of the R&S SGS to the | and Q connectors of the R&S
SGS.

d) Connect the RF OUT of the the R&S SGS to the LO IN of the R&S SGU.

e) Connect the TRIG connectors of the the R&S SGS and the R&S SGU.

f) Connect the RF OUT of the R&S SGU to the RF IN of the signal analyzer.

2. Select "SGMA-GUI main panel > R&S SGS > Extension".

Tip: Steps 3 to 5 can be omitted if the R&S SGS and a single R&S SGU are con-
nected using PCle or USB or by a direct LAN connection because the SGS will
automatically activate the SGU.

3. Press the ID key on the front panel of the R&S SGU (only required if the compo-
nents are connected via a company network).

4. In the "Extension" dialog, trigger "Scan".



How to Enable a Baseband Bypass Mode

Ths scan functions finds out the connected R&S SGU.

5. Select the R&S SGU from the list and set "Available Instruments > Select > On" to
enable it as an extension.

A green status indicator "Connected" indicates the successfully established remote
connection to the extension.

6. Select "Test Signal Connections > Test" to trigger a check of all required signal
connections.

Available Instruments ~

7 Test Signal Connections ~

Test

SGU

Loin  Trig

L Trig  SGS )

The diagram displays the connection state of the tested connections.

7. Select "SGMA-GUI > R&S SGS > Freq = 20 GHz", "Lev = -30 dBm" and enable
"RF > State > On".

The extension adopts these values and states automatically. Generated is an 1/Q
signal with RF = 20 GHz and Level = -30 dBm.

9.3 How to Enable a Baseband Bypass Mode

1. Provide an external analog signal at the | or Q connector or on both at the rear of
the instrument.
Refer to figure 5-8 for visualization of the signal flow.

2. Select "SGMA-GUI > Instrument Name > Operation Mode > Baseband Bypass".



How to Configure the Reference Oscillator Source

Some instrument's functions like Frequency and 1/Q settings are disabled.

3. Select "SGMA-GUI > Instrument Name > Level > RF Level" and adjust the level of
the output signal.

4. For the corresponding instrument, set "SGMA-GUI > RF > On" or press the RF ON
key on the front panel of the instrument to enable the output of the generated sig-
nal at the RF connector.

The RF ON key is green.

The fed signal is amplified with the selected value and output at the RF connector
of the instrument.

9.4 How to Configure the Reference Oscillator Source

To use the internal reference frequency source

1. To enable the instrument to use its internal reference frequency source, perform
one of the following:

a) Select "SGMA-GUI main panel > Ext Ref Off ".
b) Select "SGMA-GUI > Instrument Name > Reference Oscillator > Source > Int".

2. In the "Reference Oscillator" dialog, set the "REF/LO Out > REF".
The "Output Frequency" can be configured to either 10 MHz or 1 GHz.

The instrument uses the internal reference signal. The REF EXT LED at the front
panel of the instrument is off.

To output the reference frequency (internal or external) at the REF/LO OUT connector
of the instrument, select "Reference Oscillator > REF/LO Output > REF".

To use an external reference frequency source

To improve measurement accuracy, it is advisable to provide an external reference fre-
quency to all of the instruments in the test setup or to distribute the internal reference
signal of the signal generator to the remaining instruments.

1. Provide the signal of an external reference frequency source to the REF/LO IN
connector of the instrument.

2. To enable the instrument to use the external reference frequency source, perform
one of the following:

a) Select "SGMA-GUI main panel > REF > Ext Ref On ".
b) Select "SGMA-GUI > Instrument Name > Reference Oscillator > Source > Ext".



How to Configure the Local Oscillator (LO) Coupling Source

3. Inthe "Reference Oscillator" dialog, set the parameter "Ext. Ref. Input Frequency"
to the value of the fed external reference frequency.

Now, the instrument uses an external reference signal. The green REF EXT LED
at the front panel of the instrument indicates that the instrument is synchronized to
the external reference signal.

If the instrument is configured to use an external reference signal but no signal is fed in
at the REF/LO IN connector, the REF EXT LED on the front panel of the instrument is
red and an error message is displayed in the "Info" line.

9.5

How to Configure the Local Oscillator (LO) Coupling
Source

The R&S SGS can use two frequency sources for the carrier frequency (LO Signal) of
the I/Q modulator, an internal and an external one. The first possibility is to use the out-
put signal of the internal synthesizer. If an external LO signal is provided at the
REF/LO IN connector, this signal can alternatively be directly routed to the LO input of
the I/Q modulator.

To use an external LO source
1. Provide the signal of an external LO source to the REF/LO IN connector of the
instrument.

Note: The Local Oscillator input/output requires the additional software option
R&S SGS-K90.

2. Select "SGMA-GUI > Instrument Name > Frequency/Phase > LO Coupling Source
> Ext".

Tip: When you select "Source > Ext" the icon @ appears in the R&S SGMA-GUI
next to the instrument's name.

oo sos

The signal provided by the external frequency source is directly routed to the input
of the I/Q modulator and used as carrier frequency.
To use the internal LO source

» Select "SGMA-GUI > Instrument Name > Frequency/Phase > LO Coupling Source
> Int".

The output signal of the internal synthesizer is used.
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9.6 How to Define the Signal at the REF/LO OUT Connec-
tor

The Ref. Oscillator and the LO use the same REF/LO IN connector. Hence, it is not
possible to use both an external reference source and an external LO source signal at
the same time.

The signal at the REF/LO OUT connector also depends on the selected Reference
Oscillator and LO sources. The following table gives an overview of this dependency.

Table 9-1: Selection available at the REF/LO OUT connector depending on the LO and Reference

Oscillator Sources
LO Coupling Source
Ref. Oscillator Source Int Ext
Int "OFF/REF/LO" "OFF/LO"
Ext "OFF/REF/LO" Combination not possible

To define the signal at the REF/LO OUT connector

1. In the "Frequency / Phase > Local Oscillator (LO) Coupling" dialog, select the "LO
Source" as required.

2. In the "Reference Oscillator" dialog, select the "Ref. Oscillator Source" as required.

3. Inthe "Frequency / Phase > Local Oscillator (LO) Coupling" dialog, set the REF/LO
Output.
Consider the dependencies, see table 9-1.

9.7 How to Connect and Configure Instruments for Opti-
mum Phase Coherence

Using the LO input/output connectors, two or more instruments can be coupled to ach-
ieve optimum phase coherence between their RF output signals. The first instrument in
the chain delivers the LO signal at the REF/LO OUT connector to the REF/LO IN con-
nector of second instrument. If required, more instruments can be connected in the
same way. The first instrument is set such that the internal synthesizer generates the
system LO frequency. In all following instruments, the internal synthesizer is switched
off and the LO signal from the REF/LO IN connector drives the 1/Q modulator or the
CW path.

To connect the instruments

1. Connect the instruments as a daisy chain (see figure 9-3), i.e. connect the REF/LO
IN connector of each further instrument to the REF/LO OUT connector of the previ-
ous one.

2. Optionally, provide an external reference signal for the first instrument.

HE
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How to Restore the LAN Connection to an Instrument

3. Avoid unnecessary cable lengths and branching points.

Refer to figure 9-3 for an example of how to connect two instruments for achieving
phase coherence. The configuration can be extended by further instruments.

R&S SGS#1 rear panel R&S SGS#2 rear panel

r

* |[EREF/LO OUT

=i

PR i

Reference

Ext. Ref. Source —
Frequency Lo Signalbh
Local Oscillator Signall for further
instruments

Fig. 9-3: Example of setup: LO Coupling

To configure the first instrument in the chain

1. In the "Frequency / Phase > Local Oscillator (LO) Coupling" dialog, select "LO
Source > Internal”.

2. Inthe "Frequency / Phase > Local Oscillator (LO) Coupling" dialog, select "REF/LO
Output > LO".

3. If an external reference frequency is used, select "SGMA-GUI > Instrument Name
> Reference Oscillator > Source > External”.
To configure the following instrument(s)

1. Inthe "Frequency / Phase > Local Oscillator (LO) Coupling" dialog, select "LO
Source > External".

2. Inthe "Frequency / Phase > Local Oscillator (LO) Coupling" dialog, select "REF/LO
Output > LO".

9.8 How to Restore the LAN Connection to an Instrument

» If the LAN connection to an instrument configured to use a static IP address is lost,
press the LAN LED on the instrument's front panel for more than 3 seconds to
reset the LAN settings and to set the "Address Mode" on page 103 to DHCP.

Provided the network supports automatic assignment of IP address, new IP
address will be automatically assigned to the instrument.



How to Switch Between the Operating States

9.9 How to Switch Between the Operating States

The figure 9-4 gives an overview of the operating states of the instruments and how to
trigger the switch-over between them.

:RESTart
.Setup > Restart"

.oetup > Standby*
L~Shut Down Instruments and Exit*
POWER ON/STANDBY

Booting

:RESTart
POWER ON/STANDBY

Standby

POWER SWITCH OFF

OWER SWITCH ON

Fig. 9-4: Operating states

:RESTart, :STANdby = SCPI commands

"Setup > Standby", "Setup > Restart", "Shut Down Instru- = R&S SGMA-GUI controls

ments and Exit"

POWER ON/STANDBY, POWER SWITCH ON/OFF = Hardkey controls on the front/rear panel of the
instrument

The table 9-2 provides a short description of the operating states and their indication.

Table 9-2: Indication of the operating states

Operating | Description Indication

State

Off The instrument is shut down. All LEDs on the front panel of the instrument
are off.

Booting The instrument boots the operating system | The green POWER ON /STAND BY key blinks.
and starts the instrument firmware.
If the previous session was terminated reg-

ularly, the instrument uses the last setup
with the relevant instrument settings.
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Operating | Description Indication
State

Standby The standby power mode keeps the power | In the R&S SGMA-GUI, the status indicator in
switch circuits and the remote control sys- front of the instrument name is red.

tem active. The orange POWER ON /STAND BY key is
In this state it is safe to switch off the AC on.

power and disconnect the instrument from
the power supply.

Ready The instrument is ready for operation. All In the R&S SGMA-GUI, the status indicator in
(normal modules are power-supplied. front of the instrument name is green.
operation) The green POWER ON /STAND BY key is on.

To switch the instrument to standby state

> To switch the instrument to the standby state, use one of the following:

a) On the remote PC, select "SGMA-GUI > Instrument Name > Setup > Standby".
b) Press the POWER ON/STANDBY key on the front panel of the instrument.
c) Send the SCPI command : STANdby.

The current instruments settings are automatically stored. The instrument switches
to a power saving mode.

In the R&S SGMA-GUI, the standby state is indicated by the red state symbol in
front of the corresponding instrument's name, on the front panel, by the orange
POWER ON/STANDBY button.

The instrument can still be remote controlled.

To return the instrument from standby to ready state

» To switch from standby to ready state, use one of the following:

a) On the remote PC, select "SGMA-GUI > Instrument Name > Setup >Restart".

b) Press the orange POWER ON/STANDBY key on the front panel of the instru-
ment.

c) Send the SCPl command :RESTart.

The instrument loads the last setup with all instrument settings, switches to ready
state and is ready for normal operation.

In the R&S SGMA-GUI, the ready state is indicated by the green state symbol in
front of the corresponding instrument's name, on the front panel, by the green
POWER ON /STAND BY button.

To switch all connected instruments to standby state and close the R&S SGMA-
GUI

» In the R&S SGMA-GUI main panel, select "File > Shut down instruments and exit".

The R&S SGMA-GUI quits and switches the connected instruments to standby
state.



How to Use Computer Names

@

For description on how to terminate work and shut down the instrument regularly, refer
to chapter 2.1.5, "Switching the Instrument On and Off", on page 17.

9.10

How to Use Computer Names

Provided that there is a name server in the network, alternatively to the IP address
each PC or instrument connected in a LAN can be accessed via an unambiguous com-
puter name. Each instrument is delivered with an assigned computer name, but this
name can be changed.

For instruction on how to find out the default computer name, refer to chapter 6.4.3,
"Finding Out the Default Hostname of the Instrument”, on page 61.

To query and change a computer name

To avoid violations and to make use of the easy identification provided by the computer
name, it is recommended to keep the default hosthame unchanged.

9.11

1. Open "SGMA-GUI > Instrument Name > Setup > Network Settings" dialog.
The computer name is displayed under "Hostname".

2. Select "SGMA-GUI > Instrument Name > Setup > Protection" and enable the "Pro-
tection Level 1".
The parameter "Hostname" in the "Network Settings" dialog is now enabled for
configuration.

3. Change the "Hostname".

4. Press the POWER ON /STAND BY key to restart the instrument.

Note: The "Factory Preset" function restores the factory value of the parameter
"Hostname"!

How to Optimize Performance

In its (factory) preset state, the instrument uses predefined frequency and level setting
designed for best performance. The predefined settings, e.g. the Level modes "Auto"
and "Normal" or the use of calibrated value of the internal reference signal, ensure that
the instrument automatically selects the optimal settings depending on the configured
RF frequency and level.

However, in some special application cases it might be necessary to choose different
settings or to optimize the signal for the particular application. This section describes
instructions on how to achieve this.



How to Install a new Firmware Version on the Instrument

Restoring the default settings

Use the "R&S SGMA-GUI main panel > Instrument name > Preset" or the "R&S
SGMA-GUI main panel > Instrument name > Setup > Factory Preset" function to return
the instrument to its predefined state.

For information on how to adjust the quality characteristics of the RF output signal, i.e.
to optimize the quality characteristics of RF output signal, like improving the harmonic
distortion or improving the wideband noise, refer to chapter 7.5, "Level and Power-On
Settings", on page 71.

For information on how to adjust the reference oscillator, e.g. to allow the frequency of
the internal reference oscillator to be impaired for example to simulate a frequency
error or to adjust the bandwidth of an external reference oscillator, refer to chapter 7.4,
"Reference Oscillator", on page 69.

9.12 How to Install a new Firmware Version on the Instru-
ment

You can update the firmware of the R&S SGS .

Firmware Installation through the R&S SGMA-GUI

instrument, it is mandatory that the new instrument's firmware is installed prior to the

6 If an update to a new firmware version is required for both the R&S SGMA-GUI and the
update of the R&S SGMA-GUI to the new version.

1. Select "SGMA-GUI main panel > Instrument Name > Setup > Maintenance > Oper-
ation > Install firmware package".

2. Press "Select Package" and navigate to the directory the new firmware is stored in.

3. If several instruments have to be updated to new firmware version, enable the fea-
ture "Update All " to accelerate the update process.
All instruments that are in active state and are connected to this controller are
updated simultaneously.

4. Enter the "Security Password".

5. Confirm the update with "Accept".

The software transfers the firmware file and automatically starts the update proce-
dure. During the update, the message "Updating Firmware" is displayed in the Info
line. The update process is indicated by an LED running light.

Note: The update procedure requires a restart of the instrument. The restart is per-
formed automatically. The instrument is not accessible during that time.
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6. Wait until the message "Updating Firmware" disappears and the update is comple-
ted.

The green POWER ON /STAND BY LED is on.

Tip: Calibration Error. If the Info line shows the message "Calibration Error", select
"SGMA-GUI main panel > Instrument Name > Setup > Internal Adjustments >
Adjust All" to trigger internal adjustment.

7. Ifrequired, install the new R&S SGMA-GUI.
For detailed description, refer to chapter 2.3.1, "Installing the R&S SGMA-GUI Soft-
ware on an External PC", on page 21

8. If the instrument and the controller/PC are connected over the PCle interface and
the external PC does not support hot-plugging, it is required to restart the external
PC.

Firmware Update through a Session Control Protocol (SCP)

instrument, it is mandatory that the new instrument's firmware is installed prior to the

6 If an update to a new firmware version is required for both the R&S SGMA-GUI and the
update of the R&S SGMA-GUI to the new version.

1. Connect the R&S SGS and a Windows PC to the same network.
2. On the PC open a windows explorer window.

3. To connect to the R&S SGS enter the name of the instrument or its IP address in
the windows taskbar.

4. Enter the user name and password to connect to the R&S SGS. The default user
name is instrument and the password is instrument.

A folder opens, containing the share and the update folder.
5. Open the update folder and copy the new firmware update file in it.

The update starts automatically.

@ Unsuccessful or Erroneous Firmware Update

An erroneous or unsuccessful installation of firmware update package is indicated by a
combination of red and one orange LEDs on the front panel.

Refer to the Service Manual for a description of the displayed error code or contact the
customer support center. The description and the official company contact addresses
are provided on the CD included in the delivery.
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9.13 How to Activate Options

A firmware update prior to the activation of the SW option may be required.
Refer to the description of the SW option for the required firmware version!

See also chapter 9.12, "How to Install a new Firmware Version on the Instrument”,
on page 121 for instruction on how to update the firmware version.

1. Select "SGMA-GUI main panel > Instrument Name > Setup > Install SW-Options".
2. Select "Option Key" and enter the key code delivered with the new option.

The new option is now enabled and ready for operation.

9.14 How to Manually Set a PCle Direct Connection
between an R&S SGS and an R&S SGU

To build a direct PCle connection between an R&S SGU and an R&S SGS, which has
a "Controller > Revision" < 5, first you have to manually set the correct PCle interface
mode. If your R&S SGS has a "Controller > Revision" 5 or higher, this settings are
done automatically.

You can check the "Controller > Revision" of your instrument in the "SGMA-GUI >
Instrument Name > Hardware Config" dialog.

To manually set a PCle direct connection between an R&S SGS and an R&S SGU

1. Connect the R&S SGS and the R&S SGU directly using a PCle cable. Refer to
chapter 10.3.3, "Connecting the Controller and the Instrument", on page 137 for
cable requirements and setup information.

Switch on the R&S SGS and the R&S SGU.
Select "SGMA-GUI main panel > Instrument Name > Setup > Maintainance".
Select "Operation > PCle Interface Mode".

Select "PCle Interface Mode > Root Complex".

o a &~ w N

Restart your instrument for the changes to take place.

The PCle connection between the R&S SGS and the R&S SGU is establihed and
the instruments can be used.
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10 Network and Remote Control Operation

As an alternative to operating the R&S SGS interactively via the R&S SGMA-GUI, one
can also controll the R&S SGS using programmed commands from a remote PC.

The description in this section requires basic knowledge of the remote control opera-
tion. Definitions specified in the SCPI standard are not provided.

i

Nevertheless, you will find some basic information to the SCPI syntax, command lists,

and general programming recommendations in chapter 14.1, "Remote Control Basics",
on page 231. In addition, this chapter provides information on the status reporting sys-
tem of the instrument.

10.1 Remote Control Interfaces and Protocols

The instrument supports several interfaces for remote control. The following table gives
an overview.

Table 10-1: Remote control interfaces and protocols

Interface | Protocols, VISA" address string and Library Remarks
Local Area | ®  HiSLIP High-Speed LAN Instrument Protocol A LAN connector is located on the
Network (IVI-6.1) rear panel of the instrument.
TCPIP::host add ::thislipOJ[::
(LAN) INSTR] oSt adaress tslip0l The interface is based on TCP/IP and
o VXI-11 supports various protocols.
TCPIP::host address::inst0[::INSTR] | For details see chapter 10.1.2, "LAN
Library: VISA Interface”, on page 127
® socket communication (Raw Ethernet, simple
Telnet)
TCPIP::host address](::
LAN device name]::<port>::SOCKET
Library: VISA or socketcontroller
USB USBTMC A USB connector is located on the
USB: :<vendor ID>::<product ID>:: rear panel of the instrument.
<serial number>[::INSTR] For details see chapter 10.1.3, "USB
Library: VISA Interface”, on page 130
PCle Proprietary A PCle connector is located on the
PCIe::<vendor ID>::<product ID>:: rear panel of the instrument.
<serial number>[::INSTR] For details see chapter 10.1.4, "PCI
Library: pciecontroller Express Interface", on page 131

) VISA is a standardized software interface library providing input and output functions
to communicate with instruments. A VISA installation on the controller is a prerequisite
for remote control over LAN (when using VXI-11 or HiSLIP protocol) or USB. However,
no VISA installation is necessary for remote control while using socket communication.
For more information about VISA refer to the user documentation.
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For information on how to query the VISA resource strings, see chapter 8.9, "Remote
Channels", on page 104.

SCPI (Standard Commands for Programmable Instruments)

SCPI commands are used for remote control. Commands that are not taken from the
SCPI standard follow the SCPI syntax rules. The instrument supports the SCPI version
1999. The SCPI standard is based on standard IEEE 488.2 and aims at the standardi-
zation of device-specific commands, error handling and the status registers. The tuto-
rial "Automatic Measurement Control - A tutorial on SCPI and IEEE 488.2" from John
M. Pieper (R&S order number 0002.3536.00) offers detailed information on concepts
and definitions of SCPI.

10.1.1 Remote Control Programs and Libraries

The figure 10-1 provides a schematic illustration of the remote control capabilities of
the instrument.

Protocol Proprietary VXI-11 HiSLIP USBTMC
Library e g VISA
controller controller

Instrument Driver

Application Program

Fig. 10-1: Remote control interfaces, protocols and libraries

The following examples give an overview of the dependencies between the available
libraries, the possible interfaces and protocols, and whether an instrument driver is pro-
vided. The involved parts are highlighted.

® Remote control program using VISA
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Interface LAN m
Protocol VXI-11 HiSLIP USBTMC
Library VISA

Application Program

Fig. 10-2: Remote control program using VISA

Protocol Remote Control Program

Socket viOpen (..., "TCPIP:rssgsl00al00010::5025::SOCKET", ...)
viPrintf (..., "SOUR:FREQ 2GHz\n")

VXI-11 viOpen (..., "TCPIP:rssgsl00al100010::instO::INSTR", ...)
viPrintf (..., "SOUR:FREQ 2GHz\n")

HiSLIP viOpen (..., "TCPIP:rssgsl100al00010::hislip0O::INSTR", ...)
viPrintf (..., "SOUR:FREQ 2GHz\n")

USBTMC viOpen (..., "USB::0x0aad::0x0088::1000010::INSTR", ...)
viPrintf (..., "SOUR:FREQ 2GHz\n")

® Remote control program using instrument driver (VISA available)

Interface LAN

Protocol Proprietary m VXI-11 HiSLIP USBTMC
Library peie- VISA
controller

Instrument Driver

Application Program

Fig. 10-3: Remote control program using instrument driver (VISA available)
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Protocol Remote Control Program

Socket rssgs_init ("TCPIP:rssgsl100al100010::5025::SOCKET", ...)
rssgs_SetFrequency (..., 2e9)

VXI-11 rssgs_init ("TCPIP:rssgs100al00010::inst0::INSTR", ...)
rssgs_SetFrequency (..., 2e9)

HiSLIP rssgs_init ("TCPIP:rssgs100al00010::hislip0O::INSTR", ...)
rssgs_SetFrequency (..., 2e9)

USBTMC rssgs_init ("USB::0x0aad::0x0088::1000010::INSTR", ...)
rssgs_SetFrequency (..., 2e9)

PCle rssgs_init ("PCIe::0x162f::0x132e::1000010::INSTR", ...)
rssgs_SetFrequency (..., 2e9)

® Remote control program using instrument driver (VISA not available)

Protocol Proprietary m
. pcie- socket-

Instrument Driver

Application Program

Fig. 10-4: Remote control program using instrument driver (VISA not available)

Protocol Remote Control Program

Socket rssgs_init ("TCPIP:rssgsl100al100010::5025::SOCKET", ...)
rssgs_SetFrequency (..., 2e9)

PCle rssgs_init ("PCIe::0x162f::0x132e::1000010::INSTR", ...)
rssgs_SetFrequency (..., 2e9)

10.1.2 LAN Interface

To be integrated in a LAN, the instrument is equipped with a LAN interface, consisting
of a connector, a network interface card and protocols.

For remote control via a network, the PC and the instrument must be connected via the
LAN interface to a common network with TCP/IP network protocol. They are connected
using an RJ45 cable (shielded or unshielded twisted pair category 5). The TCP/IP net-
work protocol and the associated network services are preconfigured on the instru-
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ment. Software for instrument control and (for specified protocols only) the VISA pro-
gram library must be installed on the controller.

Identifying instruments in a network

If several instruments are connected to the network, each instrument has its own IP
address and associated resource string. The controller identifies these instruments by
means of the resource string.

10.1.2.1 VISA Resource Strings

The VISA resource string is required to establish a communication session between
the controller and the instrument in a LAN. The resource string is a unique identifier,
composed of the specific IP address of the instrument and some network and VISA
specific keywords.

TCPIP::host address[::LAN device name] [::INSTR]

® TCPIP designates the network protocol used

® host address is the IP address or host name of the device
See also chapter 6.4.3, "Finding Out the Default Hostname of the Instrument”,
on page 61.

® [::LAN device name] defines the protocol and the instance number of a sub-
instrument:

® [::INSTR] indicates the instrument resource class (optional)

The IP address (host address/computer name) is used by the programs to identify and
control the instrument. It is automatically assigned by the DHCP server the first time
the device is registered on the network. Alternatively, you can also assign its LAN
device name.

You can find the IP address in the "SGMA-GUI > Instrument Name > Setup > Remote"
dialog, and also adjust it manually, if required.

See below the characteristics of the VISA resource strings for the corresponding inter-
face protocols. The highlighted characters are crucial.
HiSLIP

TCPIP::host address::hislipO[::INSTR]

® hislip0 HiSLIP device name, designates that the interface protocol HiSLIP is used
(mandatory)

hislip0 is composed of [::HiSLIP device name[,HiSLIP port]] and must be assigned.
For details of the HiSLIP protocol, refer to chapter 10.1.2.2, "HiSLIP Protocol",

on page 129.
VXI-11
TCPIP::host address[::inst0] [::INSTR]

® [::inst0] LAN device name, indicates that the VXI-11 protocol is used (optional)
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inst0 currently selects the VXI-11 protocol by default and can be omitted.

For details of the VXI-11 protocol, refer to .chapter 10.1.2.3, "VXI-11 Protocol",
on page 130

Socket Communication

TCPIP::host address::port::SOCKET

® port determines the used port number

® SOCKET indicates the raw network socket resource class

Socket communication requires the specification of the port (commonly referred to as

port number) and of "SOCKET" to complete the VISA resource string with the associ-
ated protocol used.

The registered port for socket communication is port 5025.

See also chapter 10.1.2.4, "Socket Communication", on page 130.

Example:

® |Instrument has the IP address 70.773.11.97; the valid resource string using VXI-11
protocol is:
TCPIP::10.113.11.91::INSTR

® The DNS host name name is rssgs100a100021; the valid resource string is:
TCPIP::rssgsl100a100021::hislip0 (HiSLIP)
TCPIP::rssgsl00a100021::inst0 (VXI-11)

® A raw socket connection can be established using:
TCPIP::10.113.11.91::5025::SOCKET

10.1.2.2 HiSLIP Protocol

The HiSLIP (High Speed LAN Instrument Protocol) is the successor protocol for
VXI-11 for TCP-based instruments specified by the IVl foundation. The protocol uses
two TCP sockets for a single connection - one for fast data transfer, the other for non-
sequential control commands (e.g. Device Clear or SRQ).

HiSLIP has the following characteristics:

® High performance as with raw socket network connections

® Compatible IEEE 488.2 support for Message Exchange Protocol, Device Clear,
Serial Poll, Remote/Local, Trigger, and Service Request

® Uses a single IANA registered port (4880), which simplifies the configuration of fire-
walls

® Supports simultaneous access of multiple users by providing versatile locking
mechanisms

® Usable for IPv6 or IPv4 networks
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i

Note that HiSLIP data is sent to the device using the "fire and forget” method with
immediate return, as opposed to VXI-11, where each operation is blocked until a
VXI-11 device handshake returns. Thus, a successful return of a VISA operation such
as viWrite () does not guarantee that the instrument has finished or started the
requested command, but is delivered to the TCP/IP buffers.

10.1.2.3

10.1.2.4

10.1.3

For more information see also the application note: 1MA208: Fast Remote Instrument
Control with HiSLIP.

VXI-11 Protocol

The VXI-11 standard is based on the ONC RPC (Open Network Computing Remote
Procedure Call) protocol which in turn relies on TCP/IP as the network/transport layer.
The TCP/IP network protocol and the associated network services are preconfigured.
TCP/IP ensures connection-oriented communication, where the order of the
exchanged messages is adhered to and interrupted links are identified. With this proto-
col, messages cannot be lost.

Socket Communication

An alternative way for remote control of the software is to establish a simple network
communication using sockets. The socket communication, also referred to as “Raw
Ethernet communication”, does not necessary require a VISA installation on the
remote controller side.

The simplest way to establish socket communication is to use the built-in telnet pro-
gram. The telnet program is part of every operating system and supports communica-
tion with the software on a command-by-command basis.

Socket connections are established on a specially defined port. The socket address is
a combination of the IP address or the host name of the instrument and the number of
the port configured for remote-control. All instruments use port number 5025 for this
purpose. The port is configured for communication on a command-to-command basis
and for remote control from a program running on a connected PC.

USB Interface

For remote control via USB connection, the PC and the instrument must be connected
via the USB interface. A USB connection requires the VISA library to be installed. VISA
detects and configures the R&S instrument automatically when the USB connection is
established. You do not have to install a separate driver.

USB Resource String

The syntax of the used USB resource string is:

USB: :<vendor ID>::<product ID>::<serial number>[::INSTR], where:
® USB denotes the used interface

e <vendor ID> is the manufacturer ID for Rohde&Schwarz
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e <product ID> is the product identification of the R&S instrument
® <serial number> is the individual serial number on the rear of the instrument
® [::INSTR] indicates the instrument resource class (optional)

You can retreive the USB resource string from the "SGMA-GUI > Instrument Name >
Setup > Remote" dialog.

Example:
USB::0x0AAD::0x0088::100021::INSTR
0x0AAD is the vendor ID for Rohde&Schwarz

0x0088 is the product ID for the R&S SGS

100021 is the serial number of the particular instrument

10.1.4 PCI Express Interface

A PCI Express (PCle) connector is provided on the rear panel of the instrument.

Refer to chapter 10.3, "Advanced Remote Control Using PCle", on page 134 for a
description of how to set up a remote control connection via PCle and the permitted
cables.

Via PCI Express some commands can be sent to the instrument with optimized speed
(memory-mapped remote control), e.g. frequency or level settings. This allows mini-
mum setup time.

PCle Resource String

The syntax of the used PCle resource string is:

PCIe::<vendor ID>::<product ID>::<serial number>[::INSTR], where:
® PCle denotes the used interface

e <vendor ID> is the manufacturer ID for Rohde&Schwarz

e <product ID> is the product identification of the R&S instrument

® <serial number> is the individual serial number on the rear of the instrument

[::INSTR] indicates the instrument resource class (optional)

You can retreive the PCle resource string from the "SGMA-GUI > Instrument Name >
Setup > Remote" dialog.

Example:
PCIe::0x162f::0x132e::100021::INSTR
0x162f is the vendor ID for Rohde&Schwarz

0x132e is the product ID for the R&S SGS

100021 is the serial number of the particular instrument
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10.2 Starting a Remote Control Session

The instrument and the controller have to be connected with a suitable cable and
switched on.

A remote control program must open a connection to the instrument, before it can send
commands to and receive device responses from the instrument.

Instrument Address
In order to operate the instrument via remote control it must be addressed using the
defined interface address.

See chapter 10.1.2, "LAN Interface", on page 127, chapter 10.1.3, "USB Interface",
on page 130 or chapter 10.1.4, "PCI Express Interface", on page 131 for details.

The VISA resource strings are indicated in the "SGMA-GUI main panel > Instrument
name > Setup > Remote Channels" dialog.

10.2.1 How to Find the VISA Resource String

To find the VISA resource strings of your instrument:

» Select "SGMA-GUI main panel > Instrument name > Setup > Remote Channels".

r Visa Resource Strings

&=
wr
=
=

Device Identify

The "Remote Channel Settings" dialog shows all specified resource strings of the
supported remote control interfaces.
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10.2.2 Example: Remote Control over LAN using Socket Communication

This section provides an example on how to establish a remote control connection over
telnet protocol and a simple sockets-based program example that can be further devel-
oped (see also chapter 14.2, "Telnet program examples", on page 252).

Basic knowledge of programming and operation of the controller are assumed. A
description of the interface commands can be obtained from the relevant manuals.

Refer to the Getting Started manual for an example on how to set up remote control
connection over LAN using VXI-11 protocol.

To set up a Telnet connection

To control the software, only a telnet program is required. The telnet program is part of
every operating system.

1. To establish a Telnet connection with the R&S SGS, start the telnet program and
enter the socket address.
The socket address is a combination of the IP address or the host name of the
R&S SGS and the number of the port configured for remote-control via telnet.
Tip: The R&S SGS uses the port number 5025 for remote connection via Telnet.

=7 Run @

= Type the name of a program, folder, document, or Internet
resource, and Windows will open it for you.

Open: telnet 10.11311.91 5025 -

| ok || cence || Browse. |

The connection to the instrument is set up and remote-control commands can be
sent.

o Telnet 10.113.11.91

2. Even if the cursor is not visible on the screen, enter blind a remote-control com-
mand and confirm with Enter.

e
User Manual 1173.9105.02 — 10 133
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c® Telnet 10.113.11.91

10.3 Advanced Remote Control Using PCle

The PCle bus is a high-speed serial bus, composed of point-to-point serial links. A pair
of serial links, one transmitting and one receiving link, make up a lane.

Fast Settings

The PCle interface can be utilized not only to transfer text messages e.g. SCPI com-
mands but also to carry register based remote control messages. The latter mode is
called fast settings mode. The specially for this purposes provided instrument's driver
is mandatory for the instrument control by means of fast settings. This instrument
driver contains special functions for fast setup.

® Using the PCle interface is mandatory (see also chapter 10.3.1, "Setting Up a
Remote Control Connection via PCle", on page 134)

To use the advantage of the fast settings, the following prerequisites must be fulfilled:

® The fast settings must be enabled by means of the function
rssgs_useFastSettings (see also chapter 10.3.4, "Enabling Fast Settings”,
on page 138).

The instrument driver will automatically use the fast settings method whenever possi-
ble - currently only for the parameters frequency, level, RF state, modulator state - and
will send SCPI messages in all other cases.

Remote control programs written for PCle will, without modifications, also run if one of
the other control channels, LAN or USB is used.

10.3.1 Setting Up a Remote Control Connection via PCle

To set up a remote control connection vie PCle, perform the following steps:
1. Configure the controller, see 10.3.2

2. Connect the controller and the instrument, see 10.3.3

|
User Manual 1173.9105.02 — 10 134
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Advanced Remote Control Using PCle
3. Enable fast settings, see 10.3.4.
Configuring the Controller

This section focuses on the steps necessary to configure a controller with Linux or
Windows operating system.

@

The necessary files are provided on the CD, included in the delivery. The files are
stored in folder /software.

Contents of folder /software

® TInstrumentDriver
C source code files which provide a functional application programming interface
(API) to R&S SGS instruments. Required if you want to control an instrument via
PCle.

® TLinuxKernelDriver
€ source code files from which you can build a Linux kernel mode driver for the
R&S SGS PCle remote control interface.

e SGMA-GUI
Graphical user interface program for one or more instruments. Runs on a remote
PC.

® SgsDriverDemo
C source code module for a demo program using the instrument driver API.

® SharedLibraries-Dlls

Shared libraries (DlIs) for remote control channels Socket and PCle. To be used
with the instrument driver.

10.3.2.1

Building and Installing the Hardware Driver

The hardware driver defines the way to communicate with the instrument via PCle
interface.

For Windows operating systems, the hardware driver is installed automatically together
with the installation of the R&S SGMA-GUI software.

See also section "Installation of R&S SGMA-GUI Software" in the Getting Started man-
ual.

For Linux operating system, the source code of the driver is provided on the CD, inclu-
ded in the delivery.

In order to build and install this driver, root authority is required.

1. Copy folder LinuxKernelDriver to your hdd

2. Go to directory host.



Advanced Remote Control Using PCle

3. On the command line enter make.
The driver sgshost. ko is automatically built.
4. Entermake install.

Device nodes sgsX are created under the folder /dev (X from 0 to 31).
The module sgshost is loaded.

5. Enter 1smod to verify the module.

10.3.2.2 Making Shared Libraries Accessible

Two library files per operating system are provided on the CD included in the delivery:

e for Linux operating system
libsocketcontroller.so and libpciecontroller.so

® for Windows operating system
SocketController.dll and PCIeController.dll

These libraries act as the dynamic link libraries for programs using the socket or PCle
interface.

Linux operating system

» To make the libraries accessible, perform one of the following:
a) Append the environment variable LD_LIBRARY_PATH with the path of these
two files e.g. by changing the /etc/environment file.
b) Move these two files to /usr/1ib or /1ib directory.
Windows operating system

» To make the libraries accessible, perform one of the following:

a) Copy these two files to the folder of your executable.
b) Copy these two files to the WINDOWS\ system32 folder.

10.3.2.3 Building a Program

The help file rssgs_vxi.chm shows all functions of the instrument which you can use
in your own remote control program.

Additionally, an example file is provided ( SgsDriverDemo. c).

Building the example program (Linux)
1. Copy folders InstrumentDriver and SgsDriverDemo to your hard disk.
2. Go to folder Build

3. On the command line enter cmake ..
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4. Enter make

Folder Build should now contain the executable SgsDriverDemo.

Building the example program (Windows)

1. Copy folders InstrumentDriver and SgsDriverDemo to your hard disk.
2. Open sgsDriverDemo.vcproj with Visual Studio.

3. Build the program.

Running the example program
» On the command line enter . /SgsDriverDemo RESOURCESTRING [cmd].

Where

e RESOURCESTRING is the (Visa) resource string of your instrument, e.g.
TCPIP::ipaddress::5025::SOCKET or PCIE: : 0x162f::
Ox132e::serialno: : INSTR.

Where ipaddress is the IP address or hostname of your instrument and
serialno is its serial number.

e cmd is an optional command (see table).

The following table list the available commands.

Command Description

? Usage

a Quit

f value Set frequency

£? Query frequency

1 value Set level

1? Query level

r value Set RF state (value = 0,1,0N,OFF)
r? Query RF state

If you enter an additional optional command SgsDriverDemo will execute it and
enter a loop waiting for further commands.

Example:
TCPIP::10.111.11.44::5025::SOCKET *?

Lists the available commands.

10.3.3 Connecting the Controller and the Instrument

A PCle connector is provided on the rear panel of the instrument.
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Risk of device failure
The R&S SGS is equipped with a single lane PCle interface that supports hot plugging.

Do not connect an external PC to the PCle connector of the instrument during opera-
tion if this external PC does not support hot-plugging!

Permitted PCle cables
PCle extension cables must fulfill the following requirements:

® single lane connectors

® max. cable length of 5 m.

For example: OSS-PCle-CBL-x1 cable from One Stop Systems or 74576-000x cable
from Molex.

Connecting an external PC that does not support hot-plugging

1. Switch off the external PC and the instrument.
See also chapter 2.1.5, "Switching the Instrument On and Off", on page 17.

2. Connect the instrument and the controller with the suitable cable.
3. Switch on the instrument.

4. Wait until the instrument has completed the booting (the "POWER" LED on the
instrument's front panel is constantly on).

5. Switch on the external PC.

10.3.4 Enabling Fast Settings

» To enable the special PCl express feature fast settings, enable the function
rssgs_UseFastSettings (ViSession instrumentHandle, ViBoolean
fastEnabled, ViBoolean asynchronousEnabled) included in the instru-
ment driver.

Settings for some parameters like level and frequency will accelerate.

To disable the fast settings, call the function rssgs UseFastSettings with argu-
ment fastEnabled=false.
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10.4 Advanced Remote Control Using Fast Socket

Fast Settings

The Socket interface can be utilized not only to transfer text messages e.g. SCPI com-
mands but also to carry register based remote control messages. The latter mode is
called fast settings mode. The Fast Socket communication is based on the Ethernet
protocol which does not support routing. Therefore a controller PC can only control
devices within its own network segment using the Fast Socket method.

To use the advantage of the fast settings, the following prerequisites must be fulfilled:
6 ® On Windows operating systems, the fast socket driver must be installed.
® The application program must be run with root/administrator rights.
® The fast settings must be enabled by means of the function
rssgs_useFastSettings (see also chapter 10.3.4, "Enabling Fast Settings”,

on page 138).

The instrument driver will automatically use the fast settings method whenever possi-
ble - currently only for the parameters frequency, level, RF state, IQ modulator state,
IQ wideband state - and will send SCPI messages in all other cases.

10.4.1 Setting Up a Remote Control Connection via Fast Socket

Windows Operating Systems

To set up a remote control connection via Fast Socket for Windows operating systems,
perform the following steps:

1. Connect the controller and the instrument, see chapter 2.3.2, "Connecting a
Remote PC via LAN", on page 22.

2. Install the protocol driver to the controller, see chapter 10.4.2, "Installing the Proto-
col Driver", on page 140.

3. On the controller start the driver by using one of the following:

a) Start the Windows console user interface as an administrator and execute the
net start SGMANDISPROT command.

b) Use a program for opening the driver.
An example file is provided on the Documentation CD (SgsDriverDemo. c).

4. Start the application with administrator rights.

5. Enable fast settings, see chapter 10.4.3, "Enabling Fast Settings", on page 140.
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10.4.3

Advanced Remote Control Using Fast Socket

Linux Operating Systems

To set up a remote control connection vie Fast Socket for Linux operating systems,
perform the following steps:

1. Connect the controller and the instrument, see chapter 2.3.2, "Connecting a
Remote PC via LAN", on page 22.

2. Start the application as root.

3. Enable fast settings, see chapter 10.4.3, "Enabling Fast Settings", on page 140.

Installing the Protocol Driver

The protocol driver defines the way to communicate with the instrument via the LAN
Fast Socket interface.
For Linux operating system no special driver is needed.

For Windows operating systems the SGMANDISPROT driver is required. The protocol
driver is installed automatically together with the installation of the R&S SGMA-GUI
software. It is additionally provided on the CD, included in the delivery.

To install the driver manually on a Windows operating system:
1. Open "Control Panel > Network and Sharing Center".

2. Select the network adapter on which you want to install the driver and click on it.

The "Local Area Connection Status" dialog opens.
Click "Properties" to open the "Local Area Connection Properties" dialog.
Click "Install" to open the "Select Network Feature Type" dialog.

Select "Protocol" and click "Add".

o o > w

In the "Select Network Protocol" dialog, click "Have Disk", navigate to the directory
where the driver is saved and click "OK" to install the driver.

Enabling Fast Settings

» To enable the fast settings for the Fast Socket, call function
rssgs_UseFastSettings (ViSession instrumentHandle, ViBoolean
fastEnabled, ViBoolean asynchronousEnabled) included in the instru-
ment driver.

Settings for some parameters like level and frequency will accelerate.

To disable the fast settings, call the function rssgs UseFastSettings with argu-
ment fastEnabled=false.
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10.5 Using the R&S SGMA-GUI to Monitor the Remote
Control Operation

The R&S SGMA-GUI can be used to monitor the behavior of one or more instruments
while they are remote controlled.

A typical configuration consists of one monitor, controller(s) and instrument(s), where
the monitor is the remote PC on which the R&S SGMA-GUI is installed and the control-
ler is the remote PC on which the application program runs.

Simultaneous control of an instrument from a controller and a monitor may lead to colli-
sions whenever both the controller and the monitor utilize the same remote channel.
These collisions are indicated by an error message in the Info line, e.g. "Query inter-
rupted" or "Resource locked". Simultaneous monitoring and control over the same
remote channel is only possible, if the used protocols support

viLock () /viUnlock () and the remote program use these functions.

The table 10-2 shows whether a collision-free communication over a particular combi-
nation of remote channels is possible or not and if there are any restrictions.

Table 10-2: Cross-reference between used remote channels and collision-free communication

Monitor/ LAN LAN (HiSLIP) uUsB LAN (Socket) | PCle
Controller (vXI-11)

LAN (VXI-11) OK* OK OK OK OK
LAN (HiSLIP) OK OK OK OK OK
uUsB OK OK viLock/viUnlock OK OK
LAN (Socket) | OK OK OK X OK
PCle OK OK OK OK X
where:

® OK: communication possible, no collisions
*) the R&S SGMA-GUI always uses the LAN device name instr1, see also chap-
ter 10.1.2.3, "VXI-11 Protocol", on page 130.

® X: communication is not possible without collisions

® vilock/viUnlock: communication is only possible, if the remote control com-
mands are enclosed ina viLock () - viUnlock () pair.

@ The R&S SGMA-GUI uses the viLock () /viUnlock () functions.

The figure below shows an example of configuration where the monitor and the con-
troller are two different computers, connected to the same instrument over two different
hardware interfaces.
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4 R&S SGMA-GUI
= Information
Interface#2
Monitor (e.g. LAN)
Application
Program

Interface#1
(e.g. PCle)

Remote Control

Controller

Fig. 10-5: Example of setup for remote control monitoring

Connecting and configuring the monitoring PCs

In the "Setup > Security > Security Settings" dialog, check the state of the LAN and
USB interfaces and enable them if necessary.

1. Connect the monitoring PC to the instrument.

Note: Choose the hardware interface considering the limitations described in
table 10-2!

2. Configure the instrument in the R&S SGMA-GUI, see chapter 6.4.2, "Handling
Instruments in the R&S SGMA-GUI", on page 58.

3. Inthe "SGMA-GUI > Setup > Instruments > Edit Instruments" dialog, disable
"Exclusive Access".
Note: The two functions "Exclusive Access" and monitoring are mutually exclusive!
4. Send remote control commands from the controller to the instrument, open the cor-

responding dialogs in the R&S SGMA-GUI and observe the status of the parame-
ters.
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11 Remote Control Commands

In the following, all remote-control commands will be presented in detail with their
parameters and the ranges of numerical values.

For an introduction to remote control and the status registers, refer to chapter 14.1,
"Remote Control Basics", on page 231.

Conventions used in SCPI Command Descriptions

Note the following conventions used in the remote command descriptions:

e Command usage
If not specified otherwise, commands can be used both for setting and for querying
parameters.
If a command can be used for setting or querying only, or if it initiates an event, the
usage is stated explicitely.

® Parameter usage
If not specified otherwise, a parameter can be used to set a value and it is the
result of a query.
Parameters required only for setting are indicated as Setting parameters.
Parameters required only to refine a query are indicated as Query parameters.
Parameters that are only returned as the result of a query are indicated as Return
values.

® Conformity
Commands that are taken from the SCPI standard are indicated as SCPI con-
firmed. All commands used by the R&S SGS follow the SCPI syntax rules.

® Asynchronous commands
A command which does not automatically finish executing before the next com-
mand starts executing (overlapping command) is indicated as an Asynchronous
command.

® Reset values (*RST)
Default parameter values that are used directly after resetting the instrument (*RST
command) are indicated as *RST values, if available.

® Default unit
This is the unit used for numeric values if no other unit is provided with the parame-
ter.

® Manual operation
If the result of a remote command can also be achieved in manual operation, a link
to the description is inserted.

11.1 Programming Examples

This chapter provides simple programming examples for the R&S SGS. The purpose
of the examples is to present all commands for a given task. In real applications, one
would rather reduce the examples to an appropriate subset of commands.

HE
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The programming examples have been tested with a software tool which provides an
environment for the development and execution of remote tests. To keep the examples
as simple as possible, only the "clean" SCPI syntax elements are reported. Non-exe-
cutable command lines (e.g. comments) start with two // characters.

At the beginning of most remote control program, an instrument (p)reset is recommen-
ded to set the R&S SGS to a defined state. The commands *RST and
SYSTem:PRESet are equivalent for this purpose. *CLS also resets the status registers
and clears the output buffer.

It is also recommended that you lock the instrument for remote control from the
selected controller prior to further configuration. Use the ZOCK command for this pur-
pose.

We assume that the R&S SGS is fully equipped with all available options.

11.1.1 Performing General Task for Instrument Setup

In the following example we assume that a remote PC is connected to the instrument,
the remote PC and the instrument are switched on and a connection between them is
established.

// RS RS EEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEREEEEEEEEEEEEEEEEEEEE S

// Reset instrument first

// RR R R R I E A E b E I S E h E E E b E E dE h b b b b b dE b b b E h b b E E b 3E b b b b b h b b b 3h b b I i

*RST; *CLS

// :SYSTem:PRESet
// :RESTart

// :SYSTem:FPReset

// RS RS E S EEEEEEE SRR EEEEEEEEEEEEREEEEEEEEEEEEEEEEEEEE S

// Lock the instrument to the controller

// ER R R R b b I I I I E I E b E E h E E E b E E E E b b b b dE h b b b b E h b b E E b 3E kb b I b b b b E h b h I i

:LOCK? 72349234

// Lock instrument to avoid interference by other controllers
// Use an arbitrary number

// Response: 1

// Request granted, i.e. the instrument is locked

// Abort program if request is refused

// ER R R R I h I I h b h I E E h E E E b E E E h b b b b b dE h b b b E h b b E E b 3E b b E b b b b b b 3 i

// Launch selftest, diagnostic and internal adjustments and retrieve results

// KKK A KA AR A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A AR A AR AR A AR KA KKK

:TEST:ALL:STARt?
:TEST:ALL:RESult?
// Response: RUN
// Call :TEST:ALL:RESult? repeatedly until finished (0 or 1 is returned)
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:DIAGnostic:POINt:CATalog?
// Response: D_TEMP RFB,D TEMP_CPU,D TEMP DBL, ...
:DIAGNostic:MEASure:POINt? 'D TEMP_RFB'

// Calibration functions may take several minutes

// Set timeout values of controller accordingly

:CALibration:ALL:MEASure?

// starts the adjustment of all functions for the entire instrument

// Response: 0 / 1

// i.e. adjustment has been performed successfully / adjustment failed
:CALibration:FREQuency:MEASure?

// starts the adjustment of frequency and level
:CALibration:LEVel:MEASure?

// starts adjustments for maximum level accuracy

// Options R&S SGS-B106V or R&S SGS-B112V required for modulator functions
:CALibration:IQModulator:FULL?
:CALibration:IQModulator:LOCal

// RS EEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEREEEEEEEEEEEEEEEEEEEEE

// Query the entries in the error queue

// ER R h b b h I Sk E E I E b b b b E h b b E b b E E E h b b b b dh E h b b b E 3h b b h E b 3E kb b b b b b b b b b b b 3

:SYSTem: SERRor?

// Query static errors

// :SYSTem:ERRor:CODE:COUNT?
// :SYSTem:ERRor:CODE:NEXT?
// :SYSTem:ERRor:NEXT?

// :STATus:QUEue:NEXT?

// :SYSTem:ERRor:CODE:ALL?
:SYSTem: ERRor :ALL?

// Query error queue

// RR R E kb dh b b h b b E I E b h b b b E h E E h b E h E h b b b b b b b b b b b b b b b h b b 3E b b b E b b b b b b b b b b

// Query system information

// RR Rk ik ko kb kb kb b bk b kb b b b E b b b b h kb b b b b R R R R b bk kb h R bk b b b b b

SYSTem:VERSion?

// AR SRS EEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEE

// Activate eco mode

// ER R E kb dE Ik b b E E I E b b b b E E b E E b b E h E b b b b b b dh b b b b b b 3h b b b h b 3E kb dE E b b b b b b b b b b

:SYSTem: EMODe EM1
// Ak hkhkhkhkhkhkhkhkhhkhkhhkhkhhkhkhkhhkhhkhkhkhhhkhhkhkhkdhhkhkhkhkhkhkdhhkhkhhkhkhkhkhkdkhkhkhkhkhkhrkhhhkhhkhxkx*x

// Query the installed common assemblies and HW options

// RR Rk ik kb kb bk b b bk b b b b b ik b b b bk b b b b b b h R b bk kb b h Rk kR b b b b
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:SYSTem: SOFTware:OPTionl :NAME?
:SYSTem: SOFTware:0PTionl:DESignation?
:SYSTem: SOFTware:0PTionl:LICenses?
:SYSTem: SOFTware:OPTionl:EXPiration?

:SYSTem:HARDware:ASSemblyl : NAME?

:SYSTem: HARDware:ASSemblyl : PNUMber?
:SYSTem: HARDware:ASSemblyl : SNUMber?
:SYSTem: HARDware:ASSemblyl:REVision?

// ER R E h h dE b b bk E I h b h b b h h b E E b b E E E h b b b b b dE E b b b b h b b b h I b 3E b b b h b b b b b b b b 3 i

// Unlock the instrument

// RR Rk ki kb kb kb b bk b b b b b bk b b b b kb b b b b b b R b Rk kb R bk b b b b b b

:UNL 72349234

11.1.2 Generating an I/Q Modulated Signal

In the following example we assume that a remote PC is connected to the instrument,
the remote PC and the instrument are switched on and a connection between them is
established. An external analog signal is provided at the | and Q connectors of the
instrument.

// KKK A AR A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A AR A AR A AR AR AR KA KRR KKK

// Reset instrument first

// KKK KA KA KA KA KA A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A AR AR KA A KK KK

*RST; *CLS

// KKK KA A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A AR AR AR AR KRR R KKK

// Lock the instrument to the controller

// KK KA KA KA KA A KA A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A AR A KA A KA K KK

:LOCK? 72349234

// Lock instrument to avoid interference by other controllers
// Use an arbitrary number

// Response: 1

// Request granted, i.e. the instrument is locked

// BAbort program if request is refused

// KK KA KA KA KA KA A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A AR A KA A KA K KK

// Select normal operation mode

// R R R R R R R R R R R R R R R R

:SOURce :0PMode NORMal
// R i i I i I I I I I I S I I I S S I Ih b b S b dh I b S b b Sh b b b b b b S b 2 b

// Set RF frequency and level

// R R R R R R R R R R R R R R R R R R R
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:SOURce:FREQuency:CW 2 GHz
// :SOURce:PHASe 0

// :SOURce:PHASe:REFerence
:SOURce:POWer -10dBm
:SOURce: POWer:PEP?

// ER R R E h h dE b b b b S E E I h E E h b b E E b E E b b E E E E b b b b dE b b b b b E b b b b E b 3E b b b b b b b b b b b b b 3

// Enable internal reference frequency source

// Rk kb kb kb b bk kb b b b bk b b b h kb b b b b b b R R Rk kb b h Rk bk b R b b b R

:SOURce:ROSCillator:SOURce INTernal

// ER R R I E h b b S E E I b b h b b E E b E E b b SE E E b b b b b dh b b b b b h h b b b E b 3E kb dE b b b b b b b b b b 3

// Enable internal LO source

// RR Rk ki kb kb kb b bk b b b b b b b b h kb b b b b b R R R b Rk kb bk kb b R b

:SOURce:LOSCillator:SOURce INT

// RR R R E h b dE b b b b b h I E b h b E E b E E b b E E E h b b E b b dh b b b b E 3h b b b 3 b 3h b b b I b b b b b b b b b 3

// Define and enable impairments
// Enable modulation

// ER R R E h dh dE b b b b E I h b b b b E E b b E b b E h E b b b b b b dh b b b b b h b b b b h b 3E b b b b b b b b b b b b b 3

:SOURce:IQ:IMPairment:LEAKage:I -1
:SOURce:IQ:IMPairment:LEAKage:Q 1
:SOURce:IQ:IMPairment:IQRatio:MAGNitude 1
// Sets the gain imbalance to 1 %
:SOURce:IQ:IMPairment:IQRatio:MAGNitude?
// Response: 0.087 dB
:SOURce:IQ:IMPairment:QUADrature:ANGLe 2
:SOURce:IQ:WBSTate ON
:SOURce:IQ:CREStfactor 0.05

:SOURce:IQ:IMPairment:STATe ON
:SOURce:IQ:STATe ON

// ER Rk kb b b b S E A h E b h b b E h kb E h b S E E b b b b b dh b b b b b b b b b b E b 3E b b dE h b h b b b b b 3 b b

// Enable output of the generated signal at the RF connector

// RR Rk kb kb b bk kb b b kb b bk b b b b b b R R b bk kb b bk b b b b

:OUTPut:STATe ON

// Ak hkhkhkhkhhkhkhkhhkhhkhkhkhhkhdhhhkhkhkhhhhhkhhkhkhkdhhhkhhkhkhdhhkhkhhkhkhkhkhkdhkhkhkhkhkhkkhhhkhhkhxkx*x
// Unlock the instrument

// RR Rk ki kb kb kb b b b b b b b b E kb b b h b b b b b b kb b b bk kb b b b bk b R b

:UNL 72349234
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11.1.3 Adjusting Network and Remote Channel Settings

In the following example we assume that a remote PC is connected to the instrument,
the remote PC and the instrument are switched on and a connection between them is
established.

// KA KK AR AR A AR R KA AR A A IR A A A A A I A A A A A A A A A A AR KA AAKAAAAKAAIAAF A AR KA XA A A KA KKK

// Reset instrument first

// R R R R R R R R R R R R R R R R R R R I I R R R R R I R I E R R I I I i

*RST; *CLS

// KA KA AR AR A AR R A A AR A A IR A A A AR A A A A A A A A A A A AR KA AA KA AAKAAIAAFI A AR KA XA KA KA KKK

// Lock the instrument to the controller

// R R R R R R R R R R I R R R R R R R I i R R R R R I I I E I I R I R I I i

:LOCK? 72349234

// Lock instrument to avoid interference by other controllers
// Use an arbitrary number

// Response: 1

// Request granted, i.e. the instrument is locked

// Abort program if request is refused

// R R R R R R R R I R R R R R R R R R R R R R R R I R I I R I I i

// Query the VISA resource strings

// KKK KA A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A AR A AR A A AR KRR KKK

:SYSTem:COMMunicate:NETWork:RESource?

// Response: TCPIP::10.113.11.91::INSTR
:SYSTem:COMMunicate: SOCKet :RESource?

// Response: TCPIP:rssgsl100al00021::5025::SOCKET
:SYSTem:COMMunicate:USB:RESource?

// Response: USB::0x0AAD::0x0088::100021::INSTR
:SYSTem:COMMunicate:PCIexpress:RESource?

// Response: PCIe::0x0AAD::4909::100021::INSTR

// KA KA AR AR A A AR KA AR A A KA A A A AR A A A A A A A A A A A AR KA AAKAAAAKAAIAAF A AR KA XA A A KA KKK

// Query network settings

// R R R R R R R R R R I I R R R R R R R R I R R R R R R I I R R b R I R I I

:SYSTem:COMMunicate :NETWork:COMMon :HOSTname?

// Response: rssgsl00al00021
:SYSTem:COMMunicate:NETWork: IPADdress :MODE?

// Response: AUTO
:SYSTem:COMMunicate:NETWork: IPADdress?

// Response: 10.113.11.91
:SYSTem:COMMunicate :NETWork: IPADdress: SUBNet :MASK?
//Response: 255.255.0.0
:SYSTem:COMMunicate:NETWork: IPADdress:GATeway?
//Response: 10.113.0.1



Programming Examples

// ER R dE b Ik E E I b E h b b E h b E E b b E E E b b b b b dh b b b b b E b b b h E b 3E b b b b b b b b b b b b b 3

// Changing network settings

// RR Rk dh kb kb kb b b bk b b b b b kb b kb b b b b b b R b Rk kb b h bk kb R b b

:SYSTem: PROTectl:STATe OFF, 123456

// :SYSTem:COMMunicate:NETWork:COMMon:HOSTname "mySGS"
// :SYSTem:COMMunicate:NETWork:IPADdress:MODE STATic
// :SYSTem:COMMunicate:NETWork:IPADdress 9.8.7.6
:SYSTem:COMMunicate:NETWork:RESTart

// RS RS EEEEEEE SRR EEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEE S

// Unlock the instrument

// ER R R dE b b b S E E I h b h b b S E b E E b E E E b b b b b dh b b b b b E h b b E E b 3E b b b h b b b b b b b 3 3 3

:UNL 72349234

11.1.4 Advanced Task for Optimizing Performance

In the following example we assume that a remote PC is connected to the instrument,
the remote PC and the instrument are switched on and a connection between them is
established.

// ER R R R h I I I E E E h I I E h E E E b E E E h b b b b b dh h b b b h h b b E b 3E b b E I b b b b E b b h I i

// Reset instrument first

// Rk ki kb kb bk b b bk b kb bk b h b b kb b b b b b b b bk kb b Rk kb b b b b

*RST; *CLS

// :SYSTem:PRESet
// :RESTart

// :SYSTem:FPReset

// ER R R R I I I I E I b I b E E E b E E IE E b b b b dE E b b b b h h b b h b b 3E b b b E b b b b E E b b i

// Lock the instrument to the controller

// RR Rk kb kb kb bk b b b bk b b b b bk b b E kb b b b b b b b b bk kb b R bk b b b b

:LOCK? 72349234

// Lock instrument to avoid interference by other controllers
// Use an arbitrary number

// Response: 1

// Request granted, i.e. the instrument is locked

// Abort program if request is refused

// RR Rk ki kb kb kb b bk kb b b b b b b h kb b b b b b h b b bk kb Rk kb h R b b b

// Query and adjust the reference oscillator settings

// KA KA AR A A KRR A A A A A I AR I I A A F A A A A A I A A I I AR I I AA A A AAA I IAA I I A A A XA A A A KA KKK

:SOURce:ROSCillator:SOURce?
// Response: EXT
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:SOURce:ROSCillator:EXTernal:FREQuency?

// Response: 100MHZ
:SOURce:ROSCillator:EXTernal:SBANdwidth?
//Response: WIDE

:SOURce:ROSCillator:SOURce INTernal
:SOURce:ROSCillator:0UTput:FREQuency 100MHZ
:SOURce:ROSCillator:INTernal:ADJust:STATe OFF
// uses the calibrated adjustment value of the internal ref. frequency
:SOURce:ROSCillator:INTernal:ADJust:VALue?
:CONNector:REFLo:OUTPut?

// Response: REF

// KKK KA A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A AR AR AR A KA KKK

// Optimizing the quality characteristics of the RF signal

// AR SRS EEEEEEEEEE R EE R EEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEE

:SOURce: POWer : LMODe LNO

// optimize the signal to noise ratio
:SOURce:POWer:SCHaracteristic AUTO

// ensure highest dynamic range and fastest setting time
:SOURce:POWer:LEVel:IMMediate:AMPLitude -30dBm
:SOURce:POWer:LIMit:AMPLitude 30dBm
:SOURce: POWer :ALC:SONCe

:OUTPut:STATe: PON UNCHanged

// RR R E h h dE b b b Sk h E I b b h b b h b E E b b E E E E b b b b b b b b b b b b b b h b 3E b b b b b b b b b b b b b 3

// Unlock the instrument

// KKK A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A AR AR AR AR AKX KKK

:UNL 72349234

Enabling and Configuring an Extension Mode

In the following example we assume that a remote PC is connected to the instrument,
the remote PC and the instrument are switched on and a connection between them is
established; the required application program is running on the remote PC. We
assume that at least one R&S SGU is connected to the instrument, directly or over net-
work/switch, i.e. there is a remote control connection between the instrument and the
extension; we assume, that the required signal connections between the instrument
and the extension are established, too.

// AR R SRS EEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEET

// Reset instrument first

// RR R R E kb b b b b b b h b b b I b b b b h b E E b b E h E h b b b b dh b b b b b b b b b b b 3E b b b b b b b b b b b b b

*RST; *CLS

// :SYSTem:PRESet
// :RESTart

// :SYSTem:FPReset
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// ER R dE b Ik E E I b E h b b E h b E E b b E E E b b b b b dh b b b b b E b b b h E b 3E b b b b b b b b b b b b b 3

// Lock the instrument to the controller

// RR Rk kb kb bk b b bk b b b b b b b b b b h b b b b b b h R R b bk kb b bk b R b b b b

:LOCK? 72349234

// Lock instrument to avoid interference by other controllers
// Use an arbitrary number

// Response: 1

// Request granted, i.e. the instrument is locked

// Abort program if request is refused

// RR Rk ki kS kb ik kb b bk b kb b b kb b b h kb b b b b b h R R R Rk kb R bk R b b R b

// Confirm that there is no extension currently enabled for the instrument
// Scan the network for available extension instruments and

// query information on the available instruments:

// hostname/IP adress, serial number, used remote channel

// select and enable an extension

// RR Rk kb kb kb b b bk kb b b b b b b h kb b b bk R b bk kb b bk b b b b b
:EXTension:SELect?

// 0

// no extension is currently enabled

:EXTension:INSTruments:SCAN:STATe 1
:EXTension:INSTruments:SCAN:STATe?
// 1

// scan process is running
:EXTension:INSTruments:SCAN:STATe?
// 0

// scan finished

:EXTension:INSTruments:REMote: LAN:NAME?
// rssgul00al00002,rssqul00al01010
:EXTension:INSTruments:REMote:CHANnel?
// LAN,LAN
:EXTension:INSTruments:REMote:SERial?
// 100002,101010

// there are two available extensions

// select and enalbe the first extension (rssgul00al00002)
:EXTension:SELect 1

// determines the extension

// all further remote control commands are related to this extension
:EXTension:REMote:STATe?

// 1

:EXTension:BUSY:STATe?

// 0

// extension is connected and ready for operation

// ER R R E h h dE b b b E h I E b h b b h E b E E b b SE E E b b b b b b dh b b b b b b 3h b b b E b 3E b b b E b b b b b b b b b 3
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// Send remote commands to the extension to control it

// e.g. activate the RF optput of the extension and subsequently confirm this
// AR SRS EEEEEEEEEEEEEE R EEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEE S
:EXTension:SEND ":OUTP:STAT ON"

:EXTension:SEND? ":0UTP:STAT?"

// 1

// the RF ouptput of the extension is active

// AR SRS EEEEEEEEEEEEEEEEEEEEEEEEEEEREEEEEEEEEEEEEEEEEEEE S

// Unlock the instrument

// R R E h h dE I b b Sk E E I E E h h b E E b E E b b E E E b b b b b b b b b b b b b h b b h E b 3E b b b b b b b b b b b 3 3 i

:UNL 72349234

Configuring Instruments in the R&S SGMA-GUI

This section provides an example of the automation of the R&S SGMA-GUI.

In the following example we assume that a remote PC with installed R&S SGMA-GUI
on it is connected to a LAN and that the remote PC and the instruments are switched
on.

For more information, refer to chapter 2.3, "Connecting an External PC and Devices",
on page 20.

// KKK A KK A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A AR A AR A AAAAAAAAA A AN A A A AR

// Trigger the scan function to search for instruments connected

// to the remote computer via all of the available interfaces.

// RR Rk kS kb kb bk b b b h kb b b b b b kb b b b b b b b b b bk kb b

:INSTruments:SCAN:HNPRefix "rssg"

// scan returns only instruments with hostname beginning with "rssg"
:INSTruments:SCAN 1

*OPC?

// R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R i

// Query the number of available instruments and the settings of each
// configured instrument: instrument type, symbolic name,
// remote channel used, serial number, hostname/IP address

// Adjust settings if required

// Rk kb kb bk b b b h kb b b b S b b b b b b b b b b b b bk kb

:INSTruments:COUNt?
// Response: 3

:INSTruments:TYPE?
// Response: SGU, SGS, SGT

:INSTruments:NAME?
// Response: SGU-100002,SGS-100006, SGT-100008
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:INSTruments:SERial?
// Response: 100002,100006,100008

:INSTruments:REMote:CHANnel?
// Response: LAN,USB, PCIe

:INSTruments:REMote :NAME?
// Response: rssqgul00al00002, rssgsl00al00006, rssgtl00al00008

// ER R E dh b E b b b S E I E I h h b b E h h E E b b E E E b b b E b b dh b b b b b E b b b b E b 3E b b E E b h b b b b b b b 3

// Check the instrument state and activate instruments if required

// KKK A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A AR A A AR AR AR KA XA KKK

:INSTruments:ACTive: STATe?

// Response: 0,1,1

:INSTruments:ACTive:STATe ON,OFF,OFF

// Activates the first instruments in the list,

// i.e. the instruments with symbolic names SGS-100006

// AR SRS EEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEE SIS

// Export the configuration into a mapping file

// RR R R E b dE b b b b b I b b h b b S E b E E h b E E E E b b h b b b b b b b b E h b b b h b 3E kb b E b b b b b b b b b 3

:INSTruments:MAPPing:FILE 'd:\mapping files\mapping.map'

// RS RS E SRS EEEEEEEEEEEEEEEREEEEEEEEEEEEEEEEEEEEE

// Enable exclusive access for the selected instrument

// RR R Ik b b I h b Sk E I E b b b b E E kb E b b E h E E b b b b dh b b b b b h h b b b h b 3E b b b E b b b b b b b b b 3

:INSTruments:EACCess:STATe?
// Response: 0,0,0
:INSTruments:EACCess:STATe ON,OFF, OFF

// Locks the first instrument

Common Commands

Common commands are described in the IEEE 488.2 (IEC 625-2) standard. These
commands have the same effect and are employed in the same way on different devi-
ces. The headers of these commands consist of "*" followed by three letters. Many
common commands are related to the Status Reporting System.

Available common commands:

SO PP PP PP PP 154
BT PP 154
B =T PP 154
10 154
5 1 155
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RO L PP 155
B ST 155
L = PP P PP PRRP T 155
TN 156
L 156
RS T e e 156
RS 7 TP PTPPPPI 156
ST = TP PP PRR PR 156
RS 1= PP 157
S 20T TSRO PPN 157
LR T PN 157
FVVALL ¢ttt 157
*CLS

Clear status

Sets the status byte (STB), the standard event register (ESR) and the EVENt part of
the QUEStionable and the OPERation registers to zero. The command does not
alter the mask and transition parts of the registers. It clears the output buffer.

Usage: Setting only

*ESE <Value>
Event status enable

Sets the event status enable register to the specified value. The query returns the con-
tents of the event status enable register in decimal form.

Parameters:
<Value> Range: 0 to 255

*ESR?
Event status read

Returns the contents of the event status register in decimal form and subsequently
sets the register to zero.

Return values:

<Contents> Range: 0 to 255
Usage: Query only

*IDN?

Identification

Returns the instrument identification.
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Return values:

<ID> "Rohde&Schwarz,<device type>,<serial number>,<firmware ver-
sion>"

Example: Rohde&Schwarz, SGS,
1407.6004%k02/000000,3.1.17.1-03.01.158

Usage: Query only

*IST?

Individual status query

Returns the contents of the IST flag in decimal form. The IST flag is the status bit
which is sent during a parallel poll.

Return values:

<ISTflag> 01
Usage: Query only
*OPC

Operation complete

Sets bit 0 in the event status register when all preceding commands have been execu-
ted. This bit can be used to initiate a service request. The query form writes a "1" into
the output buffer as soon as all preceding commands have been executed. This is
used for command synchronization.

*OPT?
Option identification query

Queries the options included in the instrument. For a list of all available options and
their description refer to the data sheet.

Return values:

<Options> The query returns a list of options. The options are returned at
fixed positions in a comma-separated string. A zero is returned
for options that are not installed.

Usage: Query only

*PRE <Value>
Parallel poll register enable

Sets parallel poll enable register to the indicated value. The query returns the contents
of the parallel poll enable register in decimal form.

Parameters:
<Value> Range: 0 to 255
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*PSC <Action>
Power on status clear

Determines whether the contents of the ENAB1e registers are preserved or reset when
the instrument is switched on. Thus a service request can be triggered when the instru-
ment is switched on, if the status registers ESE and SRE are suitably configured. The
query reads out the contents of the "power-on-status-clear" flag.

Parameters:

<Action> 011
0
The contents of the status registers are preserved.
1

Resets the status registers.

*RCL <Number>
Recall

Loads the instrument settings from an intermediate memory identified by the specified
number. The instrument settings can be stored to this memory using the command
*SAV with the associated number.

It also activates the instrument settings which are stored in a file and loaded using the
MMEMory:LOAD <number>, <file name.extension>command.

*RST
Reset

Sets the instrument to a defined default status. The default settings are indicated in the
description of commands.

The command is equivalent to SYSTem: PRESet.

Usage: Setting only

*SAV <Number>
Save

Stores the current instrument settings under the specified number in an intermediate
memory. The settings can be recalled using the command *RCL with the associated
number.

To transfer the stored instrument settings in a file, use the command : MMEMory :
STORe:STATe.

*SRE <Contents>

Service request enable
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Sets the service request enable register to the indicated value. This command deter-
mines under which conditions a service request is triggered.

Parameters:

<Contents> Contents of the service request enable register in decimal form.
Bit 6 (MSS mask bit) is always 0.
Range: 0 to 255

*STB?

Status byte query
Reads the contents of the status byte in decimal form.

Usage: Query only

*TRG
Trigger

Triggers all actions waiting for a trigger event. In particular, *TRG generates a manual
trigger signal. This common command complements the commands of the TRIGger
subsystem.

Usage: Event

*TST?
Self-test query

Initiates self-tests of the instrument and returns an error code in decimal form (see Ser-
vice Manual supplied with the instrument). "0" indicates no errors occured.

Usage: Query only

*WAI
Wait to continue

Prevents servicing of the subsequent commands until all preceding commands have
been executed and all signals have settled (see also command synchronization and
*OPC).

Usage: Event
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11.3 General Commands

B = Y 1= 158
ST ANGDY ...ceeeieertterttt i eieeeeete s ettt eeeeeeeeeeeeeee e e e esesrar e b e b a——aaseeseaaaaaaaeserererererrrrrrrrararannnnn 158
0 L4 1 158
10 1 Yo T 158
:RESTart

Restarts the instrument.

Usage: Event

:STANdby

Switches the instruments to stand by state. To return the instrument from standby to
ready state, send the SCPl command :RESTart.

Usage: Event

:LOCK? <LockRequestld>
Sends a lock request ID which uniquely identifies the controller to the instrument.

Parameters:
<LockRequestld> Number

0
test query to prove whether the instrument is locked

Controller ID
request lock from the controller with the specified Controller ID

Return values:
<Value> Number

0
request refused; the instrument is already locked to other <Lock
Request Id>, i.e. to another controller

1
request granted

Example: :LOCK? 12345
Response: 1
:UNL 12345

Usage: Query only

Manual operation: See "Exclusive Access" on page 50

:UNLock <Unlockld>

Unlocks an instrument locked to a controller with Controller ID = <Unlock Id>.
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Setting parameters:
<Unlockld> Number

Unlock ID which uniquely identifies the controller to the instru-
ment. The value must match the Controller ID <Lock Request
Id> set with the command : LOCK?.

0
Clear lock regardless of locking state
Usage: Setting only

Manual operation: See "Exclusive Access" on page 50

Preset Commands

The preset commands are not bundled into one subsystem. Therefore, they are listed
separately in this section. In addition, a specific preset command is provided for each
digital standard and for the fader. These specific commands are described in the asso-
ciated subsystems.

The following presetting actions are available:

® Activating the default state of all internal instrument functions (*RST on page 156).
Functions that concern the integration of the instrument into a measurement setup
are not changed, e.g. TCP/IP address or reference oscillator source settings.

® Activating the original state of delivery (factory reset, : SYSTem: FPReset
on page 159). Only functions that are protected by a password remain unchanged
as well as the passwords themselves.

:SOURce<hw>:PRESet
:SYSTem:PRESet

Triggers an instrument reset. It has the same effect as:
® the *RST command
® the "SGMA-GUI > Instrument Name > Preset" function

For an overview of the settings affected by the preset function, see chapter 7.9, "Pre-
set", on page 86.

Example: SYST:PRES
All instrument settings (also those that are not currently active)
are reset to their default values.

Usage: Setting only

:SYSTem:FPReset
Triggers an instrument reset to the original state of delivery.

Example: SYST:FPR
all instrument settings (also those that are not currently active)
are reset to the factory values.
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Usage: Event

Manual operation: See "Execute Factory Preset" on page 105

CALibration Subsystem

CALIDrationN:ALLEMEASUIE]?......ceeeeeeeeeetettetteeeeese e e e e eeeeeeaeeeeeeeeeeeeessstababasbaaaaaesesenas 160
:CALibration:FREQUENCY[:IMEASUIE]?.....iiieietiieieieeiiiiee e e eeeinee e e e esears s e s s eeesnan s e e seeenaaneaees 160
:CALibration:IQModulator:FULL?........ceeii et e e et e e et e e e e e e e e e eaaans 160
:CALibration:IQModulator:LOCal?........ccoeuneieie ettt e 161
:CALIbration:LEVEIIMEASUIE]? ... .o eeeeeeee ettt e e e e e e e e e e e e e e e e e eeeeeeeeeeeenenennnnaenn 161
:CALibration:LEVELTEMPEratUrE?........uceeeee et e e e e e e e e e e e e e e eaan s 161
:CALibration:FREQUENCY: TEMPEIAtUrE?..........cceeeieeeeeieeeeererieiiiceeeeeseeeeeeeeeaeaeeeeeeeeeeeeeenns 161
:CALibration:IQModulator: TEMPErAtUIE?.......ceeeeeriieeieeeeeeiieeeeeeeteee e e e e eetae e e e e e eaataeeeeeeeennas 161
CCALIDratioN:OEXTENSION. cetuuueieeiiettiieeeeeeettteeseeeeeetaeeeeeeestaaaeeesersanneeessesrannsaeseestnnasaeseens 161
:CALibration<hw>:ROSCillator:DATAIMODE.........ccoiiieiiieeeeee et 162
:CALibration<hw>:ROSCiIllator[:DATA]. ..c ettt ettt e e eae 162

:CALibration:ALL[:MEASure]?
Starts all internal adjustments for which no external measuring equipment is needed.

Return values:
<All> 0]1]OFF|ON

Example: See chapter 11.1.1, "Performing General Task for Instrument
Setup", on page 144.

Usage: Query only

Manual operation: See "Adjust All" on page 92

:CALibration:FREQuency[:MEASure]?
Performs all adjustments which affect the frequency.

Return values:
<Synthesis> 0]1]OFF|ON

Example: See chapter 11.1.1, "Performing General Task for Instrument
Setup", on page 144.

Usage: Query only

Manual operation: See "Synthesis" on page 92

:CALibration:IQModulator:FULL?

Starts the adjustment of the I/Q modulator for the entire frequency range. The 1/Q mod-
ulator is adjusted with respect to carrier leakage, 1/Q imbalance and quadrature.
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Return values:
<Modulator> 011

Example: See chapter 11.1.1, "Performing General Task for Instrument
Setup", on page 144.

Usage: Query only

Manual operation: See "I/Q Modulator" on page 93

:CALibration:IQModulator:LOCal?

Starts the adjustment of the I/Q modulator for the current frequency. The I/Q modulator
is adjusted with respect to carrier leakage, 1/Q imbalance and quadrature.

Example: See chapter 11.1.1, "Performing General Task for Instrument
Setup", on page 144.

Usage: Query only

Manual operation: See "Adjust I/Q Modulator at Current Frequency" on page 92

:CALibration:LEVel[:MEASure]?
Starts all adjustments which affect the level.

Return values:
<Level> 0]1]OFF|ON

Example: See chapter 11.1.1, "Performing General Task for Instrument
Setup", on page 144.

Usage: Query only

Manual operation: See "Level" on page 92

:CALibration:LEVel: TEMPerature?
:CALibration:FREQuency:TEMPerature?
:CALibration:IQModulator:TEMPerature?

Queries the delta temperature since the last performed adjustment.

Return values:
<Temperature> string

Usage: Query only

Manual operation: See "Delta Temperature" on page 93
:CALibration:OEXTension <OExtension>

This SCPI command is used when the instrument is in extension mode.

Enables you to run an internal adjustment only on the extension instrument.
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Parameters:
<OExtension> 0]1]OFF|ON
*RST: 0
Example: :CAL:OEXT ON

activates the mode for calibrating only the extension instrument
:CAL:LEV:MEAS?

calibrates only the extension instrument
:CAL:OEXT OFF

deactivates the mode for calibrating only the extension instru-
ment

:CALibration<hw>:ROSCillator:DATA:MODE <Mode>

Defines whether the factory provided or a custom defined calibration value is used to
adjust the reference oscillator.

Parameters:
<Mode> FACTory | CUSTomer
*RST: FACTory
Example: :CALibrationl:ROSCillator:DATA:MODE CUSTomer

:CALibrationl:ROSCillator:DATA 35600

Manual operation: See "Active Adjustment Data" on page 108

:CALibration<hw>:ROSCillator[:DATA] <Data>

Sets the calibration value for the custom defined external adjustment.

Parameters:

<Data> integer
Range: 0 to INT_MAX
*RST: 0

Example: see :CALibration<hw>:R0OSCillator:DATA:MODE
on page 162

Manual operation: See "Calibration Value" on page 108

11.6 CONNector Subsystem

{CONNECIONREFLO:OUTPUL....cunieiieeeeeeeeeee et et e e e e e e e e e e e e e e e e e e e e eenaans 162
:CONNECIOr:TRIGGEIrOMODE.........cceeeeeeeieeeeeeeeeeeeeie e e e e e e e e e e e e eaaeeeeeeeeeeeeeesesaasaraaananas 163

:CONNector:REFLo:OUTPut <Output>

Determines the signal provided at the output connector REF/LO OUT (rear of the
instrument).
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Parameters:
<Output> REF | LO | OFF

*RST: REF
Manual operation: See "REF/LO Output" on page 68

:CONNector:TRIGger:OMODe <Mode>
Sets the operating mode of the trigger connector.

The parameters PvOut | PETRigger | PEMSource are available only with option
R&S SGS-K22.

Parameters:
<Mode> SVALid | SNValid | PVOut | PETRigger | PEMSource

SVALid|SNValid
signal valid /not valid

PVOut
pulse generator video out

PETRigger
pulse generator external trigger

PEMSource
external pulse modulator source

Manual operation: See "Trigger Connector Mode" on page 79

11.7 DIAGnostic Subsystem

DIAGNOSHCPOINECATAIOG?. ¢t e e e e e e e e e e e et et e ettt eeee et et b a e e e e e e e e e aaaaaaaeeeaeanenes 163
:DIAGNOSHC[:MEASUIE]:POINE?. .. e ettt e et e e e e e eaaas 163

:DIAGnostic:POINt:CATalog?

Queries the test points available in the instrument. A detailed description of the test
points can be found in chapter 3, section "Troubleshooting" of the Service Manual (on
CD-ROM, supplied with the instrument).

Example: See chapter 11.1.1, "Performing General Task for Instrument
Setup", on page 144.

Usage: Query only

:DIAGnostic[:MEASure]:POINt? <Name>

Triggers voltage or temperature measurement at the specified test point and returns
the measured value. A detailed description of the test points can be found in section
"Trouble Shooting" of the Service Manual (on CD-ROM, supplied with the instrument).
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A list of the available test points for the respective path can be queried using the com-
mand :DIAGnostic:POINt:CATalog?.

Query parameters:
<Name> string

Return values:
<Value> number

Default unit: V or °C

Example: See chapter 11.1.1, "Performing General Task for Instrument
Setup”, on page 144.

Usage: Query only

11.8 EXTension Subsystem

EXTEeNSION:REMOIE:STATE?. ..ottt e et et e e e e e e et e e e e e e e e e eeneeenenns 164
EXTension:INSTrumentS:NAME?.........oooiiiieieeeeeeiet i reeeae e e e e e e eeeeeeeaeeeeeeeeeeeessessssararnnanas 164
EXTension:INSTruments:SCANSTATE]......ccvvirrrrerrriiririeieaeieieseeeeeeeeeeerereeeereessrrsreranan——— 165
:EXTension:INSTruments:REMOte:CHANNEI?.......uueieeiiiiicieeeeeeee et eeaaaas 165
:EXTension:INSTruments:REMOtE:LANINAME?.......coovvriiieie et e e e e e v 165
:EXTension:INSTruments:REMOote:SERIAI?.......c.uiiiiiieieee e 166
EXT NS 0N BUS Y (1S T AT ] 2. . eeeee e ettt e ettt ettt e e e e e e e e e e e e e aaaaaaeeeeeeeeeeees 166
) =10 Yo o TR = =Y S 166
IEXTENSIONISEND. ....coiiiiiietiiiteiit i eieeeeee et e e eeeeeeeeeeeeeeeeeeeeeresesbabaa e seseeaaeaaaaaasesseeereenens 167

:EXTension:REMote:STATe?
Queries the state of the remote control connection to the extension.

Return values:
<State> 0]1]OFF|ON

1|ON
connected

0|OFF
not connected

Example: see chapter 11.1.5, "Enabling and Configuring an Extension
Mode", on page 150

Usage: Query only

Manual operation: See "Available Instruments” on page 89

:EXTension:INSTruments:NAME?
Queries the list of the symbolic names of the available extension devices.
Usage: Query only

Manual operation: See "Available Instruments" on page 89
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:EXTension:INSTruments:SCAN[:STATe] <State>
Starts a scan for the available extension instruments.
Setting parameters:

<State> 0]1]OFF|ON

1
starts scan

0
aborts scan

*RST: OFF
Return values:
<State> 0|1]|OFF|ON

1
scan is running

0
scan finisched

*RST: OFF

Example: see chapter 11.1.5, "Enabling and Configuring an Extension
Mode", on page 150

Manual operation: See "Available Instruments" on page 89

:EXTension:INSTruments:REMote:CHANnNel? <Channel>

Queries the remote channels of the available extension instruments. Possible interfa-
ces are: LAN, USB, SOCKet, PCIe.

Parameters:

<Channel> <Channelinstr#1>[,<Channellnstr#2>,...]
Returns a list of the used remote channels of the available
extensions, one interface per instrument. If an extension uses
more than one remote channels, returned is the fastest one.

Example: see chapter 11.1.5, "Enabling and Configuring an Extension
Mode", on page 150

Usage: Query only

Manual operation: See "Available Instruments” on page 89

:EXTension:INSTruments:REMote:LAN:NAME?
Queries the IP addresses/instrument names of the available extension instruments.

Return values:
<|PAddress> <IPAdr_Inst#1>[,<IPAdr_Inst#2>,...]

Example: see chapter 11.1.5, "Enabling and Configuring an Extension
Mode", on page 150
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Usage: Query only

Manual operation: See "Available Instruments” on page 89

:EXTension:INSTruments:REMote:SERial? <Serial>

Queiries the serial numbers of the available extension instruments.

Parameters:

<Serial> <SerialNumberlnstr#1>[, <SerialNumberinstr#2>,...]

Example: see chapter 11.1.5, "Enabling and Configuring an Extension
Mode", on page 150

Usage: Query only

Manual operation: See "Available Instruments" on page 89

:EXTension:BUSY[:STATe]?

Queries the state of the extension instrument.
Return values:

<State> 0]1]OFF|ON

0
the extension is connected to the master instrument and can be
remotely operated

1
the extension is busy, i.e. in standby or locked state, or is per-
forming a time consuming operation

Example: see chapter 11.1.5, "Enabling and Configuring an Extension
Mode", on page 150

Usage: Query only

Manual operation: See "Available Instruments” on page 89

:EXTension:SELect <SelNr>

Selects an extension by its index number. The subsequent SCPI commands are rela-
ted to this extension.

Parameters:
<SelNr> float
0
no selection
Example: see chapter 11.1.5, "Enabling and Configuring an Extension

Mode", on page 150
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:EXTension:SEND <Cmd>

In test setups without remote connection between the controller (remote PC) and the
extension, the R&S SGS acts as a "bridge" between them. The com-
mand :EXTension:SEND sends a SCPI command to the extension instrument.

Parameters:

<Cmd> string

Example: see chapter 11.1.5, "Enabling and Configuring an Extension
Mode", on page 150

FORMat Subsystem

The FORMat subsystem contains the commands which determine the format of the
data that the R&S SGS returns to the controller. This affects all query commands
which return a list of numerical data or block data. Reference is made to this in the
descriptions of the commands.

IFORMEAEBORDET. ...ceuuiieteeeete ettt e et e et e et et e e e st e e eaa s e saa e eebeeraasesaan e aebaearannas 167
TFORMEILDATAL ettt ee et et eeeeesereeeeeeseeeeeeeeseeteeeteseseseseeeesesesesseseseseesesesesaseeneseseseeneseneeeaes 167
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:FORMat:BORDer <Border>

Determines the sequence of bytes within a binary block. This only affects blocks which
use the IEEE754 format internally.

Parameters:

<Border> NORMal | SWAPped
NORMal
The instrument expects (with setting commands) and sends
(with queries) the least significant byte of each IEEE754 floating-
point number first and the most significant byte last.

SWAPped

The instrument expects (with setting commands) and sends
(with queries) the most significant byte of each IEEE754 floating-
point number first and the least significant byte last.

*RST: NORMal

Example: FORM:BORD SWAP
the data is transferred with the most significant bit first.

:FORMat[:DATA] <Data>

Determines the data format which the R&S SGS uses to return data. When data is
transferred from the control computer to the instrument, the instrument detects the data
format automatically. In this case, the value set here is irrelevant.
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Parameters:

<Data> ASCii | PACKed
ASCii
Numerical data is transferred as plain text separated by com-
mas.
PACKed
Numerical data is transferred as binary block data. The format
within the binary data depends on the command. The various
binary data formats are explained in the description of the
parameter types.

*RST: ASCii

Example: FORM ASC
The data is transferred as ASCII data.

:FORMat:SREGister <Format>

Determines the numerical format which is returned when the status registers are quer-
ied.
Parameters:
<Format> ASCii | BINary | HEXadecimal | OCTal
ASCii
The register content is returned as a decimal number.
BiNary

The register content is returned as a binary number. #B is
placed in front of the number.

HEXadecimal
The register content is returned as a hexadecimal number. #H is
placed in front of the number.

OCTal
The register content is returned as an octal number. #Q is
placed in front of the number.

*RST: ASCii

Example: FORM: SREG HEX
The register content is returned as a hexadecimal number.

11.10 MMEMory Subsystem

The MMEMory subsystem (Mass Memory) contains the commands for managing files
and directories as well as for loading and storing complete instrument settings in files.

The files are stored on the internal flash memory of the instrument or on external USB
memory devices.

The default directory is determined using the command MMEMory : CDIR.



MMEMory Subsystem

Use the command : SYSTem:MMEMory : PATH: USER? to query the path of the direc-
tory for user-defined data.

files on this directory contain data that must not be changed. Therefore, this directory
should not be accessed, since reconstruction of the system partition will lead to data
loss.

6 The /opt directory is a protected and therefore a not accessible system directory. The

11.10.1 File Naming Conventions

To enable files in different file systems to be used, the following file naming conven-
tions should be observed.

The file name can be of any length and is case-sensitive, meaning it is distinguished
between uppercase and lowercase letters.

The file and the optional file extension are separated by a dot. All letters and numbers
are permitted (numbers are, however, not permitted at the beginning of the file name).
If possible, special characters should not be used. The use of the slashes "\" and "/"
should be avoided since they are used in file paths. A number of names are reserved
for the operating system, e.g. CLOCKS, CON, AUX, COM1...COM4, LPT1...LPT3, NUL
and PRN.

In the R&S SGS all files in which lists and settings are stored are given a characteristic
extension. The extension is separated from the actual file name by a dot (see chap-
ter 11.10.2, "Extensions for User Files", on page 170 for an overview of the file types).

The two characters ™" and "?" function as "wildcards", meaning they are used for
selecting several files. The "?" character represents exactly one character, while the ™"
character represents all characters up to the end of the file name. "*.*" therefore stands
for all files in a directory.

When used in conjunction with the commands, the parameter <file name> is speci-
fied as a string parameter with quotation marks. It can contain either the complete path
including the drive, only the path and the file name, or only the file name. The file name
must include the file extension. The same applies for the parameters

<directory name> and <path>.

Depending on how much information is provided, either the values specified in the
parameter or the values specified with the command MMEM: CDIR (default directory)
are used for the path and the drive settings in the commands.

Before the instrument settings can be stored in a file, they have to be stored in an inter-
mediate memory using common command *SAV <number>. The specified number is
subsequently used in the :MMEMory: STORe: STATe on page 177 command. Also,
subsequently to loading a file with instrument settings with command : MMEMory :
LOAD: STATe on page 175, these settings have to be activated with the common com-
mand *RCL <number>.
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11.10.2 Extensions for User Files

The following table lists all available file extensions for user files.

Table 11-1: Automatically assigned file extensions in the instrument

Function Contents File suffix

R&S SGMA-GUI Save As/Open Software settings *.savrcl

11.10.3 Examples

In these examples, the current instrument setting is stored in the file
test.savrcltxt in the directory /var/sgs/ ..

Storing and Loading Current Settings

1. Store the current setting in an intermediate memory with the number 4. This setting
can be called using command *RCL and the associated number of the memory, for
example *RCL 4.

*SAV 4

2. To store the settings in a file in a specific directory, specify the complete path.
MMEM: STOR:STAT 4,"/var/sgs/test.savrcltxt"

3. To store the settings in a file in the default drive, set the default drive and specify
only the file name.
MMEM:CDIR '/var/sgs/'*SAV 4
MMEM: STOR:STAT 4, "test.savrcltxt"

4. Load the file test.savrcltxt in the user directory.
MMEM:LOAD:STAT 4, '/var/sgs/test.savrcltxt'

5. Activate the instrument setting of the file test.savrcltxt.
*RCL 4

Working with Files and Directories

1. Read out all files in the specified directory.
MMEM:CAT? 'usbuser'

Response: 127145265,175325184, "test,DIR, 0", "temp, DIR, 0",
"readme.txt,ASC,1324","state.savrcltxt, STAT,5327",
"waveform.wv,BIN, 2342"

the directory usbuser contains the subdirectories test and temp as well as the
files readme. txt, state.savrcltxt and waveform.wv which have different
file types.

Tip: To query only the subdirectories of the current or specified directory, perform:
MMEM:DCAT? 'usbuser'

Response: "test', 'temp'
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To query only the number of subdirectories in the current or specified directory,
perform:

MMEM:DCAT : LENG? 'usbuser'
Response: 2

2. To query the number of files in the current or specified directory, perform:
MMEM:CAT:LENG? 'usbuser'

Response: 3

3. Create a new subdirectory for mass memory storage in the specified directory.
MMEM:MDIR 'usbnew'

4. Copy the file state to a new file.
MMEM:COPY '/var/sgs/state.savrcltxt', 'usbnew'’

5. Rename the file state.
MMEM:MOVE 'state.savrcltxt', 'state new.savrcltxt'

6. Remove the test directory.
MMEM:RDIR 'usbtest'

11.10.4 Remote Control Commands

IMMEMOTY:CATAIOG?. ..eeeeeieerereitetitaeaaaaeteseeeeeaeaeeeseeeeeeeerassssrararaan—asesesseeaeasseseesereneennes 171
R\ 1Y 1 =3V o Y @7 AN =1 Lo Yo I = N { N 172
IMMEMOTY:CDIRECIONY...ceetiiieitiitiiiieaisaaeeseeeeeeeeeeeeeeeeeeereeeesstntaran i aeseseeeaaaaaaaeseereeenenns 172
IMIMEMOTY COPY ..ttt et e e et ettt ettt te et e e e e e e e e e e e e e aaaaeeeeeeeeeaeaeeesensnnnnanann 173
AT Y Y (o) Y I Y I U 173
1Y 1LY 1 =31V oY Y T AN IF=1 o o S 174
"MMEMOory:DCATalOG:LENGEN?.....ccciiiiiieieeeee et e e s e e e e e e e e e e e e e e e eeeeeeeeeesesreraaaaas 174
IMIMEMOTY:DELELE....cvuvuretiiriiiieieeeeieeeeeeeeeeeeeeeeeeeeeeesesess b aaaseseseeeaaaeseserersersrssssssarasnnen 175
IMEMOIY:HFEREE?. ... i ittt s e s e s e e e e e e e e e e e e et et e e e eeeeee s te b et n e aeseseeeaaaaaaaaaaenenes 175
IMMEMOTY:LOAD ST AT . .ttt e e e e e e e e e e e et et e ettt et eete b e e e e e e e e e e e e aaaaaeeeeeeeenaeaessnsnnnnan 175
IMMEMOTY:MDIRECIONY . ettt e e e e e e e e e e e e e e e e e e e e ettt emeeeeeseseaaa e e e e e e e e e e aeaaaaaaaaeeeeaeennnes 176
IMMEMOTY:IMOVE. .. ..ttt ettt ettt e et e et e e e e e ee e e e ea e eaeaann e 176
IMMEMOTYIMSIS .. et e e e e e e e e e e e s e e e e e et e eren e e ren e eenans 176
IMMEMOTY:RDIRECIONY....cevvvrtrrriiiirutiiiieieieseeeeeeeeesereeeerreeesrssstararananiaseseesaeesasseesererenns 176
IMMEMOTY:STORE ST AT .. uiiiitiieeie e e e e e e ee et e e e e e e e e e e s e et e b e eeeeeaaeesessannnnbeaereeeaaaaens 177

:MMEMory:CATalog? <path>

Returns the content of a particular directory.
Query parameters:

<path> string

String parameter to specify the directory.

If you leave out the path, the command returns the contents of
the directory selected with : MMEMory :CDIRectory.

The path may be relative or absolute.



Return values:
<UsedDiskSpace>

<FreeDiskSpace>

<Filelnfo>

Example:

Usage:

MMEMory Subsystem

Byte size of all files in the directory.
Remaining disk space in bytes.

<NameFileN>,<SuffixFileN> <SizeFileN>
List of files, separated by commas

<NameFileN>
Name of the file.

<SuffixFileN>
Type of the file. Possible suffixes are: ASCii, BINary, DIRectory

<SizeFileN>
Size of the file in bytes.

See "Working with Files and Directories" on page 170.

Query only

:MMEMory:CATalog:LENGth? <Path>

Returns the number of files in the current or in the specified directory.

Query parameters:
<Path>

Return values:
<FileCount>

Example:

Usage:

string

String parameter to specify the directory. If the directory is omit-
ted, the command queries the content of the current directory,
queried with :MMEMory : CDIRectory command.

integer
Number of files.

See "Working with Files and Directories" on page 170.

Query only

:MMEMory:CDIRectory <Directory>

Changes the default directory for mass memory storage. The directory is used for all
subsequent MMEM commands if no path is specified with them.

Parameters:
<Directory>

Example:

Usage:

<directory_name>

String containing the path to another directory. The path may be
relative or absolute.
To change to a higher directory, use two dots ".." .

See "Working with Files and Directories" on page 170.

SCPI confirmed
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:MMEMory:COPY <SourceFile>[,<DestinationFile>]

Copies an existing file to a new file. Instead of just a file, this command can also be
used to copy a complete directory together with all its files.

Setting parameters:

<SourceFile> string
String containing the path and file name of the source file
If <destination> is not specified, <source> is copied to the
MMEM: CDIR directory. Files which already exist with the same
name in the destination directory are overwritten without an error
message.

<DestinationFile> string

String containing the path and name of the target file. The path
may be relative or absolute.

If no file destination is specified, the source file is copied to the
current directory, queried with the :MMEMory:CDIRectory
command. Files which already exist with the same name in the
destination directory are overwritten without an error message.

Example: See "Working with Files and Directories" on page 170.

Usage: Setting only
SCPI confirmed

:MMEMory:DATA <Filename>, <BinaryBlock>
:MMEMory:DATA? <Filename>

The setting command writes the block data <BinaryBlock> to the file identified by
<Filename>. Set the GPIB-bus terminator to EOI to ensure correct data transfer.

The query command transfers the specified file from the instrument to the GPIB-bus
and then on to the controller. It is important to ensure that the intermediate memory on
the controller is large enough to take the file. The setting for the GPIB-bus terminator is
irrelevant.

Tip: Use this command to read/transfer stored instrument settings or waveforms
directly from/to the instrument.

Parameters:
<BinaryBlock> #<number><length_entry><data>

#: Hash sign; always comes first in the binary block
<number>: the first digit indicates how many digits the subse-
quent length entry has

<length entry>:indicates the number of subsequent bytes
<data>: binary block data for the specified length.

For files with a size with more than 9 digits (Gigabytes) the
instrument allows the syntax # (<Length>), where <Length>
is the file size in decimal format.
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Parameters for setting and query:

<Filename> string
String parameter to specify the name of the file.

Example: MMEMory:DATA '/var/sgs/test.txt',#15hallo
Writes the block data to the file test. txt.
The digit 1 indicates a length entry of 1 digit; the digit 5 indicate
a length of the binary data (hallo) in bytes.
MMEMory:DATA? '/var/sgs/test.txt'
sends the data of the file test. txt from the instrument to the

controller in the form of a binary block.
Response: #15hallo

Usage: SCPI confirmed

:MMEMory:DCATalog? <path>
Returns the subdirectories of a particular directory.

Query parameters:

<path> String parameter to specify the directory. If the directory is omit-
ted, the command queries the content of the current directory,
queried with : MMEMory : CDIRectory command.

Return values:
<Catalog> <file_entry>

Names of the subdirectories separated by colons. The first two
strings are related to the parent directory.

Example: See "Working with Files and Directories" on page 170.

Usage: Query only

:MMEMory:DCATalog:LENGth? [<Path>]
Returns the number of subdirectories in the current or specified directory.

Query parameters:

<Path> String parameter to specify the directory. If the directory is omit-
ted, the command queries the contents of the current directory,
to be queried with : MMEMory : CDTRectory command.

Return values:
<DirectoryCount> integer

Number of parent and subdirectories.
Example: See "Working with Files and Directories" on page 170.

Usage: Query only
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:MMEMory:DELete <Filename>
Removes a file from the specified directory.

Setting parameters:

<Filename> string
String parameter to specify the name and directory of the file to
be removed.

Example: See "Working with Files and Directories" on page 170.

Usage: Event

SCPI confirmed

:MEMory:HFRee?
Returns the used and available memory in Kb.

Return values:
<TotalPhysMemKb> integer

Total physical memory.

<ApplicMemKb> integer
Application memory.

<HeapUsedKb> integer
Used heap memory.

<HeapAuvailableKb> integer
Available heap memory.

Usage: Query only

:MMEMory:LOAD:STATe <SavRclIStateNumb>, <file_name>
Loads the specified file stored under the specified name in an internal memory.

After the file has been loaded, the instrument setting must be activated using an *RCL
command.

Setting parameters:
<SavRclIStateNumb> Determines to the specific <number> to be used with the *RCL
command, e.g. *RCL 4.

<file_name> String parameter to specify the file name with extension
*.savrcltxt.

Example: See "Storing and Loading Current Settings" on page 170.

Usage: Setting only
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:MMEMory:MDIRectory <Directory>

Creates a new subdirectory for mass memory storage in the specified directory. If no
directory is specified, a subdirectory is created in the default directory. This command
can also be used to create a directory tree.

Setting parameters:
<Directory> string

String parameter to specify the new directory.
Example: See "Working with Files and Directories" on page 170.

Usage: Event

:MMEMory:MOVE <SourceFile>, <DestinationFile>

Moves an existing file to a new location or, if no path is specified, renames an existing
file.

Setting parameters:
<SourceFile> string

String parameter to specify the name of the file to be moved.

<DestinationFile> string
String parameters to specify the name of the new file.

Example: See "Working with Files and Directories" on page 170.

Usage: Event
SCPI confirmed

:MMEMory:MSIS <Msis>

Defines the drive or network resource (in the case of networks) for instruments with
windows operating system, using msis (MSIS = Mass Storage Identification String).

Note: Instruments with Linux operating system ignore this command, since Linux does
not use drive letter assignment.

Usage: SCPI confirmed

:MMEMory:RDIRectory <Directory>

Removes an existing directory from the mass memory storage system. If no directory
is specified, the subdirectory with the specified name is deleted in the default directory.

Setting parameters:
<Directory> string

String parameter to specify the directory to be deleted.
Example: See "Working with Files and Directories" on page 170.

Usage: Event



Fast Speed Commands

:MMEMory:STORe:STATe <savrcl_state_nr>, <file_name>
Stores the current instrument setting in the specified file.

The instrument setting must first be stored in an internal memory with the same num-
ber using the common command *sSAv.

Setting parameters:
<savrcl_state_nr> Corresponds to the specific <number> defined with the *sav
command, e.g. *SAV 4.

<file_name> String parameter to specify the file name with extension
*.savrcltxt.

Example: See "Storing and Loading Current Settings" on page 170.

Usage: Event

11.11 Fast Speed Commands

This section describes special commands that allow a fast frequency and level setting.

| PO PP PPN 177
[ | SO UPRRN 177
:FFASt <Freg>

Special command to set the RF output frequency with minimum latency. No unit (e.g.
Hz) allowed.

Bypasses the status system so command *0PC? cannot be appended.

Parameters:

<Freq> float

Example: FFASt 12750000000
:PFASt <Pow>

Special command to set the RF output level with minimum latency. No unit (e.g. dBm)
allowed.

Bypasses the status system so command *OPC? cannot be appended.

Parameters:
<Pow> float
Example: :PFASt -20
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11.12 OUTPut Subsystem
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:OUTPut:AFIXed:RANGe:LOWer?

Queries the minimum level which can be set without the attenuator being adjusted
(Attenuator F1Xed).

Return values:
<Lower> float

Default unit: dBm

Example: See chapter 11.1.2, "Generating an I/Q Modulated Signal”,
on page 146.
Usage: Query only

:OUTPut:AFIXed:RANGe:UPPer?

Queries the maximum level which can be set without the attenuator being adjusted
(Attenuator FIXed).

Return values:
<Upper> float

Default unit: dBm

Example: See chapter 11.1.2, "Generating an 1/Q Modulated Signal",
on page 146.
Usage: Query only

:OUTPut:AMODe <AMode>

Switches the mode of the attenuator at the RF output.
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Parameters:

<AMode> AUTO | FIXed | APASsive
AUTO
The attenuator is switched automatically. The level settings are
made in the full range.
APASsive
The attenuator is switched automatically. The level settings are
made only for the passive reference curcuits. The high level
ranges are not available.
FIXed
The level settings are made without switching the attenuator.
When this operating mode is switched on, the attenuator is fixed
to its current position and the resulting variation range is defined.
*RST: AUTO

Example: See chapter 11.1.2, "Generating an 1/Q Modulated Signal",
on page 146.

:OUTPut[:STATe]:PON <Pon>

Selects the state which the RF output assumes when the instrument is switched on.

Parameters:
<Pon> OFF | UNCHanged
*RST: UNCHanged
Example: See chapter 11.1.4, "Advanced Task for Optimizing Perform-

ance", on page 149.

Manual operation: See "Power-On State" on page 74

:OUTPut[:STATe] <State>

Activates/ deactivates the RF output.

Parameters:
<State> 0]1]OFF|ON
Example: See chapter 11.1.2, "Generating an I/Q Modulated Signal”,

on page 146.
Manual operation: See "RF ON/OFF" on page 56

11.13 SOURce Subsystem
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[:SOURce]:OPMode <OpMode>
Sets the operation mode.

Parameters:
<OpMode> NORMal | BBBYpass

NORMal
normal operation

BBBYpass
Baseband bypass mode

*RST: NORMal

Example: See chapter 11.1.2, "Generating an I/Q Modulated Signal”,
on page 146.

Manual operation: See "Operation Mode" on page 65

[:SOURce]:FREQuency[:CW|FIXed] <Cw>

Sets the RF frequency at the RF output connector of the selected instrument.

Parameters:

<Cw> float
*RST: 1 GHz

Example: See chapter 11.1.2, "Generating an I/Q Modulated Signal”,
on page 146.

Manual operation: See "Frequency" on page 56

[:SOURce]:LOSCillator:SOURce <Source>

Selects the source of the local oscillator signal.

Parameters:

<Source> INTernal | EXTernal
INT: use built in oscillator; EXT: use signal at REF/LO IN con-
nector

Example: See chapter 11.1.2, "Generating an I/Q Modulated Signal”,
on page 146.

Manual operation: See "Source" on page 68

[:SOURce]:PATH:COUNt?
The command queries the number of installed RF paths.

Return values:

<Count> integer
Range: 1 to INT_MAX
*RST: 1
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SOURCce:CORRection Subsystem

Example: PATH:COUN?

queries the number of RF paths.
Response: 1

the instrument is equipped with one RF path.

Usage: Query only

SOURce:CORRection Subsystem

The output level is corrected in the CORRection subsystem. Correction is performed
by user-defined table values being added to the output level for the respective RF fre-
quency. In the R&S SGS, this subsystem is used to select, transfer and activate user
correction tables.

Each list is stored as a file. The name of the user correction file can be freely selected.
The file extension * . uco is assigned automatically and cannot be changed.

The files can be stored in a freely selectable directory and opened from there. The
default directory is set using command :MMEMory:CDIRectory on page 172. In the
case of files which are stored in the default directory, only the file name has to be
specified in commands. Otherwise, the complete absolute path has to be specified with
every command. The extension can be omitted in any case.

In the following command examples, the files are stored in the default directory.

[:SOURCEe]:CORRECtON:CSET:CATAIOG?.c.cevvrerrrrrrurnriiiieieieseeeeeeeeeeeeserereeeeeresersrrsrasnnnnnnn 181
[:SOURce<hw>]:CORRection:CSET:DATA:IFREQUENCY.....cieiiieiiireieeeeeiiiie e eeeeeraeeeeeeeennns 182
[:SOURce<hw>]:CORRection:CSET:DATA:FREQUENCY:POINLS?....cccvvvviieiieriiniee e 182
[:SOURce<hw>]:CORReCtion:CSET:DATAIPOWET......ccctiuieeieeeeeice e e e eeteee e e eeeeaae e e e eeeenas 183
[:SOURce<hw>]:CORRection:CSET:DATA:POWEIPOINES?....ceuureeunaaaae e eeeeeeeeaaaaeeeeeeeees 183
[:SOURCE]:CORRECION:CSET:DELELE. .. .uueuuaaeaeie e e e e e e e eeeeee e e e e e e 183
[:SOURce<hw>]:CORRection:DEXChange:AFILE:CATAIOG?......uuueierieeeeeeiieierinieeereaaaaeeans 184
[:SOURce<hw>]:CORRection:DEXChange:AFILe:EXTENSION........cceeeeeeeieieeeeeeeeeveereririaannnns 184
[:SOURce<hw>]:CORRection:DEXChange:AFILE:SELECE.......uuuueeieieieeeeeeeeeeeeeeeeeeeeeeeeeeienns 184
[:SOURce<hw>]:CORRection:DEXChange:AFILe:SEParator:COLUMN.......c...ceereererrnnnreneenns 185
[:SOURce<hw>]:CORRection:DEXChange:AFILe:SEParator:DECIimal............cccevvueeeeerennnn. 185
[:SOURce<hw>]:CORRection:DEXChange:EXECULE..........uuuuuuuaaaaae e e e e e e eeeeeeeeeeeeeeeeeeeanens 186
[:SOURce<hw>]:CORRection:DEXChange:MODE............uuuuuaaaaaaaaaeeeeeeeeeeeeeeeeeeeeeeeeeeeeenens 186
[:SOURce<hw>]:CORRection:DEXChange:SELECE......uuuuuieeieieieeeeeeeeeeeeeeeeeeeeeeeeeevevevevaaees 187
[:SOURCce<hw>]:CORRECtON:CSET[:SELEC]...cceiiieieieeeeeeeieiieeeeeeeeeeererebee e e e e e e e e 187
[:SOURCE<hW>]:CORRECHON[:STATE] i eeeeieetiieieeeeetiieeeeeeertteieeeeeerataseeeerstaneeeeseenraenns 188
[:SOURCEe<hW>]:CORRECHON:VALUE .. it ietieiteieeeeeiitiee s e eeeeetes e e eeeeaase s e e e e e eaaneeeeeeenna s 188

[:SOURce]:CORRection:CSET:CATalog?

Requests a list of user correction tables. The individual lists are separated by commas.
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The lists are stored with the fixed file extensions * . uco in a directory of the user's
choice. The directory applicable to the commands is defined with the command
MMEMory:CDIR.

Return values:
<Catalog> string

Example: MMEM:CDIR '/var/sgs/ucor'

selects the directory for the user correction files.
CORR:CSET:CAT?

queries which correction tables are available.
Response:UCOR1, UCOR2, UCOR3

the correction tables UCOR1, UCOR2 and UCOR3 are availa-
ble.

Usage: Query only

[:SOURce<hw>]:CORRection:CSET:DATA:FREQuency <Frequency>
Transfers the frequency data to the table selected with : CORRection:CSET:SELect.

The numerical suffix at SOURce must not be used for this command.

Parameters:
<Frequency> Frequency#1[, Frequency#2, ...]

Range: 300 kHz to RFmax (depending on model)
Example: CORR:CSET '/var/sgs/ucorl'

selects the table ucorl.
CORR:CSET:DATA:FREQ 100MHz, 102MHz,103MHz, ...
enters the frequency value in the table ucori.

[:SOURce<hw>]:CORRection:CSET:DATA:FREQuency:POINts?
The command queries the number of frequency values in the selected table.
The numerical suffix at SOURce must not be used for this command.

Return values:

<Points> integer
Range: 0 to 10000
*RST: 0

Example: CORR:CSET '/var/sgs/'

selects the table ucor1.

CORR:CSET:DATA:FREQ: POIN?

queries the number of frequency values in the table ucor1.
Response: 440

the table ucor1 contains 440 frequency values.

Usage: Query only
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[:SOURce<hw>]:CORRection:CSET:DATA:POWer <Power>

Transfers the level data to the table selected with [ : SOURce<hw>] : CORRection:
CSET[:SELect].

*RST does not affect data lists. The numerical suffix at SOURce must not be used for
this command.

Parameters:
<Power> Power#1[, Power#2, ...]
Example: CORR:CSET '/var/sgs/ucorl'

selects the table ucorl.
CORR:CSET:DATA:POW 1dB, 0.8dB, 0.75dB,...
enters the level values in the table ucorl.

[:SOURce<hw>]:CORRection:CSET:DATA:POWer:POINts?
Queries the number of level values in the selected table.
The numerical suffix at SOURce must not be used for this command.

Return values:

<Points> integer
Range: 0 to 10000
*RST: 0
Example: CORR:CSET '/var/sgs/ucorl'

selects the table ucor1.
CORR:CSET:DATA: POW: POIN?

queries the number of level values in the table ucor1.
Response: 440

the table ucor1 contains 440 level values.

Usage: Query only

[:SOURce]:CORRection:CSET:DELete <Filename>
Deletes the specified table.

The lists are stored with the fixed file extensions * . uco in a directory of the user's
choice. The directory applicable to the commands is defined with the command
MMEMory : CDIR. A path can also be specified in command SOUR: CORR:CSET : CAT?,
in which case the file in the specified directory is deleted.

Setting parameters:
<Filename> <table name>

Example: MMEM:CDIR '/var/sgs/ucor'
selects the directory for the user correction files.
CORR:CSET:DEL 'UCORL'

deletes the table ucorl.

Usage: Setting only
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[:SOURce<hw>]:CORRection:DEXChange:AFILe:CATalog?

Requests a list of available ASCII files for export/import of user correction data. The
individual files are separated by commas.

The ASCII files are stored with the fixed file extensions * . txt or *.csv in a directory
of the user's choice. The directory applicable to the commands is defined with the com-
mand MMEMory : CDIR.

Return values:

<Catalog> string

Example: MMEM:CDIR '/var/sgs/import'
selects the directory for the ASCII files with frequency and level
value pairs.

CORR:DEXC:AFIL:EXT TXT

selects that ASCII files with extension * . txt are listed.
CORR:DEXC:AFIL:CAT?

queries the available files with extension * . txt.
Response: 'ucorl,ucor2’

the ASCII files ucorl.txt and ucor2.txt are available.

Usage: Query only

[:SOURce<hw>]:CORRection:DEXChange:AFILe:EXTension <Extension>

Selects the file extension of the ASCII file to be imported or exported. Selection TXT
(text file) or CSV (Excel file) is available.

Parameters:

<Extension> TXT | CSV
*RST: TXT

Example: MMEM:CDIR '/var/sgs/import'
selects the directory for the ASCII files with frequency and level
value pairs.

CORR:DEXC:AFIL:EXT TXT

selects that ASCII files with extension *.txt are listed.
CORR:DEXC:AFIL:CAT?

queries the available files with extension *.txt.

Response: "1istl,1list2’

the ASCII files ucorl.txt and ucor2. txt are available.

[:SOURce<hw>]:CORRection:DEXChange:AFILe:SELect <Filename>
Selects the ASCII file to be imported or exported.

The ASCII files are stored with the fixed file extensions * . txt or *.csv in a directory
of the user's choice. The directory applicable to the commands is defined with the com-
mand MMEMory : CDIR. A path can also be specified in command
SOUR:CORR:DEXC:AFIL:SEL, in which case the files are stored or loaded in the
specified directory.
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Parameters:
<Filename> <ascii file name>
Example: CORR:DEXC:MODE IMP

selects that ASCII files with frequency and level value pairs are
imported and transferred into user correction lists.
CORR:DEXC:AFIL:SEL '/var/sgs/import ucor.csv'
selects that ASCII file ucor.csv is imported.
CORR:DEXC:SEL '/var/sgs/import ucor imp'

selects that the ASCII file ucor. csv is imported into user cor-
rection list ucor imp.

[:SOURce<hw>]:CORRection:DEXChange:AFILe:SEParator:COLumn <Column>

Selects the separator between the frequency and level column of the ASCII table.

Parameters:

<Column> TABulator | SEMicolon | COMMa | SPACe
*RST: COMMa

Example: CORR:DEXC:MODE EXP

selects that the user correction list is exported into an ASCII file.
CORR:DEXC:AFIL:SEL '/var/sgs/import ucor.csv'
selects ASCII file ucor.csv as destination for the user correction
list data.

CORR:DEXC:AFIL:SEP:COL TAB

the pairs of frequency and level values are separated by a tabu-
lator.

CORR:DEXC:AFIL:SEP:DEC DOT

selects the decimal separator dot.

CORR:DEXC:SEL '/var/sgs/import ucor imp'

selects that the user correction list ucor_imp is imported into
ASCII file ucor.csv.

[:SOURce<hw>]:CORRection:DEXChange:AFILe:SEParator:DECimal <Decimal>

Selects the decimal separator used in the ASCII data between '.' (decimal point) and ;'
(comma) with floating-point numerals.

Parameters:
<Decimal> DOT | COMMa

*RST: DOT



Example:
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CORR:DEXC:MODE EXP
selects that the user correction list is exported into an ASCII file.
CORR:DEXC:AFIL:SEL '/var/sgs/import ucor.csv'
selects ASCII file ucor.csv as destination for the user correction
list data.

CORR:DEXC:AFIL:SEP:COL TAB

the pairs of frequency and level values are separated by a tabu-

lator.
CORR:DEXC:AFIL:SEP:DEC DOT

selects the decimal separator dot.

CORR:DEXC:SEL '/var/sgs/import ucor imp'
selects that the user correction list ucor imp is imported into
ASCII file ucor.csv.

[:SOURce<hw>]:CORRection:DEXChange:EXECute

Starts the export or import of the selected file. When import is selected, the ASCII file is
imported as user correction list. When export is selected, the user correction list is
exported into the selected ASCII file.

Example:

Usage:

CORR:DEXC:MODE IMP
selects that ASCII files with frequency and level value pairs are
imported and transferred into user correction lists.
CORR:DEXC:AFIL:SEL '/var/sgs/import ucor.csv'
selects that ASCII file ucor.csv is imported.

CORR:DEXC:SEL '/var/sgs/import ucor imp'

selects that the ASCII file ucor. csv is imported into user cor-
rection list ucor imp.

CORR:DEXC:EXEC

starts the import of the ASCII file data into the user correction
file.

Event

[:SOURce<hw>]:CORRection:DEXChange:MODE <Mode>

Selects if user correction lists should be imported or exported. Depending on the selec-
tion her, the file select command define either the source or the destination for user
correction lists and ASCI| files.

Parameters:

<Mode>

IMPort | EXPort
*RST: IMPort
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Example: CORR:DEXC:MODE IMP
selects that ASCII files with frequency and level value pairs are
imported and transferred into user correction lists.
CORR:DEXC:AFIL:SEL '/var/sgs/ucor.csv'

selects that ASCII file ucor.csv is imported.

CORR:DEXC:SEL '/var/sgs/ucor imp'

selects that the ASCII file ucor. csv is imported into user cor-
rection list ucor imp.

[:SOURce<hw>]:CORRection:DEXChange:SELect <Filename>
Selects the user correction list to be imported or exported.

The user correction files are stored with the fixed file extensions * . uco in a directory
of the user's choice. The directory applicable to the commands is defined with the com-
mand MMEMory : CDIR. A path can also be specified in command

SOUR:CORR:DEXC: SEL, in which case the files are stored or loaded in the specified

directory.

Parameters:

<Filename> string

Example: CORR:DEXC:MODE IMP

selects that ASCII files with frequency and level value pairs are
imported and transferred into user correction lists.
CORR:DEXC:AFIL:SEL '/var/sgs/import ucor.csv'

selects that ASCII file ucor.csv is imported.

CORR:DEXC:SEL '/var/sgs/import ucor imp'

selects that the ASCII file ucor. csv is imported into user cor-
rection list ucor imp.

[:SOURce<hw>]:CORRection:CSET[:SELect] <Filename>
Selects or creates a file for the user correction data.

If the file does not exist, the instrument automatically creates a new file with the name
you assigned. Note the predefined file extensions under chapter 11.10.2, "Extensions
for User Files", on page 170.

To determine the file location (directory/path) you can either enter it with the command
directly, or use the command MMEMory : CDIR.

To activate level correction use the command [ : SOURce<hw>] : CORRection]|:
STATe].

Parameters:
<Filename> <table name>



11.15
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Example: CORR:CSET '/var/sgs/ucorl'
selects the table ucorl.
CORR ON
activates level correction. Correction is performed using the
table ucorl.

[:SOURce<hw>]:CORRection[:STATe] <State>

Activates/deactivates level correction. Level correction is performed using the table
which has been selected with the command [ : SOURce<hw>] : CORRection:CSET [ :
SELect].

Parameters:
<State> 0|1]|OFF|ON
*RST: 0
Example: SOUR:CORR:CSET '/var/sgs/ucorl'

selects the table ucorl.
SOUR:CORR ON
activates user correction.

[:SOURce<hw>]:CORRection:VALue?
Queries the current value for user correction.

Return values:

<Value> float
Range: -100 to 100
Increment: 0.01
*RST: 0

Example: CORR:VAL?

queries the value currently used for level correction.
Response: -3
the correction value is - 3 dB.

Usage: Query only

SOURce:IQ Subsystem

[ S OURCE]IQ:STATE . eeeeeeeeeeeeeeeeeeeeeeeeseeeeeeeeseseseseeeeeeeeeeeseseseaseseseseseeeeeseeeeeeeseseaneesenaens 189
[:SOURCcel:IQ:IMPairment:IQRatio[:MAGNItUAE].........ceeeeeeereirriniiiceieeeie e e e e e e eeeeeeeeeeeeeeeeeens 189
[:SOURCcel:IQ:IMPairment: LEAKAGE: L .. .iiiieeeriie ettt e et e e e e e e s eeaa e e e 189
[:SOURCcel:IQ:IMPairment:LEAKAGE: Q... ciieeeerieeeeeeeiiiie e e ee ettt se e e e eeaaee s e e e e eetaan e e e eeeenn e 189
[:SOURCce]:IQ:IMPairment: QUADrature[:ANGLE]. c.cceurruueeeaaaaaaa e e e e e e e e e e e e e eeeeeeeeeeeeeenenaeas 189
[:SOURCE]:IQ:IMPAIMENt:STATE]. .. e e et et eeeeeeeeeieiieteteeeeeee e e e e e e e e e e e e e e aeaeeeeeeeeeeeeneeennnnnnnnnnn 190
[:SOURCE]:IQ:CRESHACION. . cieieeeeeeeeeeeeeee ettt eese s e e e e e eeaeaeaeaaeseeeeeeeeesesesessnsanas 190
[[SOURCE]:IQ:VWBSTAE. c.cerreuerurueunnaaaaaaeeeeeseseeeaaeeteeeeeeeeeeeeesensasnnnnnaaaaeseseeeasaaaaeeeeeeerennens 190
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[:SOURce]:IQ:STATe <State>

Switches the 1/Q modulation on and off.

Parameters:

<State> 0]1]OFF|ON
*RST: 0

Example: See chapter 11.1.2, "Generating an 1/Q Modulated Signal",
on page 146.

Manual operation: See "Mod State" on page 56

[:SOURce]:IQ:IMPairment:IQRatio[:MAGNitude] <IqgRatio>

Sets the ratio of | modulation to Q modulation (amplification “imbalance”). The input
may be either in dB or %. The resolution is 0.001 dB, an input in percent is rounded to
the closest valid value in dB. A query returns the value in dB.

Parameters:
<lgRatio> float
Range: -1 to 1
Increment: 1E-3
*RST: 0
Example: See chapter 11.1.2, "Generating an 1/Q Modulated Signal",
on page 146.

Manual operation: See "Gain Imbalance" on page 85

[:SOURce]:IQ:IMPairment:LEAKage:I <|>
[:SOURcel:IQ:IMPairment:LEAKage:Q <Q>

Sets the carrier leakage amplitude for the Q-signal component.

Parameters:
<Q> float
Range: -5 to 5
Increment: 0.01
*RST: 0
Default unit: PCT
Example: See chapter 11.1.2, "Generating an 1/Q Modulated Signal",

on page 146.

Manual operation: See "Offset" on page 85

[:SOURce]:IQ:IMPairment:QUADrature[:ANGLe] <Angle>
Sets the quadrature offset for the digital I/Q signal.
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Parameters:
<Angle> float
Range: -8 to 8
Increment: 0.01
*RST: 0
Default unit: DEG
Example: See chapter 11.1.2, "Generating an I/Q Modulated Signal”,

on page 146.

Manual operation: See "Quadrature Offset” on page 86

[:SOURce]:IQ:IMPairment[:STATe] <State>

Activates/ deactivates the three impairment or correction values LEAKage, QUADra-
ture and IQRatio for the baseband signal prior to input into the 1/Q modulator.

Parameters:

<State> 0]1]OFF|ON
*RST: 0

Example: See chapter 11.1.2, "Generating an 1/Q Modulated Signal",
on page 146.

Manual operation: See "State" on page 85

[:SOURce]:IQ:CREStfactor <CrestFactor>

Sets the crest factor of the IQ modulation signal.

Parameters:
<CrestFactor> float
Range: 0 to 35
Increment: 0.01
*RST: 0
Example: see chapter 11.1.2, "Generating an I/Q Modulated Signal",
on page 146

Manual operation: See "Crest Factor" on page 84

[:SOURce]:IQ:WBSTate <State>

Selects optimized settings for wideband modulation signals.

Parameters:

<State> 0]1]OFF|ON
*RST: 0

Example: See chapter 11.1.2, "Generating an I/Q Modulated Signal”,
on page 146.

Manual operation: See "I/Q Wideband" on page 84
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SOURCce:PHASe Subsystem

SOURce:PHASe Subsystem

[ESOURCEIPHASE. ...t eee e eeeeee e eeeeeeesteeseseeeeeeeeeeesesseseeeeeeeeeeeseeseeeeeesseeseesessseeeneeeen 191
[[SOURCE]:PHASEREFEIENCE. ...cciieieeeeeeeeeeeieeeeeeeeeeetett b erseeseseseseeeeeaeseseeeeeeeeeeessssarananas 191

[:SOURce]:PHASe <Phase>

Specifies the phase variation relative to the current phase.

Parameters:
<Phase> float
Range: -360 to 360
Increment: 0.1
*RST: 0
Default unit: DEG
Example: See chapter 11.1.2, "Generating an I/Q Modulated Signal”,

on page 146.

Manual operation: See "Delta Phase" on page 66

[:SOURce]:PHASe:REFerence
Adopts the phase set with command [ : SOURce] : PHASe as the current phase.

Example: See chapter 11.1.2, "Generating an 1/Q Modulated Signal",
on page 146.

Usage: Event

Manual operation: See "Reset Delta Phase Display" on page 66

SOURce:POWer Subsystem

[:SOURCE]:POWEr:ALC:DSENSITIVITY ...uieuietieiieeii et e e e 192
[:SOURCE]:POWEFALCESTATE] . eeeeeereeeeeesereeeeseseseeseseeeseeseseseeseseseseeseseseesesesesseseseseeseseses 192
[:SOURGCE]:POWEIALC:SONCE. . .uciieieieieeeeeeeeeieeeeeeeeeeeeeaaatab e aeaeseseeeeeasaaaaeeeseseeeesesrenes 192
[:SOURCce]:POWer:ATTenuation:RFOFfIMODE..........cooieiiiiiiiieeeeeeriiee e eeereeeeeeeenrneeeeees 192
[:SOURCce]:POWer:ATTenuation:SOVer[:OFFSet].......cuiuuiiiiiiieiiiie et seeeaeves e e e e 192
[:SOURCE]:POWETLIMODE........cciiieeeeieeeeeeeeeieeeet e e e e e e e e e e e e e e eaeeeeeeeeeeeenaessnnnnnnnns 192
[:SOURCE]:POWEITIPOWET.....ceeiiieieteuiaaeaaaaaae e e e e e e e e e e e e eee et et eeeeaeeentnann e a e e e e e e e e aeaaaaeaeens 193
[:SOURCE]:POWET:SCHAraCteriStiC. .. .. eveeeeeeeeeieeininieaaaaaaeae e e e eeeeeeaeeeeeeeeeeeeeeeeeenennennnnnnnnan 193
[:SOURce]:POWer[:LEVel][:IMMediate][:AMPLIEUAE]......ceeeeeiereeeeeeeeeieeeeeeeeeeererrerevbee s 194
[:SOURce]:POWer[:LEVel|[:IMMediate]:OF FSet...uuuururuirieieieieeieeeeeeeeeeeeeeeeeeeeeeevevesrasannnnnes 194
[:SOURCEe]:POWEr:LIMIt:AMPLIEUAE]. ...cvuuueeeeeieetiieeeeeeeeteee e ee et e e e e et e e e e e et e e e e e eeannanns 194
RSO L o=y H o @ A=Y o P 195
[:SOURCE]:POWEIRANGE:LOWEI?.....cceeeeieeeeeeeeeeeeeetet e e e e e e e e e e e e e e e e e e eaeeeeeeeeeeeeneenennnnan 195
[:SOURCE]:POWEIRANGEIUPPEI?.....ccci i e ettt eeeeeaa e s e e e e e e e e e e aeaeeeeeeeeeeneenenennnnnnan 195



SOURCce:POWer Subsystem

[:SOURce]:POWer:ALC:DSENsitivity <Sensitivity>
Sets the power detector sensitivity. Used for compatibility reasons only.

Parameters:
<Sensitivity> OFF | LOW | MED | HIGH

*RST: OFF

[:SOURce]:POWer:ALC[:STATe] <State>

Activates/deactivates automatic level control.

Parameters:

<State> 1| OFFTable | OFF | ONTable | AUTO | ON
*RST: ONTable

Example: See chapter 11.1.2, "Generating an I/Q Modulated Signal”,
on page 146.

[:SOURce]:POWer:ALC:SONCe
Briefly activates level control for correction purposes.
Usage: Event

Manual operation: See "Readjust” on page 74

[:SOURce]:POWer:ATTenuation:RFOFf:MODE <Mode>
Determines the attenuator's state after the instrument is switched on.

Parameters:
<Mode> MAX | FATTenuated | FIXed | UNCHanged

*RST: MAX

[:SOURce]:POWer:ATTenuation:SOVer[:OFFSet] <Offset>

Sets the switch-over offset value of the attenuator.

Parameters:

<Offset> float
Range: -10 to 10
Increment: 0.1
*RST: 0

[:SOURce]:POWer:LMODe <LevMode>

Selects the level mode.



Parameters:
<LevMode>

Example:

Manual operation:

SOURCce:POWer Subsystem

NORM | LNOise | LDIStortion

NORM
automatic selection of the best settings

LNOISe
settings for lowest noise

LDIStortion
settings for lowest distortions

See chapter 11.1.4, "Advanced Task for Optimizing Perform-
ance", on page 149.

See "Mode" on page 72

[:SOURce]:POWer:POWer <Amplitude>

Sets the level at the RF output connector.

This value does not consider a specified offset. The command [ : SOURce] : POWer [ :
LEVel] [:IMMediate] [ :AMPLitude] sets the level of the "Level" display, that
means the level containing offset.

Parameters:
<Amplitude>

Example:

Manual operation:

float

Range: -20 to 25
Increment: 0.01
*RST: -10
POW:POW 15

sets the RF level at output to 15 dBm.

See "Level" on page 56

[:SOURce]:POWer:SCHaracteristic <Characteristic>

Selects the characteristic for the level setting.

Parameters:
<Characteristic>

Example:

Manual operation:

AUTO | UNINterrupted | CVSWr | USER | MONotone

UNINterrupted
uninterrupted level setting

CVSWr
constant-VSWR

MONotone
strictly monotone

*RST: AUTO

See chapter 11.1.4, "Advanced Task for Optimizing Perform-
ance", on page 149.

See "Setting Characteristic" on page 73
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[:SOURce]:POWer[:LEVel][:IMMediate][:AMPLitude] <Amplitude>

Sets the RF level at the RF output connector of the instrument.

Parameters:
<Amplitude> float
Range: -20 to 25
Increment: 0.01
*RST: -10
Example: See chapter 11.1.4, "Advanced Task for Optimizing Perform-

ance", on page 149.

Manual operation: See "Level" on page 56

[:SOURce]:POWer[:LEVel][:IMMediate]:OFFSet <Offset>
Note: The level offset is also effective for level sweeps!

The command specifies the constant level offset of a downstream attenuator/amplifier.
If a level offset is entered, the level entered with [ : SOURce] : POWer : POWer no longer
corresponds to the RF output level.

The following correlation applies:
: POWer = RF output level + POWer : OFFSet.

Entering a level offset does not change the RF output level, but rather the query value

of : POWer.

Parameters:

<Offset> float
Range: -100 to 100
Increment: 0.1
*RST: 0

Manual operation: See "Offset" on page 72

[:SOURce]:POWer:LIMit[:AMPLitude] <Amplitude>
Sets the upper limit of the RF signal power.

The value is not affected by an instrument preset and *RST function. This parameter is
influenced only by the factory preset (SYST: FPR) and its factory value is equal to the

upper limit.
Parameters:
<Amplitude> float
Range: -120 to 25
Increment: 0.01
Default unit: dBm
Example: See chapter 11.1.4, "Advanced Task for Optimizing Perform-

ance", on page 149.
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Manual operation: See "Limit" on page 74
[:SOURce]:POWer:PEP?

Queries the RF signal's peak envelope power.

Return values:

<PEP> float

Example: see chapter 11.1.2, "Generating an I/Q Modulated Signal",
on page 146

Usage: Query only

Manual operation: See "PEP" on page 56

[:SOURce]:POWer:RANGe:LOWer?
[:SOURce]:POWer:RANGe:UPPer?

Queries the minimum/maximum level range in the current level mode

Return values:
<Upper> float

Usage: Query only

Manual operation: See "Level Range" on page 74

11.18 SOURce:PULM Subsystem

This subsystem contains the commands for setting the pulse modulation.
Programming Examples

Example: Performing pulse modulation
This example shows a command sequence to perform pulse modulation.

// KA KA KA KA KA KA A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A AKX KK

// Reset the instrument to start from an initial state

// RR R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R i

*RST; *CLS

// RER R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R

// Set the RF signal freguency and level

// KKK A KA A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A A AR AR A A AR A AR R KK

SOURce: FREQuency:CW 4000000000
SOURce:POWer:LEVel:IMMediate:AMPLitude -25

// ER R R R R R R R R R R R R R R R R R R R R R R R R R R R R R i
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// Configure the pulse modulation settings

// Ak hkhhkhkhhkhkhkhhhkhhkhkhhkhhhhkhhkhkhkhhhkhhkhkhdh kb hkhkhkdkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhkhhhkhhkhxkx*x
// Select the internal modulation generator

SOURce: PULM: SOURce INT

// Set trigger mode

SOURce: PULM: TRIGger :MODE AUTO

// Select pulse mode

SOURce: PULM:MODE DOUB

// RR Rk kb ik kb b bk kb b b b bk b b b h kb b b bk b b R R bk kb Rk kb b b b b b

// Alternatively configure the pulse modulation settings for

// external modulation source

// RR Rk ki kb kb kb b bk b b b b b bk b b b b kb b b b b b b R b Rk kb R bk b b b b b b
// Select the external modulation source

SOURce: PULM: SOURce EXT

// Set the polarity of the externally applied modulation signal.
SOURce:PULM: POLarity NORMal

// Select the impedance for the external pulse modulation trigger input
SOURce:PULM: TRIGger:EXTernal : IMPedance G10K

// RS EEEEEEEEEEEEEE R EEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEE

// Configure the pulse generator settings

// ok ok ok ok k k ok ok ke kK ok ke kR ok ke ke ok ok ok ke kK ok sk ok ok ok sk ko ok ok ke ko ok sk kR ok ke ko ok ok ke ko ok ke ok ok ok ok ke ok ok ok ke ok ok ok ok
// Set pulse period

SOURce:PULM: PERiod 10 us

// Set pulse width

SOURce:PULM:WIDth 8 us

// Set double pulse width

SOURce: PULM: DOUBle:WIDTh 0.0000012

// Set double pulse delay

SOURce: PULM:DOUBle:DELay 0.0000045

// AR SRS EEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEE SIS

// Activate the signal output

// ER R R E kb dh b b b E I E b h b b E E kb E b b E E E b b b b b dh b b b b b b b b b b h b 3E b b b h b h b b b b b 3 b

SOURce:PGENerator:OUTPut:STATe 1
SOURce:PULM: STATe 1
OUTPutl:STATe 1

Example: Generating a pulse train signal
This example shows a command sequence to create a pulse train signal.

Prior to the selection of the pulse train mode make sure that you have generated and
selected a pulse train data list. Otherwise, the instrument generates an error.

// RR Rk kb ik b bk b b b b b b b b b b b b b kb b b b R kb b b

// Reset the instrument to start from an initial state
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// RR Rk dh ki kb ik kb kb b bk b b b b b b b b b h kb b b b b b b R b bk kb b h kb R b b b b b

*RST; *CLS

// RR Rk kb kb bk b b bk b b b b b b b b b b h b b b b b b h R R b bk kb b bk b R b b b b

// Set the RF signal frequency and level

// AR SRS EEEEEEEEEEEEE R EEEEEEEEEEEEEEREEEEEEEEEEEEEEEEEEEE S
SOURce:FREQuency:CW 4000000000

SOURce:POWer:LEVel:IMMediate:AMPLitude -25

// Rk dh kb kb bk b b b b b b b b b Rk b b b h kb b b b b b b R b bk kb b h kb b b b R b

// Create a pulse train data list

// RS RS EEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEREEEEEEEEEEEEEEEEEEEEE
// Select the directory

MMEM:CDIR '/var/user/Lists/'

// Create and/or select the pulse train data file
SOURCe:PULM:TRAin:SEL ‘P_FIVE'

// Enter the pulse train data

SOURCe:PULM: TRAiNn:ONTime 10ns,30ns,40ns,20ns,10ns
SOURCe: PULM: TRAin:OFFTime 30ns, 40ns,50ns,40ns, 30ns

SOURCe:PULM: TRAin:REPetition 10,1,3,10,6

// RR Rk kS kb ik bk kb b bk b b b b b b b b h kb b b b b R b bk kb b h Rk b b b b b

// Select pulse train mode

// RS EEEEEEEEEEEEEEE R EEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEE S
// Select the internal modulation generator and the pulse mode
SOURce:PULM: SOURce INTernal

SOURce: PULM:MODE PTRain

// ER R R I b dE I b b Ik I E b b b E I b b E h b E h E h b b h b b dh b b b b b E b b b E E b 3E b b b b b b b b b b b b b 3

// Activate the signal output

// RR Rk kb ik bk kb b bk kb b b b b b b h b b b b b b b R b b Rk kb b h b b kb E R b b b b
SOURce:PGENerator:0UTPut:STATe 1

SOURce:PULM: STATe 1

OUTPutl:STATe 1
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[:SOURCESNWS]:PULM:PERIOG. .. u1uttutitieieeeieieeeeeeeeeeeieeeeeeeeeeessssssssasannnieseseeeesassesessssenes 199
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[:SOURce<hw>]:PULM:DELay <Delay>
Sets the pulse delay.

Parameters:

<Delay> float
Range: 0 to 100 s
Increment: 10 ns
*RST: 10 ns

Example: PULM:DEL 13 us

13 us elapse after a trigger before the first pulse is generated.

Manual operation: See "Pulse Delay" on page 78

[:SOURce<hw>]:PULM:DOUBIe:DELay <Delay>

Sets the delay from the start of the first pulse to the start of the second pulse.

Parameters:

<Delay> float
Range: 40ns to 100 s
Increment: 10 ns
*RST: 1ns

Example: PULM:DOUB:DEL 22 us

22 us elapse between the beginning of the first pulse and the
beginning of the second pulse in double-pulse mode.

Manual operation: See "Double Pulse Delay" on page 78

[:SOURce<hw>]:PULM:DOUBIe:WIDTh <Width>
Sets the width of the second pulse in case of double pulse generation.

Example: PULM:DOUB:WIDT 33 us
sets a width of 33 us for the second pulse.

Manual operation: See "Double Pulse Width" on page 78

[:SOURce<hw>]:PULM:MODE <Mode>

Sets the mode of the pulse generator.

Parameters:

<Mode> SINGle | DOUBIe
SINGle
Enables single pulse generation.
DOUBIe

Enables double pulse generation. The two pulses are generated
in one pulse period.

*RST: SINGle
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Example: PULM:MODE DOUB
enables double pulse generation.

Manual operation: See "Pulse Mode" on page 77

[:SOURce<hw>]:PULM:PERiod <Period>

Sets the period of the generated pulse. The period determines the repetition frequency
of the internal signal.

Parameters:

<Period> float
Range: 100 ns to 100 s
Increment: 10 ns
*RST: 10 ns

Example: PULM:PER 220 us

the pulse period is 220 us.

Manual operation: See "Pulse Period" on page 78

[:SOURce<hw>]:PULM:POLarity <Polarity>

Sets the polarity of the pulse modulator signal. This command is effective only for an
external modulation signal.

Parameters:
<Polarity> NORMal | INVerted

NORMal
The RF signal is suppressed during the pulse pause.

INVerted
The RF signal is suppressed during the pulse.

*RST: NORMal

Example: PULM:SOUR EXT
selects the external modulation source.

Example: PULM:POL INV
selects inverted polarity.

Manual operation: See "Polarity” on page 77

[:SOURce<hw>]:PULM:SOURce <Source>

Selects the source for pulse modulation.



Parameters:
<Source>

Manual operation:

SOURCce:PULM Subsystem

INTernal | EXTernal

INTernal
The internal pulse generator is used for the pulse modulation.

EXTernal
The signal applied externally via the trigger connector is used for
the pulse modulation.

*RST: INTernal

See "Source" on page 77

[:SOURce<hw>]:PULM:STATe <State>

Activates the pulse modulation.

Parameters:
<State>

Example:

Manual operation:

01| OFF | ON
*RST: 0

PULM:STAT ON
activates pulse modulation.

See "State" on page 76

[:SOURce<hw>]:PULM:TRIGger:EXTernal:GATE:POLarity <Polarity>

Selects the polarity of the Gate signal.

Parameters:
<Polarity>

Example:

Manual operation:

NORMal | INVerted
*RST: NORMal

PULM:TRIG:EXT:GATE: POL NORM
The pulse signal is generated while the gate signal is high.

See "Gate Input Polarity" on page 80

[:SOURce<hw>]:PULM:TRIGger:EXTernal:IMPedance <Impedance>

Selects the impedance for external pulse trigger.

Parameters:
<Impedance>

Example:

Manual operation:

G50 | G10K
*RST: G50

SOUR:PULM: TRIG:EXT:IMP G50
selects 50 Ohm as the trigger impedance for the external pulse
trigger.

See "External Impedance" on page 77
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[:SOURce<hw>]:PULM:TRIGger:EXTernal:SLOPe <Slope>

Sets the polarity of the active slope of an externally applied trigger signal.

Parameters:
<Slope>

Example:

Manual operation:

NEGative | POSitive
*RST: POSitive

PULM: TRIG:EXT:SLOP NEG
The pulse generator is triggered on the negative slope of the
external trigger signal.

See "Ext. Trigger Input Slope" on page 80

[:SOURce<hw>]:PULM:TRIGger:MODE <Mode>

Selects the trigger mode for pulse modulation.

Parameters:
<Mode>

Example:

Manual operation:

AUTO | EXTernal | EGATe
AUTO
The pulse modulation is generated continuously.

EXTernal
The pulse modulation is triggered by an external trigger event.
The trigger signal is supplied via the trigger connector.

EGATe
The pulse modulation is gated by an external gate signal. The
trigger signal is supplied via the trigger connector.

*RST: AUTO

PULM: TRIG:MODE EXT
selects triggering by an external trigger event.

See "Trigger Mode" on page 79

[:SOURce<hw>]:PULM:WIDTh <Width>

Sets the width of the generated pulse. The width determines the pulse length. The
pulse width must be at least 20ns less than the set pulse period.

Parameters:
<Width>

Example:

Manual operation:

float

Range: 20ns to 100 s
Increment: 10 ns
*RST: 2 us

PULM:WIDT 33 us
sets a width of 33 us for the pulse.

See "Pulse Width" on page 78
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11.19 SOURce:ROSCillator Subsystem

[:SOURCce]:ROSCillator:EXTernal:FREQUENCY ... ... uuuuaaaaaaeeeeeeeeeeaeeeeeeeeeeeeeeeaneennnnnnnnnnns 202
[:SOURCce]:ROSCillator:OUTPUt:FREQUENCY.......cceeeeeereiiiininriiaaeaeieseeeeeeeaaaaeeeseeeeeeeeeennnnes 202
[:SOURCE]:ROSCIllAatOr:SOURCE. ...evvvrrrrrurnraieieieteeeeeeeaeeeseeterereeersrsrararsrseseeeeaeaaeses 202
[:SOURCce]:ROSCillator[:INTernall:ADJUSEVALUE. .......uueeieeeeeeieeeeeeeeveeeeeeeeetee e e e eevaae s 202
[:SOURCce]:ROSCillator[:INTernal]l: ADJUSL:STATE] .. i ieeeeeieeieeeeeeeeiee e e e e eeenree e e e e eean e e e eeeeees 203
[:SOURce]:ROSCillator:EXTernal:SBANAWIALh. ......cceuiiieee e 203

[:SOURce]:ROSCillator:EXTernal:FREQuency <ExtFreg>

Selects the frequency of the external reference.

Parameters:
<ExtFreqg> 10MHZ | 100MHZ | 1000MHZ
Example: See chapter 11.1.4, "Advanced Task for Optimizing Perform-

ance", on page 149.

Manual operation: See "Ext. Ref. Input Frequency" on page 70

[:SOURce]:ROSCillator:OUTPut:FREQuency <OutputFreq>

Selects the output for the reference oscillator signal.

Parameters:
<OutputFreqg> 10MHZ | 100MHZ | 1000MHZ
Example: See chapter 11.1.4, "Advanced Task for Optimizing Perform-

ance", on page 149.

Manual operation: See "Output Frequency" on page 70

[:SOURce]:ROSCillator:SOURce <Source>

Select the reference oscillator signal source.

Parameters:
<Source> INTernal | EXTernal
Example: See chapter 11.1.2, "Generating an 1/Q Modulated Signal",

on page 146.

Manual operation: See "REF/Ref. Oscillator Source" on page 57

[:SOURce]:ROSCillator[:INTernal]:ADJust:VALue <Value>

Allows an application to shift the reference oscillator frequency by a small amount.

Parameters:

<Value> integer
Range: 0 to 1023 (65635)
*RST: 32767
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Example: See chapter 11.1.4, "Advanced Task for Optimizing Perform-
ance", on page 149.

Manual operation: See "DAC Value" on page 71

[:SOURce]:ROSCillator[:INTernal]:ADJust[:STATe] <State>

Determines whether the calibrated (OFF) or a user-defined (ON) adjustment value is
used for fine adjustment of the frequency. With STATe ON, the instrument is no longer
in the calibrated state. However, the calibration value is not changed and the instru-
ment resumes the calibrated state after switching the Adjustment State to Off.

Parameters:

<State> 0]1|OFF|ON
*RST: --

Example: ROSC:SOUR INT

selects the internal source.
ROSC:ADJ ON

activates use of a user-defined adjustment value.
ROSC:ADJ:VAL 1400

sets the adjustment value to 1400.

Manual operation: See "Adjustment Active" on page 71

[:SOURce]:ROSCillator:EXTernal:SBANdwidth <SBandwidth>

Sets the synchronization bandwidth for an external reference signal.

Parameters:
<SBandwidth> WIDE | NARRow
NARRow
The synchronization bandwidth is 40 Hz.
WIDE
Synchronization bandwidth is 250 Hz.
Example: ROSC:SOUR EXT

selects the external source.
ROSC:EXT:FREQ 10 MHz
informs the instrument that the external reference has a fre-

quency of 10 MHz.
ROSC:EXT:SBAN WID

selects wideband setting for synchronization bandwidth.

Manual operation: See "Synchronization Bandwidth" on page 70

STATus Subsystem

This system contains the commands for the status reporting system. See also chap-
ter 14.1.5, "Status Reporting System", on page 243 for detailed information.
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*RST on page 156 has no effect on the status registers.

Value ranges

® Queries return the current value of the respective register, which permits a check of
the device status.
Return values: A decimal value in the range 0 to 32767 (=2'5-1)

® The configuration commands set the respective register thus determining which
status changes of the R&S SGS cause the status registers to be changed.
Setting values: A decimal value in the range 0 to 32767 (=2'5-1)
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:STATUS:OPERGLONENABIE. .....ceieiei et e e e e e e e e enes 204
:STATUS:OPERAION[:EVENT]. ... ittt e e e e e e e e e ee e e e e 205
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:STATus:OPERation:CONDition <Condition>

Sets the content of the CONDition part of the STATus:OPERation register. This part
contains information on the action currently being performed in the instrument. The
content is not deleted after being read out because it indicates the current hardware

status.

Parameters:

<Condition> string

Example: :STATus:0PERation:CONDition?

queries the Status:Operation:Condition register.

:STATus:OPERation:ENABIle <Enable>

Sets the bits of the ENABIe part of the STATus:OPERation register. This setting deter-
mines which events of the Status-Event part are forwarded to the sum bit in the status
byte. These events can be used for a service request.

Parameters:
<Enable> string
Example: :STAT:OPER:ENAB 32767

all events are forwarded to the sum bit of the status byte.
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:STATus:OPERation[:EVENt] <Event>

Queries the content of the EVENT part of the STATus:OPERation register. This part
contains information on the actions performed in the instrument since the last readout.
The content of the EVENTt part is deleted after being read out.

Parameters:
<Event> string
Example: :STAT:0OPER:EVEN?

queries the STATus:OPERation:EVENT register.

:STATus:OPERation:NTRansition <Ntransition>

Sets the bits of the NTRansition part of the STATus:OPERation register. If a bit is set,
a transition from 1 to 0 in the condition part causes an entry to be made in the EVENt
part of the register. The disappearance of an event in the hardware is thus registered,
for example the end of an adjustment.

Parameters:
<Ntransition> string
Example: :STAT:OPER:NTR O

a transition from 1 to 0 in the condition part of the Status:Opera-
tion register does not cause an entry to be made in the EVENt
part.

:STATus:OPERation:PTRansition <Ptransition>

Sets the bits of the PTRansition part of the STATus:OPERation register. If a bit is set,
a transition from 0 to 1 in the condition part causes an entry to be made in the EVENt
part of the register. A new event in the hardware is thus registered, for example the
start of an adjustment.

Parameters:
<Ptransition> string
Example: :STAT:O0PER:PTR 32767

all transitions from 0 to 1 in the condition part of the Status:Oper-
ation register cause an entry to be made in the EVEN! part.

:STATus:PRESet <Preset>

Resets the status registers. All PTRansition parts are set to FFFFh (32767), i.e. all
transitions from 0 to 1 are detected. All NTRansition parts are set to 0, i.e. a transition
from 1 to 0 in a CONDition bit is not detected. The ENABIe parts of STATus:OPERa-
tion and STATus:QUEStionable are set to 0, i.e. all events in these registers are not
passed on.

Parameters:
<Preset> string
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Example: STAT :PRES
resets the status registers.

:STATus:QUEStionable:CONDition <Condition>

Queries the content of the CONDition part of the STATus:QUEStionable register. This
part contains information on the action currently being performed in the instrument.
The content is not deleted after being read out since it indicates the current hardware

status.

Parameters:

<Condition> string

Example: :STATus :QUEStionable:CONDition?

queries the Status:Questionable:Condition register.

:STATus:QUEStionable:ENABIe <Enable>

Sets the bits of the ENABIe part of the STATus:QUEStionable register. This setting
determines which events of the Status-Event part are enabled for the sum bit in the
status byte. These events can be used for a service request.

Parameters:
<Enable> string
Example: STAT:0PER:ENAB 1

problems when performing an adjustment cause an entry to be
made in the sum bit.

:STATus:QUEStionable[:EVENt] <Event>

Queries the content of the EVENT part of the STATus : QUEStionable register. This
part contains information on the actions performed in the instrument since the last
readout. The content of the EVENT part is deleted after being read out.

Parameters:
<Event> string
Example: STAT:QUES:EVEN?

queries the Status:Questionable:Event register.

:STATus:QUEStionable:NTRansition <Ntransition>

Sets the bits of the NTRansition part of the STATus:QUEStionable register. If a bit is
set, a transition from 1 to 0 in the condition part causes an entry to be made in the
EVENT part of the register.

Parameters:
<Ntransition> string
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Example: STAT:0PER:NTR 0
a transition from 1 to 0 in the condition part of the Status:Ques-

tionable register does not cause an entry to be made in the
EVENL part

:STATus:QUEStionable:PTRansition <PTransition>

Sets the bits of the NTRansition part of the STATus:QUEStionable register. If a bit is
set, a transition from 1 to 0 in the condition part causes an entry to be made in the
EVENT part of the register.

Parameters:
<PTransition> string
Example: :STAT:OPER:PTR 32767

all transitions from 0 to 1 in the condition part of the Sta-
tus:Questionable register cause an entry to be made in the
EVENt part

:STATus:QUEue[:NEXT]?

Queries the oldest entry in the error queue and then deletes it. Positive error numbers
denote device-specific errors, and negative error numbers denote error messages
defined by SCPI. If the error queue is empty, 0 ("No error") is returned.

The command is identical to : SYSTem:ERRor [ : NEXT] ? on page 210.

Return values:
<Next> string

Example: :STATus :QUEue?

queries the oldest entry in the error queue.
Response: 0, 'no error'

no errors have occurred since the error queue was last read out

Usage: Query only

11.21 SYSTem Subsystem

The sYSTem subsystem contains a series of commands for general functions which do
not directly affect signal generation.
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:SYSTem:EMODe <Mode>

Enables and selects the Eco Mode. With enabled eco mode EM1 the doubler stage in a
12 GHz instrument is permanently switched off to reduce power consumption and the
maximum frequency is limited to 6 GHz.

Parameters:
<Mode> OFF | EM1
*RST: OFF
Example: see chapter 11.1.1, "Performing General Task for Instrument

Setup”, on page 144

:SYSTem:ERRor:ALL?

Queries the error/event queue for all unread items and removes them from the queue.
The response is a comma separated list of error number and a short description of the
error in FIFO order.

Positive error numbers are instrument-dependent. Negative error numbers are
reserved by the SCPI standard.



Return values:
<All>

Example:

Usage:

SYSTem Subsystem

string
List of: Error/event_number,"Error/event_description>[;Device-

dependent info]"
If the queue is empty, the response is 0, "No error"

SYST:ERR:ALL?
queries all entries in the error queue.
Response: 0, 'no error'

No errors have occurred since the error queue was last read out.

Query only

:SYSTem:ERRor:CODE:ALL?

Queries all entries in the error queue and then deletes them. Only the error numbers
are returned and not the entire error text.

Return values:
<All>

Example:

Usage:

string

0

"No error", i.e. the error queue is empty

positive value

Positive error numbers denote device-specific errors
negative value

Negative error numbers denote error messages defined by
SCPI.

SYST:ERR:CODE:ALL

queries all entries in the error queue.
Response: 0

no errors have occurred since the error queue was last read out.

Query only

:SYSTem:ERRor:CODE[:NEXT]?

Queries the oldest entry in the error queue and then deletes it. Only the error number
is returned and not the entire error text.

Return values:
<Next>

string
0
"No error", i.e. the error queue is empty

positive value
Positive error numbers denote device-specific errors

negative value
Negative error numbers denote error messages defined by
SCPI.
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Example: SYST:ERR:CODE
queries the oldest entry in the error queue.
Response: 0
No errors have occurred since the error queue was last read out.

Usage: Query only

:SYSTem:ERRor:COUNt?

Queries the number of entries in the error queue. If the error queue is empty, '0' is
returned.

Return values:
<Count> string

Example: SYST:ERR:COUN
queries the number of entries in the error queue.
Response: 1

One error has occurred since the error queue was last read out.

Usage: Query only

:SYSTem:ERRor[:NEXT]?

Queries the error/event queue for the oldest item and removes it from the queue. The
response consists of an error number and a short description of the error.

Positive error numbers are instrument-dependent. Negative error numbers are
reserved by the SCPI standard.

Return values:
<Next> string

Error/event_number,"Error/event_description>[;Device-depend-
ent info]"
If the queue is empty, the response is 0, "No error"

Example: SYST:ERR?
queries the oldest entry in the error queue.
Response: 0, 'no error'
No errors have occurred since the error queue was last read out.

Usage: Query only

:SYSTem:SERRor?

Returns a list of all errors existing at the time when the query is started. This list corre-
sponds to the display on the info page under manual control.

Return values:
<Serror> string

Example: SYST:SERR
queries all errors existing in the error queue.
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Example: Response: -221, 'Settings conflict', 153,
'Input voltage out of range'
The two returned errors have occurred since the error queue
was last queried.

Usage: Query only

:SYSTem:VERSion?
Queries the SCPI version the instrument's command set complies with.

Return values:
<Version> string

Example: SYST:VERS
queries the SCPI version.
Response: "1996"
The instrument complies with the SCPI version from 1996.

Usage: Query only

:SYSTem:COMMunicate:NETWork:IPADdress <IpAddress>
Sets the IP address.

Parameters:
<IpAddress> string
Range: 0.0.0.0. to ff.ff.ff.ff
Example: SYSTem:COMMunicate:NETWork:IPADdress '7.8.9.10"

sets the IP address of the instrument.

Manual operation: See "IP Address" on page 103

:SYSTem:COMMunicate:NETWork:IPADdress:MODE <Mode>

Selects manual or automatic setting of the IP address.

Parameters:
<Mode> AUTO | STATic
*RST: AUTO
Exanuﬂe: SYSTem:COMMunicate:NETWork: IPADdress :MODE AUTO

the IP address is assigned automatically (DHCP)

Manual operation: See "Address Mode" on page 103

:SYSTem:COMMunicate:NETWork:MACaddress? <MacAddress>
Queries the MAC address of the network adapter.

Return values:
<MacAddress> string
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Example: SYST:COMM:NETW:MAC?
queries the MAC address.

Usage: Query only

:SYSTem:COMMunicate:NETWork:STATus?
Queries the network configuration state.

Return values:
<State> 0]1]OFF|ON

Usage: Query only

:SYSTem:COMMunicate:NETWork:RESTart

Restarts the network connection to the instrument, terminates the connection and sets

it up again.
Example: SYSTem:COMMunicate:NETWork:RESTart
Usage: Event

:SYSTem:COMMunicate:NETWork[:COMMon]:HOSTname <Hostname>
Sets the individual host name of the R&S SGS.

Note: it is recommended that you do not change the host name in order to avoid prob-
lems with the networdk connection. However, if you change the host name be sure to
use an unique name.

The host name is a protected parameter, To change it, first disable protection level 1
with command : SYSTem: PROTect<ch>[:STATe] on page 215.

Parameters:
<Hostname> string
Example: SYSTem:PROTectl:STATe OFF, 123456

SYSTem:COMMunicate:NETWork:HOSTname 'SIGGEN'
sets the individual computer name of the R&S SGS.

Manual operation: See "Hostname" on page 102

:SYSTem:COMMunicate:NETWork[:IPADdress]:GATeway <Gateway>
Sets the IP address of the default gateway.

Parameters:
<Gateway> string
Range: 0.0.0.0 to ff.ff.ff.ff
Example: SYSTem:COMMunicate:NETWork:IPADdress:GATeway

'1.2.3.4"
sets the IP address of the default gateway.
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Manual operation: See "Default Gateway" on page 103

:SYSTem:COMMunicate:NETWork[:IPADdress]:SUBNet:MASK <Mask>

Sets the subnet mask.

Parameters:
<Mask> string
Example: SYSTem:COMMunicate:NETWork:IPADdress:SUBNet:

MASK '255.255.0.0"
determines the subnet mask.

Manual operation: See "Subnet Mask" on page 103

:SYSTem:COMMunicate:NETWork:RESource?

Queries the VISA resource string, used for remote control of the instrument with
VXI-11 protocol.

Return values:
<Resource> string

Example: SYSTem:COMMunicate:NETWork:RESource?
Response: "TCPIP::192.1.2.3::INSTR"

Usage: Query only

Manual operation: See "Visa Resource Strings" on page 104

:SYSTem:COMMunicate:SERial:BAUD <Baud>

Sets the baudrate for the serial remote control interface.

Parameters:

<Baud> 2400 | 4800 | 9600 | 19200 | 38400 | 57600 | 115200
*RST: 115200

Example: SYSTem:COMMunicate:SERial:BAUD 115200

determines 115200 baudrate.

:SYSTem:COMMunicate:SERial:PARity <Parity>

Sets the parity for the serial remote control interface.

Parameters:
<Parity> NONE | ODD | EVEN

*RST: NONE
Example: SYST:COMM: SER: PAR NONE

selects parity NONE.
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:SYSTem:COMMunicate:SERial:RESource?

Queries the visa resource string for the serial remote control interface. This string is
used for remote control of the instrument.

Return values:
<Resource> string

Example: SYSTem:COMMunicate:SERial:RESource?
queries the VISA resource string.
Response: "ASRL1:: INSTR"

Usage: Query only

:SYSTem:COMMunicate:SERial:SBITs <SBits>

Sets the number of stop bits for the serial remote control interface.

Parameters:
<SBits> 112
*RST: 1
Example: SYST:COMM:SER:SBIT 2

selects 2 stop bits.

:SYSTem:COMMunicate:HISLip:RESource?

Queries the VISA resource string, used for remote control of the instrument with
HiSLIP protocol.

Return values:
<Resource> string

Example: SYSTem:COMMunicate:HISLip:RESource?
Response: "TCPIP::192.1.2.3::hislip0::INSTR"

Usage: Query only

Manual operation: See "Visa Resource Strings" on page 104

:SYSTem:COMMunicate:PClexpress:RESource?
Queries the visa resource string for remote control via the PCle interface.

Return values:
<Resource> string

Usage: Query only

Manual operation: See "Visa Resource Strings" on page 104
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:SYSTem:COMMunicate:SOCKet:RESource?

Queries the visa resource string for remote control via LAN interface, using TCP/IP
socket protocol.

Return values:
<Resource> string

Example: SYSTem:COMMunicate:SOCKet:RESource?
Response: "TCPIP::10.113.1.150::5025: : SOCKET"

Usage: Query only

Manual operation: See "Visa Resource Strings" on page 104

:SYSTem:COMMunicate:USB:RESource?
Queries the visa resource string for remote control via the USB interface.

Return values:

<Resource> string

Example: SYSTem:COMMunicate:USB:RESource?
queries the VISA resource string for remote control via the USB
interface.

Response: "USB::72::000000: : INSTR"
Usage: Query only

Manual operation: See "Visa Resource Strings" on page 104

:SYSTem:PROTect<ch>[:STATe] <State>[, <Key>]

Activates/deactivates the specified protection level.

Parameters:
<State> select
*RST: 1
Setting parameters:
<Key> integer

The respective functions are disabled when the protection level
is activated. No password is required for activation. A password
must be entered to deactivate the protection level. The pass-
word for the first level is 123456.

This protection level can be used to lock-out internal adjust-
ments.

Example: SYSTem:PROTectl:STATe ON
activates protection level 1. Internal adjustments are only possi-
ble after deactivating the lock-out.
SYSTem:PROTectl:STATe OFF, 123456

deactivates protection level 1. Internal adjustments are enabled
again.
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:SYSTem:STARtup:COMPIlete?
Queries if the startup of the instrument is completed.

Return values:

<Complete> 0|1]|OFF|ON
*RST: 0
Example: SYST:STAR:COMP

Response: 1
The startup of the instrument is completed.

Usage: Query only

:SYSTem:HARDware:ASSembly<dir>:NAME?
The query returns a list of hardware assembly names.

Suffix:
<dir> 1.2
Defines the section: 1 = common assembly, 2 = RF assembly.

Return values:
<Name> string

Example: See chapter 11.1.1, "Performing General Task for Instrument
Setup", on page 144.

Usage: Query only

Manual operation: See "Assembly" on page 94

:SYSTem:HARDware:ASSembly<dir>:PNUMber?
The query returns the list of hardware module part numbers.

Suffix:
<dir> 1.2
Defines the section: 1 = common assembly, 2 = RF assembly.

Return values:
<PNumber> string

Example: See chapter 11.1.1, "Performing General Task for Instrument
Setup", on page 144.

Usage: Query only

Manual operation: See "Assembly” on page 94

:SYSTem:HARDware:ASSembly<dir>:REVision?

Queries the list of hardware module revisions.
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Suffix:
<dir> 1.2
Defines the section: 1 = common assembly, 2 = RF assembly.

Return values:
<Revision> string

Example: See chapter 11.1.1, "Performing General Task for Instrument
Setup", on page 144.

Usage: Query only

Manual operation: = See "Assembly" on page 94

:SYSTem:HARDware:ASSembly<dir>:SNUMber?
Queries the list of hardware module serial numbers.

Suffix:
<dir> 1.2
Defines the section: 1 = common assembly, 2 = RF assembly.

Return values:
<SNumber> string

Example: See chapter 11.1.1, "Performing General Task for Instrument
Setup", on page 144.

Usage: Query only

Manual operation: See "Assembly” on page 94

:SYSTem:SOFTware:OPTion<dir>:DESignation?
Queries the list of option descriptions.

Suffix:
<dir> 1.2
Defines the section: 1 = hardware, 2 = software.

Return values:
<Designation> string

Example: See chapter 11.1.1, "Performing General Task for Instrument
Setup", on page 144.

Usage: Query only

Manual operation: See "Hardware / Software/WinlQSIM" on page 96

:SYSTem:SOFTware:OPTion<dir>:EXPiration?

Queries the list of option expiration informations.
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Suffix:
<dir> 1.2
Defines the section: 1 = hardware, 2 = software.

Return values:
<Expiration> string

Example: See chapter 11.1.1, "Performing General Task for Instrument
Setup", on page 144.

Usage: Query only

Manual operation: See "Hardware / Software/WinlQSIM" on page 96

:SYSTem:SOFTware:OPTion<dir>:LICenses?
Queries the list of option license counts.

Suffix:
<dir> 1.2
Defines the section: 1 = hardware, 2 = software.

Return values:
<Licenses> string

Example: See chapter 11.1.1, "Performing General Task for Instrument
Setup", on page 144.

Usage: Query only

Manual operation: See "Hardware / Software/WinlQSIM" on page 96

:SYSTem:SOFTware:OPTion<dir>:NAME?
Queries the list of option names.

Suffix:
<dir> 1.2
Defines the section: 1 = hardware, 2 = software.

Return values:
<Name> string

Example: See chapter 11.1.1, "Performing General Task for Instrument
Setup", on page 144.

Usage: Query only

Manual operation: See "Hardware / Software/WinlQSIM" on page 96

:SYSTem:MMEMory:PATH:USER?
Queries the user directory, that means the directory the instrument stores user files on.

Return values:
<PathUser> string
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Example: SYSTem:MMEMory: PATH:USER?
Response: "/var/sgs/"

Usage: Query only

:SYSTem:0SYStem?
Queries the operating system of the instrument.

Return values:
<OperSystem> string

Example: SYSTem:0SYStem?
Response: "Linux"

Usage: Query only

11.22 TEST Subsystem

The TEST system contains the commands for performing the routines as well as for
direct manipulation of the hardware assemblies (: TEST: DIRect).

The self tests return a "0" if the test is performed successfully, otherwise a value other
than "0" is returned. None of the commands of this system have an *RST value.

Improper use may destroy the assembly!

The respective hardware assembly responds directly to the : TEST : DIRect command;
any safety mechanisms are bypassed. The command is used for servicing purposes
and should not be applied by the user.
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:TEST:ALL:STARt
Starts the selftest. Use the command : TEST:ALL:RESult? to query the result.

Example: See chapter 11.1.1, "Performing General Task for Instrument
Setup", on page 144.

Usage: Event

:TEST:ALL:RESult?

Queries the result of the performed selftest. Start the selftest with : TEST : ALL: STARE.
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UNIT Subsystem

Return values:

<Result> 0] 1| RUNning | STOPped
*RST: STOPped
Example: See chapter 11.1.1, "Performing General Task for Instrument

Setup", on page 144.
Usage: Query only

:TEST:KEYBoard[:STATe] <State>
Enable/disable keyboard and LED test state.

Parameters:
<State> 0]1]OFF|ON
UNIT Subsystem

The UNIT subsystem contains the commands specifying which units are valid if no unit
is indicated in a command. These settings are valid for the entire instrument.

:UNIT:ANGLe <Angle>

Sets the default angle unit for remote control. Does not influence the manual control
parameter units and the display.

Parameters:

<Angle> DEGRee | RADian
*RST: RADian

Example: UNIT:ANGL DEG

sets DEG as a default unit for all commands which determine
angle values.

:UNIT:POWer <Power>

Defines the default unit for power parameters. This setting affects the GUI, as well as
all remote control commands that determine power values.

Parameters:

<Power> V | DBUV | DBM
*RST: DBM

Example: UNIT:POW V
sets V as a default unit for all commands which determine power
values.
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11.24 R&S SGMA-GUI Settings

This section comprises the SCPl commands provided to remote control the R&S

SGMA-GUI.
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:INSTruments:ACTive[:STATe] <State>

Enables/disables the instrument for the R&S SGMA-GUI. The main panel of this soft-
ware displays only activated instruments.

Parameters:
<State> List of BOOL-values
<Statelnstr##1> <Statelnstr#2>,...
0, 1, ON, OFF
Example: See chapter 11.1.6, "Configuring Instruments in the R&S SGMA-

GUI", on page 152.

Manual operation: See "Available Instruments” on page 47

!INSTruments:COUNt?
Queries the number of the currently available instruments.

Return values:
<Count> float

Range: 0 to 12

Example: See chapter 11.1.6, "Configuring Instruments in the R&S SGMA-
GUI", on page 152.

Usage: Query only

Manual operation: See "Available Instruments" on page 47

:INSTruments:EACCess[:STATe] <State>

"Locks" the instruments, meaning the instrument is reserved and can be operated
exclusively from the remote PC that sent this SCPI command.
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Tip: It is recommended to lock the instrument prior to further configuration.

Parameters:
<State> List of BOOL-values
<LocklInstr#1>,<LocklInstr#2>, ...
0,1,0FF,ON
Example: See chapter 11.1.6, "Configuring Instruments in the R&S SGMA-

GUI", on page 152.

Manual operation: See "Exclusive Access" on page 50

:INSTruments:MAPPing:FILE <File>

Saves the list of the available instruments in a mapping file. Mapping files are stored
with the predefined file extension .map; the file extension may be omitted.

The file is saved in the default directory. Use the command MMEM: CDIRectory to
change the default directory or specify the complete path.

Parameters:
<File> string
Example: See chapter 11.1.6, "Configuring Instruments in the R&S SGMA-

GUI", on page 152.

Manual operation: See "Export" on page 47

:INSTruments:NAME <Name>

Selects the alias name of the instruments, i.e. sets the "Symbolic Name".

Parameters:
<Name> <SymbolicNamelnstr#1>,<SymbolicNamelnstr#2>, ...
Example: See chapter 11.1.6, "Configuring Instruments in the R&S SGMA-

GUI", on page 152.

Manual operation: See "Available Instruments" on page 47

:INSTruments:REMote:CHANnNel <Channel>

Sets the hardware interface used by the remote channel.

Parameters:
<Channel> List of CHAR-Data

<Channelinstr#1>,<Channellnstr#2>,...

The available interfaces are: LAN, USB, SOCKET, PCIe
Example: See chapter 11.1.6, "Configuring Instruments in the R&S SGMA-

GUI", on page 152.

Manual operation: See "Hardware Channel" on page 50
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:INSTruments:REMote:NAME <Name>

Enters the IP Address or the host name of the connected instrument.

Parameters:

<Name> <Hostname/IP-Addressinsr#1>,<Hostname/IP-Addres-
sinsr#2>,...

Example: See chapter 11.1.6, "Configuring Instruments in the R&S SGMA-

GUI", on page 152.

Manual operation: See "Instrument Name / IP Address" on page 50

:INSTruments:SCAN <State>

Triggers a scan function and searches for instruments connected to the remote com-
puter via all of the available interfaces.

Parameters:

<State> number
1 = triggers the scan function, 0 = aborts the running scan proc-
ess
The query command returns 1 as long as scan is running; 0 indi-
cates completed scan process.

Example: See chapter 11.1.6, "Configuring Instruments in the R&S SGMA-

GUI", on page 152.

Manual operation: See "Scan" on page 47

:INSTruments:SCAN:HNPRefix <Prefix>

Sets the prefix the searched host names begin with.

Parameters:
<Prefix> string
Example: See chapter 11.1.6, "Configuring Instruments in the R&S SGMA-

GUI", on page 152.

Manual operation: See "Scan LAN instruments with host name prefix" on page 48

:INSTruments:SERial <Serial>

Enters the serial number as instrument's identification while using the USB interface for
remote control.

Parameters:
<Serial> <SerialNumberlnstr##1>, <SerialNumberlnstr#2>,...
Example: See chapter 11.1.6, "Configuring Instruments in the R&S SGMA-

GUI", on page 152.

Manual operation: See "Serial Number" on page 50
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:INSTruments:TYPE <Type>

Selects the instrument's family.

Parameters:
<Type> List of CHAR-Data
<Typelnstr#1>,<Typelnstr#2>,...
Example: See chapter 11.1.6, "Configuring Instruments in the R&S SGMA-

GUI", on page 152.

Manual operation: See "Available Instruments" on page 47
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12 Maintenance

The instrument does not need a periodic maintenance. Only cleaning the instrument is
essential.

Follow the instructions in the service manual and the safety instructions when
exchanging modules or ordering spare parts. The order number for spare parts is inclu-
ded in the service manual. The service manual includes further information particularly
on troubleshooting, repair, exchange of modules (including battery exchange, adjust-
ment of the OCXO oscillator) and alignment.

The address of our support center and a list of all Rohde & Schwarz service centers
can be found at the beginning of this manual.

12.1 Cleaning

The outside of the instrument can be cleaned sufficiently using a soft, lint-free dust
cloth. Make sure that the fan openings are not obstructed.

Shock hazard

Before cleaning the instrument, make sure that the instrument is switched off and dis-
connected from all power supplies.

Instrument damage caused by cleaning agents

Cleaning agents contain substances that may damage the instrument. For example,
cleaning agents that contain a solvent may damage the front panel labeling, plastic
parts, or the display.

Never use cleaning agents such as solvents (thinners, acetone, etc), acids, bases, or
other substances.

The outside of the instrument can be cleaned sufficiently using a soft, lint-free dust
cloth.
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Risk of instrument damage due to obstructed fans

If the instrument is operated in dusty areas, the fans may become obstructed by dust
or other particles in the process of time. Make sure to check and, if necessary, clean

the fans regularly to ensure they operate properly at all times. If the instrument is run
with obstructed fans for a longer period, it may become overheated which may cause
damage.

12.2 Storing and Packing

The storage temperature range of the instrument is given in the data sheet. If the
instrument is to be stored for a longer period of time, it must be protected against dust.

Repack the instrument as it was originally packed when transporting or shipping. The
two protective foam plastic parts prevent the control elements and connectors from
being damaged. The antistatic packing foil avoids any undesired electrostatic charging
to occur.

If you do not use the original packaging, use a sturdy cardboard box of suitable size
and provide for sufficient padding to prevent the instrument from slipping inside the
package. Wrap antistatic packing foil around the instrument to protect it from electro-
static charging.



13

13.1

13.2

13.21

Status Information

Error Messages and Troubleshooting

This chapter describes the error messages of the R&S SGS. The error messages are
output in the "Info" line on the screen and entered in the error/event queue of the sta-
tus reporting system.

A great variety of different messages such as status messages, error messages, warn-
ings or information are displayed in the header field of the screen. Some error mes-
sages require that the error must be eliminated before correct instrument operation can
be ensured. The "Info" window with a list of current messages and a detailed descrip-
tion of each message can be opened with the "Info" button (see also chapter 6.2.1,
"Info Dialog", on page 52).

Status Information

The status messages are displayed in the Info line of the R&S SGMA-GUI main panel.
The status information gives the user an overview of the main operating states and set-
tings of the instrument. The states are indicated for information only and do not neces-
sitate any action by the user.

Status Information displayed in the Info line

AttFixed
Attenuator fixed mode is active.

The uninterrupted level settings are made in a fixed range without attenuator switching.
The variation range is set automatically when this mode is activated. The range is dis-
played with the parameter "SGMA-GUI > Instrument Name > Level > Attenuator Fixed
Range".

Error Messages

Messages indicate errors in the instrument. They are displayed in the info line in differ-
ent colors depending on their importance and display duration. Errors (e.g. no calibra-
tion data) are displayed in red, information (e.g. file not found) and warnings in black.
Warnings indicate less significant errors (e.g. the instrument operates outside specified
data).

See also chapter 6.2.1, "Info Dialog", on page 52 and chapter 6.2.2, "Understanding
the Messages in the Info Bar", on page 53.
Volatile messages

Volatile messages report automatic settings in the instrument (e.g. switching off of
incompatible types of modulation) or on illegal entries that are not accepted by the
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instrument (e.g. range violations). They are displayed in the info line on a yellow back-
ground. They are displayed on top of status information or permanent messages.

Volatile messages do not normally demand user actions and disappear automatically
after a brief period of time. They are stored in the history, however.

SCPIl command: : SYSTem:ERRor:ALL? and : SYSTem: ERRor [ :NEXT] 2.

13.2.2 Permanent messages

Permanent messages are displayed if an error occurs that impairs further instrument
operation, e.g. a hardware fault. The error signaled by a permanent message must be
eliminated before correct instrument operation can be ensured.

The message is displayed until the error is eliminated. It covers the status display in
the info line. After error elimination, the message automatically disappears and is also
recorded in the history.

SCPI command: : SYSTem: SERRor?

13.3 SCPI-Error Messages

The SCPI error messages are the same in all SCPI instruments. Detailed information
and an overview of all error messages as defined in SCPI standard can be found in the
corresponding documentation.

The errors are assigned negative numbers. The error text being entered into the error/
event queue or being displayed is printed in bold face on the left together with the error
code. Below the error text, there is an explanation as to the respective error.

13.4 Device-Specific Error Messages

The following table contains all error messages specific for the instrument in alphabeti-
cal order, as well as an explanation of the error situation. The positive error codes
mark the errors specific of the instrument.

The device-specific error messages set bit 3 in the ESR register.

@ The index provides a list of the error messages sorted according to their error codes.
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Error
Code

Error

Description

Remedy

180

Adjustment failed

Adjustment could not be executed

The adjustment data have to be
generated first by an internal or

external adjustment or to be loa-
ded into the device.

182

Adjustment data miss-
ing

Adjustment data are missing.

The adjustment data have to be
generated first by an internal or

external adjustment or to be loa-
ded into the instrument.

183

Adjustment data inva-
lid

Adjustment data are invalid and must
be restored.

The adjustment data have to be
generated again by an internal or
external adjustment or to be loa-
ded into the instrument.

200

Cannot access hard-
ware

The data transmission to a module
was unsuccessful.

The module is not installed, not
properly installed or missing.

201

Hardware revision out
of date

A later version of certain parts of the
instrument is necessary to execute
the function selected.

The driver does not support the
installed version of a module.

202

Cannot access the
EEPROM

A error occurs when writing or reading
a EEPROM.

The EEPROM might be defect
and has to be replaced.

203

Invalid EEPROM data

204

Driver initialization
failed

Initialization of a driver fails when
booting the instrument firmware.

The driver is not compatible with
the hardware or software config-
uration of the instrument.

241

No current list

There is no list selected.

To execute the required opera-
tion, a list has to be selected in
the related dialog. If no list is
available, a new list must be cre-
ated.

242

Unknown list type
specified

The list type selected is not valid for
the required operation.

For instance, the file extension for
mapping files is * . map. It is not possi-
ble to enter another file extension
when selecting a list.

Check the selected list type.

460

Cannot open file

The selected file can not be opened.

Check the path and file name.

461

Cannot write file

The file can not be written.

Check if the file is read-only.

462

Cannot read file

The file can not be read.

Check if the file contents are
compatible with the file type.

463

Filename missing

The required operation cannot be
executed because the file name is not
specified.

A file name has to be entered
when creating a new list.

464

Invalid filename exten-
sion

The file extension is not valid for the
required operation.

Check the file extension.

For instance, the file extension
for the mapping files is * .map. It
is not possible to enter another
file extension when storing a list.




Device-Specific Error Messages

Error | Error Description Remedy

Code

465 File contains invalid The selected file contains data thatis | Check the file extension.
data not valid for the file type.

The file extension determines the
data that is valid for this file type.
If the file extension is changed
the lists are no longer recognized
and the data are therefore inva-
lid.

468 Cannot find directory Required folder cannot be found. Check drive and path.

469 No files found Folder is empty
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14 Annex

14.1 Remote Control Basics

This chapter provides basic information on operating an instrument via remote control.

14.1.1 Messages

The messages transferred on the data lines are divided into the following categories:

® |Interface messages
Interface messages are transmitted to the instrument on the data lines, with the
attention line being active (LOW). They are used to communicate between the con-
troller and the instrument. Interface messages can only be sent by instruments that
have GPIB bus functionality. For details see the sections for the required interface.

® Instrument messages
Instrument messages are employed in the same way for all interfaces, if not indica-
ted otherwise in the description. Structure and syntax of the instrument messages
are described in chapter 14.1.3, "SCPI Command Structure", on page 232. A
detailed description of all messages available for the instrument is provided in the
chapter "Remote Control Commands".
There are different types of instrument messages, depending on the direction they
are sent:
— Commands

— Instrument responses

Commands

Commands (program messages) are messages the controller sends to the instrument.
They operate the instrument functions and request information. The commands are
subdivided according to two criteria:

® According to the effect they have on the instrument:
— Setting commands cause instrument settings such as a reset of the instru-
ment or setting the frequency.

— Queries cause data to be provided for remote control, e.g. for identification of
the instrument or polling a parameter value. Queries are formed by directly
appending a question mark to the command header.

® According to their definition in standards:

— Common commands: their function and syntax are precisely defined in stand-
ard IEEE 488.2. They are employed identically on all instruments (if implemen-
ted). They refer to functions such as management of the standardized status
registers, reset and self-test.

— Instrument control commands refer to functions depending on the features of
the instrument such as frequency settings. Many of these commands have also
been standardized by the SCPI committee. These commands are marked as
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"SCPI confirmed" in the command reference chapters. Commands without this
SCPI label are device-specific; however, their syntax follows SCPI rules as per-
mitted by the standard.

Instrument responses

Instrument responses (response messages and service requests) are messages the
instrument sends to the controller after a query. They can contain measurement
results, instrument settings and information on the instrument status.

14.1.2 LAN Interface Messages

In the LAN connection, the interface messages are called low—level control messages.
These messages can be used to emulate interface messages of the GPIB bus.

Command Long term Effect on the instrument
&ABO Abort Aborts processing of the commands just received.
&DCL Device Clear Aborts processing of the commands just received and

sets the command processing software to a defined initial
state. Does not change the instrument setting.

&GTL Go to Local Transition to the "local" state (manual control). (The
instrument automatically returns to remote state when a
remote command is sent UNLESS &NREN was sent

before.)

&GTR Go to Remote Enables automatic transition from local state to remote
state by a subsequent remote command (after sNREN
was sent).

&GET Group Execute Trigger Triggers a previously active instrument function (e.g. a

sweep). The effect of the command is the same as with
that of a pulse at the external trigger signal input.

&LLO Local Lockout Disables transition from remote control to manual control
by means of the front panel keys.

&NREN Not Remote Enable Disables automatic transition from local state to remote
state by a subsequent remote command. (To re-activate
automatic transition use &GTR.)

&POL Serial Poll Starts a serial poll.

14.1.3 SCPI Command Structure

SCPI commands consist of a so-called header and, in most cases, one or more param-
eters. The header and the parameters are separated by a "white space" (ASCII code 0
to 9, 11 to 32 decimal, e.g. blank). The headers may consist of several mnemonics
(keywords). Queries are formed by appending a question mark directly to the header.

The commands can be either device-specific or device-independent (common com-
mands). Common and device-specific commands differ in their syntax.
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Syntax for Common Commands

Common (=device-independent) commands consist of a header preceded by an aster-
isk (*) and possibly one or more parameters.

Examples:

*RST RESET Resets the instrument.

*ESE EVENT STATUS ENABLE Sets the bits of the event status enable
registers.

*ESR? EVENT STATUS QUERY Queries the contents of the event status
register.

*IDN? IDENTIFICATION QUERY Queries the instrument identification
string.

Syntax for Device-Specific Commands

Not all commands used in the following examples are necessarily implemented in the
instrument.

For demonstration purposes only, assume the existence of the following commands for
this section:

® DISPlay[:WINDow<l...4>]:MAXimize <Boolean>

® FORMat:READings:DATA <type>[,<length>]

® HCOPy:DEVice:COLor <Boolean>

® HCOPy:DEVice:CMAP:COLor:RGB <red>,<green>,<blue>
® HCOPy|[:IMMediate]

® HCOPy:ITEM:ALL

e HCOPy:ITEM:LABel <string>

® HCOPy:PAGE:DIMensions:QUADrant [<N>]

® HCOPy:PAGE:ORIentation LANDscape | PORTrait

® HCOPy:PAGE:SCALe <numeric value>

® MMEMory:COPY <file source>,<file destination>

® SENSE:BANDwidth|BWIDth[:RESolution] <numeric value>
® SENSe:FREQuency:STOP <numeric value>

® SENSe:LIST:FREQuency <numeric value>{,<numeric value>}

Long and short form

The mnemonics feature a long form and a short form. The short form is marked by
upper case letters, the long form corresponds to the complete word. Either the short
form or the long form can be entered; other abbreviations are not permitted.
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Example:
HCOPy:DEVice:COLor ON is equivalent to HCOP:DEV:COL ON.

Case-insensitivity
Upper case and lower case notation only serves to distinguish the two forms in the
manual, the instrument itself is case-insensitive.

Numeric suffixes

If a command can be applied to multiple instances of an object, e.g. specific channels
or sources, the required instances can be specified by a suffix added to the command.
Numeric suffixes are indicated by angular brackets (<1...4>, <n>, <i>) and are replaced
by a single value in the command. Entries without a suffix are interpreted as having the
suffix 1.

Example:

Definition: HCOPy : PAGE : DIMensions : QUADrant [<N>]
Command: HCOP: PAGE : DIM: QUAD2

This command refers to the quadrant 2.

6 Different numbering in remote control

For remote control, the suffix may differ from the number of the corresponding selec-
tion used in manual operation. SCPI prescribes that suffix counting starts with 1. Suffix
1 is the default state and used when no specific suffix is specified.

Some standards define a fixed numbering, starting with 0. If the numbering differs in
manual operation and remote control, it is indicated for the corresponding command.

Optional mnemonics

Some command systems permit certain mnemonics to be inserted into the header or
omitted. These mnemonics are marked by square brackets in the description. The
instrument must recognize the long command to comply with the SCPI standard. Some
commands are considerably shortened by these optional mnemonics.

Example:
Definition: HCOPy [ : IMMediate]
Command: HCOP: IMM is equivalent to HCOP
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6 Optional mnemonics with numeric suffixes

Do not omit an optional mnemonic if it includes a numeric suffix that is relevant for the
effect of the command.

Example:
Definition:DISPlay [ :WINDow<1l...4>] :MAXimize <Boolean>
Command: DISP:MAX ON refers to window 1.

In order to refer to a window other than 1, you must include the optional WINDow
parameter with the suffix for the required window.

DISP:WIND2:MAX ON refers to window 2.

Parameters

Parameters must be separated from the header by a "white space”. If several parame-
ters are specified in a command, they are separated by a comma (,). For a description
of the parameter types, refer to chapter 14.1.3.3, "SCPI Parameters", on page 236.

Example:
Definition:HCOPy : DEVice : CMAP: COLor :RGB <red>, <green>,<blue>
Command:HCOP: DEV:CMAP:COL:RGB 3,32, 44
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Special characters

| Parameters

A vertical stroke in parameter definitions indicates alternative possibilities in the sense of "or". The
effect of the command differs, depending on which parameter is used.

Example:

Definition:HCOPy : PAGE : ORIentation LANDscape | PORTrait
Command HCOP: PAGE : ORI LAND specifies landscape orientation
Command HCOP: PAGE: ORI PORT specifies portrait orientation
Mnemonics

A selection of mnemonics with an identical effect exists for several commands. These mnemonics are
indicated in the same line; they are separated by a vertical stroke. Only one of these mnemonics
needs to be included in the header of the command. The effect of the command is independent of
which of the mnemonics is used.

Example:

DefinitionSENSE : BANDwidth | BWIDth[:RESolution] <numeric value>
The two following commands with identical meaning can be created:
SENS:BAND:RES 1

SENS:BWID:RES 1

[1 | Mnemonics in square brackets are optional and may be inserted into the header or omitted.
Example: HCOPy [ : IMMediate]

HCOP:IMM is equivalent to HCOP

{} | Parameters in curly brackets are optional and can be inserted once or several times, or omitted.
Example: SENSe:LIST:FREQuency <numeric value>{,<numeric value>}

The following are valid commands:

SENS:LIST:FREQ 10

SENS:LIST:FREQ 10,20

SENS:LIST:FREQ 10,20,30,40

14.1.3.3 SCPI Parameters

Many commands are supplemented by a parameter or a list of parameters. The
parameters must be separated from the header by a "white space" (ASCIl code 0 to 9,
11 to 32 decimal, e.g. blank). Allowed parameters are:

® Numeric values

® Special numeric values

® Boolean parameters

o Text
® Character strings
® Block data

The parameters required for each command and the allowed range of values are
specified in the command description.
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Numeric values

Numeric values can be entered in any form, i.e. with sign, decimal point and exponent.
Values exceeding the resolution of the instrument are rounded up or down. The man-
tissa may comprise up to 255 characters, the exponent must lie inside the value range
-32000 to 32000. The exponent is introduced by an "E" or "e". Entry of the exponent
alone is not allowed. In the case of physical quantities, the unit can be entered.
Allowed unit prefixes are G (giga), MA (mega), MOHM and MHZ are also allowed), K
(kilo), M (milli), U (micro) and N (nano). If the unit is missing, the basic unit is used.

Example: SENS:FREQ:STOP 1.5GHz = SENS:FREQ:STOP 1.5E9

Units

For physical quantities, the unit can be entered. Allowed unit prefixes are:

* G (giga)

® MA (mega), MOHM, MHZ
® K (kilo)

o M (milli)

® U (micro)

® N (nano)

If the unit is missing, the basic unit is used.

Example:
SENSe:FREQ:STOP 1.5GHz = SENSe:FREQ:STOP 1.5E9

Some settings allow relative values to be stated in percent. According to SCPI, this unit
is represented by the PCT string.

Example:
HCOP:PAGE:SCAL 90PCT

Special numeric values

The texts listed below are interpreted as special numeric values. In the case of a
query, the numeric value is provided.

e MIN/MAX
MINimum and MAXimum denote the minimum and maximum value.
e DEF

DEFault denotes a preset value which has been stored in the EPROM. This value
conforms to the default setting, as it is called by the *RST command.

e UP/DOWN
UP, DOWN increases or reduces the numeric value by one step. The step width
can be specified via an allocated step command for each parameter which can be
set via UP, DOWN.

® INF/NINF
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INFinity, Negative INFinity (NINF) represent the numeric values 9.9E37 or -9.9E37,
respectively. INF and NINF are only sent as instrument responses.

* NAN
Not A Number (NAN) represents the value 9.91E37. NAN is only sent as a instru-
ment response. This value is not defined. Possible causes are the division of zero
by zero, the subtraction of infinite from infinite and the representation of missing
values.

Example:
Setting command: SENSe:LIST: FREQ MAXimum
Query: SENS:LIST:FREQ?, Response: 3.5E9

Queries for special numeric values

6 The numeric values associated to MAXimum/MINimum/DEFault can be queried by
adding the corresponding mnemonics to the command. They must be entered follow-
ing the quotation mark.
Example: SENSe:LIST:FREQ? MAXimum

Returns the maximum numeric value as a result.

Boolean Parameters

Boolean parameters represent two states. The "ON" state (logically true) is represen-
ted by "ON" or a numeric value 1. The "OFF" state (logically untrue) is represented by
"OFF" or the numeric value 0. The numeric values are provided as the response for a

query.

Example:

Setting command: HCOPy : DEV: COL ON
Query: HCOPy : DEV:COL?

Response: 1

Text parameters

Text parameters observe the syntactic rules for mnemonics, i.e. they can be entered
using a short or long form. Like any parameter, they have to be separated from the
header by a white space. In the case of a query, the short form of the text is provided.

Example:
Setting command: HCOPy : PAGE: ORIentation LANDscape

Query: HCOP : PAGE : ORI ?
Response: LAND

Character strings

Strings must always be entered in quotation marks (' or ").
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Example:
HCOP:ITEM:LABel "Testl" or HCOP:ITEM:LABel 'Testl'

Block data

Block data is a format which is suitable for the transmission of large amounts of data. A
command using a block data parameter has the following structure:

Example:
FORMat :READings :DATA #45168XXXXXXXX

The ASCII character # introduces the data block. The next number indicates how many
of the following digits describe the length of the data block. In the example the 4 follow-
ing digits indicate the length to be 5168 bytes. The data bytes follow. During the trans-
mission of these data bytes all end or other control signs are ignored until all bytes are
transmitted.

#0 specifies a data block of indefinite length. The use of the indefinite format requires a
NL~END message to terminate the data block. This format is useful when the length of

the transmission is not known or if speed or other considerations prevent segmentation
of the data into blocks of definite length.

Overview of Syntax Elements

The following table provides an overview of the syntax elements:

The colon separates the mnemonics of a command. In a command line the separating semico-
lon marks the uppermost command level.

; The semicolon separates two commands of a command line. It does not alter the path.

s The comma separates several parameters of a command.

? The question mark forms a query.

* The asterisk marks a common command.

v Quotation marks introduce a string and terminate it (both single and double quotation marks are
" possible).

# The hash symbol introduces binary, octal, hexadecimal and block data.
®  Binary: #810110

® QOctal: #07612

® Hexa: #HF3A7

®  Block: #21312

A "white space" (ASCII-Code 0 to 9, 11 to 32 decimal, e.g. blank) separates the header from the
parameters.

14.1.3.5 Structure of a command line

A command line may consist of one or several commands. It is terminated by one of
the following:
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® a<New Line>

® a <New Line> with EOI

® an EOI together with the last data byte

Several commands in a command line must be separated by a semicolon ";". If the

next command belongs to a different command system, the semicolon is followed by a
colon.

Example:
MMEM:COPY "Testl", "MeasurementXY"; :HCOP:ITEM ALL

This command line contains two commands. The first command belongs to the MMEM
system, the second command belongs to the HCOP system.

If the successive commands belong to the same system, having one or several levels
in common, the command line can be abbreviated. To this end, the second command
after the semicolon starts with the level that lies below the common levels. The colon
following the semicolon must be omitted in this case.

Example:

HCOP:ITEM ALL; :HCOP:IMM

This command line contains two commands. Both commands are part of the HCOP
command system, i.e. they have one level in common.

When abbreviating the command line, the second command begins with the level
below HCOP. The colon after the semicolon is omitted. The abbreviated form of the
command line reads as follows:

HCOP:ITEM ALL; IMM
A new command line always begins with the complete path.

Example:
HCOP:ITEM ALL
HCOP:IMM

Responses to Queries

A query is defined for each setting command unless explicitly specified otherwise. It is
formed by adding a question mark to the associated setting command. According to
SCPI, the responses to queries are partly subject to stricter rules than in standard
IEEE 488.2.

® The requested parameter is transmitted without a header.
Example: HCOP: PAGE : ORI ?, Response: LAND

® Maximum values, minimum values and all other quantities that are requested via a
special text parameter are returned as numeric values.
Example: SENSe: FREQuency: STOP? MAX, Response: 3.5E9



Remote Control Basics

Numeric values are output without a unit. Physical quantities are referred to the
basic units or to the units set using the Unit command. The response 3.5E9 in
the previous example stands for 3.5 GHz.

Truth values (Boolean values) are returned as 0 (for OFF) and 1 (for ON).
Example:

Setting command: HCOPy : DEV: COL ON

Query: HCOPy : DEV:COL?

Response: 1

Text (character data) is returned in a short form.

Example:

Setting command: HCOPy: PAGE: ORIentation LANDscape

Query: HCOP : PAGE : ORI ?

Response: LAND

14.1.4 Command Sequence and Synchronization

IEEE 488.2 defines a distinction between overlapped and sequential commands:

A sequential command is one which finishes executing before the next command
starts executing. Commands that are processed quickly are usually implemented
as sequential commands. Sequential commands are not implemented in the instru-
ment, however the execution time of most commands is so short that they act as
sequential commands when sent in different command lines.

An overlapping command is one which does not automatically finish executing
before the next command starts executing. Usually, overlapping commands take
longer to process and allow the program to do other tasks while being executed. If
overlapping commands do have to be executed in a defined order, e.g. in order to
avoid wrong measurement results, they must be serviced sequentially. This is
called synchronization between the controller and the instrument.

Setting commands within one command line, even though they may be implemented
as sequential commands, are not necessarily serviced in the order in which they have
been received. In order to make sure that commands are actually carried out in a cer-
tain order, each command must be sent in a separate command line.

As a general rule, send commands and queries in different program messages.

14.1.41

Preventing Overlapping Execution

To prevent an overlapping execution of commands, one of the commands *OPC,
*OPC? or *WAI can be used. All three commands cause a certain action only to be
carried out after the hardware has been set. By suitable programming, the controller
can be forced to wait for the corresponding action to occur.
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Synchronization using *OPC, *OPC? and *WAI

Com-
mand

Action

Programming the controller

*OPC

Sets the Operation Complete bit in the ESR
after all previous commands have been exe-
cuted.

®  Setting bit 0 in the ESE
®  Setting bit 5 in the SRE
®  Waiting for service request (SRQ)

*OPC?

Stops command processing until 1 is
returned. This is only the case after the Oper-
ation Complete bit has been set in the ESR.
This bit indicates that the previous setting has
been completed.

Sending *OPC? directly after the command
whose processing should be terminated
before other commands can be executed.

*WAI

Stops further command processing until all
commands sent before *WAI have been exe-
cuted.

Sending *WAI directly after the command
whose processing should be terminated
before other commands are executed.

Command synchronization using *WAI or *OPC? appended to an overlapped com-
mand is a good choice if the overlapped command takes only little time to process. The
two synchronization techniques simply block overlapped execution of the command.

For time consuming overlapped commands it is usually desirable to allow the controller
or the instrument to do other useful work while waiting for command execution. Use
one of the following methods:

*OPC with a service request

1. Set the OPC mask bit (bit no. 0) in the ESE: *ESE 1

Set bit no. 5 in the SRE: *SRE 32 to enable ESB service request.

2
3. Send the overlapped command with *OPC
4

Wait for a service request

The service request indicates that the overlapped command has finished.

*OPC? with a service request

1. Set bit no. 4 in the SRE: *SRE 16 to enable MAV service request.

2. Send the overlapped command with *OPC?

3. Wait for a service request

The service request indicates that the overlapped command has finished.

Event Status Register (ESE)
1. Set the OPC mask bit (bit no. 0) in the ESE: *ESE 1

2. Send the overlapped command without *OPC, *OPC? or *WAI

3. Poll the operation complete state periodically (by means of a timer) using the
sequence: *OPC; *ESR?

A return value (LSB) of 1 indicates that the overlapped command has finished.
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*OPC? with short timeout
1. Send the overlapped command without *OPC, *OPC? or *WAI

2. Poll the operation complete state periodically (by means of a timer) using the
sequence: <short timeout>; *OPC?

3. Areturn value (LSB) of 1 indicates that the overlapped command has finished. In
case of a timeout, the operation is ongoing.

4. Reset timeout to former value

5. Clear the error queue with SYStem:ERRor? to remove the "-410, Query interrup-
ted" entries.

Using several threads in the controller application

As an alternative, provided the programming environment of the controller application
supports threads, separate threads can be used for the application GUI and for control-
ling the instrument(s) via SCPI.

A thread waiting for a *OPC? thus will not block the GUI or the communication with
other instruments.

14.1.5 Status Reporting System
The status reporting system stores all information on the current operating state of the

instrument, and on errors which have occurred. This information is stored in the status
registers and in the error queue.

You can query both with the commands of the STATus Subsystem.
14.1.5.1 Hierarchy of the Status Registers

The figure 14-1 shows the hierarchical structure of information in the status registers
(ascending from left to right).
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Fig. 14-1: Graphical overview of the status registers hierarchy

OPER = Operation Status Summary Bit
RQS/MSS = Service Request Generation

ESB = Standard Event Status Summary Bit
MAV = Message Available in Output Queue
QUES = Querstionable Status Summary Bit
2 = Error- /Event-Queue

1,0 = not used

Note: This legend explains the abbreviations to the Status Byte Register.

The R&S SGS uses the following status registers:

e Status Byte (STB) and Service Request Enable (SRE), see chapter 14.1.5.3,
"Status Byte (STB) and Service Request Enable Register (SRE)", on page 247.
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e Standard Event Status, i.e. the Event status Register (ESR) and the Event Status
Enable (ESE), see chapter 14.1.5.4, "Event Status Register (ESR) and Event Sta-
tus Enable Register (ESE)", on page 248.

® Questionable Status and Operation Status, the (SCPI status registers, see chap-
ter 14.1.5.2, "Structure of a SCPI Status Register", on page 245, chapter 14.1.5.5,
"Questionable Status Register (STATus:QUEStionable)", on page 248 and chap-
ter 14.1.5.6, "Operation Status Register (STATus:OPERation)", on page 249.

e Output-Queue
The output queue contains the messages the instrument returns to the controller. It
is not part of the status reporting system but determines the value of the MAV bit in
the sTB and thus is represented in the overview.

® Error- /Event-Queue
The error-/event-queue contains all errors and events that have occurred in the

past. When reading the queue the instrument starts with the first occurred error/
event.

All status registers have the same internal structure.

SRE, ESE

The service request enable register SRE can be used as ENAB1e part of the STB if the
STB is structured according to SCPI. By analogy, the ESE can be used as the ENABle
part of the ESR.

14.1.5.2

Structure of a SCPI Status Register

Each standard SCPI register consists of 5 parts. Each part has a width of 16 bits and
has different functions. The individual bits are independent of each other, i.e. each
hardware status is assigned a bit number which is valid for all five parts. Bit 15 (the
most significant bit) is set to zero for all parts. Thus the contents of the register parts
can be processed by the controller as positive integers.

States, events or summary bits of other registers

B T N T TN T 2 A

CONDition part 3
3

EEREEREEREN

15|14 [ 13 | 12 PTRansition part

N le— N |e—
- |l - |e—
o |l o |e—

15|14 [ 13 | 12 NTRansition part 3|2 1 0

REERERENERENERN

15| 14 | 13 | 12 EVEN part 3|2 (1|0

Logic OR of
all bits

NNNNRRRAANEENY
'

Summary bit of SCPI register,
written into a bit of the STB or
into the CONDition bit of a
superordinate register.

Logical AND of
EVENt and
ENABIe bits

15 | 14 | 13 | 12 ENABIle part 312|110

Fig. 14-2: The status-register model
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Description of the five status register parts

The five parts of a SCPI register have different properties and functions:

CONDition

The CONDition part is written into directly by the hardware or the sum bit of the
next lower register. Its contents reflect the current instrument status. This register
part can only be read, but not written into or cleared. Its contents are not affected
by reading.

PTRansition / NTRansition

The two transition register parts define which state transition of the CONDition
part (none, 0 to 1, 1 to 0 or both) is stored in the EVENt part.

The Positive-TRansition part acts as a transition filter. When a bit of the
CONDition partis changed from O to 1, the associated PTR bit decides whether
the EVENt bit is set to 1.

— PTR bit =1: the EVENt bit is set.

— PTR bit =0: the EVENt bit is not set.

This part can be written into and read as required. Its contents are not affected by
reading.

The Negative-TRansition part also acts as a transition filter. When a bit of the
CONDition partis changed from 1 to 0, the associated NTR bit decides whether
the EVENt bit is set to 1.

— NTR bit =1: the EVENt bit is set.

— NTR bit =0: the EVENt bit is not set.

This part can be written into and read as required. Its contents are not affected by
reading.

EVENt

The EVENt part indicates whether an event has occurred since the last reading, it
is the "memory" of the condition part. It only indicates events passed on by the
transition filters. It is permanently updated by the instrument. This part can only be
read by the user. Reading the register clears it. This part is often equated with the
entire register.

ENABIle

The ENABle part determines whether the associated EVENt bit contributes to the
sum bit (see below). Each bit of the EVENt part is "ANDed" with the associated
ENABle bit (symbol '&'). The results of all logical operations of this part are passed
on to the sum bit via an "OR" function (symbol '+').

ENABle bit = 0: the associated EVENt bit does not contribute to the sum bit
ENABle bit = 1: if the associated EVENt bit is "1", the sum bit is set to "1" as well.
This part can be written into and read by the user as required. Its contents are not
affected by reading.

Sum bit

The sum bit is obtained from the EVENt and ENABle part for each register. The result
is then entered into a bit of the CONDition part of the higher-order register.
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The instrument automatically generates the sum bit for each register. Thus an event
can lead to a service request throughout all levels of the hierarchy.

14.1.5.3 Status Byte (STB) and Service Request Enable Register (SRE)

The STatus Byte (STB) is already defined in IEEE 488.2. It provides a rough over-
view of the instrument status by collecting the pieces of information of the lower regis-
ters. A special feature is that bit 6 acts as the sum bit of the remaining bits of the status
byte.

The STB is read using the command *STB? or a serial poll.

The STatus Byte (STB)is linked to the Service Request Enable (SRE) register.
Each bit of the STB is assigned a bit in the SRE. Bit 6 of the SRE is ignored. If a bit is
set in the SRE and the associated bit in the STB changes from 0 to 1, a service
request (SRQ) is generated. The SRE can be set using the command *sRE and read
using the command *SRE?.

Table 14-2: Meaning of the bits used in the status byte

Bit No. | Meaning

0...1 Not used

2 Error Queue not empty

The bit is set when an entry is made in the error queue. If this bit is enabled by the SRE, each
entry of the error queue generates a service request. Thus an error can be recognized and
specified in greater detail by polling the error queue. The poll provides an informative error mes-
sage. This procedure is to be recommended since it considerably reduces the problems
involved with remote control.

3 QUEStionable status register summary bit

The bit is set if an EVENt bit is set in the QUEStionable status register and the associated
ENABle bitis set to 1. A set bit indicates a questionable instrument status, which can be speci-
fied in greater detail by querying the STATus : QUEStionable status register.

4 MAV bit (message available)

The bit is set if a message is available in the output queue which can be read. This bit can be
used to enable data to be automatically read from the instrument to the controller.

5 ESB bit

Sum bit of the event status register. It is set if one of the bits in the event status register is set
and enabled in the event status enable register. Setting of this bit indicates a serious error which
can be specified in greater detail by polling the event status register.

6 MSS bit (master status summary bit)

The bit is set if the instrument triggers a service request. This is the case if one of the other bits
of this registers is set together with its mask bit in the service request enable register SRE.

7 STATus:OPERation status register summary bit

The bit is set if an EVENt bit is set in the OPERat ion status register and the associated
ENABle bitis set to 1. A set bit indicates that the instrument is just performing an action. The
type of action can be determined by querying the STATus : OPERation status register.
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14.1.5.4 Event Status Register (ESR) and Event Status Enable Register (ESE)

The ESR is defined in IEEE 488.2. It can be compared with the EVENt part of a SCPI
register. The event status register can be read out using command *ESR?.

The ESE corresponds to the ENAB1e part of a SCPI register. If a bit is set in the ESE
and the associated bit in the ESR changes from 0 to 1, the ESB bit in the STB is set.
The ESE register can be set using the command *EsE and read using the command
*ESE?.

Table 14-3: Meaning of the bits used in the event status register

Bit No. | Meaning

0 Operation Complete
This bit is set on receipt of the command *OPC exactly when all previous commands have been
executed.

1 Not used

2 Query Error

This bit is set if either the controller wants to read data from the instrument without having sent a
query, or if it does not fetch requested data and sends new instructions to the instrument
instead. The cause is often a query which is faulty and hence cannot be executed.

3 Device-dependent Error

This bit is set if a device-dependent error occurs. An error message with a number between
-300 and -399 or a positive error number, which denotes the error in greater detail, is entered
into the error queue.

4 Execution Error

This bit is set if a received command is syntactically correct but cannot be performed for other
reasons. An error message with a number between -200 and -300, which denotes the error in
greater detail, is entered into the error queue.

5 Command Error

This bit is set if a command is received, which is undefined or syntactically incorrect. An error
message with a number between -100 and -200, which denotes the error in greater detail, is
entered into the error queue.

6 User Request

This bit is set when the instrument is switched over to manual control.

7 Power On (supply voltage on)

This bit is set on switching on the instrument.

14.1.5.5 Questionable Status Register (STATus:QUEStionable)
This register contains information on questionable instrument states. Such states may
occur when the instrument is not operated in compliance with its specifications.

To read the register, use the query commands STAT:QUEST:COND? or
STAT:QUEST[:EVEN]?.
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Table 14-4: Meaning of the bits used in the questionable status register

Bit No. | Meaning

0-15 not used

Operation Status Register (STATus:OPERation)

This condition part contains information on the actions currently being performed by
the instrument, while the event part contains information on the actions performed by
the instrument since the last readout of the register.

To read the register, use the query commands STAT:OPER:COND? or
STAT:OPER[:EVEN]?.

Table 14-5: Meaning of the bits used in the operation status register

Bit No. | Meaning

0 Calibrating

The bit is set during the calibration phase.

1-2 not used

3 Sweeping
This bit is set during a sweep in automatic or single mode.

4-15 not used

Application of the Status Reporting System

The purpose of the status reporting system is to monitor the status of one or several
devices in a measuring system. To do this and react appropriately, the controller must
receive and evaluate the information of all devices. The following standard methods
are used:

® Service request (SRQ) initiated by the instrument

® Serial poll of all devices in the bus system, initiated by the controller in order to
find out who sent a SRQ and why

® Query of a specific instrument status by means of commands
® Query of the error queue

Service Request

Under certain circumstances, the instrument can send a service request (SRQ) to the
controller. Usually this service request initiates an interrupt at the controller, to which
the control program can react appropriately. An SRQ is always initiated if one or sev-
eral of bits 2, 4 or 5 of the status byte are set and enabled in the SRE. Each of these
bits combines the information of the error queue or the output buffer. In order to use
the possibilities of the service request effectively, all bits should be set to "1" in the
enable registers SRE and ESE.
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Example:

Use command *0OPC to generate an SRQ .

*ESE 1 - set bit 0 of ESE (Operation Complete)

*SRE 32 - set bit 5 of SRE (ESB).

After its settings have been completed, the instrument generates an SRQ.

The SRQ is the only possibility for the instrument to become active on its own. Each
controller program should set the instrument such that a service request is initiated in
the case of malfunction. The program should react appropriately to the service request.

Serial Poll

In a serial poll, just as with command *STB, the status byte of an instrument is queried.
However, the query is realized via interface messages and is thus clearly faster.

The serial poll method is defined in IEEE 488.1 and used to be the only standard pos-
sibility for different instruments to poll the status byte. The method also works for
instruments which do not adhere to SCPI or IEEE 488.2.

The serial poll is mainly used to obtain a fast overview of the state of several instru-
ments connected to the controller.

Query of an instrument status

Each part of any status register can be read using queries. There are two types of
commands:

® The common commands *ESR?, *IDN?, *IST?, *STB? query the higher-level
registers.

® The commands of the STATus system query the SCPI registers
(STATus:QUEStionable...)

The returned value is always a decimal number that represents the bit pattern of the
queried register. This number is evaluated by the controller program.

Queries are usually used after an SRQ in order to obtain more detailed information on
the cause of the SRQ.

Error Queue

Each error state in the instrument leads to an entry in the error queue. The entries of
the error queue are detailed plain text error messages that can be looked up in the
Error Log or queried via remote control using SYSTem: ERRor [ : NEXT] ? or
SYSTem:ERRor:ALL?. Each call of SYSTem:ERRor [ :NEXT] ? provides one entry
from the error queue. If no error messages are stored there any more, the instrument
responds with 0, "No error".

The error queue should be queried after every SRQ in the controller program as the
entries describe the cause of an error more precisely than the status registers. Espe-
cially in the test phase of a controller program the error queue should be queried regu-
larly since faulty commands from the controller to the instrument are recorded there as
well.
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Reset Values of the Status Reporting System

The following table contains the different commands and events causing the status
reporting system to be reset. None of the commands, except of *RST and

SYSTem: PRESet affect the functional instrument settings. In particular, DCIL. does not
change the instrument settings.

Table 14-6: Resetting the status reporting system

Event Switching on supply | DCL, *RST or STA- *CLS
voltage SDC SYS- Tus:PRE-
Power-On-Status- (Device ;em:PRE' Set
Clear Clear, et
Selected
Device
Effect 0 1
¢ Clear)
Clear STB, ESR - yes - - - yes
Clear SRE, ESE - yes - - - -
Clear PPE - yes - - - -
Clear error queue yes yes - - - yes
Clear output buffer yes yes yes 1) 1) 1)
Clear command processing yes yes yes - - -
and input buffer
1) The first command in a command line that immediately follows a <PROGRAM MESSAGE TERMINA-
TOR> clears the output buffer.

14.1.6 General Programming Recommendations

Initial instrument status before changing settings

Manual operation is designed for maximum possible operating convenience. In con-
trast, the priority of remote control is the "predictability” of the instrument status. Thus,
when a command attempts to define incompatible settings, the command is ignored
and the instrument status remains unchanged, i.e. other settings are not automatically
adapted. Therefore, control programs should always define an initial instrument status
(e.g. using the *RST command) and then implement the required settings.

Command sequence

As a general rule, send commands and queries in different program messages. Other-
wise, the result of the query may vary depending on which operation is performed first
(see also Preventing Overlapping Execution).

Reacting to malfunctions

The service request is the only possibility for the instrument to become active on its
own. Each controller program should instruct the instrument to initiate a service
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Telnet program examples

request in case of malfunction. The program should react appropriately to the service
request.

Error queues

The error queue should be queried after every service request in the controller pro-
gram as the entries describe the cause of an error more precisely than the status regis-
ters. Especially in the test phase of a controller program the error queue should be
queried regularly since faulty commands from the controller to the instrument are
recorded there as well.

Telnet program examples

The following program example shows a simple TcpClient class thatis intended to
explain on how to get started with programming of sockets.

The example sets up a socket communication to R&S SGS and opens a simple user
interface, very similar to the telnet, which allows input of commands. To enable real
automation, further development of the program is required.

TcpClient.h

#include <string>
//defines structs for socket handling
#include <netinet/in.h>
using namespace std;
typedef struct sockaddr in SockAddrStruct;
typedef struct hostent HostInfoStruct;
class TcpClient
{
public:
TcpClient () ;
~TcpClient () ;
void connectToServer( string &hostname, int port );
void disconnect ( );
void transmit( string &txString );

void receive( string &rxString );

string getCurrentHostName ( ) const;

int getCurrentPort ( ) const;
private:

string currentHostName;

int currentPort;

int currentSocketDescr;

SockAddrStruct serverAddress;
HostInfoStruct * currentHostInfo;
bool clientIsConnected;

int receiveBufferSize;
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TcpClient.cpp

#include <string>
//defines structs for socket handling
#include <netinet/in.h>
using namespace std;
typedef struct sockaddr in SockAddrStruct;
typedef struct hostent HostInfoStruct;
class TcpClient
{
public:
TcpClient () ;
~TcpClient () ;
void connectToServer( string &hostname, int port );
void disconnect( );
void transmit( string &txString );

void receive( string &rxString );

string getCurrentHostName ( ) const;

int getCurrentPort ( ) const;
private:

string currentHostName;

int currentPort;

int currentSocketDescr;

SockAddrStruct serverAddress;
HostInfoStruct * currentHostInfo;
bool clientIsConnected;
int receiveBufferSize;

}i

#include <netdb.h>

#include <netinet/in.h>

#include <unistd.h>

#include "TcpClient.h"

TcpClient::TcpClient ()
currentHostName ( "" )

, currentPort( 0 )

, currentSocketDescr( 0 )

, serverAddress ( )

, currentHostInfo ( NULL )

, clientIsConnected( false )

, receiveBufferSize( 1024 )

TcpClient::~TcpClient ()
{
currentHostInfo = NULL;

void TcpClient::connectToServer ( string &hostname, int port )

{
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currentHostInfo = gethostbyname ( hostname.c str( ) );
if ( currentHostInfo == NULL )
{

currentHostName ="";

currentPort = 0;

currentHostInfo = NULL;

clientIsConnected = false;

printf ("error connecting host\n" );
}
currentHostName = hostname;
currentPort = port;

currentSocketDescr = socket (AF_INET, SOCK_STREAM, 0);

if ( currentSocketDescr == 0 )
{
currentHostName = "";
currentPort = 0;
currentHostInfo = NULL;

clientIsConnected = false;

printf ("can't create socket\n" );
}
serverAddress.sin family = currentHostInfo->h addrtype;
serverAddress.sin port = htons ( currentPort );
memcpy ( (char *) &serverAddress.sin addr.s_addr,

currentHostInfo->h addr 1ist[0], currentHostInfo->h length );

if ( connect ( currentSocketDescr, ( struct sockaddr *) &serverAddress,
sizeof ( serverAddress ) ) < 0 )

{

throw string("can't connect server\n" );

}

clientIsConnected = true;

4

void TcpClient::disconnect( )

{

if( clientIsConnected )

{

close ( currentSocketDescr );

}

currentSocketDescr = 0;
currentHostName ="";
currentPort = 0;
currentHostInfo = NULL;
clientIsConnected = false;

4

void TcpClient::transmit( string &txString )

{

if( !clientIsConnected )

{

throw string("connection must be established before any data can be sent\n");

}

char * transmitBuffer = new char[txString.length() +11;
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memcpy ( transmitBuffer, txString.c str(), txString.length() );
transmitBuffer[txString.length()] = '\n'; //newline is needed!
if( send( currentSocketDescr, transmitBuffer, txString.length() + 1, 0 ) < 0 )
{
throw string("can't transmit data\n");
}
delete [] transmitBuffer;
}
void TcpClient::receive( string &rxString )
{
if( !'clientIsConnected )
{
throw string("connection must be established before any data can be received\n");
}
char * receiveBuffer = new char|[receiveBufferSize];
memset ( receiveBuffer, 0, receiveBufferSize );
bool receiving = true;
while( receiving )
{
int receivedByteCount = recv( currentSocketDescr,
receiveBuffer, receiveBufferSize, 0 );
if ( receivedByteCount < 0 )
{
throw string("error while receiving data\n");
}

rxString += string( receiveBuffer );

receiving = ( receivedByteCount == receiveBufferSize );
}
delete [] receiveBuffer;
}
string TcpClient::getCurrentHostName( ) const

{

return currentHostName;

}
int TcpClient::getCurrentPort( ) const

{

return currentPort;

TelnetClient.cpp

#include <iostream>
#include "TcpClient.h"
void printUsage ()

{

cout<<"usage: EthernetRawCommand <server-ip> [scpi-command]"<<endl;
}
int main( int argc, char *argv[] )
{

int errorCode = 0; //no error
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bool useSingleCommand = false;

string singleCommand = "";
string hostname = .
int port = 5025;
string input = nw,

TcpClient client;
switch( argc )
{

case 3:

useSingleCommand = true;

singleCommand = argv[2];
case 2:
hostname = argv[1l];
break;
default:

printUsage () ;

return(-1);
try

client.connectToServer ( hostname, port );
bool terminate = false;
while( !'terminate )
{
char buffer[1024];
if ( useSingleCommand )
{
input = singleCommand; //send string
}
else
{
cin.getline( buffer, 1024 );
input = buffer;
if ( input == "end" )
{

terminate = true;

}
if ( !terminate)
{
client.transmit ( input ); //send string
int gPos = input.find( "?2", 0 );
//receive string only when needed
if( gbPos > 0 )
{
string rcStr = "";
client.receive( rcStr );

cout << rcStr << endl;
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if ( useSingleCommand )

{

terminate = true;

}

}catch( const string errorString )

{

cout<<errorString<<endl;
}
client.disconnect( );

return errorCode;
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